Mac OS X Tiger
Timesaving Techniques for Dummies

Expert insights that help you work like a pro!

Larry Ullman
Marc Liyanage

Over 60 timesavers
About the Authors

Larry Ullman is the Director of Digital Media Technologies at DMC Insights, Inc., and the author of several computer books. In addition to writing, Larry develops dynamic Web applications, conducts training seminars, and is an Extension Instructor for the University of California at Berkeley. He’s been working with Apple computers for more than 20 years, starting with the Apple IIe back in the dark (or monochrome) ages.

When he’s not tinkering on his Mac, Larry spends his time reading, remodeling his house, and, given the time, napping in front of the fireplace. Larry currently lives outside of Washington, D.C., with his wife of nine years, Jessica.

Marc Liyanage is a senior software engineer at futureLAB AG, a research and development company focusing on emerging Internet, telecommunications, and wireless technologies.

He’s been using and programming Macintosh computers professionally for 15 years for desktop publishing, video and TV screen design, and software development. He’s been a UNIX user and software engineer for the past ten years in the Internet/ISP industry, doing commercial Web application work and large-scale ISP systems design and implementation using open source software packages. He has also taught classes on XML and trained junior software engineers.

He’s been a Mac OS X user and developer since the first beta versions, and he’s very excited about this OS because it brings together the elegance of the Macintosh with the power of UNIX. In his spare time, he runs the developer-oriented Mac OS X Web site www.entropy.ch, writes Cocoa software, and tinkers with his Mac.

His other spare-time interests include graphic design, typography, and digital photography. He enjoys watching and reading science fiction movies and books. Marc lives in Zurich, Switzerland.
Dedication

We dedicate this book to the good people at Apple. Thanks for designing wicked hardware, putting out the best operating system we’ve ever used (that’d be OS X), giving away some top-notch software, and demonstrating that there’s nothing wrong with a computer that’s cool, feature-rich, secure, and stable.

Marc would like to also dedicate this book to his mother, Martina.

Authors’ Acknowledgments

As always, thanks to Jessica for her support.

Our thanks to everyone at Wiley and at Waterside.

A special shout-out to David at Apple, for being such a swell guy.

Thanks to my excellent co-author, Marc, both for his much-needed assistance with this book as well as for the copious amount of work and support he has done for the Mac OS X platform over the years.

Last but not least, my sincerest gratitude goes out to you, the reader. Thanks for having such good taste in both computers and books!

—Larry Ullman

First and foremost, big thanks to Larry Ullman for inviting me to join him on this book project and for being a great guy to work with. I enjoyed every minute and learned a lot on the way.

Thanks to my friends at futureLAB for making this the best work place in the world!

Finally, thanks to my brother Andy for being a great friend.

—Marc Liyanage
Publisher’s Acknowledgments

We’re proud of this book; please send us your comments through our online registration form located at www.dummies.com/register.

Some of the people who helped bring this book to market include the following:

**Acquisitions, Editorial, and Media Development**

- **Project Editor**: Pat O’Brien
- **Acquisitions Editor**: Bob Woerner
- **Copy Editor**: Virginia Sanders
- **Technical Editor**: Dennis Cohen
- **Editorial Manager**: Kevin Kirschner
- **Media Development Manager**: Laura VanWinkle
- **Media Development Supervisor**: Richard Graves
- **Editorial Assistant**: Amanda Foxworth
- **Cartoons**: Rich Tennant, www.the5thwave.com

**Composition Services**

- **Project Coordinator**: Nancee Reeves
- **Layout and Graphics**: Lauren Goddard, Denny Hager, Stephanie D. Jumper, Lynsey Osborn, Melanee Prendergast, Heather Ryan
- **Proofreaders**: Leeann Harney, Jessica Kramer, Carl William Pierce, Sossity R. Smith
- **Indexer**: Johnna VanHoose

---

**Publishing and Editorial for Technology Dummies**

- **Richard Swadley**, Vice President and Executive Group Publisher
- **Andy Cummings**, Vice President and Publisher
- **Mary Bednarek**, Executive Acquisitions Director
- **Mary C. Corder**, Editorial Director

**Publishing for Consumer Dummies**

- **Diane Graves Steele**, Vice President and Publisher
- **Joyce Pepple**, Acquisitions Director

**Composition Services**

- **Gerry Fahey**, Vice President of Production Services
- **Debbie Stailey**, Director of Composition Services
## Contents at a Glance

**Introduction**  
1

**Part I: Starting, Stopping, and Running Your Mac Faster**  
7
- Technique 1: Installing Tiger without the Hassle  
9
- Technique 2: Starting Up with Speed  
20
- Technique 3: Running Tiger Faster  
26
- Technique 4: When Good Applications Go Bad  
34
- Technique 5: Logging Out and Shutting Down  
39
- Technique 6: Goodbye Microsoft, Hello Mac!  
45

**Part II: Optimizing Your Interface**  
51
- Technique 7: Making Your Mac More Accessible  
53
- Technique 8: Working with Displays  
61
- Technique 9: Speedy Keyboard Navigation  
69
- Technique 10: Essential Keyboard Shortcuts  
78
- Technique 11: A Faster Finder  
84
- Technique 12: Customizing Windows for Your Convenience  
93
- Technique 13: Establishing an Efficient Dock  
102
- Technique 14: Saving Steps with Contextual Menus  
108
- Technique 15: Easily Managing Windows with Exposé  
114

**Part III: Handling Files (And Other Stuff) Quickly**  
121
- Technique 16: Organizing Your Home Directory  
123
- Technique 17: Managing Aliases, Favorites, and Icons  
132
- Technique 18: Addressing Your Addresses  
141
- Technique 19: Managing Information Effectively  
151
- Technique 20: Working with Files  
155
- Technique 21: Finding Things in Tiger  
164
- Technique 22: Slimming Down Your Hard Drive  
172

**Part IV: Improving Application Performance**  
177
- Technique 23: Launching Applications Fast  
179
- Technique 24: Switching, Hiding, and Quitting Applications  
186
- Technique 25: Opening Files Faster  
191
- Technique 26: Saving and Printing Files  
197
- Technique 27: Cut, Copy, Paste  
204
- Technique 28: Managing Fonts  
209
- Technique 29: Getting to Know Services  
217

**Part V: Cranking Up Your Internet Activities**  
223
- Technique 30: Surfing with Safari  
225
- Technique 31: Customizing Safari  
237
- Technique 32: Managing Bookmarks Better  
243
- Technique 33: Speedy Searches with Google  
251
- Technique 34: Mastering Mail  
258
- Technique 35: Stopping Spam in Its Tracks  
271
- Technique 36: Innovative iChat  
278

**Part VI: Optimizing Your Network**  
287
- Technique 37: Getting Your Mac Online  
289
- Technique 38: The Wonderful World of Wireless Networking  
297
<table>
<thead>
<tr>
<th>Technique</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>39</td>
<td>Sharing the Wealth with Bonjour</td>
<td>304</td>
</tr>
<tr>
<td>40</td>
<td>Share the Love: Sharing Files, Printers, and More</td>
<td>311</td>
</tr>
<tr>
<td>41</td>
<td>Network Security</td>
<td>319</td>
</tr>
<tr>
<td>42</td>
<td>Your Guide to .Mac: $100 Well Spent</td>
<td>324</td>
</tr>
<tr>
<td><strong>Part VII: Fast and Furious Multimedia</strong></td>
<td></td>
<td>331</td>
</tr>
<tr>
<td>43</td>
<td>iTunes: Rockin’ in the (Partially) Free World</td>
<td>333</td>
</tr>
<tr>
<td>44</td>
<td>Working with iPhoto</td>
<td>344</td>
</tr>
<tr>
<td>45</td>
<td>Snapping Screenshots Fast</td>
<td>352</td>
</tr>
<tr>
<td>46</td>
<td>Staying on Schedule with iCal</td>
<td>358</td>
</tr>
<tr>
<td>47</td>
<td>Working with CDs and DVDs</td>
<td>366</td>
</tr>
<tr>
<td>48</td>
<td>Getting More Than Music out of Your iPod</td>
<td>372</td>
</tr>
<tr>
<td><strong>Part VIII: Security and Maintenance</strong></td>
<td></td>
<td>381</td>
</tr>
<tr>
<td>49</td>
<td>Better Backups with rsync and .Mac</td>
<td>383</td>
</tr>
<tr>
<td>50</td>
<td>Battling Viruses</td>
<td>391</td>
</tr>
<tr>
<td>51</td>
<td>Keeping Your Software Up to Date</td>
<td>398</td>
</tr>
<tr>
<td>52</td>
<td>Securing Files</td>
<td>403</td>
</tr>
<tr>
<td>53</td>
<td>Proper Password Policy</td>
<td>409</td>
</tr>
<tr>
<td>54</td>
<td>Useful Utilities</td>
<td>415</td>
</tr>
<tr>
<td><strong>Part IX: The Scary or Fun Stuff</strong></td>
<td></td>
<td>421</td>
</tr>
<tr>
<td>55</td>
<td>Controlling Cellphones with Bluetooth</td>
<td>423</td>
</tr>
<tr>
<td>56</td>
<td>The Terminal, the Finder, and You</td>
<td>434</td>
</tr>
<tr>
<td>57</td>
<td>Managing and Finding Files Fast</td>
<td>443</td>
</tr>
<tr>
<td>58</td>
<td>Piping and Redirecting Output with the Terminal</td>
<td>449</td>
</tr>
<tr>
<td>59</td>
<td>Viewing and Editing Text Files</td>
<td>456</td>
</tr>
<tr>
<td>60</td>
<td>Customizing Your Terminal</td>
<td>462</td>
</tr>
<tr>
<td>61</td>
<td>Automating Your Routines</td>
<td>470</td>
</tr>
<tr>
<td>62</td>
<td>Entertaining Yourself with Screen Savers</td>
<td>478</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td><strong>Index</strong></td>
<td>485</td>
</tr>
</tbody>
</table>
# Table Of Contents

## Introduction

1. Saving Time with This Book
2. What’s New in Tiger
2. What’s New in This Book
2. Foolish Assumptions
3. How This Book Is Organized

   - Part I: Starting, Stopping, and Running Your Mac Faster
   - Part II: Optimizing Your Interface
   - Part III: Handling Files (And Other Stuff) Quickly
   - Part IV: Improving Application Performance
   - Part V: Cranking Up Your Internet Activities
   - Part VI: Optimizing Your Network
   - Part VII: Fast and Furious Multimedia
   - Part VIII: Security and Maintenance
   - Part IX: The Scary Or Fun Stuff

4. Conventions Used in This Book
5. Icons Used in This Book
5. Comments and Questions

## Part I: Starting, Stopping, and Running Your Mac Faster

### Technique 1: Installing Tiger without the Hassle
9. What Tiger Can Do for You
10. Choosing an Installation Method
11. Managing Your Hard Drives
12. Formatting a Volume
13. Installing Tiger
17. Working with Setup Assistant
18. Transferring Files Flawlessly

### Technique 2: Starting Up with Speed
20. Faster Startups: Never Shut Down
21. Scheduling Your Startups
22. Speeding Up the Login Process
23. Starting Applications Automatically
25. Keeping the System Preferences Handy

## Technique 3: Running Tiger Faster
26. Optimizing Your System through Maintenance
29. Disabling Unnecessary Features
30. Longer Battery Life
32. Improving Performance through Hardware

## Technique 4: When Good Applications Go Bad
34. Slaying Stalled Apps with the Dock
35. Gaining Better Performance through Activity Monitoring
37. Crashing Your Mac

## Technique 5: Logging Out and Shutting Down
39. Logging Out
41. Securing Your System with a Screen Saver
42. Fast User Switching
44. Making the Quick Exit

## Technique 6: Goodbye Microsoft, Hello Mac!
45. Where Is the Alt Key? Mac Basics
46. Your new keyboard
47. How to use a one-buttoned mouse
47. Working with the Finder, your new Desktop
48. Setting System Preferences
49. Using Mac Help
50. Useful Migration Resources

## Part II: Optimizing Your Interface

### Technique 7: Making Your Mac More Accessible
51. Listening to Your Mac
56. Talking Back to Your Computer
57. Using Visual Clues
58. Customizing the Keyboard and Mouse to Suit Your Needs
<table>
<thead>
<tr>
<th>Technique 8: Working with Displays</th>
<th>61</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Your Display Resolution</td>
<td>61</td>
</tr>
<tr>
<td>Adjusting the Colors</td>
<td>63</td>
</tr>
<tr>
<td>Handling Fonts</td>
<td>65</td>
</tr>
<tr>
<td>Using Multiple Displays</td>
<td>66</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 9: Speedy Keyboard Navigation</th>
<th>69</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard Characters</td>
<td>69</td>
</tr>
<tr>
<td>Moving Around in a Finder Window</td>
<td>70</td>
</tr>
<tr>
<td>Navigating in any view mode</td>
<td>70</td>
</tr>
<tr>
<td>Navigating in icon view</td>
<td>71</td>
</tr>
<tr>
<td>Navigating in list view</td>
<td>72</td>
</tr>
<tr>
<td>Navigating in column view</td>
<td>72</td>
</tr>
<tr>
<td>Navigating the Desktop</td>
<td>74</td>
</tr>
<tr>
<td>Getting Places</td>
<td>74</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 10: Essential Keyboard Shortcuts</th>
<th>78</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Most Essential of the Essential</td>
<td>78</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>80</td>
</tr>
<tr>
<td>Application Shortcuts</td>
<td>80</td>
</tr>
<tr>
<td>Function Keys</td>
<td>82</td>
</tr>
<tr>
<td>Programming Your Own Keyboard Shortcuts</td>
<td>82</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 11: A Faster Finder</th>
<th>84</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finder Preferences</td>
<td>84</td>
</tr>
<tr>
<td>General</td>
<td>85</td>
</tr>
<tr>
<td>Labels</td>
<td>85</td>
</tr>
<tr>
<td>Sidebar</td>
<td>87</td>
</tr>
<tr>
<td>Advanced</td>
<td>87</td>
</tr>
<tr>
<td>Show View Options</td>
<td>88</td>
</tr>
<tr>
<td>Menus</td>
<td>89</td>
</tr>
<tr>
<td>Using Your Input Device</td>
<td>91</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 12: Customizing Windows for Your Convenience</th>
<th>93</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding the View Modes</td>
<td>93</td>
</tr>
<tr>
<td>Icon view</td>
<td>94</td>
</tr>
<tr>
<td>List view</td>
<td>95</td>
</tr>
<tr>
<td>Column view</td>
<td>97</td>
</tr>
<tr>
<td>Customizing Windows</td>
<td>97</td>
</tr>
<tr>
<td>Toolbar</td>
<td>98</td>
</tr>
<tr>
<td>Sidebar</td>
<td>99</td>
</tr>
<tr>
<td>Scroll bars</td>
<td>100</td>
</tr>
<tr>
<td>Moving Windows Around</td>
<td>101</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 13: Establishing an Efficient Dock</th>
<th>102</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customizing the Dock</td>
<td>102</td>
</tr>
<tr>
<td>Organizing the Dock</td>
<td>104</td>
</tr>
<tr>
<td>Keyboard and Mouse Shortcuts for the Dock</td>
<td>104</td>
</tr>
<tr>
<td>Shareware for the Dock</td>
<td>107</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 14: Saving Steps with Contextual Menus</th>
<th>108</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grasping the Basics of Contextual Menus</td>
<td>108</td>
</tr>
<tr>
<td>Using CMs with Third-Party Applications</td>
<td>110</td>
</tr>
<tr>
<td>AppleScript, Contextual Menus, and You</td>
<td>111</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 15: Easily Managing Windows with Exposé</th>
<th>114</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introducing Exposé</td>
<td>114</td>
</tr>
<tr>
<td>Getting the Most out of Exposé</td>
<td>116</td>
</tr>
<tr>
<td>Dragging and dropping with Exposé</td>
<td>118</td>
</tr>
<tr>
<td>Using Exposé without the mouse</td>
<td>119</td>
</tr>
<tr>
<td>Dashing to the Dashboard</td>
<td>119</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part III: Handling Files (And Other Stuff) Quickly</th>
<th>121</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Technique 16: Organizing Your Home Directory</th>
<th>123</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your Stuff, Your Home Directory, and You</td>
<td>123</td>
</tr>
<tr>
<td>Checking Out Your Library</td>
<td>126</td>
</tr>
<tr>
<td>A Cluttered Desktop Is a Sign of a Cluttered Mind</td>
<td>128</td>
</tr>
<tr>
<td>Revisiting Our Friend, the Dock</td>
<td>130</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 17: Managing Aliases, Favorites, and Icons</th>
<th>132</th>
</tr>
</thead>
<tbody>
<tr>
<td>Also Known As: Working with Aliases</td>
<td>132</td>
</tr>
<tr>
<td>These Are a Few of My Favorites Things</td>
<td>135</td>
</tr>
<tr>
<td>If You Can, Icon</td>
<td>137</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 18: Addressing Your Addresses</th>
<th>141</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting to Know the Address Book</td>
<td>141</td>
</tr>
<tr>
<td>Customizing the Template</td>
<td>142</td>
</tr>
<tr>
<td>Creating Your Own vCard</td>
<td>144</td>
</tr>
</tbody>
</table>
Creating and Using Groups 146
  Using the New Group From Selection tool 146
  Creating a group manually 147
  Duplicating an existing group 148
  Creating Smart Groups 148
Other Cool Address Book Tricks 149

Technique 19: Managing Information Effectively 151
  Storing Information as a Sticky Note 151
  Stickies Lite: Using Dashboard 152
  Stickies Pro: Using StickyBrain 153

Technique 20: Working with Files 155
  Understanding a File's Properties 155
    The General panel 156
    The More Info panel 157
    The Name & Extension panel 158
    The Open With panel 159
    The Preview panel 159
    The Ownership & Permissions panel 160
    The Spotlight Comments panel 161
  Solving Common File Problems 162
    Deleting locked files 162
    Ejecting stuck disk images 162
    Finding the original for an alias 162
    Sharing files with another OS 163

Technique 21: Finding Things in Tiger 164
  Basic Finder Window Searches 164
  Using a Find Window 166
  Working With Smart Folders 168
  Searching for Things with Spotlight 170

Technique 22: Slimming Down Your Hard Drive 172
  Avoiding Unnecessary Installations 172
  Weeding Your Hard Drive: Manually Deleting Files 173
    Pruning your Home directory 174
    Thinning out no-longer-required applications 174
    Cleaning out your System and Library folders 175
    Cleaning other volumes 175
  Diet Tools: Third-Party Applications 176
  Hands Off: What Not to Trash 176

Part IV: Improving Application Performance 177

Technique 23: Launching Applications Fast 179
  Auto-Launching with the Accounts Panel 179
  Launching with the Finder 181
  Launching with the Dock 182
  Other Ways to Launch Applications 184
    Favorites and aliases 184
    Recent Items 184
  Launching with Shareware Tools 184

Technique 24: Switching, Hiding, and Quitting Applications 186
  Switching among Open Applications 186
    Switching apps with Tiger 186
    Switching apps with shareware 188
  Hiding Applications 188
  Quitting Applications 190
  Logging Out and Shutting Down 190

Technique 25: Opening Files Faster 191
  Opening Files with the Finder 191
  Opening Files with Specific Applications 192
    Using the Finder Window toolbar to open files 192
    Using the Dock to open files 192
    Using Favorites to open files 192
    Opening files with a contextual menu 192
  Using LaunchBar 193
  Opening Files within an Application 194
  Recalling Recent Items 194
    Recalling files from the Apple menu 195
    Recalling files from application menus 195
  Setting the Default Application for Files 196

Technique 26: Saving and Printing Files 197
  Saving Files 197
    Marc's cool trick for navigating in Save dialogs 200
    Overwriting existing files 200
  Printing 201
    Customizing print settings 201
    Previewing your documents 202
    Desktop printing 202
  Creating PDFs 202
<table>
<thead>
<tr>
<th>Technique 27: Cut, Copy, Paste</th>
<th>204</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copying and Pasting with the Keyboard and Mouse</td>
<td>204</td>
</tr>
<tr>
<td>Understanding the Clipboard</td>
<td>207</td>
</tr>
<tr>
<td>Clipboard Shareware Alternatives</td>
<td>207</td>
</tr>
<tr>
<td>Copy and Paste Tips and Tricks</td>
<td>207</td>
</tr>
<tr>
<td>Copying items within the Finder</td>
<td>208</td>
</tr>
<tr>
<td>Using the Find Clipboard</td>
<td>208</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 28: Managing Fonts</th>
<th>209</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fonts Supported in Tiger</td>
<td>209</td>
</tr>
<tr>
<td>Installing Fonts</td>
<td>210</td>
</tr>
<tr>
<td>Viewing Fonts</td>
<td>210</td>
</tr>
<tr>
<td>Character Palette</td>
<td>211</td>
</tr>
<tr>
<td>Font panel</td>
<td>213</td>
</tr>
<tr>
<td>Font Book</td>
<td>214</td>
</tr>
<tr>
<td>Managing Fonts</td>
<td>215</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 29: Getting to Know Services</th>
<th>217</th>
</tr>
</thead>
<tbody>
<tr>
<td>What Are Services?</td>
<td>217</td>
</tr>
<tr>
<td>Grasping the Best Services Techniques</td>
<td>219</td>
</tr>
<tr>
<td>Adding Services</td>
<td>221</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part V: Cranking Up Your Internet Activities</th>
<th>223</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technique 30: Surfing with Safari</td>
<td>225</td>
</tr>
<tr>
<td>Navigation Shortcuts</td>
<td>225</td>
</tr>
<tr>
<td>Standard Shortcuts</td>
<td>226</td>
</tr>
<tr>
<td>Other Shortcuts</td>
<td>227</td>
</tr>
<tr>
<td>Setting Preferences</td>
<td>228</td>
</tr>
<tr>
<td>Setting General preferences</td>
<td>228</td>
</tr>
<tr>
<td>Working with tabbed browsing</td>
<td>229</td>
</tr>
<tr>
<td>Blocking Pop-Up Windows</td>
<td>231</td>
</tr>
<tr>
<td>Saving Time with AutoFill Forms</td>
<td>232</td>
</tr>
<tr>
<td>Managing Usernames and Passwords</td>
<td>233</td>
</tr>
<tr>
<td>Marking Pages with SnapBack</td>
<td>234</td>
</tr>
<tr>
<td>Working with Really Simple Syndication</td>
<td>235</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 31: Customizing Safari</th>
<th>237</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improving Your Surfing Experience</td>
<td>237</td>
</tr>
<tr>
<td>Safari Search Enhancements</td>
<td>240</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 32: Managing Bookmarks Better</th>
<th>243</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Bookmarks in Safari</td>
<td>243</td>
</tr>
<tr>
<td>Bookmarking a page</td>
<td>245</td>
</tr>
<tr>
<td>Using the Bookmarks window</td>
<td>245</td>
</tr>
<tr>
<td>Using the Bookmarks Menu</td>
<td>246</td>
</tr>
<tr>
<td>Working with the Bookmarks Bar</td>
<td>246</td>
</tr>
<tr>
<td>Setting bookmark preferences in Safari</td>
<td>247</td>
</tr>
<tr>
<td>Accessing Safari Bookmarks</td>
<td>248</td>
</tr>
<tr>
<td>Sharing Bookmarks across Browsers</td>
<td>249</td>
</tr>
<tr>
<td>Bookmark Tips and Tricks</td>
<td>250</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 33: Speedy Searches with Google</th>
<th>251</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doing Basic Google Searches</td>
<td>251</td>
</tr>
<tr>
<td>Doing Advanced Google Searches</td>
<td>252</td>
</tr>
<tr>
<td>Doing Specialized Google Searches</td>
<td>253</td>
</tr>
<tr>
<td>Searching Google with Safari</td>
<td>254</td>
</tr>
<tr>
<td>Google Tips and Tricks</td>
<td>255</td>
</tr>
<tr>
<td>Google, the dictionary</td>
<td>255</td>
</tr>
<tr>
<td>Google, the mathematician</td>
<td>255</td>
</tr>
<tr>
<td>Google, the unit converter</td>
<td>256</td>
</tr>
<tr>
<td>Google, the linguist</td>
<td>256</td>
</tr>
<tr>
<td>Google, the investor</td>
<td>257</td>
</tr>
<tr>
<td>Google, the cartographer</td>
<td>257</td>
</tr>
<tr>
<td>Google, the (fill in the blank)</td>
<td>257</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 34: Mastering Mail</th>
<th>258</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Keyboard Shortcuts</td>
<td>258</td>
</tr>
<tr>
<td>Navigation shortcuts</td>
<td>259</td>
</tr>
<tr>
<td>Other shortcuts</td>
<td>259</td>
</tr>
<tr>
<td>Customizing Mail’s Appearance and Behavior</td>
<td>260</td>
</tr>
<tr>
<td>Setting General preferences</td>
<td>260</td>
</tr>
<tr>
<td>Setting Composing preferences</td>
<td>260</td>
</tr>
<tr>
<td>Customizing the Mail toolbar</td>
<td>261</td>
</tr>
<tr>
<td>Customizing the messages window</td>
<td>262</td>
</tr>
<tr>
<td>Customizing the New Message window</td>
<td>263</td>
</tr>
<tr>
<td>Organizing Your Mailboxes</td>
<td>265</td>
</tr>
<tr>
<td>Technique 35: Stopping Spam in Its Tracks</td>
<td>271</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>Fighting Spam with the Junk Mail Button</td>
<td>271</td>
</tr>
<tr>
<td>Creating and Using Rules</td>
<td>273</td>
</tr>
<tr>
<td>Stopping Spam before It Gets to You</td>
<td>275</td>
</tr>
<tr>
<td>Bouncing spam</td>
<td>276</td>
</tr>
<tr>
<td>Other spam tools</td>
<td>277</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 36: Innovative iChat</th>
<th>278</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard and Mouse Shortcuts</td>
<td>278</td>
</tr>
<tr>
<td>Customizing iChat</td>
<td>280</td>
</tr>
<tr>
<td>Transferring Files with iChat</td>
<td>282</td>
</tr>
<tr>
<td>Using the Videoconference</td>
<td>283</td>
</tr>
<tr>
<td>Creating URLs</td>
<td>285</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part VI: Optimizing Your Network</th>
<th>287</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technique 37: Getting Your Mac Online</td>
<td>289</td>
</tr>
<tr>
<td>Defining a Location</td>
<td>289</td>
</tr>
<tr>
<td>Using a Modem</td>
<td>292</td>
</tr>
<tr>
<td>Networking Tips and Tricks</td>
<td>294</td>
</tr>
<tr>
<td>Switching locations on the fly</td>
<td>294</td>
</tr>
<tr>
<td>Ordering your ports</td>
<td>295</td>
</tr>
<tr>
<td>Dialing with a calling card</td>
<td>295</td>
</tr>
<tr>
<td>Using FireWire over IP</td>
<td>295</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 38: The Wonderful World of Wireless Networking</th>
<th>297</th>
</tr>
</thead>
<tbody>
<tr>
<td>What to Look for in a Wireless Network</td>
<td>297</td>
</tr>
<tr>
<td>Creating an AirPort Network</td>
<td>299</td>
</tr>
<tr>
<td>Understanding Encryption</td>
<td>300</td>
</tr>
<tr>
<td>Finding Networks</td>
<td>301</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technique 39: Sharing the Wealth with Bonjour</th>
<th>304</th>
</tr>
</thead>
<tbody>
<tr>
<td>Why You Should Use Bonjour</td>
<td>304</td>
</tr>
<tr>
<td>Setting Up Bonjour</td>
<td>305</td>
</tr>
</tbody>
</table>

| Technique 40: Share the Love:                          | 311 |
| Sharing Files, Printers, and More                       | 311 |
| Safe Sharing                                            | 311 |
| Sharing a Web Page                                      | 312 |
| What's in a Name (Or URL)?                              | 313 |
| Fun with File Sharing                                    | 314 |
| Personal File Sharing                                    | 314 |
| Print Sharing                                            | 316 |
| Sharing Your Internet Connection                        | 316 |

| Technique 41: Network Security                         | 319 |
| Keeping Your Mac Secure                                 | 319 |
| Using a Firewall                                        | 320 |
| Software firewalls                                      | 320 |
| Hardware firewalls                                      | 321 |
| Checking for Security Problems                          | 322 |

| Technique 42: Your Guide to .Mac: $100 Well Spent       | 324 |
| Top Ten Reasons to Use .Mac                             | 324 |
| I Like My iDisk: Storing Stuff Online                   | 325 |
| Making your iDisk secure                                | 327 |
| Using another .Mac member's iDisk                       | 328 |
| Synchronizing Data with .Mac                            | 329 |

<table>
<thead>
<tr>
<th>Part VII: Fast and Furious Multimedia</th>
<th>331</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technique 43: iTunes: Rockin’ in the (Partially) Free World</td>
<td>333</td>
</tr>
<tr>
<td>Tweaking Your Preferences</td>
<td>333</td>
</tr>
<tr>
<td>Redecorating the iTunes Window</td>
<td>338</td>
</tr>
<tr>
<td>Managing Your Music</td>
<td>339</td>
</tr>
<tr>
<td>Editing song information</td>
<td>340</td>
</tr>
<tr>
<td>Searching for tracks</td>
<td>340</td>
</tr>
<tr>
<td>Creating playlists</td>
<td>341</td>
</tr>
<tr>
<td>Controlling iTunes</td>
<td>341</td>
</tr>
<tr>
<td>Blowing Your Paycheck at the iTunes Music Store</td>
<td>342</td>
</tr>
</tbody>
</table>
### Table of Contents

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mac GNU Privacy Guard</strong></td>
</tr>
<tr>
<td><strong>PGP</strong></td>
</tr>
<tr>
<td><strong>SubRosaSoft and CodeTek Studios</strong></td>
</tr>
<tr>
<td>Using the Finder’s Secure Empty Trash Option</td>
</tr>
<tr>
<td><strong>Technique 53: Proper Password Policy</strong></td>
</tr>
<tr>
<td>Creating a Good Password</td>
</tr>
<tr>
<td>Working with Apple’s Keychain Access</td>
</tr>
<tr>
<td>Changing the Login Password</td>
</tr>
<tr>
<td><strong>Technique 54: Useful Utilities</strong></td>
</tr>
<tr>
<td>Working with TinkerTool</td>
</tr>
<tr>
<td>Automating Tasks with cron</td>
</tr>
<tr>
<td>Performing Maintenance</td>
</tr>
<tr>
<td>Other Useful Utilities</td>
</tr>
<tr>
<td><strong>Part IX: The Scary or Fun Stuff</strong></td>
</tr>
<tr>
<td><strong>Technique 55: Controlling Cellphones with Bluetooth</strong></td>
</tr>
<tr>
<td>What Is Bluetooth?</td>
</tr>
<tr>
<td>Getting Started with Bluetooth</td>
</tr>
<tr>
<td>Setting Up Your Connection</td>
</tr>
<tr>
<td>Working with Your Address Book</td>
</tr>
<tr>
<td>Dialing from within Address Book</td>
</tr>
<tr>
<td>Display incoming call alerts</td>
</tr>
<tr>
<td>Sending and receiving SMS messages</td>
</tr>
<tr>
<td>Dialing Your Phone from a Text Selection</td>
</tr>
<tr>
<td>Synchronizing with iSync</td>
</tr>
<tr>
<td>Setting up iSync</td>
</tr>
<tr>
<td>Your Cellphone as a Remote Control</td>
</tr>
<tr>
<td>Storing Notes and Pictures on a Cellphone</td>
</tr>
<tr>
<td><strong>Technique 56: The Terminal, the Finder, and You</strong></td>
</tr>
<tr>
<td>Navigating within the Terminal</td>
</tr>
<tr>
<td>Getting around in the Terminal</td>
</tr>
<tr>
<td>Tab completion</td>
</tr>
<tr>
<td>Viewing directory contents</td>
</tr>
<tr>
<td>Navigating among open Terminal windows</td>
</tr>
<tr>
<td>Other commands</td>
</tr>
<tr>
<td>Terminal Tips and Tricks</td>
</tr>
<tr>
<td>Getting help</td>
</tr>
<tr>
<td>A command of history, or a history of commands</td>
</tr>
<tr>
<td>Role playing: Executing commands as another user</td>
</tr>
<tr>
<td>Making the Terminal and the Finder Play Together Nicely</td>
</tr>
<tr>
<td>Using the open command</td>
</tr>
<tr>
<td>Drag and drop with the Finder</td>
</tr>
<tr>
<td>Editing between the Terminal and the Finder</td>
</tr>
<tr>
<td><strong>Technique 57: Managing and Finding Files Fast</strong></td>
</tr>
<tr>
<td>Copying, Moving, Renaming, and Deleting Files</td>
</tr>
<tr>
<td>Creating and Listing Directories</td>
</tr>
<tr>
<td>Using Wildcards</td>
</tr>
<tr>
<td>Using the find Command</td>
</tr>
<tr>
<td>Using the locate Command</td>
</tr>
<tr>
<td><strong>Technique 58: Piping and Redirecting Output with the Terminal</strong></td>
</tr>
<tr>
<td>Handy Commands to Use with Piping</td>
</tr>
<tr>
<td>Combining Commands with Pipes</td>
</tr>
<tr>
<td>Redirecting Output</td>
</tr>
<tr>
<td><strong>Technique 59: Viewing and Editing Text Files</strong></td>
</tr>
<tr>
<td>Viewing Files</td>
</tr>
<tr>
<td>cat</td>
</tr>
<tr>
<td>more or less</td>
</tr>
<tr>
<td>Viewing Parts of Files</td>
</tr>
<tr>
<td>Editing Files</td>
</tr>
<tr>
<td>Editing with pico</td>
</tr>
<tr>
<td>Editing with Finder tools</td>
</tr>
<tr>
<td><strong>Technique 60: Customizing Your Terminal</strong></td>
</tr>
<tr>
<td>Adjusting Terminal’s Preferences</td>
</tr>
<tr>
<td>Terminal Preferences panel</td>
</tr>
<tr>
<td>Window Settings</td>
</tr>
<tr>
<td>Creating Terminal Preferences Files</td>
</tr>
<tr>
<td>Choosing Your Shell</td>
</tr>
<tr>
<td>Customizing Your Shell</td>
</tr>
<tr>
<td>Shareware Tools for Working with the Terminal</td>
</tr>
</tbody>
</table>
**Introduction**

We’re fairly smart people, and presumably you’re a really smart person (you are looking at the right book, after all), but it seems like technology evolves faster than we do. Even the magical Mac — the symbol of all things easy in the computer world — is chock full of features and gadgets and bells and whistles and pretty lights. (Okay, the lights are on the outside, but . . .) Make no mistake: You’ll love these things, once you know what they all are and how to use them, that is. So the question is How do I get from point A (merely having the features) to point B (doing what I want/need to do, quickly and easily)?

By reading this book, of course!

But if that isn’t enough to convince you (and we can’t imagine why not; after all, we’ve never lied to you before), take a moment or two to read through this introduction. We tell you where we’re coming from, what this book offers, and how it’ll make you fall in love with your Mac all over again.

**Saving Time with This Book**

The *Timesaving Techniques For Dummies* books focus on high-payoff techniques that save you time, either immediately or over the long haul. And these books get to the point in a hurry, with step-by-step instructions to take you through the tasks you need to do, without any of the fluff you don’t want. We’ve identified more than 60 techniques that Mac OS X Tiger users need to know to make the most of their computers. In addition, each technique includes lots of figures that make following along a breeze. Decide for yourself how to use this book: Read it cover to cover if you like, or skip right to the technique that interests you the most.

In *Mac OS X Tiger Timesaving Techniques For Dummies*, you can find out how to

- **Tame time-consuming tasks**: Because we demystify the inner workings of Mac OS X Tiger for you, letting you in on more than 60 tips and tricks along the way, you can spend more time making computer magic and less time fussing around.

- **Take your skills up a notch**: You’re already familiar with the basics of using Mac OS X. Now this book takes you to the next level, helping you become an even savvier Mac user. The things you’ll discover will amaze your friends, scare your enemies, and duly impress your boss.
Customize Mac OS X to meet your needs:
Spending some upfront time customizing Mac OS X so that it works faster, more reliably, and more like how you work on a daily basis can save you time (and aggravation) later. Even if you’re not an organized person by habit, rest assured that at least your Mac will be in shipshape condition.

What’s New in Tiger

Tiger has big new features and applications as well as nice, little additions to existing software. On the big scale, there is Spotlight, a most excellent search tool for finding things on your computer (see Technique 21). There is also Dashboard, a widget mechanism that’s part of Exposé (Technique 15), which is both cool and useful. Last, in Part IX of the book, you find out how to use Automator, our new best friend.

If you’re the kind of person that appreciates the little things, you’ll like the Safari changes, like the ability to access RSS feeds (in you don’t know what these are, march on over to Technique 30). You might also enjoy the transformation of iChat AV, which can now do video or audio conferencing (Technique 36). These are just a few of the 150 changes Apple says are in Tiger. We haven’t counted them all ourselves, but we do like what we see and think you will, too.

Apple also added a whole slew of other behind-the-scenes features to Tiger: new graphics and video technology; support for 64-bit processors (like the G5); a new kernel (the very, very heart of the operating system); and improved support for multi-processor Macs. Yes, these additions are nice and new and they’ll possibly make your computer do some things faster, but that’s all we really have to say about them with respect to timesaving techniques in this book.

What’s New in This Book

When Apple says “Jump,” we say “How high?” When Apple releases a new version of its glorious OS, we, well, we release a new version of this book. And for good reason, too: There’s oodles of new information you ought to have.

For starters, there are five entirely new techniques in this book. The first is a guide for users switching from Windows to a Mac. (We know you’re out there.) The second offers interface suggestions to those Mac users with special needs, a strong suit of Tiger and one that many people aren’t aware of. Third, we’ve been using the Address Book more and more and feel you should, too, so we now give that application its own treatment. The same goes for Safari: We use other Web browsers, yes, but Safari really earns its Mac dominance. Therefore, we dedicate a second Safari chapter to customizing and tweaking the application, adding features you won’t believe you lived without. The fifth new chapter shows you how to use Automator, Tiger’s scripting tool. If you have sequences you often do, knowing how to automate them goes a long way towards increasing your productivity.

Beyond the new techniques, we did revamp all the other existing material so that it continues to show you the most accurate, timesaving ideas we know of. In some cases, this means highlighting new features of the operating system (like searching for files by using Spotlight). In other cases, this means showing you how to use some great piece of free- or shareware.

All in all, every single page has been reviewed, re-read, checked for accuracy, and partially rewritten. Besides being more up to date, a rough calculation determined that this book is now 37 percent more timesaving-y.

Foolish Assumptions

Every book is written with certain assumptions about the reader, and this one is no exception. Don’t be alarmed: We aren’t looking for an advanced degree in computer science or the ability to recall long lists of Mac trivia at parties. We do expect two things of you:
A Macintosh, running Tiger (Mac OS X v.4):
Well, to be perfectly frank, if you aren’t running Tiger (but are running another version of Mac OS X), you can still get a lot of things out of this book; you just can’t do everything this book says you can do. This requirement is more of a highly advisable suggestion.

Basic familiarity with your computer: In some ways, this is the same kind of For Dummies book you’ve come to know and love, but it isn’t the kind that shows you how to plug in a printer or save a document. (It shows you how easy it is to share a printer on a network and how you can save documents faster, though.) We promise that you won’t be overwhelmed by anything in this book, but keep in mind that you won’t be spoon-fed, either.

Having a fast Internet connection will help you get the most out of this book, and so will a little extra spending money (but just a little). But neither of these are required as long as you have a Mac and a willingness — or a need — to discover how to use your computer better.

How This Book Is Organized

As devoted Mac users, we’ve amassed a gazillion pieces of useful knowledge. By sheer luck, it turned out that these little pieces could be organized into techniques, which are chapter-like sections grouped by application or the general concept being discussed. These techniques were then herded together into larger parts, which we’re calling (appropriately enough) parts (we’re clever that way). Right here we give you the highlights as to what each part is all about, but remember that you can approach this book the way you want to. Read a part straight through, skip from technique to technique, or just pick out the little pieces most relevant to the way you work. This book has a structure, but you can be a free thinker. You own a Mac, after all!

Part I: Starting, Stopping, and Running Your Mac Faster

This first part of the book focuses exclusively on how to get the machine and operating system to load and run faster — in other words, how to speed up the process between pushing the power button and actually doing anything. While we’re at it, we also discuss some faster aspects of the installation process and the easiest ways to shut down and log out. These might be the basics of using your computer, but even here, you find ways to do things more efficiently. Finally, if you’re new to the Mac world, the chapter on making the conversion from a Windows mindset should help ease that transition. (Here’s a preview: It isn’t as big of a jump as you might think.)

Part II: Optimizing Your Interface

Comprehending how best to interact with your computer is the foundation for just about everything. Hence, this is the general guide to doing anything better. The heart of Part II is navigation techniques, both with the keyboard and the mouse. You also discover how to customize the Finder, windows, and the Dock. All in all, the absolutely most-universal and most-helpful timesaving techniques are here.

Part III: Handling Files (And Other Stuff) Quickly

Like a teenager’s closet, your Mac is full of stuff. Who knows what it all is? Okay, we know, and we think you should, too. Although your hard drive might not yet be bursting, there’s always going to be a lot of junk in there. This third part of the book demonstrates how to best organize, manage, and find your (and your computer’s) stuff. You also see how to save hard drive space and remove clutter by trashing unnecessary files.

Part IV: Improving Application Performance

Included on your computer (see Part III) are applications — software that does stuff with other stuff (not to be too technical about it). The focus
isn’t on any one specific application here but rather on some useful knowledge for using any application more efficiently.

**Part V: Cranking Up Your Internet Activities**

As Homer Simpson says, “They have the Internet on computers now.” Well, the man’s never been more correct. Accessing e-mail and the World Wide Web are why many people have computers. Most folks spend a decent portion of their computing life in this realm. Part V covers Web browsers, performing searches, using e-mail, and other online timesaving techniques. Tips on stopping spam and using Google effectively can save you minutes per day — minutes you could spend surfing the Internet.

**Part VI: Optimizing Your Network**

The networking section of the book is Part V’s counterpart. Although not every user has advanced networking needs, most could benefit from using locations, working with an iDisk, and knowing how to easily connect to other computers when the time comes. You have a network of some sort, you have a bunch o’ wires (or not), and you need to make them all play nicely together.

**Part VII: Fast and Furious Multimedia**

Apple markets itself as the multimedia machine, and with good reason: The free software that comes with the operating system is exceptional. In the multimedia section of the book, we take a few of these applications and demonstrate how to more efficiently use them. For you lucky iPod users, you see what else that beautiful little toy can do for your day-to-day productivity.

**Part VIII: Security and Maintenance**

Okay, so your Mac pretty much takes care of itself. Still, a little TLC couldn’t hurt. Part VIII (that’s eight to you and me) offers you all the motherly advice you can use on viruses, creating backups, keeping your software up to date, and the like. Think of this as the *An ounce of prevention is worth a pound of cure* section of the book.

**Part IX: The Scary Or Fun Stuff**

Whether you know it or not, your Mac is a powerful machine capable of some really, really cool things. The final part of the book strongly emphasizes our friend, the Terminal, and gives a nod to Automator, a tool for making your own timesaving techniques. If you’re looking for something more fun and less scary, check out the technique on using your cell phone with your Mac or the one on screen savers.

**Conventions Used in This Book**

This book has a lot of visual stuff in it to help guide you along the way. You know . . . different fonts and icons, indentations, and a few funny characters. Here’s a Rosetta Stone as to what they all mean:

- **Keyboard shortcuts:** This book has a healthy amount of keyboard shortcuts in it. These use a conjoining minus sign to indicate that two (or more) keys should be pressed in harmony. So when you see something like Ô-A (the Select All shortcut), you should press and hold Ô, press A once, and then release both. Something like Control-click means that you hold down the Control key while clicking the mouse button once.

- **Menu bar:** The menu bar is the thing going across the entire top of your window. It has all the, you know, menus, but in bar form.

- **Menu sequences:** Sequences of menus are referenced with an arrow. For example, Go➪Recent Folders means that you should click the Go menu (on the menu bar) and then choose the Recent Folders submenu from there.

- **Apple menu:** The Apple menu, represented by the apple symbol, is that blue Apple symbol in the upper-left corner of your window. (It’s shaded differently from the rest of the menu bar in Tiger.)
Comments and Questions

We’d like to think that this book was everything you wanted or needed, and that you have no more comments, problems, questions, and the like. But writing can be a cruel mistress (we don’t know what that means, either, but it sounds bad), and no book is ever comprehensive. If you have something to say or ask, here are some places to turn:

- **Wiley** ([www.dummies.com](http://www.dummies.com)): You can contact Wiley, the publisher of this book, at its For Dummies Web site. Feel free to leave all sorts of feedback, including praise (Woo-hoo!), complaints (D’oh!), and requests (that’s okay, too).

- **Mac OS X Tiger Timesaving Techniques For Dummies, the Web site** ([www.dmcinsights.com/mactst](http://www.dmcinsights.com/mactst)): At Larry’s Web site, we’re maintaining a separate section that focuses solely on this book and its predecessor (Mac OS X Panther Timesaving Techniques For Dummies). Its contents will vary, but basically you can find news, links to useful Web pages and software, and so forth. Plus, you can also find our contact information and the link to the supporting forum.

- **Mac OS X Tiger Timesaving Techniques For Dummies, the support forum** ([www.entropy.ch/mactst](http://www.entropy.ch/mactst)): Marc has established a forum at his Web site where you can ask questions about the book, about us, and about your Mac. Not only will we reply (probably faster than we’ll get to an e-mail), but you’ll also hear what other readers have to say. Make sure, though, that you mention what version of OS X you’re using (Panther, Tiger, and so on), just to be clear.

- **E-mail the authors**: If you’d like to contact us directly, you can e-mail us at mactst@dmcinsights.com. Although we do respond to every e-mail we receive, there’s no guaranteeing how quickly that’ll happen. Don’t get us wrong: We absolutely appreciate the feedback, but there are only so many hours in the day. And, again, it’s best if you’re specific about what version of OS X you’re running.

Icons Used in This Book

This book is littered with lots of little tidbits and notes, set aside by different icons. In due time, you’ll probably identify the pattern for what each icon represents, but here’s a quick heads-up:

- **Tips** are just extra ideas that we think you’ll appreciate. Although not life-altering, tips are our way of saying, “Hey, you know what else you could try?”

- These icons reemphasize the timesaving point we’re making in a certain section. If you don’t feel like reading through all those pesky words and get tired of our trite jokes, look for these.

- This icon means that you’ve seen this idea before, you’ll see this idea again, and you ought to keep it in mind. These are publishing’s version of sticky notes or Stickies, in Mac terms.

- For crying out loud, pay close attention to anything marked with this icon! If you don’t believe anything else that we say, trust us on these warning icons. Think *curiosity* and *cat* here and how that went. You won’t see many warnings in this book, but when you do, understand that you might be about to take an irrevocable step.

Comments and Questions

When we refer to an application menu, we mean the menu that has the title of the application and appears between the Apple menu and the File menu. So in the Finder, it’s called Finder; in Microsoft Word, it’s called Word; in iTunes, it’s called iTunes.

Monospace font: Web sites (URLs) and e-mail addresses are in their own special monospace font, which looks like [www.apple.com](http://www.apple.com). On-screen messages and text in the Terminal also look like this.

User entry: Stuff you should type appears in bold, like this: Type *How now, brown cow?*.
Keep in mind that normally the quickest way to answer a general Mac question is to search Google. Also, if you’re having problems with a particular application, you’ll have the best luck contacting the manufacturer of that application. But still, if you drop us a line via one of the previously mentioned methods, trust that we’ll do our best to help out.
Part I

Starting, Stopping, and Running Your Mac Faster

The 5th Wave  By Rich Tennant

"I don't know what program you been usin' Frank, but it ain't the right one. Look—your menu bar should read, File, Edit, Reap, Gather..."
Before you can discover the magic of Apple's latest, greatest operating system, you need a version of it running on your Mac. You might even wonder whether Mac OS X Tiger is right for you. Because you're holding this book, the answer is presumably yes, but to explain why, we begin this technique by discussing some of Tiger's benefits and new technologies.

The installation process itself has a few variables, and comprehending the different choices can not only save you time during the installation process but give you a more appropriate version of the operating system. You should also be able to make knowledgeable decisions about formatting and partitioning your hard drive before you install the OS. Finally, we show you how to breeze through the Setup Assistant (Apple's program for easing you through the startup process) and then wrap up with a discussion of foolproof file transfers.

**What Tiger Can Do for You**

Whereas Panther added a ton of obvious new features to the operating system and Apple applications, Tiger's additions are more subtle, although no less useful. Compared to its predecessor (Panther), what you find new in Tiger is

- **Spotlight**, a great search tool
- **Automator**, for creating sequences of common steps within Apple applications
- Many new features in Mail
- An improved version of Safari, which can now handle newsfeeds
- The ability to perform video and/or audio conferencing in iChat
- **Xcode 2**, the latest version of the most excellent development tool
- **Dashboard**, a quick way to access different little utilities
Apple has also made quite a few behind-the-scenes alterations that you probably aren’t aware of but which might make for a faster Mac. Tiger supports 64-bit addressing (a good but very geeky thing); dual processors (like the higher end G5); a new kernel (an even geekier thing); and new graphics and video infrastructure. There’s really nothing more to say about these new features in this book (because, well, they just do their thing behind the scenes), but we wanted you to know that Tiger adds more than just the visible applications and features that we mention.

All these improvements and new features can be yours for the low, low cost of . . . okay, the not-so-low cost of $129. But it is a beauty of an operating system.

The price of Tiger ($129) is the same whether you’re upgrading from an earlier version of OS X or buying a version of OS X for the first time.

To further convince you, consider that an overriding benefit of installing Tiger is that you’ll be using the most current version of Apple’s operating system. This means that you can take advantage of all of Apple’s future development of applications and patches, which will be designed with Tiger in mind.

If you own more than one Mac, consider the Family Pack version of Tiger, which gives you license to install the OS on up to five machines for the bargain price of $199. If time truly is money, this tip alone could save you hours!

**Minimum System Requirements**

To use Tiger, Apple recommends that you have one of the following computers:

- Power Mac G5
- Power Mac G4
- Power Mac G3 (Blue and White)
- PowerBook G4
- PowerBook G3 with built-in USB

Apple also recommends that you have at least 128MB of RAM (we recommend 256MB or more, but you can get away with less if you never use Tiger’s Classic mode), a supported display, and at least 2GB of available hard drive space. (You need 3.5GB if you want to install the Developer Tools, as well.) You’re welcome to attempt to install Tiger even if you don’t meet the requirements, but you do risk having a bum computer and wasting a whole heck of a lot of time in the process.

**Choosing an Installation Method**

If you just purchased a brand new Mac, making yourself the envy of the neighborhood, you should be sitting there with a fresh copy of Tiger purring away. In that case, you can skip ahead to the section “Working with Setup Assistant” to see how to whip through the Setup Assistant. If you don’t have Tiger installed yet but are the proud owner of some shiny new installation discs (or a single shiny DVD), it’s time to put them to use.

Before you begin, take a minute to think about what type of installation you want. You have three options:

- **Upgrade a previous version of Mac OS X:** Upgrading is the easiest and least time-consuming option to use — in the short run, that is. One drawback, however, to upgrading an existing OS is that your hard drive becomes bloated with deadwood files. The resulting OS can be a little buggy, inheriting problems from its predecessor.

- **If you want to install Tiger and get on with your life with a minimum of fuss, choose the upgrade option.**
Managing Your Hard Drives

Erase and Install: This option is the most taxing, time-consuming, and drastic of the three. On the bright side, you do end up with an untouched hard drive and a brand spankin’ new OS. On the other hand, you wipe out all your files and applications in the process.

Absolutely, positively do not use the Erase and Install option unless you’ve got multiple backups of all your files, drivers, and software. This option does exactly what it says: erases the contents of your entire hard drive.

Archive and Install: This happy medium between the other two installation choices creates a new system folder with new copies of all the OS stuff, but it also allows you to maintain all the user files and non-Apple applications. Although Apple doesn’t promote this feature as the recommended type of installation, we’re quite fond of it ourselves. It gives you the benefit of a clean system folder (minus the deadwood created by an upgrade) without the serious drawback of having to reinstall all your applications and files.

The Archive and Install option throws all the existing system files and Apple applications in a folder called Previous Systems. After you’re convinced that no valuable information has been overwritten by the recent installation, delete this folder to clear up space on your hard drive.

Managing Your Hard Drives

Along with deciding what type of installation you want to perform, another topic worth your consideration before you install Tiger is the formatting and partitioning of your hard drive (or drives). To clarify:

Formatting a hard drive is the process of erasing its contents and telling the blank drive how to structure the files that will later be stored on it.

Partitioning a hard drive is the process of breaking a single drive into multiple volumes. Your computer still has the same number of physical hard drives, but the operating system behaves as if there were more. (Each volume appears as a separate drive in Finder and other software.)

Practically anything you do with the Disk Utility application requires erasing your entire hard drive. Although Disk Utility warns you before it does anything so drastic, we advise you not to use the application unless you’ve first backed up everything that you need.

You accomplish both of these tasks by using the Disk Utility application (see Figure 1-1), which you can find in the Utilities folder and on the first (or only) Tiger installation disc. If you have multiple drives or volumes, Disk Utility can format or partition any volume except for the one on which it resides (because it can’t erase itself). If you want to format or partition the drive that contains Disk Utility, you need to boot your Mac from the installation discs.

Figure 1-1: The Disk Utility application manages your hard drives.
Technique 1: Installing Tiger without the Hassle

If you plan either an Upgrade or an Archive and Install installation, do not reformat or partition your hard drive because there will be nothing to upgrade or archive. If you’re performing an Erase and Install, the installer can handle basic formatting (but not partitioning) for you.

1. Start your computer with the first (or only) Tiger installation disc.
2. At the first screen that appears (for language selection), choose Utilities ➪ Disk Utility (see Figure 1-2).
3. Follow the appropriate steps in one of the next two sections to either format or partition your drives and volumes.

Mac OS Extended (Journaled): You don’t really need to understand the details of what journaling does to appreciate that it allows you to more accurately recover your computer in the event of a disaster. Feel free to use this format because Apple now uses it as the default.

Mac OS Extended: This used to be the default format and is also a safe choice.

MS-DOS: MS-DOS . . . a Windows-compatible format. Yuck.

UNIX File System: If you choose to format with UFS, you render the hard drive unrecognizable by some operating systems (in particular, OS 9). For this reason, we advise you to stay away from it.

4. Enter the volume’s name (see Figure 1-3) in the Name text box.

Formatting a Volume

To format a volume with Disk Utility:

1. Click the volume icon in the left column.
   A hard drive’s volumes appear under the hard drive’s icon.
2. Click the Erase button.
   The volume formats are:

   - Mac OS Extended (Journaled)
   - Mac OS Extended
   - MS-DOS
   - UNIX File System

4. Enter the volume’s name (see Figure 1-3) in the Name text box.

5. Click Erase to reformat the volume.

When reformatting a hard drive, you can choose from several options by clicking the Security Options button. The options range from Don’t Erase Data to 35-Pass Erase.

Choosing anything other than Don’t Erase
Data exponentially increases how long it takes to reformat the drive, but it’s the best way to both clean the drive and ensure that it’s working properly. If you’re very security conscious and/or a little paranoid, the 35-Pass Erase option rewrites your disk 35 times, making the data virtually impossible to recover. It also takes hours or days to complete!

Partitioning a hard drive

To partition a hard drive into multiple volumes:

1. Click the drive’s icon in the left column.
   The drive will have a strange name consisting of the size and model of the device.

2. Click the Partition tab.
   The Partition tab is an option only when you select the entire hard drive.

3. Select a scheme from the Volume Scheme drop-down list (see Figure 1-4).
   A volume’s scheme refers to how many partitions you want to create. Hard drives 20GB or larger can be nicely divided into two partitions.

4. One at a time, select every partition in the volume scheme window (named Primavera and Data in Figure 1-4).
   Disk Utility automatically partitions a hard drive into equally sized volumes. You can override this by clicking and dragging the bar that separates the volumes in the scheme window. Alternatively, you can specify a size for each partition (in gigabytes) by using the Size text box.

5. Type a name in the Name text box and select a format type in the Format drop-down list for each partition.

6. Click the Partition button to enact the changes.

Installing Tiger

The installation process is fairly obvious, particularly after you understand the options, but we run through the steps and highlight a few important considerations nonetheless. To install Tiger:

1. Update your computer’s firmware.
   Apple always recommends that you do this, pointing you to www.apple.com/support/downloads. When you’re there, click your computer model under Updates by Product in the right column. This takes you to a results page where you probably won’t find an update for your firmware. We’re not suggesting that you skip this step, but don’t be surprised if it’s less than fruitful.

2. Insert the first Tiger disc into the disc drive (make sure that you have all three CDs or a single DVD), double-click the Install Mac OS X icon, click Restart (see Figure 1-5), enter your password if prompted, and then wait for your Mac to reboot.
Technique 1: Installing Tiger without the Hassle

6. On the Select a Destination page that appears, select the destination drive for the installation but don’t click Continue just yet (see Figure 1-6).

The installer presents a list of available volumes where you can place Tiger. The installer even marks the recommended destination with a green arrow and unusable destinations with a red X.

7. Before you leave the Select a Destination page, click Options at the bottom of the window.

8. In the Options dialog that appears (see Figure 1-7), select the appropriate installation method (see the earlier section “Choosing an Installation Method”).

Your choices are

- Upgrade Mac OS X
- Archive and Install
- Erase and Install
Installing Tiger

9. Click OK to close the Options dialog, and then click Continue in the Select a Destination window.

10. On the Easy Install page that appears, click the Customize button at the bottom of the screen.

11. In the Customize dialog that appears, deselect all the features that you won’t use (see Figure 1-8).

The most important timesaving consideration when installing Tiger is to avoid installing features that you’ll never need. This saves you time now and hard drive space in perpetuity. The options that you can choose to forgo include:

- **Printer Drivers:** If you don’t have a printer, you won’t need these at all, so deselect this option and save a whopping 1.1GB of hard drive space. If you do have a printer, choose to install the drivers that correspond to the make and model of your printer.

- **Fonts:** Although Apple’s been kind enough to include the fonts, an informal poll of ours concluded that most Tiger users don’t read much text written in Inuktitut or Gujarati. If that accurately describes you, drop all the fonts, along with the standard Asian ones (Japanese, Chinese, and Korean). You save yourself 130MB of room (possibly for MP3s) in the process.

---

- **Figure 1-7:** The Options dialog is where you select your installation type.

- **Figure 1-8:** Customize your installation to fit your needs.
Technique 1: Installing Tiger without the Hassle

1. You can quit the installer any time up until you click the Install button. After you do that, get out a good book because you’ll have to wait out the installation (easily 15 to 30 minutes, depending upon your computer and the installation choices made).

13. Wait patiently as the installation happens.

The installation process could easily take upwards of an hour, so you may want to grab a good book while you’re waiting.

14. The first step that the installer takes is to check for problems on the installation disc. Then it checks for problems on the destination volume. You have the option of skipping this step (click Skip in the lower-right corner), but you should let the installer do its thing.

15. If the installation process stops because there’s a problem with the integrity of your hard drive (you see an obvious error indicating such), you need to repair the hard drive before installing Tiger. To do so, reboot your computer from the Tiger installation disc, then choose Utilities ➪ Disk Utility. The Repair option is under the First Aid tab.

If you don’t install the BSD Subsystem, be aware that you won’t be able to use many of the more techie features of Tiger, including a few that we list in this book. This includes command line utilities and some Internet and networking software.

12. After you select what you want installed, click Upgrade or Install to begin the actual installation process.

The button you see depends upon the installation type you chose. You can also click Easy Install to cancel the customization.

Language Translations: If everyone using the computer primarily reads and writes English, deselect the 1GB of language translations that the OS will never use.

Depending upon what Apple decides to do in later installers (we were using a beta version when writing this), you might also be able to install

Additional Applications: The Additional Applications include Internet Explorer, Stuffit Expander, iTunes, iMovie, iPhoto, iCal, and iSync. You’ll probably want all of these, but go ahead and drop those you won’t use.

Additional Speech Voices: The speech voices require only 28MB of space, but that’s 28 more megabytes than necessary if you never use them. (You would use them if you have your Mac speak text and other stuff to you and you want a variety of speakers.)

X11: This option is admittedly close to our hearts and requires a meager 82MB of space. Installing it opens up your Mac to a whole world of free (free!) software and makes these geeky authors proud. X11 provides a graphical user interface to UNIX applications, such as The GIMP image manipulation tool, games, various text-editing programs, and a wide array of scientific tools. Although these UNIX applications don’t look or act as nice as native Mac OS X applications, the ability to run them is still very valuable, and the price is right.

Additional Applications:

Additional Speech Voices:

X11:
You can also use the installer CDs for three administrative purposes: changing the Startup Disk, resetting a password, and accessing a version of Disk Utility not running on the main hard drive (see “Managing Your Hard Drives”). Each of these is accessible through the Installer menu.

**Working with Setup Assistant**

If you perform an Erase and Install installation of Tiger or if you’re using your computer for the very first time, you get the magic of the Setup Assistant when your computer reboots. Like its Windows counterpart, Setup Assistant asks you a series of questions intended to make using the computer easier. Here are the highlights of the process so that you can whip through it more quickly:

1. **Select your country.**

2. **Answer the Do You Already Have a Mac? question.**

   This new feature makes it easier to transfer all your existing information from your old Mac to your new one. The three options are

   - **Yes, Transfer My Information from Another Mac**: This is useful only if you have another Mac, they both have a FireWire connection, and you have a FireWire cable. If you have all three requirements, this is most assuredly the way to go.

   - **Yes, Transfer My Information from Another Partition on This Mac**: If you performed a clean installation of Tiger on another partition or drive on the same computer, you can easily move all your personal stuff over.

   - **No, Do Not Transfer My Information**: Even if you choose this option, you can move stuff over manually later. See “Transferring Files Flawlessly” at the end of this technique.

   If you select either of the first two options, the Setup Assistant then instructs you on what you should do.

3. **Select your keyboard layout.**

   For this and for Step 1, the defaults will most likely work. Apple is kind enough not to display all the options, but you can get them by clicking the check box at the bottom of the window.

4. **Decide what you want to do for an Apple ID.**

   You have three options:

   - Enter your existing ID, if you have one.
   - Create a new Apple ID.
   - None of the above.

   You already have an Apple ID if you’ve registered for any of the special areas at www.apple.com or if you have a .Mac account (which will be the same as your Apple ID).

   If you don’t already have an Apple ID or a .Mac account, we strongly recommend creating one, which will give you a 60-day trial .Mac account. If you like the trial, you can pay for a permanent account. We both have one and think it’s well worth the $99 yearly price.

   You can get a free trial .Mac membership when you go through Setup Assistant. Because we refer to some .Mac stuff throughout this book, you really ought to consider signing up, even temporarily.

5. **If you want, register.**

   Unlike Windows XP, which requires activation of the operating system, you can forgo Tiger registration entirely. If you don’t feel like registering, press ⌘-Q to quit the registration application. The Setup Assistant then gives you the option to skip registration entirely (and continue with setup process), shut down the computer, or cancel.
6. **Answer a few more questions and then check out Apple’s Privacy Policy.**

7. **Create your user account.**
   
   To create your account, enter your full name, your short name (which the computer will treat as your username), and a password. Ideally, your short name should consist only of letters, numbers, and the underscore, and be eight characters in length or shorter.

   You can skip the password and verify prompts if you’d rather not have a password. This will expedite many tasks but will also make your computer far less secure.

8. **Select your Internet access type and then click Continue.**

   You have three options:
   - Set Up a Free Trial Account with EarthLink
   - Use My Existing Internet Service
   - I’m Not Ready to Connect to the Internet

9. **Follow the prompts to complete the Internet setup.**

   As long as you didn’t select I’m Not Ready to Connect to the Internet in Step 8, you’re led through a connection setup wizard. If you’re using an existing service, have your Internet information written down and ready for when you go through Setup Assistant. Getting the information correct here will save you the hassle of configuring your network later, although you always have that option.

   You need to know some combination of the following:
   - Connection type (telephone modem, cable modem, and so forth)
   - Username
   - Password

10. **Set up Mail.**

    Depending upon what choices you’ve made thus far, you might also be able to set up your Mail accounts at this time. Doing so is just a matter of using the provided form. You can always do this in the Mail application later, as well.

11. **Sync your Mac.**

    A few items can be synced across multiple Macs. If this is something you’ve used before, you can immediately sync your new Mac with this old data by following the prompts.

12. **Select your time zone, confirm the current date and time, and start using Tiger!**

### Transferring Files Flawlessly

In Technique 16, we discuss how to organize and maintain your files and folders. Tiger comes with a good implicit organization scheme that you really ought to follow. If you do so, you can restore all your documents, bookmarks, e-mail, and so forth merely by copying the contents of your old Home directory to your new user directory. Even if you use the painless Archive and Install installation option, saving the contents of the Users folder to an external source before you begin installation (hard drive, CD-ROM, DVD) is a prudent move.

While we’re at it, we recommend that you have at least one reliable backup of all your data at all times. If you’re installing a new version of the operating system, you want two or more backups that use different media. (You can never be too careful.)
The Backup application is provided free to .Mac users. Version 2 of the application can back up files to your iDisk, a CD or DVD, and even external hard drives.

Be sure that your backups aren’t in a proprietary format (for example, the Retrospect Express cataloging system; www.dantz.com) because you won’t be able to get to the data until your computer can read that format again.

We highly recommend making a CD-ROM of installed applications that also contains a text document with all your serial numbers. This fairly simple step makes restoring the software on your computer a snap!
As soon as you have Tiger running on your Mac, it’s time to make it purr. In this technique, we cover ways to make your computer usable as quickly as possible. These timesaving ideas focus on the period from the time you press the power button to using the actual applications.

We begin by pointing out the benefits of never shutting down your computer, which helps you start faster and is a reasonable option for many Tiger users. Then we show you how to best manage computers in a multi-user environment and how to bring up your must-have applications as soon as you log in to Tiger. This last little technique is a valuable timesaver for pretty much any Mac user, so we then show you a more specific example with the System Preferences panel.

**Faster Startups: Never Shut Down**

Although obvious, many people never think of this: The fastest way to get your computer to start up is to never shut it down. Even on the fastest machines, the startup process takes several minutes — minutes that you don’t need to spend sitting idly. The UNIX operating system — which is at the heart of Mac OS X — was designed to run 24 hours a day, and your Mac is perfectly capable of this as well. Granted, keeping your computer on all the time racks up the electrical bill a few cents per month, but that minimal extra cost can be easily offset by your increased productivity. Now, we’re not arguing that you should *never* shut your computer down (like if you’re going on vacation), but here are some viable alternatives to shutting down if you use your Mac a lot:

- Put the computer to sleep overnight.
- Whenever you need to, set the sleep mode (see Figure 2-1) by clicking the Show Details button within the Sleep tab of the Energy Saver panel.
Scheduling Your Startups

Tiger’s scheduling feature can save time in starting your Mac. This is particularly useful in labs or offices, where computers are used in regular intervals. Even if you’re a home Mac user, if you know the Mac is never used after midnight or before 8 a.m., you can schedule its up time accordingly. This saves you starting or stopping your computer yourself.

1. Open the System Preferences panel (choose Apple $\rightarrow$ System Preferences).

2. Click the Energy Saver icon, under Hardware.

3. In the Energy Saver panel, click the Schedule button.

   The Schedule button is always available, whether or not you have the other details displayed.

4. In the resulting prompt (see Figure 2-2), select the Start Up or Wake check box.

5. In the top-middle drop-down list, choose which days to schedule your Mac to start.

   You can specify an individual day (like if you use your Mac only on Thursdays), weekends, weekdays, or every day.

6. Set the time by using the box in the top-right corner.

   You can set the hour, minute, and AM/PM fastest by clicking once on the digit in question and then typing in the desired value. For example, in Figure 2-2 you might click the 8 and type 6 — but only if you’re an early bird.

You can access the Energy Saver panel by choosing System Preferences from the Apple menu and then clicking the Energy Saver icon in the Hardware section. Figure 2-1 shows the Energy Saver panel for a laptop, which has a few more features than the same panel on a desktop machine.

- Turn off the monitor (desktop users only).
- Close your laptop’s monitor to engage the sleep mode (laptop users only).
- Leave the computer active but engage the screen saver.

If you aren’t going to use your computer for days on end (like over a weekend or during a long holiday), shut it down. But you don’t have to shut down your computer every night, especially if you use your computer off and on all day.

- Figure 2-1: You can adjust your computer’s sleeping habits in the Energy Saver panel.

- Figure 2-2: Use the Schedule window to set when your Mac should start, wake, sleep, or shut down.
Technique 2: Starting Up with Speed

7. Select the check box next to Shut Down to set either a shut down or sleep time.

8. In the bottom first drop-down list, select either Shut Down or Sleep.

You can schedule your Mac to either shut down and start up or sleep and wake up.

9. Use the day of the week and time fields as you did on the top row.

10. Click OK to exit.

Don’t worry about your Mac shutting down when you’re in the middle of finishing the Great American Novel:

- Tiger prompts you well in advance of a regularly scheduled shut down, as shown in Figure 2-3.
- Tiger can’t shut down if any open application has an unsaved document.

Tiger includes many nice touches for using the computer in a multi-user environment. Simplify and speed up the login process like this:

1. Open the System Preferences panel (choose Apple ➤ System Preferences).
2. Click the Accounts icon, under System.
3. Click the Login Options button at the bottom of the left column.
4. Select the Automatically Log In As check box.
5. Select your username from the drop-down list (see Figure 2-4).
6. Click the lock in the bottom-left corner to make this setting permanent.

Any locked System Preferences panel needs to be unlocked in order for changes to be made. Unlocking a panel requires an administrator’s password. If you are the only administrator of

Speeding Up the Login Process

If your computer has multiple users, you have to deal with the same types of questions as with multiple operating systems:

- Should a user be automatically logged in?
- If a user should be automatically logged in, which user?
- How do you quickly switch to another user?

• Figure 2-3: Tiger prompts you before performing a scheduled shut down.

• Figure 2-4: Use the Login Options link in the Accounts panel to secure and speed up access to your computer.
your Mac, using the lock on any System Preferences page means that no one else can change that setting.

If you log in automatically, anyone who has physical access to your computer can now use your computer without restraint. If your computer stays at home and you trust your dog, this might not be an issue; if security may be an issue for you, though, do not use the automatic login feature.

If you must use the login prompt, select the List of Users radio button in the Login Options section of the Accounts panel. You can skip typing your username while still requiring a password: a reasonable security compromise.

### Security versus convenience

You might have to compromise security for greater convenience (or speed). In many of the examples of this book, you need to decide whether you want something to be easier or more secure. Factors in making this decision include

- Whether you share your Mac
- What information is stored on your Mac
- Who might have physical access to your computer
- Whether your computer is likely to be stolen

For example, the most secure login method is to require users to enter both a username and password to log in to the computer, but this is really annoying if you’re the only one who can access your Mac. In this case, automatically logging in as yourself but password-protecting sensitive files on your computer (such as a Quicken document) and keeping regular backups of everything makes sense.

This book has many techniques for making things convenient and many for making things secure. In the end, only you can decide where your total Mac usage falls on that scale.

---

### Starting Applications Automatically

After your computer is up and running and you’ve logged in, you’re ready to use applications. Part IV covers applications in detail, but we give you a related technique here. From the Accounts panel, you can set applications to launch automatically when you log in to your computer. This saves you from waiting while Mail, Safari, and whatever else loads.

Your computer must expend some time and a bit of power to start up applications. You should add applications to your list of startup items only if you always use them every time you start the computer.

1. **Open the System Preferences panel (choose Apple: System Preferences).**
2. **Click the Accounts icon, under System.**
3. **Select your username from the list of users on the left (if you have multiple users).**
4. **If the panel is locked, unlock it to make changes.**
   
   To unlock, click the lock icon in the lower-left corner and enter the administrative password.
5. **Click the Login Items tab (see Figure 2-5).**

   At this stage, you have two options:
   
   - Open your Applications folder, and then drag and drop the application(s) into the Accounts panel.
     
     This first method is much, much faster than the second.
   - Click the plus sign under the list of Login Items, navigate to the application by using the Open sheet that appears, select the application, and press Return.
Now your Mac plays that tune while it’s starting up. When you’re sick of hearing “Good Day, Sunshine,” switch to “Happiness is a Warm Gun” instead.

This trick works with any kind of file. You can automatically open a Word document at startup (that novel you’ve been hacking away at) or an Xcode project.

While you’re messing around with System Preferences, it’s a good time to make the autoloading applications do their things. For example:

- Set Mail to automatically check for new e-mail every so many minutes.

Use Mail’s General preferences panel (see Figure 2-6), accessed through Mail➪Preferences.

Speed up the startup process by disabling automatic startup applications when you won’t need them: Hold down Shift after logging in. This trick works only if you’ve gone through the login panel. (It doesn’t work with automatic logins.)

Start the day with a song

Have your Mac greet you with a song. It won’t save you a lick of time, but it might brighten up your day. Here’s how:

1. Open the Login Items panel by using the previous instructions.
2. Switch over to iTunes.
3. Find the song du jour in iTunes.
4. Select File➪Show Song File or press Ô-R.
   This highlights the actual song file as it exists on your computer.
5. Drag the song file into the Login Items panel.

Set Safari to automatically open a specific URL when it’s launched.

Use Safari’s General preferences panel (choose Safari➪Preferences) to set a Home page and indicate that all new windows should open with that.
Keeping the System Preferences Handy

Many of the techniques in this book involve going to one of the System Preferences panels. And it’s not uncommon to change some setting in some panel at least once every day. For this reason, we make the entire System Preferences application more readily available with these steps:

1. **Add System Preferences to the list of automatically opened applications** (refer to Figure 2-5).
   
   See the instructions in the preceding section for specifics. The System Preferences application itself is in your Applications folder.

2. **If you want, select the Hide check box.**
   
   This step hides the System Preferences window after it opens so that it doesn’t clutter your screen.

3. **To access a specific System Preferences pane, Control-click the System Preferences Dock icon** (see Figure 2-7).
   
   The Dock icon presents panes in alphabetical order, which is easier to navigate.

4. **Select the specific pane you want from the list that appears.**
Like many of the other techniques in the first part of the book, steps in this technique show you how to save time primarily by adjusting system-wide settings. They’re of the “do it once and forget about it” variety, except for the first list of steps, which is more of a “do it monthly and you’ll be happier” kind.

First, we show you how routine maintenance can improve your Mac’s performance. Much in the same vein, you then see some best practices that help Tiger run most effectively. For laptop users, we give some attention to the related ideas of energy management and extending your battery’s life. Finally, we cover the best ways to improve your computer’s performance by adding hardware. (As you might expect, throwing some money at a sluggish computer can go a long way.)

**Optimizing Your System through Maintenance**

Your Mac is a complex machine with lots of software and moving parts and doodads and cogs. Using your Mac inevitably adds extra clutter and confusion to the machine, which slows it down. This sounds bad, but it’s perfectly normal. We don’t advocate that you leave your computer off (although, ironically, never turning on your Mac is the best way to keep it running quickly), but we recommend some routine maintenance to improve its performance.

We haven’t experienced any problems during optimization, but you’ll be working on your system files and removing some cached data, so you can never be too careful. One very good idea is running a thorough backup before optimizing the system. (See Technique 49 about that backup.) This way, should there be a problem, you won’t lose your valuable data.
We demonstrate the optimization steps by using the Disk Utility application and the Finder, but you’ll probably find it a lot easier to use a shareware application, such as Cocktail (www.macosxcocktail.com, $15), if you’re willing to spend the money. Cocktail provides a simple interface for you to do most of these tasks easily.

Mac OS X sets maintenance tasks to run when you aren’t using the computer. Most of these are scheduled to run during the middle of the night or early morning. Often, these routines are never executed because the computer is off or asleep overnight. If you normally shut down your machine overnight, shareware tools such as Cocktail also address these maintenance needs.

We recommend periodically running the Disk Utility application and clearing caches.

To run the Disk Utility, follow these steps:

1. **Open the Disk Utility application.**
   Disk Utility can be found in the Applications > Utilities folder, as you might expect.

2. **Click your main hard drive’s name in the left column (see Figure 3-1).**
   Click the name of the hard drive (Hard Drive, Main, Tiger, or Macintosh HD), not the hard drive icon above that (which is the size and model of the hard drive).
   If you have multiple hard drives or partitions, click the name of the hard drive or partition where Tiger runs.

3. **Click the Repair Disk Permissions button under the First Aid tab.**

4. **Read ahead a few pages of this book while Disk Utility does its thing (see Figure 3-2).**
   The permissions repairs could take a while with a large drive or slower Mac.

5. **After the repairs are complete, quit Disk Utility.**

Tiger stores caches in a Caches folder within a Library folder (/Library/Caches). The /Library/Caches folders are at the top of the main Tiger hard drive or partition and in your Home directory. Deleting your caches might temporarily slow down some actions, such as loading common Web sites for
the first time. But overall, deleting these files should help your Mac do that thing it does. Use the following steps to clear each /Library/Caches folder:

1. Open a new Finder window if one isn’t already open.

Part 2 shows oodles of ways to get to the Finder, such as clicking the Finder icon in the Dock, using Exposé, and pressing Ô-Tab. The same goes for creating a new Finder window: pressing Ô-N, choosing File ▶ New Finder Window, and so on.

2. Navigate to the /Library/Caches folder that you want to clear.

You can find the folder in one of two places:

- At the top of the main Tiger hard drive or partition.
  The easiest way to get here is to click the main Tiger hard drive icon in the Sidebar (assuming it’s there), open the Library folder, and then open the Caches folder within it.

- In your own Home directory (/Users/yourusername).
  The easiest way to get here is to click your Home directory icon in the Sidebar (a house next to your username, assuming it’s there), open the Library folder, and then open the Caches folder within it (see Figure 3-3).

3. Press Ô-A or choose Edit ▶ Select All to select everything in the folder.

4. Press Ô-Delete to send it all to the Trash (or choose File ▶ Move To Trash).

5. Enter your password at the prompt (see Figure 3-4).

6. Press Ô-Shift-Delete to empty the Trash (or choose Finder ▶ Empty Trash).

7. If the Are you sure you want to remove the items in the Trash permanently? prompt appears, click OK or press Return.

When emptying the Trash, click the Continue button if you see this error: The operation cannot be completed because the item someitem is in use. The next time you log into your computer you can finish emptying the Trash.

If running the Disk Utility and clearing caches (or using something like Cocktail) don’t return your Mac to full speed, you can take the more drastic step of zapping your PRAM. The PRAM stores system settings. Resetting this bit of memory can get rid of some gremlins, although you have to re-establish some settings afterwards. Here’s what you do:

1. Restart your Mac while holding down Ô-Option-P-R (yes, all at the same time).
2. Wait until you hear the special chime two or three times.

3. Release all the keys to let your Mac boot normally.

### Speeding up specific applications

You can improve the performance of your favorite applications by giving processor priority to specific ones. The Speed Freak utility from Big Fat Stinking Software ([http://home.comcast.net/~jeff.ulicny/software](http://home.comcast.net/~jeff.ulicny/software), donationware) can do this for you. Tiger gives all applications (processes, in technical terms) the same priority. Speed Freak lets you give preferential treatment to particular applications (Safari or Adobe Photoshop), so they run faster. Applications you care less about will run more slowly, but sacrifices have to be made.

### Disabling Unnecessary Features

A tough balance exists between features and performance. The more features you run, the more your computer has to do. The more your computer has to do, the slower it becomes. The trick is to balance functionality and speed. Therefore you should adjust your operating system and computer usage so that your Mac doesn’t waste precious resources doing unnecessary things.

You can enhance your speed with these common techniques:

- **Remove CD-ROM discs and external hard drives when you aren’t using them.** Your Mac has to keep track of all mounted disks (and discs), be they CD-ROMS, DVDs, or external hard drives.
  - Tracking discs requires processor effort, which could be better used elsewhere.
  - Keeping an eye on large FireWire drives takes a noticeable toll on your Mac. (Dismounting and unplugging an external drive might cut that electricity bill a bit, too.)

- **Turn off the iDisk synchronization.** Tiger has built-in support for iDisk, so your iDisk can be available for access and in synchronization at all times. This means that your computer is constantly checking the status of your iDisk and updating it. This is a drag in performance, network speed, and hard drive space.

To disable automatic iDisk synchronization, do the following:

1. Open the Internet & Network section of the System Preferences panel.
2. Click the .Mac icon.
3. Click the iDisk tab.
4. Check whether the tab says *iDisk Syncing Off* (see Figure 3-5).

If iDisk synchronization is on, click the Stop button to shut it off.

Having an iDisk is one of the benefits of paying for a .Mac account (both of which we cover in Technique 42). Simply put, the iDisk is 250MB of online storage. (It used to be 100MB, but Apple has increased the allotted space.) There’s a little more to it than that — like a .Mac Web page, a .Mac mailbox, an easy way to download software, and a method for sharing documents online — but that’s the gist of the idea.
Turn off the items in the Sharing panel if they won’t be used regularly (see Figure 3-6). Tiger supports several network-related services: Personal Web Sharing, Personal File Sharing, and Printer Sharing. Each of these requires an actively running process. Most wait quietly in the background, but you don’t need to have them turned on if you aren’t regularly using them. Click the Sharing icon under the Internet & Network section of System Preferences to access the panel and check Technique 40 for the details (including the related security issues).

With Mac OS X, most open applications don’t affect the overall performance when they aren’t being used. You can save yourself time without bringing the computer down by not continually closing and reopening applications.

Turn off your AirPort Card when you aren’t online. Using an AirPort Card requires some processing and battery power. If you aren’t currently online, turn off the AirPort Card. See Technique 38 for other wireless-network-related ideas.

Longer Battery Life

If you’re using a laptop, the life of your battery directly affects how fast you can get things done. If you don’t believe us, try doing anything on a dead battery with no outlets in sight. To minimize or altogether eradicate such occurrences, keep in mind the following principles:

Calibrate the battery before using it. The manual that came with your Mac (you read it, right?) tells you how to do this. Do yourself a favor and make sure you do.

Disable unnecessary features. See the preceding section of this technique.

Avoid opening applications. Starting and stopping applications drains the battery more than running them. Open only the applications you need and keep them open until you’re finished.

Close CPU-hogging applications. A few applications use a lot of CPU power even when they’re in the background and they should be doing nothing. For example, Microsoft Office applications can easily use 10 percent of your CPU when
you aren’t actively using them. Use the Activity Monitor (see Technique 4) to find CPU hogs and quit them when they’re unused for long periods of time.

- **Minimize how often the computer accesses the hard drive.** Writing to and reading from any drive is a big drain on a laptop’s battery.

Most iLife applications suck the blood from your battery. Avoid listening to iTunes, editing videos in iMovie, or working with iPhoto unless you really have to or don’t mind the shortened battery life.

- **Remove CDs and DVDs from the disc drive.** Your Mac must pay some attention to all mounted drives. Removing them saves your Mac from having to perform this chore.

- **Run the battery down monthly.** This isn’t a problem for most laptop users, but you should use the battery quite a bit with some frequency, letting the battery charge back up afterwards. (Perpetually running your laptop plugged in kills a battery.) Ideally, you should completely drain and recharge your battery monthly.

- **Change your energy settings to Better Battery Life.** Head over to the Energy Saver panel (see Figure 3-7) under System Preferences. One of the default configurations is Better Battery Life (assuming you have a laptop). This option automatically configures your display, sleep, and other settings accordingly to get the most out of your battery.

If you’re using a laptop, get in the habit of displaying the battery status in the menu bar while you aren’t plugged in and disabling it otherwise. You’ll want to monitor it when you’re using battery power, but it only clutters up your screen if you’re not. To access this area, open the Energy Saver panel, click the Show Details button, then click the Options tab, and then select the Show Battery Status in the Menu Bar check box (see Figure 3-8).

- **Keep the screen as dim as possible.** A fair portion of your battery’s power goes into illuminating the monitor. To maximize your battery’s life, dim the monitor as much as you can. (Use the screen brightness keys on the keyboard to do so.) If you’re working in a particularly dark place or at night, you can get away with dimming the monitor almost entirely and still be able to read it.

If your laptop is running off the battery but you want to keep it awake when you aren’t actively using it (for example, if it’s processing something or playing iTunes), dim the monitor to the point of blackness. You save yourself lots of power for later use.
Don’t play DVDs or CD-ROM-based games. Nothing drains a battery faster.

Turn off the illuminated keyboard. If you’re lucky enough to have one of the new PowerBooks with the backlight keyboards, you have another energy-saving option. Go to the Keyboard tab of the Keyboard & Mouse System Preferences panel and deselect the Illuminate Keyboard in Low Light Conditions check box. The backlight keyboard is a great feature, but when you need extra juice, you can easily do without the light.

**Improving Performance through Hardware**

You can do a fair amount of tweaking by using the built-in Tiger software and running shareware, but if you really want to enhance your computer’s performance, you have to part with some cash. Here are some hardware improvements that you can make (from least to most expensive):

- **Add more RAM ($40–$200).** Adding RAM is far and away the most foolproof method for improving your computer’s performance. RAM has become cheaper and cheaper and is ridiculously affordable these days. If you haven’t maxed out your computer’s RAM capabilities, consider doing so now.

  We recommend at least 384MB of RAM in your computer. You don’t necessarily need to go up to 2GB, but 512MB is a nice, even number and befits most Tiger users.

- **Purchase a faster hard drive ($80–$300).** Hard drives spin at different speeds (measured in revolutions per minute, or rpms). The faster the spin, the faster the drive. Most laptops use a 4,200 rpm drive by default, but 5,400 rpm drives can be acquired for a few dollars more. Desktop machines commonly use 7,200 rpm drives, but these can be replaced with 10,000 rpm drives without breaking the bank.

- **Purchase an external FireWire drive ($150–$400).** If you need more storage space but don’t want to replace your existing hard drive, add an external one. Such a device can be used only when you need it and can be shared among many computers. If you have a FireWire 800 connection, definitely spend the extra case for a matching FireWire 800 drive (as opposed to the older FireWire 400).

- **Install a better video card ($150–$400).** People who aren’t hard-core gamers often don’t value a good video card and often don’t know how a faster card improves the overall performance. Everything that happens on-screen has to go through this device, so the performance impact is significant. Laptop users have little to no room for improvement in this area, but desktop users have many options. Consider buying a new card with as much RAM as possible (64MB is fair) and use that Accelerated Graphics Port (AGP) slot if you have it.

**How to upgrade your hardware**

If you don’t like to open a computer and mess around with the insides, you have a couple options to get the job done:

- Have it installed at the store where you purchase the upgrades.
- Go to an official Apple store.
- Take your Mac to an authorized Apple dealer, such as CompUSA.

Any of these places install the new hardware for a nominal cost (maybe $30, depending on the item in question).

If you don’t mind a little tinkering — and are willing to assume the risks involved — new RAM, hard drives and video cards can often be installed by using only basic tools. You’ll most likely find installation instructions with the purchased hardware or online. Search Google or the appropriate Apple manual ([www.info.apple.com/support/manuals.html](http://www.info.apple.com/support/manuals.html)) for specifics.
Make sure that the video card manufacturer supports Tiger with the appropriate drivers. If they don’t, either you won’t reap the performance benefits or the card might not work at all. Check a manufacturer’s Web site for compatibility information before making the investment!

Replace the motherboard (desktop users only, $400–$900). This is a pricey step and comes close to being impractical because motherboards are often almost as expensive as a new computer. But if you have a nice machine that you want to work with, you can upgrade to a newer, faster processor for a few hundred big ones.

Get that new Mac ($500–$3,000). It used to be that as a Mac user, you knew that you would spend more for your computers, get less in return, and have fewer options than your Windows friends, but those days are long gone. Apple has had great success in developing separate computer lines (professional and home) with a decent range of prices and capabilities. You can now pick up an impressive eMac for under a grand and a low-end iBook for just over that amount. Or, for the very budget-conscious, the Mac mini starts at just $500.

Take out a second mortgage and get a new dual-processor G5, with all the RAM that you can cram into it and a new 23-inch studio display ($5,000). Buy each of us one while you’re at it.

If you’re looking through this book in a library or bookstore, we highly recommend that you purchase your own copy (or better yet, buy several, and you’ll never need to read the same copy twice). The small price is well worth the timesaving techniques!
Tiger is a most excellent operating system — perhaps the best that we’ve ever used. However, we still encounter the occasional problem or misguided application that mucks up the works. Fortunately, OS X has protected memory: a stalled-out application no longer brings down the whole machine. But stalled applications gum up the works and leave your computer hanging. These techniques show you the best and fastest ways to monitor and shut down problematic software. In an ideal world, you’d never need to use these techniques, but in reality, following these steps can keep your system going. As a last resort, you also see the safest, most effective method for unsticking a stuck Tiger.

**Slaying Stalled Apps with the Dock**

Tiger lets you kill errant applications from the keyboard or the screen.

Always attempt to quit an application in the usual way before performing a force-quit. Always give your quits and force-quits a few moments to work before trying anything more drastic.

Before you cancel a slow app, make sure that you haven’t assigned this application some monumental task (such as heavy image or video processing) that explains its sluggishness.

From the keyboard, just press Option-Esc to bring up the Force Quit Applications window (see Figure 4-1).
Gaining Better Performance through Activity Monitoring

Tiger’s Activity Monitor is found in the Utilities folder. This application does exactly what you’d think: It monitors the activity of the computer. The interface of the application is a bit techie, but it can be a very useful tool for catching problems and fine-tuning your computer’s performance.

Activity Monitor can set up a floating CPU window that allows you to continuously monitor your CPU’s activity. You can use the CPU window to catch apps that might be slowing down your system performance. Follow these steps to set up the window:

1. Open the Activity Monitor, located in the Utilities folder.

2. Choose Window→Show Floating CPU Window and then choose either Vertically or Horizontally (see Figure 4-3).

By default, the Activity Monitor doesn’t display a floating CPU window. This step keeps the window visible even after you hide the Activity Monitor application.

Instead of using the menu bar, you can also create the floating CPU window by pressing Ô-4 or Ô-5.
Technique 4: When Good Applications Go Bad

3. While you have the Activity Monitor open, adjust the update frequency by choosing View ➪ Update Frequency ➪ Less Often.

Setting the Activity Monitor to update less often minimizes the performance effect that running the monitor has on your computer.

4. If the floating CPU window (see Figure 4-4) turns to solid green or solid green and red for more than a few seconds, a program is using up all the available processing power (which slows down everything else).

5. Click the Activity Monitor icon in the Dock and press Ô-1 to bring up the Activity Monitor screen (if it isn’t already up).

The Activity Monitor icon can look like the monitor image next to the Dock’s Finder icon in Figure 4-4, or it can be a graph itself (see Figure 4-5).

6. Click the %CPU column heading so that CPU usage is displayed by process in descending order (see Figure 4-6).

If a process name appears in red in the process list, the application is no longer responding and needs to be shut down.

7. Determine whether it’s reasonable to kill the application.

If the application in question is performing some intensive task (like iMovie compositing a video clip or iPhoto importing pictures), the high CPU usage makes sense. However, if you haven’t asked the application to do something taxing or it’s a normally less intensive application (like Safari), you have a problem.

8. If the application should be stopped, try quitting it.

To quit the application, highlight it and click the Quit Process icon (shaped like a stop sign) on the toolbar, which attempts to kill the application through normal means.
If the application still doesn’t stop, force it to quit by using one of the methods outlined in “Slaying Stalled Apps with the Dock,” earlier in this technique.

If you have some time to kill or just really want to know what your computer is doing and why, the Activity Monitor is the perfect tool to spend some time with. You can also use it to extend your laptop battery’s life by quitting applications that use too much CPU power.

Understanding processes

In the UNIX world, a process is an active (running) application, a daemon (a special type of constantly running utility), or another type of service. In fact, the UNIX operating system blurs the lines between these ideas. Tiger uses the same notion of processes, so it introduces an idea that might be foreign to you if you have no UNIX experience (which is most of the world’s population). The Activity Monitor displays not only your open applications but also behind-the-scenes system processes.

To find out more about any particular process, click the Process ID in the Activity Monitor and then press Ô-I. This brings up another window with details for that particular application, as shown in the following figure. When you’re done with your investigation, click the red button in the upper-left corner to close the window. Don’t click Quit — it tries to shut down the process.

Another tool for monitoring your performance is iPulse, which is a shareware application created by the good people at the Iconfactory ($12.95 at http://iconfactory.com/ip_home.asp). iPulse tracks the CPU, memory, and hard drive usage and displays them graphically on the Desktop or Dock. It even monitors the temperature of your motherboard.

If you want a free solution that monitors only CPU usage, check out Xload (http://s.sudre.free.fr/Software/Xload.html). If you are using a multi-processor Mac, it even reports on each processor individually.

Crashing Your Mac

Very, very rarely, your beloved Mac might come to a grinding halt, seemingly frozen and incapable of doing anything. Unlike those poor Windows souls, such an occurrence should be at most an annual event. If you find your Mac dead to the world, these practices can solve the problem:

Periodic backups and other maintenance can help your computer run more smoothly and minimize the potential loss in case a crash occurs.

To prevent and smoothly recover from crashes:

1. **Give it some time.**
   Don’t rush your Mac or yourself. If your Mac seems to be hanging, give the operating system a few minutes to recover on its own.

2. **Try to find and kill the offending application.**
   Sometimes the problem is in one application, which can be terminated. If the offending application is the Finder, you might need to shut down or reboot.

3. **Quit every other application before rebooting.**
   If, for example, the Finder is the problem, you should still be able to switch to and quit (like normal) every other application. Doing so minimizes problems and lost documents in those applications.
4. When all else fails, press and hold the power button to shut down.

5. Give it some time.

   Wait a few minutes for both your Mac and yourself to cool down before booting up again.

---

Keep journaling enabled on your hard drive to limit the damage from a crash. Journaling helps your Mac recover from sudden crashes. This option can be enabled during installation (see Technique 1) or from the Disk Utility.
Logging Out and Shutting Down

When the time comes to call it a night, you want to get off your Mac and on the road (or couch) as quickly as possible. In this technique, we show you a few inside tips for speeding up that process, covering the range of options: You can choose to log out of your computer, switch over to another user’s account, or shut down the computer. Don’t forget, of course, that you can also save time by just putting your Mac to sleep or by scheduling it to start and stop when you like (see Technique 2).

Logging Out

Before we cover logging out techniques, we need to make clear that logging out of your computer is necessary under only two conditions:

- The Mac is used by more than one person.
- You want to make sure that no one messes with the computer while you’re away from it.

If neither describes your situation or how your Macintosh is used, stick with your one login account and continue on your merry way.

If you share the computer and want to log out with ease, try any of the following:

- Go to the Apple menu and choose Log Out User (where User is your username; see Figure 5-1).
- If you’ve enabled Fast User Switching (see the next section of this chapter to find out how), go to the user menu in the upper-right corner of the screen and choose Login Window (see Figure 5-2).

Fast User Switching is a must-use Tiger feature for multi-user computers.

- Press Ô-Shift-Q to quit all applications and log out.

You get a warning message, as shown in Figure 5-3. Just press Return to log out or Esc to cancel.
To cut a step out of the log out process, hold down the Option key when choosing Log Out from the Apple menu or while pressing the keyboard shortcut (⌘-Shift-Q). This eliminates Apple’s warning.

Every method of logging out has these two results:

- The system automatically attempts to log you out after two minutes if you don’t click either the Log Out or Cancel button (see Figure 5-3).
- The main login screen appears after logging you out.

If you want to temporarily log out of your machine with the intention of returning to your work, enable Fast User Switching and log out from the user menu.

Unless you’re using the Fast User Switching method of logging out, remember these two facts:

- Each logout method closes any open applications.
- If you have an unsaved document in any application, you can’t log out until you opt to either Save or Don’t Save that file.

Neither of these options applies to Fast User Switching because the state of your account remains the same (meaning that all open applications and documents remain open).

### Adding user icons

Each user on a Mac running Tiger can have his or her own icon. This icon appears next to the username in the System Preferences ➤ Accounts panel, in the main login screen, and in the Fast User Switching menu. Besides being a nice representation of you and your personality, user icons make finding your login name in a list of names easy. You can change your icon by using the Picture tab after selecting your account in the System Preferences ➤ Accounts panel (as in this image).
From there you have four options:

- Click one of the default Apple icons in the rightmost column.
- Click the Edit button and drag an image into the window from the Finder (see the figure).
- Click the Edit button and take a picture of yourself by using an attached camera.
- Click the Edit button and then click the Choose button to find the image on your Mac.

If you have a FireWire video camera (including iSight) connected to your Mac, your image appears in the Edit window, and you can click the Take Video Snapshot button to make a literal iconic representation of yourself.

If you click the Choose button in the Edit window, you get a dialog (like the Open/Save ones) so that you may navigate to and select an image on your hard drive.

The user icon you select also is updated in your Address Book and in iChat. If you like switching icons often, both iChat and the Edit window from the Accounts panel remember your most often used images.

Securing Your System with a Screen Saver

If what you really want to accomplish by logging out is to protect your computer while you’re away from your desk, here’s a simple step: Use your screen saver and set it to require a password to deactivate.

1. Open System Preferences by choosing Apple ➤ System Preferences.
2. Click the Desktop & Screen Saver icon under the Personal heading.
3. If the panel appears in the Desktop mode, click the Screen Saver tab (see Figure 5-4).
4. Make sure that the screen saver is set to start after a certain length of time.

For more security, set a hot corner that starts the screen saver. This way, you can immediately enact the screen saver before you leave your desk. Otherwise, you’re trusting that no one gets to your machine between the time you leave and when the screen saver turns on.
Technique 5: Logging Out and Shutting Down

- Figure 5-5: You can password-protect your computer through the Security panel.

**Hot, hot, hot corners**

Your Mac has a feature called hot corners. You can assign special meaning to the different corners of your screen. So, for example, moving the mouse into the upper-left corner might turn on your screen saver, and moving the mouse into the lower-left corner might engage Exposé. Moving the mouse back out of a corner reverts the screen to its previous state (turns off the screen saver or Exposé, in these examples).

You enable and assign hot corners by using either the Hot Corners button in the Screen Savers panel (see Figure 5-4) or by using the Active Screen Corners section of the Exposé tab (see Technique 15).


6. In the Security panel (see Figure 5-5), select the Require password to wake this computer from sleep or screen saver check box.

While in the Security panel, you can also set your computer to log out after so many minutes of inactivity. You might find this option to be great (because it’s more secure) or a pain (as you’re consistently logging back in).

- Figure 5-4: The Screen Saver preferences panel.

**Fast User Switching**

The main benefit of Fast User Switching is that a user can log out without quitting every application. In other words, it maintains everything exactly as you have it but doesn’t let anyone back in without entering your password first.

To enable Fast User Switching, do the following:

1. Open System Preferences.

2. Click the Accounts icon under the System heading (see Figure 5-6).

3. In the Accounts panel (see Figure 5-7), click the Login Options button at the bottom of the left column.

   The Login Option panel appears.

4. In the Login Options panel, check the Enable Fast User Switching option (see Figure 5-8).
Follow these steps to switch to another account (or switch back) with Fast User Switching:

1. Choose the account from the Fast User Switching menu in the upper-right corner of your screen (refer to Figure 5-2).

2. Enter the user account’s password and click Log In (see Figure 5-9).

3. To switch back to a previous account, follow Steps 1 and 2.
You can add features and minimize the menu bar requirements of Fast User Switching (see Figure 5-10) by installing WinSwitch (www.wincent.com, donationware).

If users share a Mac, the Fast User Switching feature allows them to switch between accounts (having different preferences, documents, and Home folders) without losing their place or re-establishing the work environment upon return.

**Making the Quick Exit**

After you finish for the night (or morning or afternoon) and it’s time to close up for the day, you probably want to shut down your computer. Every Mac user knows how to do this, but not every Mac user knows how to do it as quickly as possible.

- The old-fashioned method is to choose Shut Down from the Apple menu (refer to Figure 5-1).

- You can shut down your computer by pressing the power button on your Mac or keyboard. This brings up a prompt of options (see Figure 5-11). At this prompt, press Return to shut down your computer, Esc to cancel, S to sleep, and R to restart, or click the appropriate button with your mouse.

- Hold down the Option key while you choose Apple→Shut Down. Holding down the Option key causes your computer to shut down immediately without any other prompts.

- The Option key trick for suppressing the confirmation prompt also works for restarting the computer, putting it to sleep, or logging out.

From the Energy Saver panel (in System Preferences), you can set your computer to automatically shut down at set times. This is great for lab environments or if you tend to forget to shut down your computer at the end of the day. Technique 2 covers scheduling your Mac.
So you’ve made the decision to give up that annoying Windows operating system and start using Macs. Maybe this is because you’ve seen how great iTunes and the iPod are. Maybe it’s because that Mac Mini is priced right. Maybe you’re making the switch out of spite for Microsoft (because you can’t keep rewarding such shoddy workmanship). In any case, you’ve made the right decision. But, you might ask, “What do I need to know about using Macs?”

In this technique, we give you a nice little introduction to your Mac from a Windows-user perspective. For starters, you find out who stole the Alt key, what that key is next to the space bar, why your Mac has only one mouse button (perhaps), and other basic stuff. Then you get an introduction to System Preferences, which is your new control panel. After that, we let you know how to get help. Finally, a short list of useful Mac-related resources is provided.

One of the most important things to understand from the get-go is that your Windows software doesn’t run on your Mac. So don’t try installing Office for Windows. But many Windows applications are also available in Mac versions (which you might be able to purchase at an upgrade price). More importantly, your documents should transfer with little or no problem. A Word document for Windows will open in Word for Mac. It will also open in iWork’s Pages application!

Where Is the Alt Key? Mac Basics

The Mac setup — from the keyboard to the mouse to the main screen — is just foreign enough to confuse a lifelong Windows user. The first thing to realize is that the Mac setup is a lot simpler than it looks, and it’s definitely easier to work with than Windows. In this initial section, we familiarize you with some of the basics.
Your new keyboard

A keyboard is a keyboard, right? Well, for the most part. If you’re a handy keyboard user on a Windows machine, you probably got used to using the Ctrl and Alt keys as shortcuts (for closing or opening things, quitting applications, whatever). As you’ll quickly pick up, those keys don’t exist on the Mac keyboard. Instead you have Control, Option, and ⌘ (the Command key, which is also the historical Open Apple key). We reference these keys hundreds of times throughout the book, but here are some quick facts about the most important keys:

- **The ⌘ key is the most important key.** The vast majority of shortcuts use the ⌘ key. Everything from opening and closing windows to getting information (think “properties”) about a file uses this key.

- **The ⌘ key is the Alt key, more or less.** For example, on Windows you would use Alt-F4 to close an application; on your Mac, you use ⌘-Q (for Quit).

- **The ⌘ key is somewhat like your old Ctrl key.** Did we mention that the ⌘ key is the most important? Well, it is.

- **Hold down the Control key while using the only (or the left) mouse button to create the equivalent of a right-click** (see Figure 6-1).

- **The Option key is a modifier.** Using the Option key with other shortcuts (like ⌘-W to close a window) modifies that behavior (so ⌘-Option-W closes all windows).

- **The Shift key is also sometimes a modifier.**

- **The Return key (the Enter key’s better-looking sibling) doesn’t always do what you’d think it does.** Specifically, in the Finder (the main interface you have — think of it like your Windows Desktop), the Return key doesn’t open a file or application but rather lets you rename it. This is odd, yes, but that’s the way it is. Otherwise, the Return key is pretty much your old friend the Enter key.

Here are a couple tricks to help ease the transition:

- **Pull out the cheat sheet from the front of this book to be able to quickly reference the most important keyboard commands.**

- **Use the menus at the top of the screen while you’re getting the hang of things.** Nearly all the keyboard shortcuts refer to a menu option (for example, ⌘-C for Copy is the same as going to the Edit menu and choosing Copy). So while you’re learning the ropes, feel free to use your mouse with these menus. Speaking of the mouse, check out the following section.

- **If you miss the Alt key, pry it off your old keyboard and wear it as a key chain.** We hear this is all the rage with the kids these days.
How to use a one-buttoned mouse

One of the hardest ideas for new Mac users to grasp is the single-button mouse. Macs ship with these by default, but dozens of multi-buttoned mice — and you’ll probably want to get one eventually — are available. If you have an Apple laptop, you have a trackpad that comes with but a single button. Whatever Mac you use, you have only one mouse button because you really need only one. That’s all there is to it. But we should also point out

✔ If you’d like to open something, just double-click it by — yes! — clicking it twice in succession.

✔ You can adjust a mouse’s behavior within the Keyboard & Mouse System Preferences panel.

You find out more about System Preferences later in this technique.

✔ You can achieve a Windows right-click by holding down the Control key while clicking. This creates what Mac users call a contextual menu (CM), and they are just awesome. Beyond offering the standard stuff (like the Windows right-click), the CM can be modified in many different ways to make them more useful. See Technique 14 for more on the wonder of contextual menus.

✔ Multi-buttoned mice are often programmable (see Figure 6-2). If you buy a different mouse down the road, it will most likely come with software to adjust the behavior of the buttons.

Working with the Finder, your new Desktop

The most important application on your Mac is the Finder (see Figure 6-3), which is the Mac equivalent of the Windows Desktop. It will often be how you access your files, applications, and so on. Part II of this book is largely dedicated to the Finder. Compared to your Windows interface, what you find is that

✔ A Mac has no Start menu. Instead, you open applications from the Dock (see Technique 13); from the Applications directory; or by using Favorites (see Technique 17). The Apple menu in the upper-left corner also adds Start Menu–like functionality.

✔ Icons normally line up on the right side of the screen instead of the left.
Technique 6: Goodbye Microsoft, Hello Mac!

As you can see in Figure 6-5, the System Preferences interface is organized by categories (Personal, Hardware, and so on). Within each category is a list of what panels are available (such as .Mac, Network, QuickTime, Sharing). Each panel lets you adjust your Mac’s behavior and features for that specific technological area. To access a panel, click just once on that icon. Some other useful information:

- Figure 6-5: The main interface to System Preferences.

You can use the View menu to quickly access a panel without using the main interface.

The View menu is the fastest way to switch from one System Preferences panel to another. It’s organized alphabetically.

If a System Preferences panel is locked (Figure 6-6 shows a locked option), you need to unlock it if you want to make changes.

Locking preferences panels is a great way to make sure that changes aren’t made without the proper authority. To unlock a panel,

1. Click the lock.
2. Enter your administrative password at the prompt.

Now that you have a little introduction to the interface, you can move on to other important concepts.

Setting System Preferences

System Preferences is an important tool and one we reference frequently in this book. It controls how your Mac behaves and how you interface with it. It's very much like the Control Panel in Windows. To open it, choose System Preferences from the Apple menu (see Figure 6-4).

As you can see in Figure 6-5, the System Preferences interface is organized by categories (Personal, Hardware, and so on). Within each category is a list of what panels are available (such as .Mac, Network, QuickTime, Sharing). Each panel lets you adjust your Mac’s behavior and features for that specific technological area. To access a panel, click just once on that icon. Some other useful information:

- Figure 6-5: The main interface to System Preferences.

You can use the View menu to quickly access a panel without using the main interface.

The View menu is the fastest way to switch from one System Preferences panel to another. It’s organized alphabetically.

If a System Preferences panel is locked (Figure 6-6 shows a locked option), you need to unlock it if you want to make changes.

Locking preferences panels is a great way to make sure that changes aren’t made without the proper authority. To unlock a panel,

1. Click the lock.
2. Enter your administrative password at the prompt.
3. Click OK.

To relock a panel, click the open lock icon.

- **Figure 6-6:** The Accounts pane is locked to prevent unauthorized changes.

- **Some utilities install extra System Preferences panels.**

  You can find these listed at the bottom of the main window, under Other (refer to Figure 6-5).

- **You can search the System Preferences panel.**

  This feature is new in Tiger and very useful for Windows folks. For example, if you know you need to do a printing activity, try this:

  1. Open System Preferences.
  2. Type `print` in the Search box in the top-right corner.

     As you type, a list of logical categories appears underneath the Search box. Related System Preferences panels are highlighted.
  3. Use the arrow keys to select a specific topic (see Figure 6-7).

     The corresponding System Preferences panel for the selected topic is highlighted more prominently.

     - **Figure 6-7:** Search the System Preferences panel to quickly find the pane you need.

     4. Click a topic to pursue that activity.

     After you click it, the proper System Preferences panel flashes and then opens.

     5. Click the X in the Search box to close the search.

- **Some panels have multiple subsections.**

  If a panel has subsections, they are available as a series of tabs. Click a tab heading in order to switch to a different tab within the same panel.

- **Using Mac Help**

  Tiger comes with its own Help tool, called the Help Viewer. Among the uses for the Help Viewer are

  - Finding answers to questions
  - Seeing what new features are available
  - Discovering special tips and tricks
  - Using the glossary to make the Windows transition easier
Many of the applications that come on your Mac, as well as those you install, also have their own help pages, which you can access through their Help menus. As an example of using the Help menu, open up the glossary page:

1. **Switch to the Finder if it’s not currently the active application.**
2. **Choose Help ➪ Mac Help or press Ô-? to launch the Help Viewer.**
3. **In the Search box, type glossary and press Return (see Figure 6-8).**

- **Figure 6-8: Search the Mac Help to get assistance on specific topics.**

4. **Double-click the What’s it called on my Mac? result.**
5. **When you’re done reading, click the house icon to go back to the main Help page.**

6. **Click and hold on the house icon to see a list of other available Help pages.**

### Useful Migration Resources

The tips and steps in this technique are just the tip of the proverbial iceberg when it comes to transitioning to the Mac. Oodles of resources are available to assist you. Of those, the most useful are:

- **Apple’s Switch site** ([www.apple.com/switch](http://www.apple.com/switch)): Apple discusses how you can best make the switch and provides links to more resources through this section of the Apple site. For some basic information, check out the Top 10 questions.

- **Apple’s Support site** ([www.apple.com/support](http://www.apple.com/support)): In particular, consider using the Discussions section, where other people post questions and answers about various topics. If you click the Advanced Search link on the main Support page, you can search the Knowledge Base, Apple’s library of useful articles.

- **To find out how to use the Knowledge Base more effectively, check out this article:** [http://docs.info.apple.com/article.html?artnum=75178](http://docs.info.apple.com/article.html?artnum=75178). It shows you different keyword shortcuts you can use within the Knowledge Base (such as kpbg4 for PowerBook G4).

- **Move2Mac** ([www.apple.com/switch/howto/move2mac](http://www.apple.com/switch/howto/move2mac), $50): This application, available through Apple’s online and brick-and-mortar stores, automates the transition from Windows to Macintosh. The software runs on both Windows and the Mac OS and takes all your documents from your old PC and puts them into the right location on your new Mac.
Part II

Optimizing Your Interface

The 5th Wave

By Rich Tennant

Darryl Prepares to Engage with the Aqua Interface

© Rich Tennant
Making Your Mac More Accessible

Not everyone who uses a computer has 20/20 vision or tireless wrists. Moreover, computers can be quite hard on the human body, making the need for special assistance even greater. Tiger comes with many ways to customize how you and your Mac interact, allowing for different or just easier interactions. As you look into this technique, you find that these features are quite useful for all Mac users, not just those with special needs.

You can adjust your Mac’s behavior in four primary areas:

- Setting Tiger to provide audible clues
- Using your own speech to control your Mac
- Changing the display appearance
- Altering the keyboard and mouse settings

In this technique, we cover each of these in detail, primarily focusing on the sections of System Preferences that you’ll want to use. (In case you do not already know, you can access System Preferences through the Apple menu.)

When searching for more information online regarding your Mac and this subject, use the keywords Mac and assistive technology. You can also use Mac and accessibility. Within the Mac’s Help files, the word accessibility brings up a number of articles, many of which we cover within this technique.

Listening to Your Mac

For users with limited vision, the Mac has several strategies for relaying information in non-visual ways. The main feature, called VoiceOver, is enabled within the Universal Access panel (see Figure 7-1). VoiceOver, in short, provides an audible narration for what’s happening on your Mac. This narration ranges from the basic, such as reading alerts and notifying you of what window is open, to the thorough, such as reading entire sections of text.
To turn on VoiceOver, click the On button or press Ô-F5. (This keyboard shortcut works no matter what application you’re in.) You should immediately hear “Welcome to Macintosh” or another greeting. After you enable VoiceOver, you probably want to tweak how it behaves:

1. Click the Open VoiceOver Utility button.
2. Click the Verbosity tab and adjust the settings there (see Figure 7-2).

You use the Verbosity tab to determine how much your computer speaks to you. For starters, you can adjust how VoiceOver handles

- Punctuation (which standard users might not need to hear but technical writers would)
- Alterations of text (for example, when text has italic or bold formatting)
- Text that you type

You can also set VoiceOver to do other neat tricks, such as speaking

- The text that the mouse cursor is currently over
- When the mouse enters a window
- When a modifier key (Shift, Control, Option) is pressed
- When the Caps Lock key is engaged (so that you know you’re typing in all capital letters)

1. Figure 7-1: The Universal Access pane is visually easier to work with than other panes.
2. Figure 7-2: Control how active the VoiceOver is by using the Verbosity tab.
3. Click the Navigation tab and adjust the settings there.

The Navigation aspect of VoiceOver helps you with just that: getting around. There’s a top section dedicated to Web pages, followed by one section for tracking cursor movement and another related to text.

4. Click the Voices tab and modify the Mac’s voice (see Figure 7-3).
Listening to Your Mac

Your Mac comes with about 15 different voices. Select a preferred voice first, and then adjust the rate, pitch, and volume of that voice. You can even select different voices for different narrations (content, attributes, status, whatever).

The Voices tab is one of the most important for successfully using VoiceOver. Use a voice that you like and at a rate that makes sense for how quickly you do things on your Mac.

5. Click the Display tab and turn on the Caption Panel.

The Caption Panel displays, at the bottom of the screen, the essence of what VoiceOver is also saying. You can modify its size and transparency to improve its visibility.

6. Finally, click the Pronunciation tab and adjust how VoiceOver pronounces abbreviations.

You can see some examples listed there, and hear them by clicking them. You can add and subtract pronunciations as needed, and edit the pronunciation of an item by double-clicking it. This feature is particularly good for people in fields with a specialized vocabulary.

Editing or creating the pronunciation of something isn’t as difficult as you would think. You can start by checking out the included pronunciation definitions. After that, type letters and words that you think are appropriate, and then use spaces and hyphens to create pauses and break up syllables. When creating your pronunciation, use the Play button to hear the result and then modify the pronunciation until it’s just right.

A second way to have your computer vocalize information for you is by using the Text to Speech feature. Found within the Speech pane (see Figure 7-4), Text to Speech simply speaks particular things. You can turn it on for

- Alerts (warnings and other prompts in applications)
- When an application needs something (the equivalent of the application’s bouncing Dock icon)
- Selected text, when an assigned key combination is pressed
- The current time
In the Date & Time section of System Preferences, you can set your Mac to announce the time at regular intervals, using a favorite voice.

If you use Text to Speech, make sure to choose a voice and a speaking rate that’s most effective for you. A Play button is available so that you can test the various settings.

Talking Back to Your Computer

Assuming that your Mac has a microphone (most laptops have them built in), not only can your Mac talk to you, but you can talk right back. Speech-recognition software lets you control your Mac — make it do things — by saying the proper commands.

Your Mac is able to perform certain actions, such as saving a document or quitting an application, by using the software built into Tiger. If you want to be able to dictate e-mails or text files, you need third-party software like iListen (www.macspeech.com, $150 and up).

To work with your computer by using your voice, you need to enable some of Tiger’s speech recognition features. Repeat after us. . . .

1. From the System Preferences panel, open the Speech pane.

2. Click the radio button to turn on Speakable Items.

   After you enable Speakable Items, you see a round window appear (see Figure 7-5). This window
   
   ► Shows what key needs to be pressed so that your Mac listens to you speaking. (The key is Escape by default, which you don’t see in the figure because the key is already being pressed.)
   
   ► Shows the sound input levels when you’re speaking.

   ▶ Links to the Speech panel and a window of speakable commands (click the down arrow to access these).

   You can click and drag this bubble around to position it where it’s most convenient. It will always remain on top of every other window.

   ▶ Figure 7-5: This round little guy shows that Speech Recognition is on.

3. Read the prompt on how to most effectively use Spoken Commands, and then click Continue to close the prompt.

   The prompt provides very important information. As you see,
   
   ► You need to hold down Escape when speaking a command so that your Mac hears you.
   
   ► You have to use specific commands, listed in the Commands area.
   
   ► You should speak loudly enough that you consistently hit the green levels in the microphone window (see Figure 7-5).

4. Select a sound or voice for command acknowledgement.

   Tiger lets you know whether it understood a command. By default, it does this by playing a sound, but you can set it to repeat the command back to you by selecting the Speak Command Acknowledgement check box.
To test the Speech Recognition software, hold down Escape and say “Tell me a joke.” Note that we aren’t suggesting you’ll hear a good joke!

5. Click the Commands tab.

6. Select and deselect the command groupings as necessary (see Figure 7-6).

Here you decide what types of commands Tiger should listen for. Click any item to see a description and then select or deselect the check box as appropriate.

![Figure 7-6: Check out what types of commands you can speak, and limit them if you need to.]

If you type `speakable` in the Mac Help Search box (see Technique 6) and press Return, you find some instructions for creating your own new speakable commands.

7. Click the Open Speakable Items Folder to see a list of speakable commands.

In order for Speakable Commands to work, you have to know what commands are available. These are listed, by application, within the `/Library/Speech/Speakable Items` folder.

You can also see some, but not all, of the available commands by selecting Open Speech Commands Window from the Speakable Commands floating window (see Figure 7-5). This resulting Speech Commands Window also shows the most recently spoken commands, and marks those commands you spoke that it didn’t comprehend as question marks.

**Using Visual Clues**

The Universal Access pane has a few other settings that are useful for people with limited vision. These include

- Zooming in on sections of the screen
- Displaying white text on a black background (as opposed to black on white)
- Using grayscale colors
- Adjusting the contrast
- Having your Mac flash when alerts sound (under the Hearing pane)

The last four options are easy to enable and use, requiring very little thought or customization. The zoom feature merits further discussion because it has its own keyboard shortcuts and customization options:

1. Open the Universal Access pane.
2. Turn Zoom on.
3. Memorize the keyboard shortcuts.

   To zoom in, press `Shift-Option-=` (equal sign). To zoom out, press `Shift-Option--` (hyphen). Fortunately these two keys (- and =) are right next to each other, making these combinations easier to remember.

4. Click the Options button to further customize how the zoom works (see Figure 7-7).
Technique 7: Making Your Mac More Accessible

1. Open System Preferences, if it isn’t already open.

2. Go to the Keyboard & Mouse pane.

3. Adjust the Key Repeat Rate and Delay Until Repeat settings if you’re having problems with the same key being repeated (see Figure 7-8).

   The Key Repeat Rate dictates how many lowercase x’s (or whatever) are repeated if Tiger thinks a key is being held down. The Delay Until Repeat rate sets how much time must pass for Tiger to think a key should be repeated. If you’re a slower typist, increasing the Delay Until Repeat rate and decreasing the Key Repeat Rate might minimize typing errors.

4. Adjust the mouse behavior in the corresponding tab.

   You can adjust your mouse’s behavior with respect to its tracking speed (how fast the cursor moves) and its double-click speed (how quickly you have to click in succession). You can also — depending upon the mouse in use — adjust the speed of the scroll wheel and determine the speeds of the scroll wheel.

   After you zoom in, move your mouse around — without clicking any buttons — to move the focus around your screen.

   Tiger’s zooming ability can be useful for Mac people of any kind. It’s very easy to use, doesn’t interfere with your normal operations, and can come in handy under a multitude of circumstances. Graphic designers in particular will find it useful.

**Customizing the Keyboard and Mouse to Suit Your Needs**

One final way in which you might want to customize your Mac’s behavior is to adjust how your input devices function. Slower typists, users with restricted motor skills, and people who easily become fatigued can benefit from adjusting the keyboard and mouse settings. There are two related sections of the System Preferences panel into which you should delve:
primary mouse button (which is great if you’re left-handed and want the right button to be primary).

If you have a programmable input device, you also might be able to adjust how quickly the device moves the cursor on-screen.

5. Adjust the trackpad behavior by using the Trackpad tab (if applicable).

Like the mouse, you can adjust your trackpad’s behavior with respect to its tracking speed (how fast the cursor moves) and its double-click speed (how quickly you have to click in succession). You can also set important trackpad qualities, such as whether the trackpad is ignored if a mouse is present.

6. Within the Keyboard Shortcuts tab, turn on Full keyboard access for all controls.

Doing so lets you more fully navigate your Mac from the keyboard alone. Technique 10 discusses this concept in greater detail.

The Keyboard Shortcuts tab is also critical in that it displays many of the keyboard shortcuts available within Tiger. Most of these won’t appear in any menu, so this is the only place to find them (outside of Mac Help).

7. Choose View ➪ Universal Access.

You tweak the remaining settings within Universal Access.

8. On the Keyboard tab, set the Sticky Keys and Slow Keys properties (see Figure 7-9).

Sticky Keys lets you use a difficult keyboard shortcut, like ⌘-Option-H (for Hide Others), without holding down all the keys simultaneously. The Slow Keys feature adds a delay between the time you press a key and when your Mac registers it. On this tab, you can also tell Tiger to beep when one of the modifier keys has been pressed and display the pressed keys on your screen.

9. On the Mouse & Trackpad tab, turn on Mouse Keys if you have a numberpad.

The keyboard’s numberpad can be used to control your mouse. This is a useful adjustment if you have trouble with mice or trackpads. That being said, if you don’t have a separate numberpad on your keyboard (for example, if you have a laptop), you’ll probably find the pseudo-numberpad to be much less convenient.

10. On the Mouse & Trackpad tab, adjust the size of the cursor if it’s too small for you.

The cursor itself can be hard to see and find on the screen, so use the sliding bar to increase its size to a more discernable format.

11. When you finish adjusting settings, close the Universal Access pane.

12. Use your Mac normally, and then readjust the various properties if needed.
When customizing how you and your Mac interact, remember that this isn’t a static relationship. How — and how quickly — you’re able to work might change over time, meaning that you might have to re-tweak the applicable settings to make them better represent your current needs.

If you have difficulty typing or using the keyboard, remember that you can also key in letters by using your mouse and the Character Palette. The Latin category displays the alphabet in upper- and lowercase from which you can select characters (double-click to insert a character into the current document). See Technique 28 for more on the Character Palette.

---

**Using macros and automated processes**

Besides the controls that you can adjust within the System Preferences panel, you can facilitate your interactions with your Mac in many other ways. Here are just a couple examples:

- Use Microsoft Word’s macros to automate typing, formatting, and more.
- Create Workflows in Automator (see Technique 61) to perform a sequence of actions, even across multiple applications, with one simple step.
- Use AppleScripts — those you can program yourself or ones available for download — to run through common tasks.
- Use Microsoft Word’s AutoCorrect feature to create abbreviations of words.

Although these options aren’t necessarily geared toward people with special needs, they can be just as or more useful in that capacity.
The distant ancestor of today’s Macs, the Apple IIe, had a small glass monitor that supported two colors: black and green. Today’s modern computers come equipped with beautiful monitors, some of them liquid crystal display (LCD) or plasma flat-screen, capable of displaying millions of colors, and with a viewing area of nearly two feet. But there’s more to your monitor than just the physical hardware: You also use many pieces of software to control what you see and how you see it.

In this technique, you find out a thing or two about what screen resolution is, how to choose the proper setting, and how to easily manage these settings. Determining and setting the optimal resolution for your monitor gives you more screen space to work with, a better interface, and more reliable results (for graphic designers). Then you work with color management in Tiger by using ColorSync. We introduce how Mac OS X handles fonts, why you might want to adjust that behavior, and how to do it. Finally, we cover how to configure your Mac to make the best use of multiple monitors.

**Managing Your Display Resolution**

Most beginning computer users, whether they use a Mac or a PC, never concern themselves with the display resolution. So why should you? Because adjusting the display resolution directly affects everything you do with your computer. (Because it all goes through the monitor, right?)

Monitors create everything that you see on-screen by using pixels, which are small squares of colored light. Your screen resolution is set in terms of pixels, such as 800 x 600 pixels. Common measurements for standard monitors are

- 800 x 600
- 1024 x 768
- 1280 x 1024
Technique 8: Working with Displays

2. Make sure that the Display tab is selected (see Figure 8-2).
3. Select a higher resolution than the current (presumably default) one.

The screen sizes available for use depend on
- The display itself
- The video card in the computer (in particular, the amount of VRAM — Video RAM — that it has)

A higher resolution allows you to display more stuff, but everything is smaller.

A higher screen resolution might increase your productivity (you’ll spend less time toggling around), but also your need to see an ophthalmologist (you’ll be looking at tiny, tiny things on-screen). So don’t just accept the default screen resolution set for your Mac — find one that works best for you.
4. **Select the Show Displays in Menu Bar check box.**

Marking this check box creates a monitor control in the menu bar (shown in Figure 8-3), saving you trips to the Display panel.

Click the Detect Displays button whenever you add or remove another monitor, including a projector. Doing so allows your Mac to recognize what monitors are currently in use. Alternatively, you can choose Detect Displays from the pop-up menu that appears when you click the menu bar Display icon.

![Detect Displays](image)

**Figure 8-3: The little monitor icon in the menu bar can be used to control display settings.**

5. **Set the Number of Recent Modes pop-up menu to 3, if you have that option.**

The Recent Modes drop-down list dictates how many resolutions appear in the menu bar’s Display menu. You probably have no reason to show more resolutions than three unless you’ve got some hog-wild resolution switching going on.

6. **Close the Displays panel.**

7. **Experiment with the new monitor setting.**

If it’s too hard on the eyes, switch to another resolution with either

- The menu bar Display tool (refer to Figure 8-3)
- The Display preference pane (refer to Figure 8-2)

As a compromise for your vision, you can use a high resolution and increase the default font sizes of the system (see “Handling Fonts” later in this chapter) and your applications.

**Virtual desktops**

If you never seem to have enough monitor space for all your stuff, you can get more screen space for your buck with an application such as DesktopManager (http://wsmanager.sourceforge.net, free). This program creates virtual desktops. A virtual desktop is exactly like the Finder’s Desktop except that you can have many of them instead of just the one.

After you create multiple desktops, each can have its own personality. Each individual Desktop can have its own background, Dock, set of preferences, open windows, and even open applications. For example: If you have multiple projects going on at once, a different Dock can be used for each environment. Or, you can have one Desktop in which you’re playing games and using iTunes and another where you’re actually working.

This is familiar territory for users of the Linux operating system. Linux (and other variants of UNIX) primarily uses the Gnome or KDE application as its version of the Finder. Each of these applications supports multiple desktops.

You might like the idea of virtual desktops — and you might not — but if you’re whittling away time one afternoon, it’s certainly worth your consideration. And the price — free! — can’t be beat!

**Adjusting the Colors**

Your monitor doesn’t necessarily display colors in a manner that’s consistent with other users’ monitors: It’s a foreign concept to many computer users and a hard lesson for the novice graphic designer to learn. In fact, historically, the colors of a Mac have been slightly brighter than those of a Windows PC. This is because coloring is a software issue. To help adjust for these variations, you can create different profiles with Apple’s ColorSync application. For example, you can calibrate different color profiles for different purposes (graphic design, general use) and then switch among them from the Display panel. To create a custom ColorSync profile:
1. Choose Apple→System Preferences→Displays to bring up the Display panel (refer to Figure 8-2).

2. Make sure that the Colors pop-up menu is set to Millions and that the Refresh Rate drop-down list is set as high as possible.

The number of colors is just that: how many different colors the monitor will display. We can’t name 256 colors (let alone a million), but we can definitely tell the difference between the two settings on the monitor.

The refresh rate determines how often everything on-screen is redrawn. (When you see computer monitors on television and in movies with lines scrolling down the page, a refresh is taking place.) The higher the number that you select in the Display panel, the faster the refresh. Even though you’ll probably never be aware of it, except on the lowest settings, higher refresh rates are easier on the eyes.

3. Click the Color tab (as shown in Figure 8-4).

4. Click the Calibrate button to begin the automated calibration process.

The Display Calibrator Assistant appears (see Figure 8-5).

5. Follow the on-screen instructions to create your profile.

The assistant is easy to use and has clear instructions to help you through the process. The Display Calibrator Assistant even offers an expert mode, although if your needs are advanced enough to require that, you probably don’t need our help.

If you have a laptop, adjusting the brightness of your monitor from the Display panel will throw off your colors.

6. To change from one profile to another, select from the available options in the Color section of the Display panel (see Figure 8-6).

Your Mac probably comes with a couple profiles, and every profile you add also is listed here. Select the new profile to make the switch.
Handling Fonts

How the system treats fonts affects your overall Tiger experience. On your Mac, you can adjust how the operating system handles anti-aliasing. As any graphic designer will tell you, anti-aliasing minimizes the jagged edges of characters to produce a smoother appearance. Like the refresh rate issue, this is something that you might not consciously appreciate, but it could have a subtle effect. You can adjust anti-aliasing by using the Appearance dialog:

1. Open System Preferences, and under the Personal heading, click the Appearance icon.
2. At the bottom of the Appearance dialog that appears (see Figure 8-7), select the appropriate font-smoothing style.
3. Just below the Font Smoothing Style pop-up menu, determine to what point sizes font smoothing should be applied.

From this pop-up menu, you can select 4, 6, 8, 9, 10, or 12. Any font of the size that you choose or smaller will be anti-aliased. Larger fonts won’t be.

4. Close the Appearance dialog.
Technique 8: Working with Displays

How TinkerTool can help

TinkerTool, a must-have freeware application provided by Marcel Bresink (www.bresink.de/osx/TinkerTool.html), adds many customization options to Tiger. It's been so popular in its many incarnations that its features frequently end up in later versions of OS X. One adjustment that TinkerTool can make is what fonts to use as the default system fonts, as shown in the following figure.

By adjusting these fonts, you can have a more personalized interface, correct for a screen resolution's settings, and more accurately control when font smoothing takes place.

Using Multiple Displays

Many Mac users already benefit from the Mac’s ease of using multiple monitors. Graphic designers and video editors frequently use multiple monitors to improve workspace efficiency. High-end applications such as Apple’s Final Cut Pro, Adobe Photoshop, and even Macromedia Dreamweaver have so many windows open at once that you almost need to have one monitor for open windows and another for the work in progress itself. Laptop users can connect to another monitor, using both it and the laptop’s built-in display simultaneously. (The same principle applies if you hook up a Mac to a projector for a presentation.) In each of these cases, you need to be able to manage all the displays. It’s pleasantly simple with Tiger.

You need an extra video-out port to use multiple monitors with your Mac. Laptops have an extra port by default; desktops need either a second video card or a video card with two ports.

If you have two monitors (or a monitor and a projector), there are two ways you can use them. The first is to have them mirror each other, so that they both display the exact same information, as if you only had one monitor. This is useful for presentations or if you just want to use a bigger monitor for your laptop. The second option (nonmirroring) lets the monitors act separately. One monitor will be the primary, with the menus; the other is just extra screen space. While very useful, not all Macs — even if they have an extra video port — can support separate monitors (not without hacking the software, that is). This includes iMacs, eMacs, and iBooks (consumer line products).

To configure your Macintosh to work with two monitors (or a monitor and a projector), follow these steps:

1. **Connect both displays to your Mac.**
   When connecting any new display, turn off the display (monitor, television, or projector), make the connection, and then turn on the display. You don’t have to turn off your Mac when connecting a display.

2. **Open the Displays dialog in System Preferences.**

3. **Click the Detect Displays button.**
   This button brings the new monitor to the Mac’s attention.

4. **Click the Arrangement tab in the main display window.**
   When using the Displays dialog with multiple monitors, you see two separate windows:
Using Multiple Displays

1. The main display window (see Figure 8-8) appears on the display that also has the Dock and the menu bars.

![Figure 8-8: The main display panel controls the arrangement of multiple monitors.](image)

2. The second display (see Figure 8-9) appears on the subordinate monitor.

![Figure 8-9: A secondary display panel controls only the resolution and color settings for the second monitor.](image)

5. In the main display, move the monitor icons around so that they correspond with their physical relation to each other.

The two connected displays are represented by the two blue squares in the box below the Arrangement tab (refer to Figure 8-8). The main display has a white bar across the top of an icon, which represents the menu bar. When you understand which icon represents which monitor, you can click and drag the icons to arrange them the same way your displays are physically arranged.

If you’re using a monitor and a projector, how they are arranged in the Displays panel doesn’t matter (because the screens aren’t next to each other), but you still need to visualize how the two screens meet up.

If you’re using two monitors in a nonmirroring format, you have essentially one large workspace created by virtually combining the two display areas. Consequently, the cursor scrolls off the edge of one monitor and onto the other. For those to work best, the monitors should be arranged in the Displays dialog as they are physically arranged in your work area or you need to comprehend how the cursor gets from a monitor to the projector’s screen (by scrolling off of one side or the other).

6. Move the menu bar icon to dictate which monitor is the primary.

The primary monitor will have the menu bar and a Dock at the bottom; if your Dock is on the side of your screen, it will appear on the leftmost or rightmost screen side, accordingly.

The white bar on the top of the one display icon represents the menu bar. You can click and drag this from one monitor icon to the other to set the primary computer. Your primary computer will show the menu bar at the top, the Dock at the bottom (if that’s your setting), and any mounted volumes on your Desktop (if it’s set to do so).

If you have two monitors, they can mirror each other. Mirroring means that both monitors display the same thing at the same time — which is useful when giving presentations because you can work on your computer while still controlling the overhead projection. The cursor moves in sync on both displays. To use mirroring...
1. If you haven’t already, enable the Display menu bar icon (see “Managing Your Display Resolution,” earlier in this chapter).

   The Display menu bar tool provides you with quicker access to your monitor settings, including mirroring, resolution, and detecting new displays.

2. Click the Display menu bar icon.

3. Choose Turn On Mirroring from the menu that appears (see Figure 8-10).

4. Set the appropriate screen resolution for both monitors in the Display menu (see Figure 8-10).

   In earlier versions of OS X, both monitors had to use the same resolution for mirroring to work; fortunately, this is no longer the case.

5. Use the menu bar Display icon to turn mirroring on and off as necessary.

   When giving a presentation, you can use your Mac’s ability to easily turn monitoring on and off to your advantage. If you want both monitors to present the same information, turn on mirroring. If you’d like to do something without everyone in the room seeing it, temporarily turn off mirroring and then use the nonprojected display.

---

**Quartz Extreme**

Tiger supports a feature called Quartz Extreme. Quartz is the underlying technology that handles 2-D graphics, which is most everything that you see on a daily basis. A system that uses Quartz Extreme performs significantly faster than one that isn’t.

Unfortunately, running a second monitor might disable the Quartz Extreme feature because it requires AGP 2x (Advanced Graphics Port) with 16MB VRAM. Running Quartz Extreme on two monitors requires a video card that can provide these minimum requirements for each. To find out whether your system is Quartz Extreme–accelerated (as shown in the following figure), check out the free Quartz Extreme Check tool on Marc’s Web site (www.entropy.ch/software/macosx).
If you read only one technique in this entire book, make it this one. If you read only two, read the next one, as well. Both of these chapters discuss keyboard shortcuts: tricks for quickly getting around and doing stuff with your fingers firmly placed on the keys. *Remember:* Every time that your hands have to leave the keyboard to access the mouse, you lose seconds that could be better spent typing (or playing games).

We divide all the requisite keyboard navigation techniques into two broad categories: moving around within Finder windows and the more specific “Getting Places” section, which discusses how to get yourself to spots on the computer and your network. The first and longest section of this chapter covers all the ins and outs of navigating windows, which are the basic unit of the Finder. This is preceded by a brief introduction to the various keyboard shortcut symbols that you find in Tiger — a sort of Rosetta Stone for these commands. We also cover the Desktop because not everything you do takes place inside a window. The final section shows you how to quickly access parts of your Mac. These shortcuts can be used inside or outside of Finder windows.

**Keyboard Characters**

Many of the keyboard navigation techniques can be found on-screen — for example, on the Go menu (see Figure 9-1). To use these shortcuts, you have to first know what the symbols mean. In case you never knew or simply forgot, Table 9-1 shows how Tiger symbolically refers to the modifier keys (Command, Control, Shift, Option, and Del).
Moving Around in a Finder Window

Navigating, manipulating, and otherwise using the Finder windows is such an integral part of getting the most out of Tiger that we devote this and the next three techniques to covering it. In Tiger, the windows are highly customizable so that you can tweak them to their own particular preferences.

If you really, really, really want to be able to use your Mac faster, learn to type well. Knowing how to type is infinitely quicker than hunting and pecking. It also improves the speed benefits of these keyboard shortcut chapters.

The Finder has many shortcuts. Beginners might be a bit overwhelmed at first. The shortcuts can vary depending on what view mode you’re using. The Finder supports three view modes:

- Icon view
- List view
- Column view

In this technique, we discuss some keyboard shortcuts that work in every view mode and then cover those that work only in a particular view mode.

While in a window, use -1 to switch to icon view, -2 to go to list view, and -3 for column view. These shortcuts correspond to the order of the View icons at the top of the Finder window.

Navigating in any view mode

These navigational tips apply in every view mode:
Moving Around in a Finder Window

- Type a letter to go to the first item whose name begins with that letter.
- If multiple items begin with the same letter, type two or more letters to be more selective.
- Press Tab repeatedly to jump alphabetically through a window’s contents.
- Hold down Shift while pressing Tab repeatedly to scroll backwards alphabetically through a window’s contents.
- Press Ô-[ or ] to move backward or forward, respectively, like clicking the Back and Forward buttons in a Web browser.

A Finder window can contain any combination of files, applications, folders, network links, and even volumes (hard drives, removable drives, discs). We use the generic items to collectively refer to all these things. (In other words, items means things you might find in a Finder window.)

- Use Ô-- (the tilde, found in the upper-left corner of the keyboard) to toggle among the open windows and the Desktop.
- Use the arrow keys (left, right, up, down) to move as you would expect (namely, left, right, up, or down).

Which view mode you use is best determined by context and personal tastes. Technique 12 discusses the merits of each individually and helps you decide when you should use which.

Navigating in icon view

The icon view mode (see Figure 9-2) shows the window’s contents as, well, icons. Although icon view also shows each item’s name, you mostly see the icons themselves. The basic shortcuts that we describe in the previous section also work in icon view.

- Figure 9-2: Icon view mode is familiar to every Mac user, although yours might look slightly different.

Use Ô-1 to switch to icon view.

In addition, here are some Ô options that you can use to navigate in icon view:

- Press Ô-↑ to go up one level (to the parent folder).
- Use Ô-↓ to go into the selected folder (see the Documents folder in Figure 9-3).

- Figure 9-3: In icon view, a folder is marked as selected when the name is highlighted in the selection color.

- Press Ô-O to go into a selected folder.
Technique 9: Speedy Keyboard Navigation

Use Ô-2 to switch to list view.

Here are some basic commands for navigating through list view:

- Use the up and down arrows to move up and down the list.
- Press the right arrow to expand a selected folder (see Figure 9-5). This is the equivalent of clicking the little right-pointing triangle next to an item’s name with your mouse pointer.
- Use the left arrow to close an expanded folder, assuming that it’s selected. This is the equivalent of clicking a down-pointing triangle with your mouse.

Navigating in list view

The list view (see Figure 9-4) shows the contents of a folder as an itemized list. It always lists the names of the items, but might also display various other properties. (You can customize what properties are shown. For more information, see Technique 12.)

Would you like a new window with that?

If you really like windows, you can set the Finder to open all directories in their own new windows. To do so:

1. Press Ô-, (comma) to bring up the Finder preferences panel.
2. Select the Always Open Folders in a New Window check box.
3. Press Ô-W to close the Finder preferences panel.

If you enable this option, Tiger opens up a new window every time you open a directory. We find that this habit creates a very busy work environment, so we prefer to simply use Ô-Shift-O to manually request a new window when we need one.

Navigating in column view

The column view mode is the most complex of the three. It works a little like the list view mode but also allows you to navigate forward and backward by viewing the hierarchy as a series of columns within the Finder window (see Figure 9-6).

- Figure 9-4: The list view mode.
- Figure 9-5: Expand a selected directory by pressing the right arrow.

On top of these basic commands, all the Ô keyboard shortcuts that work for the icon view also work in the list view. For a refresher on those, refer to the section, “Navigating in icon view.”
Moving Around in a Finder Window

listed in the second column are all in the Application Support folder, which is highlighted in gray in the first column.

The quickest way to navigate through columns is to type the initial letter of an item to select it, and then press the right arrow to move to the next column. Repeat until you find the item or directory you’re looking for.

Tiger offers you the choice of using column view as your default view mode. To do so:

1. Get yourself over to the Finder by clicking the Desktop or the Finder icon in the Dock.
2. Press Ô-, (comma) to bring up the Finder preferences panel.
3. Click the General button if it isn’t already selected.
4. Select the Open New Windows in Column View check box (see Figure 9-8).

When in column mode, the currently selected item is highlighted with your selection/highlight color. The gray highlight in preceding column indicates which folder’s contents are listed in the current column. For example, in Figure 9-7, the currently selected item is the folder called AddressBook, which is highlighted in the selection color and whose contents appear in the third column. The items

1. Use Ô-3 to switch to column view.
2. Use the up and down arrows to move up and down within a column.
3. Press the right arrow to move one column to the right (see Figure 9-7).
4. Use the left arrow to move one column to the left.

Here are some frequently used shortcuts for column view:

- Use the up and down arrows to move up and down within a column.
- Press the right arrow to move one column to the right (see Figure 9-7).
- Use the left arrow to move one column to the left.

Figure 9-7: The right arrow moves you into a subfolder’s listing column.

When in column mode, the currently selected item is highlighted with your selection/highlight color. The gray highlight in preceding column indicates which folder’s contents are listed in the current column. For example, in Figure 9-7, the currently selected item is the folder called AddressBook, which is highlighted in the selection color and whose contents appear in the third column. The items

Figure 9-8: Use the Finder’s preferences panel to set column view as the default.

5. Close the preferences panel by pressing Ô-W.
Navigating the Desktop

The Desktop has some keyboard navigation tricks of its own, most of which get you to a Finder window. Some of these options are limited based on how you’ve customized your Desktop (for example, what hard drives, servers, and devices will appear there). The basics are

- Pressing the arrow keys works as expected, moving you up, down, left, and right.
- Pressing Tab moves you alphabetically from item to item.
- Pressing Shift-Tab moves you reverse alphabetically from item to item.
- Typing the first letter or two of any item’s name selects that item.

Within Open/Save dialogs, Ô-D is the shortcut to your Desktop.

The following four shortcuts all require the ever-popular Ô key:

- Ô-N creates a new Finder window showing the default directory.

Use the Finder’s preferences to determine which directory a new window should open by default (refer to Figure 9-8).

- Ô-Shift-↑ takes you to the boot disk drive on the Desktop (the volume on which the running operating system is installed; see Figure 9-9).
- Ô-O opens a folder, volume, file, or application.
- Ô-↓ opens a folder or volume.

Exposé, which we cover in Technique 15, brings with it its own keyboard shortcuts.

Getting Places

You can get to important spots on your Mac with a number of specific keyboard shortcuts. These work whether you’re in a Finder window or just on the Desktop itself. The first three are the most useful:

- Ô-Shift-A takes you to the Applications directory.
- Ô-Shift-U goes to the Utilities directory.
- Ô-Shift-H moves you to your Home folder.

Most of these keyboard shortcuts are duplicated — and listed — in the Finder’s Go menu (refer to Figure 9-1).

These are handy typing tips, but you might never need them:

- Ô-Shift-K brings up the window displaying available networks.
- Ô-K brings up the Connect to Server prompt.
- Ô-Shift-I mounts your iDisk (for .Mac users only).
- Ô-? retrieves the Help Viewer application. (This is technically Ô-Shift-/ because you need to press Shift to get the question mark.)

One of the shareware applications that we recommend most often in this book is LaunchBar, created by Objective Development (www.obdev.at; $39 for businesses, $20 for personal use, free for limited use). Use LaunchBar
The Keyboard Shortcuts panel is a potent tool if you know how to use it. You can even use it to add your own customized shortcuts. See Technique 10 for further examples.

The default keyboard shortcuts, listed in the Shortcut column shown in Figure 9-11, primarily use the Control key in conjunction with your function keys. Under the Keyboard Navigation heading in Figure 9-11, you see that:

- Control-F2 takes you to the menu bar. (It’s just like clicking the menu bar with your mouse.)
- Control-F3 takes you to the Dock.

Another method of getting around your computer is to use Full Keyboard Access. Full Keyboard Access enables you to use the Tab, arrow, and other keys to select on-screen items. To enable this, follow these steps:

1. Open the System Preferences panel.
2. Click the Keyboard & Mouse icon.
3. Click the Keyboard Shortcuts tab of the Keyboard & Mouse panel that appears.
4. Click the radio button next to All Controls (see Figure 9-10).
5. Under Description, click any of the right-pointing arrows to expand a section.
6. Select the check box next to a shortcut or shortcut group to enable or disable it.

The Keyboard Navigation shortcuts can really minimize the need to use the mouse.

After you select the Dock by pressing Control-F3, you can toggle from icon to icon by using the left- and right-arrow keys or Tab and Shift-Tab. Press Return to select a highlighted icon.

When you’re in the toolbar of a window, use Tab and Shift-Tab to move around. You can use the spacebar to select an item, just like clicking it with your mouse.
Using the Go To Folder dialog
In the Finder, the Ô-Shift-G keyboard shortcut brings up the Go To Folder dialog (shown in the following figure), which you can use to quickly navigate to specific directories.

Using the Go To Folder dialog offers the following benefits:

- A new Finder window is opened if one isn’t open already.
- If a Finder window is open, the Go To Folder dialog operates within it.
- Tab completion (which allows you to type just a few characters and then press Tab to complete the entry) saves you from typing in long names.
- The Go To Folder dialog is case-insensitive.
- You can access hidden directories that don’t otherwise appear in the Finder.
- For those familiar with the cd command, the Go To Folder dialog works identically to it.

The only trick to using the Go To Folder dialog is that you need to know the path name for your desired destination. A path name is the path of folders that you must follow to find something on the computer. For example:

- The base (root) level is /.
- Apple’s e-mail client is in /Applications.
- A file on Larry’s Desktop would be under /Users/larry/Desktop (larry is the short username that he registered with).
- Larry’s Desktop could also be written in shorthand as ~/Desktop; ~ (the tilde) represents the current user’s Home directory.
- A folder on a secondary volume would have a path name of /Volumes/volumename/foldername.

This might seem like more trouble than it’s worth, but if you have a basic understanding of where things are on your computer, Tiger really helps you out.

To start:

1. **Bring up the Go menu prompt by pressing Ô-Shift-G.**
2. **Start typing the path name with either**
   - ~/ (refers to your Home directory)
   - / (refers to the root or base level of the computer)
3. **Begin typing the first letter or first few letters of the directory that’s next in the path name.**
   For example, if something is in your Documents folder, type Do or Doc after the ~/.
   If it’s on your second hard drive, type /Vo. In the figure, I begin with ~/Do to start heading into my Documents folder.

4. **Press Tab to have Tiger complete the directory name.**
   Or, if you wait just a moment, the directory name is automatically filled in. This next figure shows how ~/Do was turned into ~/Documents/.

5. **Repeat Steps 3 and 4 until the full path name of the folder that you want to explore is written out.**
6. **Press Return or click the Go button to load that directory in a Finder window.**
All in all, the Go To Folder dialog is a really smart way to quickly hop to specific destinations on your computer. Furthermore, getting comfortable with this system makes the transition to using the Terminal for command line tasks less daunting. (And most power users eventually take the Terminal for a spin.)
In this technique, we focus on more general keyboard shortcuts (as opposed to Technique 9, which covers navigation specifically). These are really the most important keyboard shortcuts on your Mac because they let you quickly do all the things you commonly do: Open items, save documents, print things, and so forth.

We begin with a hodgepodge of keyboard combinations that you should know if you don’t already. These combinations cover several common tasks. Then we go over application-related shortcuts — the key combinations that you use to navigate among open applications and those that work within all applications. Finally, this technique covers the function keys and how to set your own keyboard shortcuts.

The Most Essential of the Essential Keyboard Shortcuts

This and the preceding technique present a cornucopia of useful and worthy keyboard shortcuts, but you might have difficulty memorizing them all. These, therefore, are the most important all-purpose shortcuts:

- Pressing Return is the same as clicking OK, Yes, Continue, or whatever the default action is for a button in a prompt (see Figure 10-1).

- Figure 10-1: Pressing Return is the same as clicking the highlighted button.
Pressing Esc is the same as clicking Cancel.
- Ô-A selects everything in the currently used directory or document.
- Ô-C copies the selected (or highlighted) text or image to the Clipboard.
- Ô-X copies the selected (or highlighted) text or image and stores it on the Clipboard and then deletes it from its current location.
- Ô-V pastes the current contents of the Clipboard into the current document, window, or other location.
- Ô-Z undoes the previous action, whatever it is.

Most people know that the Ô-Z trick works in applications to undo the last action, but it also functions in the Finder. You can use this short-cut to undelete a deleted (but not trashed) file or to unmove something. Pretty much whatever you just did can be undone with Ô-Z, with some exceptions.

- Ô-O opens anything (folders, files, volumes, or applications).
- Ô-F brings up the Find prompt (see Figure 10-2 for an example of a Find prompt; this one is from Safari) or a new search window in the Finder.

In the Finder preferences panel, you can use the New Finder Windows Open pop-up menu to set in which directory each new Finder window automatically opens (see Figure 10-3). Bring up this panel by choosing Preferences from the Finder menu and clicking the General tab.

- Ô-Delete sends an item to the Trash.
- Ô-Shift-Delete takes the Trash to the curb (which is to say, empties it).

Those are the most critical keyboard shortcuts, but here are a few more that are easy to remember and quite useful:
Technique 10: Essential Keyboard Shortcuts

- Ô-W closes the active window.
- Ô-Option-W closes every open window.
- Ô-M minimizes the active open window.
- Ô-Option-M minimizes every open window.
- Ô-P prints a document.
- Ô-I brings up the Get Info prompt, where you can find information about (as well as control) some of the properties of a file, a folder, or an application.
- Ô-J brings up a window’s (or the Desktop’s) view options.
- Ô-Shift-Q lets you log out.

You can often find most or all of the shortcuts available within a particular application, including the Finder, by searching with the word shortcut in that application’s Help pages. Alternatively, KeyCue (www.ergonis.com/products/keycue, $15) displays in a floating window every menu keyboard shortcut for the current application.

Most of the preceding shortcuts work in the Finder, and most of them also function within applications (particularly those by Apple). The following shortcuts are more particular to the Finder:

- Ô-D duplicates the currently selected item or items.

If you can’t or don’t want to remember that Ô-D duplicates items, you can always select the item, copy it by pressing Ô-C, and then create the duplicate by pasting the copied item with Ô-V.

- Ô-L makes an alias to the currently selected item or items. An alias (what Windows calls a shortcut) is a reference to an item. We cover these in Technique 17.

- Ô-R locates an original file that an alias or a pointer represents.

The Ô-R shortcut is most useful in two specific instances. In the Finder, if you select an alias, it takes you to the item that the alias points to. In iTunes, if you select a particular track, Ô-R takes you to the physical file on your computer.

- Ô-T adds the selected item to the window’s sidebar (see Technique 12 for more).
- Ô-E ejects the selected disk or disc. (This disc could be an external FireWire hard drive, a Zip or floppy disk, a CD-ROM or DVD, or a mounted disk image.)

When it comes to doing things on your Mac in the most convenient way, don’t forget Universal Access, a special set of accessibility tools for improving the standard Tiger interface. We cover this and similar concepts in Technique 7.

Application Shortcuts

Pretty much everything that you do on your Mac takes place within an application. (Technically, everything you do takes place within an application because the Finder is considered an app.) You’ll probably have several applications open at the same time. Although Part IV of this book really covers applications in all their glory, this section covers the highlights that should be second nature.

Technique 24 addresses application switching in greater detail, discussing several shareware applications that can be used expressly for this purpose, such as LiteSwitch X (www.proteron.com/litestitchx, $15). Technique 23 discusses the similar concept of launching applications, for which a slew of tools exists.

Here’s an easy way to switch applications:
1. Begin by holding down ⌘ and then pressing Tab to bring up a palette listing the currently open applications, with the most recently used application automatically selected (see Figure 10-4).

![](image)

- Figure 10-4: The list of currently running applications.

2. While holding down ⌘, press Tab repeatedly to move among the application icons until the desired application is selected.

   Press ⌘-Shift-Tab to go in reverse order.

3. Release ⌘ to bring up the selected application.

4. Press Escape to cancel the switch.

- Use ⌘-H to hide the current application.
- Use ⌘-Option-H to hide all the background applications.

5. Exposé, Tiger’s window management tool, creates special mouse and keyboard commands to access all the open windows for the current application or the whole operating system. Get thee over to Technique 15 to find out all about it.

6. Getting fancy with ⌘-Tab

Strange as it might seem, you can also use your mouse (or other input device) in conjunction with ⌘-Tab. After you bring up the palette, you can hover your cursor over an application’s icon to select it and then release the ⌘ key to travel there. You don’t even need to click the mouse for this to work.

This means that you can perform drag-and-drop actions with ⌘-Tab and your mouse or other input device:

1. In an open application, select the text, image, or whatever you want to copy elsewhere.
2. Click and hold the selection.
3. While continuing to hold your mouse click, drag the selection slightly off in any direction.
4. Press ⌘-Tab to bring up the open application’s palette.
5. Use either your cursor or Tab to select the destination application (while continuing to hold both the mouse button and the ⌘ key).
6. Release the ⌘ key to bring up the destination application.
7. Position your cursor in the appropriate location in the new application.
8. Release the mouse key to complete the move.

This process might seem foreign at first, but it’s remarkably effective and a good alternative to copying and pasting.
Function Keys

The purpose of the function keys changes dramatically based on whether you’re using a desktop or a laptop Mac. Desktop Macs don’t have overriding default function key purposes, although existing applications and Finder shortcuts use many of them.

If you have a laptop, you might need to hold down the fn key to use the function keys for other than their default purposes (such as changing the brightness or the volume).

If you have a laptop, familiarize yourself with using these default functions:

- F1 dims the display.
- F2 brightens the display.
- F3 mutes the sound.
- F4 lowers the sound volume.
- F5 increases the sound volume.
- F6 engages the number lock feature, turning the keypad into a number pad.

The function keys can perform other, lesser-known shortcuts. Holding down Option while pressing any of the brightness control keys brings up the Display System Preferences panel. Holding down the Option key while pressing any of the sound control keys brings up the System Preferences Sound panel.

You can change the behavior of function keys by using shareware (sweet, sweet shareware):

- uControl (http://gnufoo.org/ucontrol/ucontrol.html, free) lets you
  - Change the function (ha!) of your keys, including the function keys. (In other words, you can reprogram what a key does.)
  - Use Mac laptop function keys without holding down the fn key.

SimpleKeys ($15) is a more advanced version of uControl. Not only can you program the function keys, you can also execute AppleScripts or paste text with keyboard shortcuts.

Programming Your Own Keyboard Shortcuts

The Mac has supported programming the function keys in many ways over the years, but Tiger includes a utility that does even more. From the Keyboard Shortcuts pane, you can create your own keyboard shortcuts that call menu commands. These shortcuts can work in a particular application or in all of them. Here’s a primer on how to use it, making a keyboard shortcut for the Finder’s File ➪ Create Archive command.

1. Open System Preferences.
2. Click the Keyboard & Mouse icon (under Hardware).
3. In the Keyboard & Mouse pane, click the Keyboard Shortcuts tab to bring up that pane (see Figure 10-5).

Even if you never want to create your own keyboard shortcuts, the Keyboard Shortcuts pane is still great for reminding you of many of the existing shortcuts that you can use.

4. Click the plus sign in the lower-left corner to add a new shortcut.
5. In the sheet that appears (see Figure 10-6) do the following:
   a. Select what application you want the shortcut to apply to in the Application pop-up menu.
   b. In the Menu Title text box, enter the name of the menu command that you want to assign the shortcut to.
You must enter the name exactly as it appears in the menu except for replacing ellipsis (…) with a semicolon (;).

c. Immediately enter the keyboard shortcut by pressing the key combination.

6. Click Add, which becomes a clickable button after you've met all the criteria in Step 5.

7. After you log out and log back in or restart your computer, the new shortcut is available (see Figure 10-7).

Many applications have a system for creating your own shortcuts as well. For example, in Microsoft Word, you can create a macro and assign it to a keyboard shortcut.
Save Time By

- Setting the Finder preferences to fit the way you use your Mac
- Finding out about shortcuts for your mouse or other input device
- Getting the most out of the Finder’s various menus

The Mac OS X Finder is the most important and most used application on the Mac, yet many people don’t take advantage of its full potential. It is the main interface for you to access files, applications, CD-ROMs, and more. Being familiar with it and knowing how to customize its behavior to suit your tastes is critical to saving time on your Mac.

This technique begins with the Finder preferences that can be set within Tiger. Included after this section is a treatment of the Finder’s many menus. Then a number of input-device-related shortcuts are covered (the clicking equivalent of many of the keyboard shortcuts listed in the preceding two techniques).

Finder Preferences

Customizing the Finder involves using two tools: the Finder preferences panel and the Desktop’s View Options panel. (You can also customize the Finder windows themselves, which is an entirely different topic; see Technique 12.)

To bring up the Finder preferences panel, either

- Press `-, (comma).
- Click Finder on the menu bar and then choose Preferences.

To customize the Desktop, press `J or choose View ➤ Show View Options. We cover this topic in Technique 16.
The preferences panel (see Figure 11-1) is divided into four sections: General, Labels, Sidebar, and Advanced.

General

The General section has a few important controls:

- **Show These Items on the Desktop**: We recommend marking all these check boxes, which makes accessing these items and knowing what’s connected or mounted to your computer easier.

- **New Finder Windows Open**: Use this pop-up menu to determine what folder is the default folder when opening new windows. Setting this value saves you a navigational step (for example, hopping over to your Home directory) with each new window.

- **Always Open Folders in a New Window**: Selecting this check box is useful only if you really, really like having lots of open windows around.

- **Open New Windows in Column View**: Column view is the only view mode that can be set as the default view for new windows. If you like it, mark this box.

- **Spring-Loaded Folders and Windows**: Spring-loaded folders and windows pop open when you drag something onto them. If you start dragging a file and hold it over a folder, that folder springs open so that you can place the file within a sub-folder. You can even continue to spring open sub-folders, allowing you to place a file several directories into your hard drive without navigating there first.

Labels

After dropping off the radar in earlier versions of Mac OS X, Labels — the OS 9 color-coded decorating tool — has made a triumphant comeback. In fact, it’s better than ever. Labels allow you to mark items with a special highlight color, each color having its own particular meaning. To assign what the colors represent, do the following:

1. Open Finder’s preferences panel by pressing Ô, (comma).
2. Click the Labels button (see Figure 11-2).
• Figure 11-2: The Labels panel with its default values.

3. Highlight a color name and change the text to whatever label makes the most sense to you.

4. Tab to the next label and change that text.
   Repeat until a label name is set for each color.

5. Close the Finder’s preferences panel.

To use the Labels, follow these steps

1. Select the item or items in a Finder window.

2. Control-click the item to bring up the contextual menu (see Figure 11-3).

3. Under the Color Label heading on the contextual menu, click the appropriate color.
   When you click each color, the contextual menu shows the label associated with each color to make the selection easier and more accurate. (In Figure 11-4, the label reads “Urgent.”)

• Figure 11-3: Add a label to an item from its contextual menu.

In icon view mode, the item’s name is highlighted in the label color (see Figure 11-5). In list and column view mode, the entire line is highlighted. After you’ve begun using labels, you can add the Label column to the list view windows (see the section “Show View Options” later in this chapter for instructions) and then sort by this value (see Figure 11-6).

If you use numbers in your label names (for example, 1 Critical, 2 Important, down to 7 Low), you can easily sort a Finder window of items by label, and they sort in numeric order.
Finder Preferences

• Figure 11-4: When selecting a label color, the contextual menu shows the corresponding text label.

• Figure 11-5: Labeled items in icon view mode.

• Figure 11-6: Sorting by label in list view mode.

Sidebar

The Sidebar preferences panel (see Figure 11-7) affects which items appear in a window’s sidebar:

- The top half of the Sidebar preferences panel dictates what appears in the top half of the window sidebar.
- The bottom half controls whether three specific folders — the Desktop, your Home directory, or the Applications folder — appear in the bottom half of the window sidebar.

Enable or disable the items in the Sidebar preferences panel that you don’t need to use or access on a regular basis.

The Sidebar panel is the only place where you can customize the top half of the window’s sidebar. You can also customize the bottom half manually. See Technique 12 for more.

Advanced

The Advanced pane of the Finder preferences window has just two options in the current version of Tiger (see Figure 11-8). You can set the Finder to always show the file extensions if you’re most comfortable dealing with files in this manner. (Note: A file’s icon also implies its extension most of the time.) You can also set whether you see those pesky warnings when taking out the Trash.
Technique 11: A Faster Finder

• Figure 11-7: The Sidebar preferences panel.

• Figure 11-8: The Advanced section of the Finder’s preferences panel.

Changing themes

Another way to customize your Finder is to adjust what theme it uses. By default, the Finder uses the Aqua theme, which controls the appearance of windows, buttons, alerts, fonts, and more. (Basically everything that gives the operating system a consistent look from application to application is set in the theme.)

Changing your theme isn’t for the faint of heart (Apple generally discourages the practice) and, arguably, has a minor payoff. If you like to tinker, head over to www.resexcellence.com/themes to download different themes and find links to useful shareware. You’ll probably want one of the following:

- ShapeShifter (www.unsanity.com/haxies/shape shifter, $20), which lets you change themes in the least intrusive way possible.
- Duality 4.0 GT (http://carpestellarem.com/Products/Duality), which allows you to change the themes (they call them schemes). Duality is available in both free and professional (paid) versions.
- ThemeChanger (http://sourceforge.net/projects/themechanger), which also changes themes and is also free.

Show View Options

You can access the Finder’s second area of customization by either

- Choosing View ➪ Show View Options.
- Pressing ⌘-J.

The View Options settings apply to the currently active window, if one is open and active. If no window is open and active, the View Options panel applies to the Desktop.

When you apply the View Options to the Desktop (see Figure 11-9), you control only how items appear on the Desktop. (View Options can affect Finder windows more dramatically.) Here’s the two-second guide to what the options mean:
The first three settings — Icon Size, Text Size, and Label Position — do what you’d expect: They control how big an item’s icon is in pixels, adjust the point size for the item’s name, and position the item’s name either underneath or to the right of the item’s icon.

![The View Options panel for the Desktop.](image)

If your monitor is set at a high resolution (see Technique 8), you can increase the size of your icons and label text to accommodate this.

The final four check boxes in the View Options dialog affect how items are arranged on the Desktop and what information is revealed.

The most important of the four check boxes is Keep Arranged By, which allows you to maintain order in an otherwise chaotic universe (or Desktop). Mark this check box and use the drop-down menu to arrange your Desktop by Name, Date Modified, Date Created, Size, Kind, or Label.

If you select the Show Item Info check box, image sizes are displayed along with their names, and size of hard drives and discs (including remaining space) are listed below their names. The Show Icon Preview check box turns an image’s icon into a miniature representation of the actual image (in icon view only).

**Menus**

The Finder, like any other application, has a series of menus across the top of the display where you can access commonly used features. The Finder’s menus are located in two areas:

- In the upper-left corner are the standard menus (see Figure 11-10).
- In the upper-right corner are extra and third-party menus (see Figure 11-11).

![The standard Finder menus.](image)

To rearrange or remove an item from the right side of the menu bar, hold down ⌘ while clicking the icon. Then you can either drag the item off to remove it (it disappears in a cloud of smoke) or drag it side to side to move it (the other icons move out of its way).
The standard menus include

✔ **Apple:** The Apple menu () is the catch-all for Tiger. Including system tools such as Software Update and System Preferences, it allows you to change the Dock settings and your network location, and it also lists the most recently used items. The bottom half of the Apple menu is for force-quitting applications, shutting down, restarting, putting your Mac to sleep, and logging out. (Read more on some of these in Technique 5.)

✔ **Finder:** The Finder menu gives you access to its preferences panel (see earlier in this technique), controls the showing and hiding of applications, and links to Services (see Technique 29).

✔ **File:** The File menu is for basic file-management stuff (such as opening and closing) and includes most of the often-used commands and keyboard shortcuts.

✔ **Edit:** The Edit menu, like any application’s Edit menu, gives you access to editing shortcuts, the keyboard equivalents of which should be second nature to any power user. Two interesting features here show you the contents of the Clipboard (useful if you forget what you copied there) and bring up the Character Palette to access special characters.

✔ **View:** The View menu is mostly useful with respect to windows (see Technique 12). Most of the options are grayed out (unusable) unless you’re in a Finder window. The remaining choices affect the Desktop.

The View menu lets you customize a selected Finder window or the Desktop. Conversely, the Window menu lets you control windows: You can switch among open windows, minimize a window, and bring all windows to focus.

✔ **Go:** The Go menu is a nice little navigational tool, giving you links and the keyboard equivalents for quickly accessing common places. We prefer the keyboard shortcuts ourselves, but the menu option is handy to have, and you can find the keyboard shortcuts listed there as a reminder.

✔ **Window:** The Window menu controls the open Finder windows (much like an application’s Window menu gives you access to the open documents in that application). Although it does give you an easy way to handle the mess of multiple windows, you might find Exposé to be an easier solution.

✔ **Help:** Need help? Use this menu to bring up the Help Viewer application.

The right side menu area is a more flexible place; what’s there depends on what you’ve enabled. For example:

✔ The Fast User Switching menu appears here if Fast User Switching is enabled under Accounts.

✔ The system clock reveals itself if you have it set to do so in the Date & Time control panel.

✔ The display menu makes an appearance if you have it set to do so in the Displays panel.

✔ The volume control appears here if you have it set to do so in the Sound panel.

✔ The Keyboard Menu shows up if you’ve set it to do so under System Preferences ➪ International ➪ Input Menu.

✔ Laptops show their battery status here if you’ve set it to do so in the Energy Saver panel.

Furthermore, extensions and applications add menus here.

Many freeware and shareware applications exist to modify or otherwise add to the menu bar. A quick sample includes the ever popular TinkerTool (www.bresink.de/osx/tinkertool.html, free), wClock (www.wolfware.com/wclock.html, free), FruitMenu (www.unsanity.com/haxies/fruitmenu, $10), and Classic Menu (www.sigsoftware.com/classicmenu, $10).
AppleScript’s Script Menu

AppleScript is a powerful automating tool that has been part of the Mac operating system for years. It’s so easy to work with that even nonprogrammers can grasp its concepts, and yet potent enough that seasoned programmers will be pleased. Not only does Tiger come with literally dozens of prebuilt AppleScripts, but it even comes with a tool for easily accessing them: Script Menu.

To enable Script Menu and add a menu icon for it:

1. In the Finder, navigate to Applications ➪ AppleScript.
2. Double-click the AppleScript Utility icon to open it.
3. Select the Show Script Menu check box in menu bar to enable the AppleScript menu.
4. Click the new AppleScript logo located on the right side of the Finder menu.

5. Browse through the folders of scripts and select any script to run.

You can also download and install other scripts created by Apple:

2. Download any of the extra scripts available there.
3. Open the downloaded archive(s).
4. From the AppleScript menu, select Open Scripts Folder and then choose one of the subfolders from this menu (see the figure).
5. Drop the downloaded scripts into the Scripts folder window that was opened in Step 4.

The new scripts will be available at the bottom of the Script Menu. Depending upon which option you took in Step 4 (affecting which folder was opened), the new script will be available just within a specific application, just for you, or for all users on the Mac.

Using Your Input Device

Your input device, be it a trackpad, mouse, trackball, or graphic tablet, has some pretty impressive power. Using input devices with the Finder automatically brings with it a slew of useful timesaving techniques, much like the keyboard shortcuts that the previous two chapters highlight.
Here are some basic mouse moves that any Mac maven must memorize:

- Click any item to select it.
- Click and drag to select multiple items.
- Double-click any file to open it in its default application.
- Double-click any folder to open it.
- Double-click any application’s icon to launch it.
- Click and hold a Dock icon to bring up a menu.
- Double-click a window’s title bar to minimize it.
- Drag an item over a folder or volume to make it pop open (assuming that you have the spring-loaded feature enabled under General preferences).

You can accomplish even more with your mouse by clicking in combination with various modifier keys, such as Control or Option:

- Control-click any item to open its contextual menu.
- Control-click a Dock icon to bring up its menu.
- Ô-Option-click a Dock icon to switch to that application and hide every other window.
Customizing Windows for Your Convenience

The Finder window is the basic currency of the operating system. You use the Finder to access applications and files, move items around, organize your data, and much, much more. Hence, customizing your Finder windows is crucial to more productively using your Mac.

In this technique, we start by covering the three view modes that you can use in your Finder windows: icon, list, and column, each of which has its own benefits. Then we show you how to customize the window’s appearance and features. We conclude with how to navigate among multiple open windows.

Understanding the View Modes

The Finder’s window can display the items in a folder in three view modes: icon, list, and column. Each has its own benefits (and keyboard shortcuts, see Technique 10), so take some time to figure out which view mode works best under what circumstances. This is mostly a matter of taste, but certain principles can help you make the best decision.

To switch among the view modes, use ⌘-1 for icon, ⌘-2 for list, and ⌘-3 for column. If you have trouble remembering these shortcuts, they correlate to the order of the icons in the window’s toolbar, from left to right (as shown in Figure 12-1).

Save Time By

- Determining which view mode to use
- Customizing the windows
- Navigating among open windows

Figure 12-1: Click the icons to change view modes or use the keyboard shortcuts.
Icon view

Icon view is familiar territory for almost everyone and is often the default view mode for mounted CD-ROMs and disk images. Icon view (see Figure 12-2) is best when you’re dealing with a directory containing only a few items or if you just prefer the look and feel of icons. Selecting a group of items (by using the mouse to click and drag) can be an easy and natural task in icon view.

Figure 12-2: A directory displayed in icon view mode.

Icon view is limiting if you’re dealing with a directory containing lots of items or if you’ll be running through multiple subfolders.

If you’re viewing a directory of images, turn on Show Icon Preview in the View Options panel and then use icon view. This displays thumbnails of the window’s contents. (After you’ve selected a window, press Ô-J or choose View ➪ Show View Options in the Finder.)

If Snap to Grid is enabled (meaning that icons are arranged along imaginary grid lines instead of free-form), icon view shows a small grid icon in the lower-left corner of the window (refer to Figure 12-2).

Setting backgrounds in icon view

Icon view mode is the only mode that allows you to customize the background of the window. Although this feature might seem like nothing more than eye candy (and it certainly can be), it has its advantages. The best way to use the background is to set a different background color or image for different folders. That way, when you minimize them, you can more easily know which window is which by looking at the window’s icon in the Dock.

This allows you to distinguish between them more easily. To set a background:

1. Open the window in question.
2. Bring up the View Options panel by pressing Ô-J or by choosing View ➪ Show View Options in the Finder.
3. Within the View Options panel, select the This Window Only radio button (at the top) so that the changes affect only this window.
4. At the bottom of the window, select either the Color or the Picture radio button.
5a. If you select Color in Step 4:
   a. Click the color block that appears next to the word Color to bring up the Colors palette.
   b. Click the color that you want to use.
   c. Click OK.

You see the window’s background change colors, as in this figure.
Understanding the View Modes

1. Press Ô-J to bring up the View Options (see Figure 12-4).

   - Figure 12-4: View Options displays different choices based on the current view mode.

2. Use the radio buttons at the top to make these options apply to this window only or to all windows.

   - To create a default window setting for all your windows, select All Windows in the View Options dialog before customizing the settings.

3. Set the icon and text sizes.

   The icon and text sizes can be increased to make up for a high monitor resolution, or these can both be reduced to make list view windows show more in a smaller space.

List view

List view is an easy-to-use-and-understand format for pretty much any user. It has two primary advantages:

- Items are displayed as a sortable list.
- Multiple item details are displayed simultaneously (see Figure 12-3).

Because of these considerations, list view is the obvious choice if you need to sort a folder’s contents or view any information (such as size, modification date, kind, creation date, and label). Also, if you need to compare contents of subfolders, list view is great because you can show multiple subfolders within the one window by expanding them. This means that you can also select items from multiple subfolders in the list view.

To get the most out of list view, you must know how to customize and use the column headings. In an open window:

- Figure 12-3: The same directory from Figure 12-2, now in list view mode.

5b. If you select Picture in Step 4:
   a. Click the Select button that appears next to the word Picture to bring up the Select a Picture dialog.
   b. Use the Select a Picture dialog to navigate to the desired picture.
   c. Click Select to close the dialog.

6. Press Ô-J to close the View Options panel (or click the little red circle in the upper-left corner).
4. Select which columns you want list view to show.

See the guidelines that follow this step list for more information.

5. Press Ô-J to close the View Options dialog (or click the little red circle in the upper-left corner).

Here are some good rules for what you might want to include in list view:

- **Date Modified:** The Date Modified option is most useful for sorting your windows by modification date. Doing so brings the most recently altered file to the top.

- **Date Created:** The Date Created option is slightly less useful than the Date Modified option but works the same way.

- **Size:** The Size value is quite handy, particularly if you’re looking for small (such as text documents) or large (like Photoshop files) items. This column can also be used to help you distinguish between multiple versions of the same file.

Sizes aren’t calculated for folders unless the Calculate All Sizes check box is enabled in the View Options panel. Keep in mind that large directories take some time to calculate, so those values don’t immediately appear in a window.

- **Kind:** The Kind attribute of the list view is rarely illuminating. The information that it lists (for example, Folder, Microsoft Word document, TIFF document) can normally be ascertained by the item’s name and icon. It does, however, allow you to sort by the file’s type.

- **Version:** Frankly, we haven’t turned on a window’s Version option in years. We can’t imagine why you would, either.

- **Comments:** Listing an item’s Comments is very, very useful — if you use comments, that is. If you don’t (like most users), leave it deselected. You might use comments to note a text file’s contents or information about an image.

You can add comments to any item by opening Get Info using the Ô-I keyboard shortcut or the File menu’s Get Info choice.

- **Label:** Viewing the Labels, like Comments, is great if you use them. See Technique 11 for information on using Labels to your advantage.

After you establish what columns to use, you should understand these facts:

- The default view is to sort the items by name in ascending order.

You can control the sorting of your files by adding special characters to a file’s name. Filenames that begin with a space always come first; filenames that begin with symbols always go last. Just don’t start a filename with a period; it will become hidden if you do.

- Click any column heading to sort the list view contents by that column in ascending order. Click the same column again to sort the contents in descending (reverse) order.

- You can rearrange the columns by dragging them, except for the Name column, which is always in view and is always listed first.

The quickest way to see a long filename (which can be cut off in list and column view modes) is to hover the cursor over the filename. After a brief moment, the file’s full name appears. To make it appear immediately, hold down the Option key while you hover the cursor above the file (see Figure 12-5).
Customizing Windows

Column view

Column view mode is unique:

- It shows a list of a folder’s contents, like the list view, but without any extra details.
- Column view opens subfolders in columns.
  (Opening a folder moves you one column to the right; closing a folder moves you one column to the left.)

For these reasons, column view mode is the fastest for quickly navigating through multiple directories. You can even set the Finder to use column view mode by default by enabling the appropriate check box in the Finder preferences panel.

To save space in column view mode, disable Show Icons in the View Options panel.

The trick to using column view mode is knowing how to change the column sizes. By adjusting the size, you can fit more columns on the screen or show more of an item’s name. Here are some tips:

- Click and drag the bottom-right corner of a window to expand it.
- Click and drag the two vertical lines separating columns to adjust one column’s width. The column to the left of the vertical lines is resized.
- To adjust every column’s width, hold down the Option key while clicking and dragging any two vertical lines.

One of the best benefits of column view is that it previews different file types for you. You can use it to view images, listen to sounds, and play movies, as shown in Figure 12-6. You can enable or disable this feature by using the View Options panel.

Scrolling through columns

Many mice and trackballs these days include a scroll wheel. If you have one and use it, you’re probably aware that you can use it to move up and down within documents, Web pages, even Finder windows. What many people aren’t aware of is that by pressing the Shift key while scrolling, the movement goes from being vertical to being horizontal. Scrolling horizontally through the column view windows can be the fastest way to access deeply nested folders.

Customizing Windows

Aside from choosing which view mode you use, you can customize the Finder’s windows in many other ways. The view modes themselves customize the window’s content area, but you can also customize the toolbar along the top, the Sidebar along the side (appropriately enough), and even tinker with how the scroll bars appear and function for larger windows.
Technique 12: Customizing Windows for Your Convenience

Toolbar

The toolbar along the top of the window has been around and customizable for a while now. Panther added to it by adding the Action pop-up (which is just another way to access contextual menus, see Technique 14) and the Search box, both of which are still present. To customize the toolbar:

1. Control-click the toolbar (see Figure 12-7).

2. Select Customize Toolbar from the contextual menu that appears.

This is the equivalent of selecting Customize Toolbar from the View menu in the Finder. A Customize Toolbar sheet appears.

3. Add items to the toolbar by dragging them from the sheet to their desired location on the toolbar (see Figure 12-8).

4. Remove items from the toolbar by dragging them off the window.

5. Use the pop-up menu and check box at the bottom of the window to dictate
   - How much information should be shown in the toolbar (Icon & Text, Icon Only, or Text Only).
   - Whether it should be in small size.

The best way to customize the toolbar depends on how you use it:

- Some options — Get Info, iDisk, Connect, and Customize — are rarely used and can be omitted.
- Burn and Eject are also options in the Sidebar if you have volumes mounted there.
- Almost all the icons have keyboard equivalents or can be re-created by Control-clicking.

Here are some other toolbar tips and shortcuts to be aware of:

- If your window becomes too small to show all the toolbar features, double arrows appear. Click them to see the hidden options (see Figure 12-9).
- Click the oval button in the upper-right corner of the toolbar to switch between a fancy Tiger window and a plain version. Strangely enough, you can also use Shift-click, Control-click, or Option-click to do the same thing.
Customizing Windows

Figure 12-9: The double arrows create a menu of hidden toolbar options.

- Ô-clicking the oval button toggles among very subtly different versions of the window.
- You can also access the Path by Ô-clicking the window’s name in the title bar. A folder’s path indicates where the folder is on the hard drive, like /Users/larry/Desktop/Stuff.

Ô-clicking the window’s name is a good trick to remember. Many other applications also use this technique to show you the file path (BBEdit) or your browser’s history (Safari).

- Hold down the Ô key while clicking and dragging to move or remove toolbar items without using the Customize Toolbar panel.
- Drag any icon from the Desktop or a Finder window to add it to the toolbar.
- Control-click the toolbar to switch view modes. Control-click a toolbar icon or tool to remove it — or just Ô-drag it off.

You can add a Delete button to the toolbar so that you can delete a file by selecting it and then clicking Delete. You can also trash a file by dropping it on the toolbar’s Delete button.

Sidebar

The Sidebar (see Figure 12-10) contains two separate parts. The top section lists major resources, such as volumes, mounted disk images, and discs. This can be customized under the Sidebar panel of the Finder’s preferences panel. Anything listed in the Sidebar can be accessed with a single mouse click. (These items don’t need to be opened with a double click.)

- Figure 12-10: The side panel on the left of the window is new to Panther and is customizable.

Resize the Sidebar width by clicking and dragging the dividing line between it and the window’s contents. If you make the sidebar really small, you can see only the icons, but you can see each item’s full name by hovering the mouse over the icon.
Here are some things that you can do in the top part of the Sidebar:

- Easily access any hard drive.
- Access your iDisk without formally connecting to it. (We cover iDisk in Technique 42.)
- View mounted disk images and discs without going to the Desktop.
- Eject mounted disk images and discs.
- Burn CD-Rs and DVD-Rs.
- See what servers you’re currently connected to.

**Using the window’s icon to move folders**

In the title bar of a window, the folder icon that appears next to the window’s name is the listed folder’s icon (also called the proxy icon). Therefore, this icon is the same as the icon for the directory that you would find in its parent folder. By clicking and holding the window’s icon, you can move this entire directory around without going up one folder. For example:

1. **Open two different folders in two different windows in the Finder.**
2. **Click and hold the title bar icon of the folder that you want to move.**
   
   You need to click and hold for just a second to get the system to engage.
3. **Drag this icon into the other window.**
4. **Release the mouse button.**

You now see the first window as a subdirectory in the second. However, the first window is still open; only its location has changed.

Proxy icons are also in other applications (for example, Word documents have an icon next to the document’s name) and are a useful concept to familiarize yourself with. You can find other examples in this book where using the proxy icon might be the easiest way to move a document (such as attaching a file to an e-mail).

The contents of the Sidebar also appear in Open/Save dialogs, thus saving you time navigating around the computer.

The bottom section of the Sidebar is partially customizable from the Finder’s preferences panel. This area should be used to access frequently used directories, such as

- The Desktop
- Your Home folder
- The Applications folder
- Your Documents folder

Select any object and press Ô-T to instantly add it to your Sidebar. Similarly, you can drag an item to the Sidebar to add it or drag it off to remove it. Sidebar items can also be rearranged by clicking and dragging them.

The Ô-T shortcut used to add an item to your Favorites directory but now adds items to the Sidebar. There is no longer a shortcut to add items to the Favorites directory.

**Scroll bars**

Scroll bars appear on the right side and/or bottom of the window when the window is too small to display every item. These settings are adjusted in the Appearance panel of System Preferences (see Figure 12-11). You can customize the scroll arrows to appear like the following:

- Figure 12-11: Part of the Appearance panel also controls the Finder window scroll bars.
Separate, at the top and bottom of the window
Together at the bottom of the window

While you’re at it, you can tweak how clicking in the scroll bar area affects the window or document. Select one of the following radio buttons:

- **Jump to the Next Page**: Moves a page at a time.
- **Jump to Here**: Moves to a particular location.

Both of these settings are more for personal taste than anything, but you should understand what you’re getting when you make your selections. (For the record, we tend to keep our scroll bars together and set clicking in the scroll bar to move one page at a time.)

If you install the free TinkerTool (see Technique 54), you have even more scroll bar options, including having both together at the top and bottom of the window.

The last two settings that you can enable are

- **Smooth scrolling**: It makes your scrolling look pretty, but it really drags down your Mac’s performance. Turn off smooth scrolling for a faster window response.
- **Double-clicking windows to minimize them**: It’s handy, but you can also minimize a window by either
  - Single-clicking the yellow button
  - Using Ô-M

**Moving Windows Around**

Despite the fact that Exposé (see Technique 15) has greatly facilitated moving about open windows, plenty of other tips and tricks are still left to be discovered. Window management is critical to using the operating system efficiently, particularly if you open every folder in a new window. Here are the best tips:

- Finder windows use three standard buttons in the upper-left corner. They are color-coordinated to represent what they do: red (close), yellow (minimize), and green (zoom).
- Option-click the yellow button to minimize every open window.
- Option-click the red button to close every open window.
- If you place the mouse cursor over an inactive window’s buttons, they light up, allowing you to close, minimize, or zoom a window without it being in front (and therefore active).
- You can move background (non-active) windows by holding down the Ô key and clicking them with the mouse.
- Double-click the toolbar to minimize a window, if enabled.
- The Appearance panel allows you to turn on the window-minimizing feature when double-clicking the window’s title bar or toolbar.
- You can directly access any particular window by clicking Window on the menu bar and selecting from the list of windows.
- The shortcut Ô-~ scrolls you forward through the open windows. Ô-Shift-~ rotates you backward.
- Minimized windows are stored in the right side of the Dock.
- By placing your cursor over a window’s Dock icon, you can see the name of the window (see Figure 12-12).

* Figure 12-12: A window’s title reveals itself when you hover over its icon in the Dock.
The Dock, that curious little bar at the bottom of your screen, is such a particular aspect of your operating system that it merits its own technique. A new concept to Mac OS X, the Dock has been much maligned in its various incarnations, but we feel that with the right treatment, the Dock can be an important ally in the war for productivity.

We begin this technique with a discussion on customizing and organizing the Dock, with the focus on making it as useful as possible. Then we demonstrate the myriad ways that mouse and keyboard shortcuts can be used to work with the Dock more efficiently. Finally, we introduce a couple of the more popular shareware applications that add to or mimic the Dock’s purpose and behavior.

**Customizing the Dock**

The Dock is like a pet: You need to take care of it. Okay, it’s really nothing like a pet, but you should still spend a bit of time doing two things: customizing its behavior and organizing its contents and layout. You can customize the Dock’s behavior from the Dock pane of System Preferences (see Figure 13-1).

**Figure 13-1:** Use the Dock System Preferences pane to set the Dock’s behavior.
Customizing the Dock

You can adjust much of the Dock's behavior from the Dock submenu of the Apple Menu (see Figure 13-2). It gives you immediate access to the Dock preferences panel without forcing you to navigate through System Preferences.

- **Figure 13-2:** The Dock submenu is located under the Apple menu.

You can adjust the following Dock properties, some of which are just cosmetic and some of which are actually useful:

- **Size**
- **Magnification** (whether it's on and how potent it is)
- **Position on the screen** (left, bottom, or right)
- **The effect used when windows and documents are minimized into the Dock** (Genie and Scale are your choices)
- **Whether opening applications are animated**
- **Whether the Dock automatically hides and shows itself**

The size, position, and hiding features of the Dock all directly relate to how you interact with your computer — and therefore, can have an effect on your productivity. That being said, how you set them is largely a matter of taste. Here are some general suggestions:

- Automatically hiding and showing the Dock is a good way to keep your screen clear if you have a smaller monitor (15 inches or less) or a laptop.

- Placing the Dock on the side makes more sense if you have a widescreen display (where you have more screen space on the sides than you do on the top and bottom).

- If you use the Desktop a lot and have folders, volumes, and other icons automatically arranged (meaning that they're located on the right side of the screen), don't put the Dock on the right, or it'll always be in the way.

- Adjust the size of the Dock so that it's as small as reasonable while still allowing you to read it.

The Dock's size automatically shrinks if the number of items in the Dock makes it too large to fit on-screen. In System Preferences, you can also make the Dock really small, but use magnification to see the items more clearly (see Figure 13-3).

- **Figure 13-3:** Magnification increases an icon's size as your mouse goes over it.

The minimizing effect, the animation of opening applications, and (to a lesser degree) the magnification are cosmetic. Turn them on to impress or annoy your friends; turn them off if you think it'll make things happen faster (though it really won't).

The TinkerTool freeware application ([www.bresink.de/osx/TinkerTool.html](http://www.bresink.de/osx/TinkerTool.html)) lets you customize your Dock in other ways. This includes positioning the Dock at the top of the screen, adjusting the alignment (left/top, center, right/bottom), making the Dock icons for hidden applications transparent, and adding a Dock shadow. It also adds a “Suck In” minimize effect for people who appreciate eye candy.
**Organizing the Dock**

The Dock is divided into two sections: the left side (where applications live) and the right side (where you can find documents, folders, and the Trash). The two sides are divided by a separator bar (a vertical line that runs the height of the Dock).

- To add any item to the Dock, drag its icon there.
- To remove any item (except the Finder and the Trash, which are permanent), drag its icon off the Dock.

The Dock always shows every icon that you add to it as well as other currently running applications (which are marked with an upward-pointing black triangle; refer to Figure 13-3).

**Technique 2** shows you a trick for making the System Preferences panels more accessible: just add the System Preferences to your Login Items. Then you can Control-click the System Preferences Dock icon to access an individual control.

To organize your Dock:

1. **Remove any of the default icons that you won’t regularly use; just click and drag them off the Dock.**

   Apple likes to give you immediate access to every Apple application that comes installed on your Mac, so your Dock has iMovie, iPhoto, iCal, Mail, and the Address Book by default. If you don’t frequently use some of these (like iMovie), drag the icon off the Dock to make it disappear in a puff of smoke.

   You can’t remove two particular Dock icons: the Finder, which is always on the far left (or the top, if the Dock is on the side); and the Trash, which is always on the far right (or bottom).

2. **Add every application that you use on a daily basis to the left side of the Dock by dragging their icons from the Finder onto the Dock.**

   Icons placed in the center of the Dock are the most stable because they’re less affected by the expansion and contraction of the Dock. As your Dock grows, applications found near the center of your Dock stay near the center of your screen. Conversely, items on the ends of the Dock move closer and closer to the end of the screen, making them slightly harder to get to.

3. **Add frequently accessed folders to the right side of the Dock by dragging their icons from the Finder onto the Dock.**

   We recommend putting your Favorites folder (which links applications and files that you use less frequently), your Home folder, and perhaps your Documents folder on the right side of the Dock. You should also consider dragging the folders for your current projects and documents there. If you want, add the Desktop folder there to immediately access Desktop items.

   Use customized icons for your Dock folders (before adding them to the Dock) to help you find a desired folder among multiple folders stored there. See Technique 17 for instructions and resources.

4. **Organize your applications so that those used in conjunction are placed together.**

   For example, if you regularly use multiple Web browsers, place these next to each other. If you use BBEdit (a text editor) with Fetch or Transmit (FTP applications), line them up.

**Keyboard and Mouse Shortcuts for the Dock**

To get the most out of the Dock, you must be able to customize it properly and also use it with ease. This comes down to understanding the various keyboard and mouse shortcuts that you can use to perform common tasks.

With your mouse (or other input device), here are the basics that you should know:
Click any application’s icon to bring that application to the front.

Click any folder’s icon to show that folder in a Finder window.

Click the Trash icon to see what’s in the garbage.

**Hierarchical pop-up menus in the Dock**

Clicking an icon in the Dock takes you to that application, but clicking folders in the Dock can give you different behavior. Both of these features are quite useful and an easy way to access your documents:

- When you click a folder’s icon, that directory is opened in a new Finder window.
- When you Control-click or click and hold a folder’s icon, a hierarchical menu is created of the folder’s contents, as shown in the following figure.

This method allows you to navigate directly to a subfolder or document buried deep inside — the hierarchy of folders is revealed while you navigate. In previous versions of Mac OS X, you were limited to only a handful of submenus, but now you can literally fill your screen up with menus to reach the file that you want, as shown in the following figure.

- Click a Dock item to make that item active, open it if it isn’t already open, and reshow minimized documents or windows.
- Click and hold a Dock icon to bring up its contextual menu (or a hierarchical menu for a folder).

- Use the contextual menu to quit, hide, and go to the item’s location in the Finder.
- Check the contextual menus for different applications to see what options they provide.

For example, the Mail application gives you the option to check your e-mail (see Figure 13-4). Many others, such as BBEdit or Safari, allow you to preselect which open document (in that application) you want to view (see Figure 13-5).

- Figure 13-4: The Mail contextual menu in the Dock.

- Figure 13-5: The Safari contextual menu in the Dock shows open Web pages.

- Click and drag the Dock’s separator up and down to adjust the Dock’s size.
- You can eject disk images, CDs, DVDs, floppy disks, Zip disks, and external hard drives by dragging their icons onto the Trash icon, which turns into an Eject button.
Technique 13: Establishing an Efficient Dock

When using only the keyboard, you’re fairly limited by what you can do with the Dock, but to start

1. Make sure that Full Keyboard Access is turned on for All controls in the Keyboard & Mouse panel of System Preferences (under Keyboard Shortcuts).

2. Press Control-F3 to access the Dock (see Figure 13-6).

To empty the Trash by using the Dock and your mouse, click and hold (or Control-click) the Dock’s Trash icon and then choose Empty Trash from the menu that appears.

- Option-click a Dock icon to hide all the other applications.
- Option-Control-click to change the contextual menu’s Quit option to Force Quit.

Laptops might need fn-Control-F3 to access the Dock.

3. Use the arrow keys to move left and right (you can also Tab and Shift-Tab).

4. After an item is highlighted, press the spacebar to make it active.

5. Use the up- or down-arrow keys to launch the contextual menu for that item (see Figure 13-7).

6. Press Return to select an option highlighted in the contextual menu.

7. Press Esc at any time to leave the Dock.

Another keyboard shortcut to remember is pressing Ô-Option-D to show or hide the Dock.

What you can do with the mouse — or the mouse and keyboard together — is much more impressive:

- Control-click a Dock icon to bring up its contextual menu. You can also just click and hold to see it.
- Option-Control-click to change the contextual menu’s Quit option to Force Quit.

8. Press Esc at any time to leave the Dock.

- Option-Command-D to show or hide the Dock.

You can also control many of the Dock’s settings by using your input device and the modifier keys. For starters:

- Control-click the Dock separator (the line between the left and right sides of the Dock) to access the Dock’s preferences (see Figure 13-8).

- Press Option-click while dragging the Dock separator to change the Dock’s size to standard icon sizes.

- Pressing Ô-Shift-click while dragging the Dock’s separator bar left and right allows you to move the Dock around the screen (from left to bottom to right).
You can adjust the Dock’s preferences from the Dock’s contextual menu.

An application’s contextual menu allows you to add the item to the Dock. You can also accomplish this by moving a Dock icon, which makes it a permanent addition.

You can open a file by dragging it onto an application’s icon in the Dock. The problem is that the Dock might mistake your intentions and frequently move the application icon out of the way so that the file can be added to the Dock. To make the Dock behave itself, hold down the % key when dragging the file. To force an application to attempt to open a file, use %-Option while you’re dragging the file onto the Dock icon.

Shareware for the Dock

After you get the hang of the Dock, investigate some of the shareware applications that either add to its functionality or otherwise duplicate its utility.

The following programs provide you with multiple Docks. They either create separately accessible Docks or one tabbed Dock (one Dock with multiple subpanels, each of which can contain its own items):

- **DragThing** ([www.dragthing.com](http://www.dragthing.com), $25) is a very popular application and consistently reviewed well by Mac users.

- **Drop Drawers** ([www.sigsoftware.com/dropdrawers](http://www.sigsoftware.com/dropdrawers), $20) has an extra emphasis on storing stuff (text, images, and the like) in a Dock drawer.

- **DockSwap** ([www.pidog.com/OSX](http://www.pidog.com/OSX), $12 suggested) allows you to have multiple Docks, switching easily among them.

Launcher programs can quickly bring up applications, Web pages, and contextual menus. These can be a dockling, pop-up menu, or menu bar extension:

- **Snard** ([www.gideonsoftworks.com/snard.html](http://www.gideonsoftworks.com/snard.html), $10) is a pop-up menu that gives you quick access to just about anything on your Mac. It’s a very unique utility, releasing you from the confines of a Dock-centric world.

- **DockExtender** ([www.codetek.com/dockextender](http://www.codetek.com/dockextender), $20) is highly customizable, taking the functionality of the Dock to universally-accessible pop-up menus.

*A dockling* is a special type of application that resides in the Dock and adds extra functionality to your computer. Unlike other Dock items, you never really use it as a standalone application.

- **ClearDock** ([http://unsanity.com/products/free](http://unsanity.com/products/free), free) by Unsanity lets you customize the Dock on a more aesthetic level. You can
  - Entirely get rid of the Dock’s background (letting your Desktop show through).
  - Change the color of the triangles that appear below open applications.

- **A-Dock X** ([http://jerome.foucher.free.fr/ ADockX/ADockX.html](http://jerome.foucher.free.fr/ ADockX/ADockX.html), $10) provides both functional and cosmetic alterations to the Dock. With it you can use different themes for your Docks or alternative Trash icons (there are more features, too, but we like the occasional eye-candy).
Contextual menus have been part of the Macintosh operating system for several incarnations now, yet many Mac owners underuse them or don’t use them at all. Contextual menus provide an immediate listing of options; usually frequently performed tasks such as invoking Get Info, changing a label, or making a copy. Although contextual menus exist in both applications and the Finder, they differ greatly across applications. Therefore, this technique specifically addresses the Finder’s contextual menus (often abbreviated as just CMs).

First, we cover a smattering of the basics about contextual menus. Then we cover, in greater detail, some of the specific contextual menu items that you can add to your system. These include many common third-party and shareware applications. Finally, you see how AppleScripts, oh-so-wonderful AppleScripts, can be called by using CMs.

**Grasping the Basics of Contextual Menus**

When you Control-click an item, whether it’s a window, the Desktop, or an icon, a contextual menu appears, listing the things that you can do with that item. Different objects in your system offer different options. For example, here are the CMs for a folder (Figure 14-1), a file (Figure 14-2), and a window. (A window’s CM can be accessed by clicking on its background, as shown in Figure 14-3.)

If you use contextual menus a lot — and you really should — and you have a programmable input device (such as a trackball or mouse), you must program one of the buttons to act as a Control-click. Doing so saves countless hours because you can access common features more easily. In fact, most two-button mice treat the right button as Control-click by default.
The Help and Get Info options are common to all three of the listed CM examples. A window has the fewest number of options, by default, whereas files generally give you the most. Some common uses of the contextual menu include:

- Creating a new folder within a directory, in case you get tripped up with the Ô-Shift-N shortcut.
- Adding, deleting, or changing the Label.
- Sending the selected item to the Trash.
- Opening a file with a specific application (see Technique 25).
- Archiving an item.
- Duplicating or just copying the item.
- Creating an alias.

If you want to know what CM options are available to you in any application, including the Finder, Control-click to investigate. Get in the habit of Control-clicking within windows, on icons, on the toolbar of windows, and on Dock icons.
Items in the Dock and the Dock itself have their own contextual menus. To see a menu, Control-click a Dock icon or Control-click the Dock. (The menu differs depending on whether you click the Dock separator or in a blank area.)

**Opening your packages**

If you’re a techie user, a contextual menu allows you to view the contents of *packages* (special bundles of information presented as one cohesive item). These are used frequently in Mac OS X, but you can view a package’s contents only in the Terminal unless you use the Show Package Contents CM.

1. **Control-click a file with the** .pkg **extension to bring up the file’s contextual menu.**
2. **Choose Show Package Contents from the CM.**
3. **A window of the package’s contents appears. In it, you commonly find**
   - Two text (XML) files that store version and other information about the package
   - An archive file
   - A resources directory

These files can then be examined, copied, or (if you know what you’re doing) modified. This concept isn’t unlike using a resource editor like ResEdit back in earlier versions of Mac OS.

As you explore this concept, you’ll notice that the /Library/Receipts folder tracks what was installed by creating packages. Also, many installers come in a package form. Even most of Tiger’s default applications, like Mail, are packages whose contents can be viewed.

**Using CMs with Third-Party Applications**

Many third-party applications, including commercial apps, shareware, and freeware, take advantage of Tiger’s contextual menus. Here are a few of the best:

- **Rainer Brockerhoff** (www.brockerhoff.net) provides, for free, a useful contextual menu application called Zingg!. It replicates Tiger’s Open With functionality that allows you to open a file with an application other than the default application. It takes this principle a small step further by allowing you to
  - Set applications, such as Preview, Photoshop, or BBEdit, to always appear
  - Prevent selected applications from ever appearing as an option
  - Disable Classic applications as an option if Classic isn’t open

- **The DesktopPictureCM tool** from Azine Software (www.azinesoftware.com/other.php, free) sets a selected image as the Desktop picture without having to go through System Preferences.

- **QuickAccessCM from Abra Code** (http://free.abracode.com/cmworkshop, free) grants you immediate access to commonly used folders (see Figure 14-4), files, and even applications. With it, you can move, copy, or even make an alias of a selected item in another directory.

![Figure 14-4](image)
OnMyCommandCM, also from Abra Code (http://free.abracode.com/cmworkshop, free), lets you invoke UNIX commands (like those you'd type in the Terminal) or AppleScripts from a contextual menu. It's a must-have for power Mac users!

Abra Code provides a slew of handy contextual menu scripts. They're all free and available at http://free.abracode.com/cmworkshop.

FinderIconCM (www.picture.com/macosx.php, free) is the fastest way to change icons, saving you lots of Get Info's, copies, and pastes. In Technique 17, you see how to use this to quickly change an item’s icon.

StuffIt Deluxe (www.stuffit.com, $80) comes with several contextual menu options. The popular utility (see Figure 14-5), whose main use is for compressing and decompressing files and folders, creates CM tools to immediately archive or open pretty much anything. You can also access the StuffIt preferences through the CM and use sequential tools such as Archive and Mail.

![Figure 14-5: StuffIt adds many useful items to the contextual menus.](image)

StickyBrain (www.chronosnet.com, $40 or potentially free with .Mac) is the Stickies application on steroids, providing you with an amazing asset for managing information. This application creates contextual menus that incorporate StickyBrain into nearly any other application. See Technique 19 for more information on StickyBrain.

CleverKeys (www.cleverkeys.com/ck.html?p=home&os=macosx, free) provides a quick link so that you can search Dictionary.com, Thesaurus.com, Google, and other sites for words you select.

Search Google or www.versiontracker.com for more contextual menu applications that you can use.

Almost all of these applications come with their own installers. After installation, log out and log back in to take advantage of your new contextual menus. To save time, install a number of contextual menus at once, then log out and log back in (rather than logging out after each installation).

AppleScript, Contextual Menus, and You

A special subsection of contextual menus exists thanks to AppleScript. Without too much work, you can trigger (or run) AppleScripts from contextual menus.

You can also invoke Workflows you’ve created with Automator through contextual menus. See Technique 61 for an introduction to this great application, examples of how to use it, and instructions for making your work there CM-accessible.
Big Cat, created by Ranchero Software (www.ranchero.com), is a free application that adds the ability to run AppleScripts from contextual menus. Big Cat creates two separate categories of scripts:

- **Text:** For example, you can copy, open a selection in TextEdit, or search with Google (see Figure 14-6).

- **Files:** These include scripts such as Copy Path and Make Alias on Desktop (see Figure 14-7).

AppleScript for the uninitiated

*AppleScript* is a programming tool for the Mac. Because it's very easy to use but still powerful, it's remained a popular application over the years.

Apple has a vast supply of ready-made AppleScripts available for download. They're organized by application at www.apple.com/applescript/apps.


Which options you see depend on what's selected when the contextual menu is brought up. (Hence the name *contextual* menu.) To install and use Big Cat:

1. Download the latest version of Big Cat from http://ranchero.com/bigcat.
2. Double-click the downloaded file, called something like *BigCat1.0.sit*, to open it.
3. Open the resulting folder, called something like Big Cat 1.0.

The contents should resemble Figure 14-8.
4. Move the Big Cat Scripts folder to ~/Library/Application Support, where ~ refers to your Home directory.

5. Move the file BigCat.plugin to the ~/Library/Contextual Menu Items folder, again where ~ refers to your Home directory.

- If you don’t already have an Application Support or a Contextual Menu Items folder in your Library directory, create one (using the exact same spelling, capitalization, and spacing).

6. Log out of your computer and then log back in.

- In this case, you can’t use Fast User Switching to log out because that doesn’t close your session.

7. When you log back in, you should now have the Big Cat options listed under Scripts when invoking contextual menus.

8. To install your own AppleScripts to use through Big Cat, drop them into the text or file sub-folder of the ~/Library/Application Support directory (see Figure 14-9).

- Figure 14-9: You can add any AppleScripts that you want to the appropriate Files or Text folder.

If you really like Big Cat, consider making a donation to the cause with the links at the Web site (www.ranchero.com/bigcat).

- After you realize the benefits of Big Cat, you might want more. The Ranchero Software Web site has other scripts that you can download and install as well as tutorials to teach you how to write your own.
New in Panther and added to in Tiger is a window management system called Exposé. Exposé allows you to access and switch among open windows either throughout the entire operating system or just in the current application. It also gives you immediate access to the Desktop.

In this technique, we introduce you to Dashboard & Exposé and all the benefits that it has to offer. We also show the default mouse and keyboard shortcuts for using Exposé and how you can alter these. Then we demonstrate a few techniques that you can use, thanks to Exposé. Knowing how to switch documents within an active application, how to drag and drop files more quickly, and how to use Exposé without the mouse goes a long way toward helping you speed through routine tasks. Finally, we introduce you to the Dashboard, a new feature in Tiger.

**Introducing Exposé**

You enable and control Exposé from the Dashboard & Exposé panel, which is found under the Personal section of System Preferences.

1. **Open System Preferences by going to the Apple menu or by clicking its icon in the Dock.**

2. **Click the Dashboard & Exposé icon.**

   The Dashboard & Exposé pane appears (see Figure 15-1).

3. **Set the corner activation settings for Exposé.**

   Exposé, like a screen saver, can use a feature called *hot corners*. Hot corners are just the corners of your screen that have been assigned special meaning. Moving the cursor into a certain corner activates a function; moving it out of the corner deactivates that function. For example, if you’re in Safari, moving into one corner might reveal the Desktop. When you move the cursor back out, Safari is revealed again. Before you can use any hot corner, though, you need to assign functions to them in the Exposé pane.
Introducing Exposé

• Figure 15-1: The Dashboard & Exposé pane.

The pop-up menus in this pane correspond to their positions on-screen. In other words, the upper-left pop-up menu controls the upper-left corner of your screen, and so on.

- You can set one corner to show every open window (All Windows).
- You can set another corner to reveal every open window for the currently active application (Application Windows).
- You can set another corner to access the Desktop (Desktop).
- You can set another corner to start your screen saver.
- You can set another corner — you’re at five corners now, so you need to start making choices — to disable the screen saver.
- You can have a corner do nothing whatsoever (just, you know, sit in the corner).

4. Use the pop-up menus in the Keyboard section to set your function keys to also perform certain Exposé- and Screen Saver–related tasks.

The Exposé pane also allows you to set hot corners to start and disable the screen saver. These controls are duplicated — even for Exposé — under the Desktop & Screen Saver System Preferences.

You might find all these options intimidating. Here are our best rules for customizing Exposé:

✔ You might want to skip setting a Desktop shortcut in Exposé because you can also access the Desktop by clicking it or by clicking the Finder icon in the Dock.

✔ Because the All Windows and Application Windows features are very similar, place the hot corners on the same side of the screen and use contiguous function keys for them.

✔ If your function keys aren’t readily accessible (or, as with laptops, require the use of the fn key to work), avoid setting the function key shortcuts or otherwise ignore them.

✔ If your function keys are already being used for other purposes, skip setting the function keys and just use the hot corners instead.

✔ If your function keys are already being used for other purposes, you can add a modifier key to the keyboard shortcut by holding down the Shift, Option, or Control key while you select the corresponding function key (see Figure 15-2).

✔ Multiple displays (see Technique 8) probably still only have four corners, even though it might seem that you physically have eight.

 Strange as it might seem, some multiple displays might have five or more screen corners. If the two displays aren’t aligned exactly, there can be an extra corner or two between the two displays, as shown in Figure 15-3. This isn’t necessarily a problem or an asset but just a curiosity to be aware of.
If you have a multi-button input device, you can set the extra buttons to trigger Exposé, with or without modifier keys (see Figure 15-4).

The most natural way to trigger Exposé is probably to use the hot corners with the mouse. For many people, the function keys aren’t as easy to access and use as the mouse is.

Getting the Most out of Exposé

After you get Exposé set up the way you want it, you need to know how to get the most out of its potential. Aside from revealing the Desktop, Exposé either displays all the open windows (including Finder windows, Web browser windows, and documents) or all the open windows for the current application. Here are the basics for using Exposé.

- If you have a Mac with a small display (such as an iBook or the 12-inch PowerBook), you might find the hot corners a nuisance. They tend to cause funny Exposé things when your cursor (even accidentally) nears a corner.
Getting the Most out of Exposé

To switch to a different document within the current application:

1. Depending on how you’ve set your System Preferences, press the keyboard shortcut, use the mouse shortcut, or move your cursor to the hot corner to bring up all the open windows for the current application (see Figure 15-5).

2. Place your cursor over each window (the rest of the screen will be dark) to view its title. (See the middle image of Figure 15-6.)

Exposé shows only open windows and documents. Minimized windows and documents are never revealed.

3. Click the desired window to make it active.

You can always press Esc to leave Exposé without switching windows or applications.

To switch to a document in another application:

1. By using the keyboard shortcut, the mouse shortcut, or the hot corner, bring up all the open windows.

   Check out the party in Figure 15-7 (and that’s not even a particularly busy day).

2. Place your cursor over each window (the rest of the screen will be dark) to view its title.

3. Click the appropriate window to make it active.

   This tip’s just too cool for school: After you use Exposé to show all the open windows and documents, you can access all the windows or documents for specific (open) applications by
pressing the Tab key. The end result is much like rotating through Exposé's current application listing without actively switching from one application to another. If you have a lot of clutter or want to view a particular window or document in a larger size, this is the way to go.

Dragging and dropping with Exposé

One of the coolest features of Exposé is that you can use it for drag-and-drop purposes, like when you want to quickly add an attachment to an e-mail or copy and paste some text from one application to another. This might not be obvious on first exposure (insert groan here), but it's a really cool technique. Here's the skinny:

1. Select the item or items that you want to drag and drop (see the 579630 ch14.sit file in Figure 15-8).

   ![Figure 15-8: To attach a document to an e-mail, first select the document in the Finder.]

For example, you can select

- A file in the Finder to attach to an e-mail
- Text in an e-mail to drop into BBEdit
- An image in Photoshop to view in your Web browser
- Text in a Word document to copy into another Word document
- Files in a Finder window to duplicate or move to another Finder window

2. Begin dragging the selected item by clicking with the mouse and moving your cursor slightly.

3. While continuing to hold down the mouse button, use Exposé to show either all the currently open windows or all the open windows for the current application.

   Do so by moving the cursor into the correct hot corner or by pressing the associated keyboard shortcut to engage Exposé.

4. While continuing to hold down the mouse button, select the appropriate window or document by moving the cursor over it (see the lower-left corner of Figure 15-9).

   ![Figure 15-9: To add an attachment to an e-mail, select the e-mail's image by hovering over it.]

5. While (still!) continuing to hold down the mouse button, activate the highlighted window or document by pressing the spacebar.

   Exposé also automatically switches over to a document or window if you hover the cursor over it for a couple of moments.

6. While (of course) continuing to hold down the mouse button, move the cursor within the window or document to where you want to drop the selected item.
7. Release the mouse button to complete the drop. See the results in Figure 15-10.

![Figure 15-10: The completed drag-and-drop attaches the file to the e-mail.](image)

8. Apply hot and cold compresses to your tired, aching, mouse-clicking finger as needed.

Using Exposé without the mouse

This technique is for you if you never take your hands off the keys or if you use the mouse as a toy for your cat.

You can use Exposé without touching the mouse at all.

1. In the Exposé panel, make sure that you have the keyboard shortcuts enabled.

2. Press the appropriate keyboard shortcut to launch Exposé.

   By default this is:
   - F9 to see all open windows
   - F10 to view all the current application’s open windows (or documents)
   - F11 to head to the Desktop

3. Use the arrow keys to select the window or document that you want.

   The arrow keys move you around the window listings as you would expect: left, right, up, and down.

4. Press the spacebar to make that window or document active.

5. If you brought up all the active windows in Step 2, you can rotate among the windows of the different active applications by pressing Tab. Use the arrow keys to select a window and the spacebar to make it active.

Dashing to the Dashboard

New to Tiger and Exposé is a whole world called the Dashboard. The Dashboard gives you one-button access (the F12 key) to widgets. A widget is a term referring to a mini-utility designed to do one simple thing (such as show a clock). People with minimal skills can write new widgets, which can later be added to Tiger. Out of the box, Tiger comes with 14 widgets:

- Access to your Address Book
- A simple calculator
- A calendar
- An iTunes information and control bar
- Stickies (sticky notes)
- A world clock
- A tile game
- A flight tracker
- A dictionary and thesaurus
- A phonebook
- A weather tracker for various locations
- A currency converter
- A language translator
- A unit converter
As you can see in Figure 15-11, you can have as many widgets open at once as you want, and often multiple copies of the same widget (for example, there are two clocks in the image).

Besides pressing F12 to get to the Dashboard, here’s what else you might want to know:

- Open a new widget by clicking its name on the widget bar.
- Hover your mouse over the widget bar and then click the More tab that appears to see more options (such as more widgets or a Trash icon for getting rid of widgets).
- Minimize the widget bar by clicking the X. It rotates into a plus symbol, which you can click to maximize the widget bar.
- Hover your cursor over any widget to create an X that allows you to close that widget (see Figure 15-12).
- Click the red button at the bottom of the Address Book to launch the actual Address Book application.

To change the city setting for the clock
1. Hover your mouse over the clock widget.
2. Click the “i” symbol that appears in the lower-right corner.
3. Select a continent from the first pop-up menu (see Figure 15-13).
4. Select a city from the second pop-up menu.
5. Click Done.
Part III

Handling Files (And Other Stuff) Quickly

The 5th Wave
By Rich Tennant

“It all started when I began surfing the web for ‘Baked Alaska’ and frozen custards...”
Picture this: You’re sitting there reading this book. You’ve got a lovely Macintosh in front of you. Tiger — Apple’s latest and greatest operating system — is purring along. You might have read Part II of this book and picked up some navigation tips, discovered how to work the Finder, organized your Dock, toyed with contextual menus, and (hopefully) begun using Exposé. But the real question haunting your mind is this: What do I do with all my stuff? That’s what we tell you in this technique.

This technique is all about your stuff: you know, those files and folders in your Home directory, most of which were created by default, and some of which you might have added. The first section of this technique is a primer on the Home directory, how it’s organized, and how to most efficiently use it. We then take you on a brief tour of your Library folder, which is a special area for special files. The third section delves into the Desktop: what you ought to know about it and some good ideas on how to use it. Finally, we briefly discuss the Dock, just to make sure that you’ve really started using it.

Your Stuff, Your Home Directory, and You

Mac OS X revolutionized the way files are managed on the hard drive (for Mac users, at least). This is largely thanks to the more secure multi-user environment. All users have their own directories, located within the Users directory on the boot operating system’s hard drive, as shown in Figure 16-1. Each user’s directory is named after the user’s short name, as entered when the account was created.

• Figure 16-1: The Users directory and its contents.
In the Users directory, the current user’s Home folder is always marked by a little house icon. (See the folder named larryullman in Figure 16-1.)

Although separating the users this way might seem like a hassle, here are some benefits:

✔ **The structure is more secure:** Each user can access only his or her own files (assuming that folks log in as themselves).

✔ **The operating system is safer:** Because your stuff is no longer interspersed with the operating system’s stuff, you’re far less likely to do something that messes up your whole computer. Granted, you can still do something to mess up your stuff, but we cover how to avoid doing that, too (see Technique 22).

✔ **Your stuff is easier to back up:** If you manage your stuff properly, using the format suggested by Apple, you can back up every important item — all your e-mail, documents, pictures, music, and even application preferences settings — simply by backing up this one directory.

✔ **Your stuff is easier to restore:** Should a disaster ever strike, you can fully recover all your stuff as long as you’ve backed up your Home directory. Whether you use backup software or just copy the entire directory to an external drive, restoring your files is never very complicated.

✔ **Your files are easier to transfer:** If you want to move your files from one computer or hard drive to another, copying the contents of your Home directory does the trick.

✔ **Operating system upgrades are less intrusive:** Whereas previous Mac OS upgrades could affect your data, OS X upgrades avoid touching the Users directory altogether, making these transitions less painful.

In this book and other resources, you often seen path names: the full name of a folder on your computer. In path names, the ~ (tilde) refers to the current user’s Home directory. For example, if Marc is logged in, ~ refers to /Users/marc. If Larry is logged in, ~ means /Users/larryullman. Thus, ~/Documents can stand for either/Users/larryullman/Documents or /Users/marc/Documents, but it is always the current user’s Document folder.

By default, your Home directory consists of what you see in Figure 16-2:

• Figure 16-2: The standard user’s Home directory.

✔ **Desktop:** The Desktop folder contains all the files and folders stored on the Desktop. The Desktop might also show volumes, CDs, DVDs, disk images, and more, but those aren’t actually in the Desktop folder.

✔ **Documents:** The Documents folder was created as a place for you to store your, um, documents (such as your Word files, work-related projects, downloaded stuff, and more). Things you look at, edit, read, delete, create, and so forth all go in the Documents directory.

✔ **Library:** The Library could actually be the most important part of your Home folder (or second most important after the Documents folder). The Library stores everything the operating system needs to know about you. This includes
Your Stuff, Your Home Directory, and You

- Address Book records
- iCal calendars
- Favorites
- Keychains
- The Mail application’s data
- Preferences files
- Web browser bookmarks
- Stickies contents

Because the Library folder is so important, we cover it a bit more in this technique.

**Movies:** The Movies directory was intended as the default directory for creating movies in iMovie. It’s one of the few optional folders in the Home directory.

**Music:** The Music directory is the iTunes equivalent of the Movies directory. It’s intended to store your music collection and the text files that iTunes uses to manage that collection.

**Pictures:** The Pictures directory is the iPhoto equivalent of the Movies and Music folders. The iPhoto application uses it by default, but it’s also a logical place to store any graphics that you have.

**Public:** The Public folder is a special case. It’s designed to provide a storeroom for files that will be accessible by other users on your Macintosh or on your network. Within the Public folder is a Drop Box folder so that others on your Network or Mac can give you files.

If a number of files need to be accessible by everyone on your Mac, place them in the Shared folder within the Users directory. Every user can read from and write to this folder, making it a great document management tool.

**Sites:** The Sites folder is for Web pages, which can be accessed by going to http://localhost/~username/ or http://your.ip.address/~username/ (see Figure 16-3).

Here are our top ten tips for organizing and using your Home directory:

- **Don’t delete or rename any of the existing folders.**
  
  As a general rule, you can add folders or files to your Home directory, but you shouldn’t delete or rename any of the default folders. In particular, tinkering with the Desktop or Library folders would be a grave mistake.

- **Use the Desktop as a temporary storage place.**
  
  See “A Cluttered Desktop Is a Sign of a Cluttered Mind,” later in this technique.

- **Use the Documents folder for all your documents.**
  
  Go wild with it. Organize your documents as logically as possible, creating subdirectories for files based upon their type (what application created them) or purpose (personal, school, work).

Most applications use the Documents folder as the default place to save or open files. Go with the flow on this point: It will save you endless time spent wandering around your computer in search of a file.
If you have enough hard drive space, place all your music, movies, and pictures in the appropriate media folders.

Add fonts, contextual menu items, AppleScripts, screen savers, and other add-ons to the operating system in the corresponding folders of your Library, not the system library.

Back up your entire Home directory frequently, often, regularly, consistently, without fail, and on a regular basis. See Technique 49 for backup utilities and best practices.

Checking Out Your Library

The Library is, in some ways, the most important item in your Home directory. It contains all the information about you and how you use the computer. Here’s a rundown of some of the Library’s important folders and how they relate to your use of the computer:

- The Application Support folder contains critical files for many applications (check it out in Figure 16-4), including:
  - Your Address Book data
  - iCal information (other than calendars)
  - Extensions to the Terminal application

Third-party applications also use the Application Support folder:

- The LaunchBar utility keeps its settings there.
- The Camino Web browser stores preferences and bookmarks.
- Big Cat stores AppleScripts for contextual menus.
- The Fire list of accounts and preferences is saved here. (Fire is an instant messaging application.)

If you create Web sites, place all the associated files within the Sites directory. (Don’t split the files between the Sites and Documents directories.)

If an application gives you the option of installing it system-wide or just for your use, install it just for your use.

If you install the application for yourself, the files go into your Home directory and are retained through any operating system transitions that follow.

Store smaller-sized software that you simply must have — such as drivers for an input device or printer — in your Home directory so that they’ll be easy to find if you need to reinstall them.

Create an Installs or Software directory within your Documents folder to store small applications that you will probably need to install again. For example, the driver for your mouse might be only 2MB in size and needs to be reinstalled with every major operating system upgrade. Keeping a copy of the installer saves you a trip online the next time you need to install it.

Create a text document listing all the software and corresponding serial numbers that you use on your computer — and then store it in your Home folder.

Print this document for reference as well.
• Figure 16-4: Many applications add items to your Application Support directory.

- Extra system alert sounds can be added to the Sounds subfolder of the Audio directory.
- The Calendars directory stores all your iCal data (see Technique 46).
- The ColorSync folder has your ColorSync profiles (see Technique 8).
- Contextual Menu Items contains your added CM tools (see Technique 14).
- The Favorites folder is where aliases to favorite applications, documents, and folders are kept (see Technique 17).
- You can install your own fonts by adding them to the Fonts folder.
- Additional plug-ins and tools for iMovie can go in the iMovie folder.
- Additional plug-ins and scripts for iTunes can go in the iTunes folder (see Technique 43).
- The Keychains folder stores your keychain, which contains your passwords (see Technique 53).
- The Mail folder has all your Mail application’s data.
- The Preferences folder contains the preferences files for almost all your applications and even your operating system as a whole.
- Safari stuff is stored in the Safari directory (see Figure 16-5).

- Figure 16-5: The ~/Library/Safari folder keeps your bookmarks, viewing history, and more.

As you can see, pretty much everything except for your applications and your files (images, documents, and what-not) gets stored in the Library directory. For this reason, be sure to treat it with respect and include it in your daily backups. (You are doing daily backups, right?)

Aside from backing up your Library folder and possibly adding a few things to it, don’t mess around with it unless you really know what you’re doing. If you delete something you shouldn’t, you can cause yourself a lot of pain.

How many Libraries does one computer need?

Your Macintosh actually has several Library folders on it . . . three at least. Strange as this might seem, these libraries all serve approximately the same purpose. The main differences are the priority and scope that each Library has. You’ll find a Library folder in

✔ The root of the system disk (/Library)

The /Library folder is primarily for third-party applications and other developers to install items for all users. During OS upgrades, Apple doesn’t mess with the /Library folder.

(continued)
Technique 16: Organizing Your Home Directory

The main difference between the Desktop and your other folders is that the Desktop’s contents are pretty much always visible because it’s the bottom layer (so to speak) of what’s on your monitor. On the bright side, anything that’s stored there is readily accessible. But if you’ve got a lot going on there, it can quickly become overwhelming.

Because the Desktop is almost always visible and can become cluttered quickly, we strongly advocate that you use it primarily for temporary storage and to access hard drives, CD-ROMs, and the like. You might even want to create subfolders on the Desktop for longer-term (yet still temporary) storage to cut down the mess.

A Cluttered Desktop Is a Sign of a Cluttered Mind

The Desktop exists in two worlds. Yes, that’s right — the Desktop is both a dessert topping and a floor wax:

- It’s the base level of the Finder, appearing on your screen underneath everything else (as shown in Figure 16-6).
- It’s another folder within your Home directory that can be used to store your stuff (see Figure 16-7).

The System folder (/System/Library)

The /System folder is basically for Apple and only Apple usage. Apple has carte blanche with /System during upgrades.

Each user’s Library folder (~/.Library)

For example, each of these Libraries might have a Contextual Menu Items folder. Items in your CM folder will be available only to you. Items in the /System/Library CM folder are available to every user on the computer and were probably put there by Apple. In future versions of the operating system, those CM items might be upgraded. Those in the /Library folder are available to all users and should remain unharmed by upgrading the OS. In case you’re the curious type, note that the contents of the various libraries are loaded in this order: /Library, /System/Library, ~/.Library.

One important consideration with the Libraries is that things stored in either /Library or /System/Library might be replaced with every new installation of an operating system. If you perform an Erase and Install, an Archive and Install, or even an Upgrade, these contents will likely be replaced or overwritten. The contents of your Library folder will remain, though, making it a good place to store all your stuff!
Aside from tinkering with how much stuff lingers on your Desktop, you can customize its behavior in three ways:

- **Use the Desktop & Screen Saver panel of System Preferences (see Figure 16-8).**

  This panel allows you to set what color, graphic, or picture is used as the backdrop of the Desktop. Although it’s an aesthetic decision, having a visually pleasing Desktop goes a long way toward preserving your sanity.

  To change your Desktop background:

  1. Control-click the Desktop to bring up the contextual menu.
  2. Select Change Desktop Background from the contextual menu.
  3. In the resulting window (see Figure 16-8), select a broad category from the left column. Only one of the options behaves uniquely: If you click the Choose Folder option, you’re given an Open dialog in which to find a folder on your hard drive. After you find the folder you want, click the Choose button or press Return.
  4. Click one of the options that appears in the right column to select a specific color or image.
  5. Quit the System Preferences panel.

  If you really like eye candy, set the Desktop panel to rotate its picture every so often by using the Change Picture drop-down list. You can also do a hack to make screen savers run as the background to your Desktop. It’s a very processor-intensive thing to do, slowing down your computer noticeably, but it’s sooo cool. See Technique 62 for instructions and helpful tools.

- **Use the Finder preferences panel (see Figure 16-9), under General.**

  • **Figure 16-8:** The Desktop & Screen Saver panel sets the graphical appearance of your Desktop.

  • **Figure 16-9:** Use the Finder’s preferences to dictate what volumes are mounted on the Desktop.
Here you can indicate whether you want hard drives, CDs, DVDs, iPods, and connected servers to appear as icons on your Desktop.

Select View → Show View Options (see Figure 16-10) in the Finder.

For how your Desktop looks and functions, the Show View Options panel is the most critical of the settings panels. Here you can set

- The default size of icons (in pixels)
- The default text size for names of items
- Whether an item’s name (called label in this panel) should appear below or to the right of an item
- Whether you want to see an item’s info (for example, the dimensions of an image or the size of a hard drive)
- Whether you want to see a thumbnail preview of images as their icon
- How files should be arranged, if at all

You want to set the icon and text sizes so that they’re easy to view but don’t take up too much space. The arrangement of items is the most important consideration. If you keep them arranged by name, your hard drives, discs, and such appear in the upper-right corner. Remaining items are listed in alphabetical order, just as you’d see them in the list or column view of a Finder window.

Revisiting Our Friend, the Dock

We give a good amount of attention to our friend, the Dock, in Technique 13. We’d like to revisit (or visit, if you haven’t read that other technique yet) one aspect of organizing the Dock.

The Dock has two sides: the left, where applications are docked, and the right, which contains the Trash and any folders or files that you choose to dock there. After you get your stuff organized, it’s a good time to add key components to the right side of the Dock. We recommend these (see Figure 16-11):
Revisiting Our Friend, the Dock

- Figure 16-11: The right side of Larry’s Dock, with current projects, his Home folder, and his Favorites all docked.

- Your Home folder itself
- Your Documents folder
- The folder(s) for any current project(s)
- The Desktop folder, if you really use the Desktop

You can access any directories that you add to the Dock in hierarchical form by Control-clicking the directory’s icon (see Figure 16-12). This trick gives you fast access to the files that you use the most.

- Figure 16-12: Control-clicking a docked folder brings up a menu of its contents.
Managing Aliases, Favorites, and Icons

17

Technique

Save Time By

- Working with aliases to establish shortcuts to popular files, directories, and applications
- Using Favorites to quickly get to your favorite things
- Customizing the icons used for files and folders

This technique deals with aliases, Favorites, and icons: all the things that give you quick access to the files and folders that you use most.

This technique has three main sections, each of which shows you how to deal with the contents of your computer indirectly. In the first section, we talk about aliases: what they are, how you create them, and how you want to use them. In the second section, we go into Favorites, which are a specific grouping of aliases. In the final part of this chapter, you find out about icons, which are the visual representation for your stuff.

Also Known As: Working with Aliases

Your computer is loaded (perhaps overloaded) with many different files, folders, and applications. Each of these items is located in a specific spot on your hard drive, represented by an icon and a filename. An alias is a secondary pointer to the same item. It can be (and normally is) placed in another location; it can have a different name; and it can even have a different icon. However, by default, an item’s alias uses the same icon as the original except for the addition of a little black arrow in the lower-left corner (see the bottom icon of Figure 17-1). The alias is created with the same filename as the original except that the word alias is also appended to the end under most circumstances.
Aliases offer the following benefits:

- They allow you to have virtually the same item existing in many locations.
- They’re relatively small in size. For example, the alias of a 6MB MP3 file might take up only a few KB.
- They enable you to create groups of aliases to related items without shuffling around the original items.
- They are very easy to create, manage, and delete.
- They make accessing files, folders, and applications easier without undermining any organizational structures.

The operating system makes use of aliases all over the place. Items in the Dock, in the left side of a Finder window, and some menu items are aliases. You might not be aware of these aliases and they might not have the little black, curved arrows, but the principle remains.

Here’s how aliases work:

- Opening an alias of a file has the same effect as opening the original file.
- Opening an alias of an application is the same as opening the application by using its original icon.
- Opening an alias of a folder opens the original folder.
- Deleting an alias has no effect on the original item at all.

An alias isn’t a copy of an item. If you open and edit the alias of a file, the effect is the same as if you open and edit the original file. But if you delete an alias, the original remains.

After you select an item, you can create an alias in any of five ways:

- Press Ô-L.
- Hold down the Option and Ô keys while dragging the item with your mouse.

If you use this method, the cursor turns into the little curved alias arrow.

If you use the Ô-Option-drag method to make an alias, it adds the word alias to the filename if you drop the file within the same folder as the original (because a folder can’t contain two items with the same name). If you create the alias in another folder, it doesn’t add the word alias. In either case, the curved black arrow is added to the icon, indicating its alias status.
Go to the Finder's File menu and choose Make Alias (see Figure 17-2).

Control-click the item and select Make Alias from the resulting contextual menu.

Use the QuickAccessCM’s Make Alias In option (see Figure 17-3).

This contextual menu is mentioned in Technique 14. One of the many features it adds is the ability to make an alias and place it in another directory, all in one step.

Remarkably, aliases continue to work no matter what you do with either the alias or the original file as long as you don’t remove either from the volume in which it was created. If an alias can’t find the original file, you see a prompt (as shown in Figure 17-4) that allows you to reselect the original or delete the alias.

To find the original item for an alias, select the alias and do one of the following:

Press Ô-R.

Choose Show Original from the Finder’s File menu.

Control-click the alias and choose Show Original from the contextual menu.
These Are a Few of My Favorites Things

In Mac OS X, Apple introduced Favorites: a collection of aliases for your favorite things. By default, your Favorites were linked as a folder in your Dock, allowing you to access those items by Control-clicking (or clicking and holding) the icon (see Figure 17-5).

A UNIX alias: Symbolic links

The Macintosh alias is the equivalent of the UNIX symbolic link (and the Windows shortcut, too, but who cares about Windows?). A symbolic link is just a secondary pointer to the original file, application, or folder. Because Mac OS X is based on the FreeBSD version of UNIX, you can also make symbolic links in it by using the Terminal application.

The syntax for linking to a file is `ln -s alias_name original_file_name`. If you aren’t in the same directory as both the original and the alias or if you otherwise want to be exact, you probably want to include the path to both the link and the original file: `ln -s /path/to/original_file_name /path/to/alias_name`. If you want to create an alias to a folder, the same syntax applies: for example, `ln -s /Users/larry/Sites /Users/larry/Desktop/Sites_alias` or simply `ln -s ~/Sites ~/Desktop/Sites_alias`. As with standard aliases, a symbolic pointer is created by this command, pointing to the original item.

Like UNIX, with the Mac you can create hard or soft links. The `-s` option creates a soft link, and omitting it creates a hard one. A soft link is exactly like an alias. A hard link is like having another copy of the data itself and also has the restriction that hard links can’t point to an item on another volume (a disk drive or partition). You really should stick to soft links because hard links are likely to cause problems in one way or another.

One advantage that the Mac’s aliases have over symbolic links is that you can move an alias from one location to another, and it still works — it finds the original just fine. Conversely, symbolic links can never be moved. They must be deleted and re-created instead.

If you’re keen on symbolic links but tired of the Terminal, check out the MakeSymlink contextual menu (www.naratt.com/MakeSymlink.html, $12). It allows you to create actual symbolic links in the Finder.

In previous versions of Mac OS X, the ⌘-T shortcut added the selected item to your Favorites, but this feature has been eliminated. (In Tiger, that shortcut now adds the item to the Finder window’s Sidebar.) But we still like the idea of Favorites, so here’s the easiest way to access your Favorites:
Technique 17: Managing Aliases, Favorites, and Icons

1. Open a Finder window.
2. Navigate to the Library folder in your Home directory (~Libr ary).
3. Select the Favorites folder.
4. Press %T to add the Favorites to the window’s Sidebar (see Figure 17-6).

5. If you want, also drag the Favorites folder onto your Dock so that it’s accessible there.

After your Favorites are readily available, you’ll want to actually add your favorite things to this collection:

1. From the Finder window, navigate to the item that you want to add to your Favorites.
2. Select the item.

3. Begin dragging the selected item toward the Favorites icon in the Sidebar.
4. While still dragging but before reaching the Favorites icon, hold down the Option and Ô keys so that the Make Alias icon appears with your dragged selection.
5. To confirm that the item was added to your Favorites, click the Favorites icon in the Sidebar to bring up the directory (see Figure 17-7).

• Figure 17-7: A Favorites folder, with aliases for applications and directories.

Whether you use Favorites is up to you, but the idea of collecting, organizing, and accessing a collection of aliases to your favorite applications, documents, and files is one worth pursuing. After you place items in your Favorites folder, you can quickly launch applications, open files, or find directories by using the Favorites link in the Sidebar or the Dock.

You don’t have to limit yourself to only one Favorites folder. Create a second or a third Favorites folder and then add these folders to your primary Favorites directory. This way you can have subgroups of applications by use or files by project. Many sequences of steps that you frequently take can be expedited by using aliases and Favorites.
If You Can, Icon

An icon is the visual representation of an item, and it tells you a lot about the item in question. Knowing how icons work and how to manipulate them goes a ways toward more productively using your computer. Here are some basics:

- All folders use a default icon that looks like a, well, folder.
- Files use an icon showing what application they’re associated with.
- Applications normally use their own custom icon.

How your computer treats icons is dictated by the View Options panel. You can bring this up by either

- Pressing Ô-J
- Choosing View➪Show View Options

The View Options menu controls these icon settings:

- The icon size in pixels.
- The size of the text associated with an icon (the item’s name).
- Where the item’s name (called the label in the Show View Options panel) appears (underneath or beside the icon).
- How icons are arranged on the Desktop or in a window.

In icon view mode only, you can dictate whether and how icons are automatically arranged. Your options are by Name, Data Modified, Date Created, Size, Kind, and Label.

Select the Show Icon Preview check box under the View Options panel to have all images represented by a thumbnail of the actual image. This feature is nice but can slow down your computer when you open directories with lots of images.

The View Options panel is also discussed in Technique 12, which covers how to customize the Finder windows.

In all likelihood, you won’t change the default icons for your files or applications, but you could (and frequently should) use new icons for your folders. Doing so helps you more easily recognize a particular folder, whether it’s in a Finder window or the Dock. You can create your own icons by using Adobe Photoshop, the open source The Gimp application, or other graphics software (see the sidebar “Making your own icons”), or you can download free icons that others have made. Check out these resourceful sites:

- **The Iconfactory:** www.iconfactory.com
- **InterfaceLIFT:** http://interfacelift.com/icons-mac
- **ResExcellence:** www.resexcellence.com

Making your own icons

If you’re graphically inclined, you can make your own custom icons without much effort. Two popular tools for doing so are Folder Icon Maker X (http://homepage.mac.com/niteowl69, $5) and IconBuilder Pro (www.iconfactory.com/ib_home.asp, $69), an add-on tool for Adobe Photoshop. A free alternative is Viou (http://perso.wanadoo.fr/prime). We haven’t used this last application ourselves, but the price is right and it looks promising. Also, there’s Iconographer (www.mscape.com/products/iconographer.html, $15), a more sophisticated icon editor.

Here, though, we focus on FinderIconCM, a free contextual-menu-based tool available at www.pixture.com/macosx.php. By using it, you can combine two different images to easily make a new one:

1. **Download and install FinderIconCM.**
2. **Click an icon in the Finder to select it.**
3. **Control-click the icon to bring up the contextual menu.**

(continued)
4. Choose Finder Icon ➪ Create Folder Icon.
The resulting window is where you’ll be experimenting.

5. If you want, use the drop-down list on the left to change the base image from a folder to an open folder to a document to whatever.

6. Use the sliders on the right to change how the icon looks on top of the base image.

7. Click the Create New Folder button to make a new folder with this icon.
Alternatively, you can click the Copy to Stock button to make this a stock image for the FinderIconCM or click the Copy to Clipboard button to manually paste this icon onto another item.

8. Click Done.

For an example, we take an image of this book’s cover and use that for the icon of the folder containing all of this book’s documents:

1. Create or find the new icon image that you want to use.

2. Select the new icon.
A border appears around it, as shown in Figure 17-8.

3. Press Ô-I to bring up the Get Info panel or Ô-Option-I to bring up the Inspector panel (see Figure 17-9) for the new icon.
• Figure 17-9: Use the Get Info or Inspector panel to copy or change an item’s icon.

Holding down the Option key while pressing Ô-I brings up the Inspector panel. It’s a lot like the standard Get Info panel except that it changes when you select a new item in the Finder. It’s particularly handy in situations like this (changing icons) so that you don’t need to repeatedly invoke the Get Info command.

4. Click the icon in the General part of the Get Info or Inspector panel to select it.

5. Press Ô-C to copy the icon.

6. Go back to the Finder and select the item whose icon you want to replace (see Figure 17-10).

• Figure 17-10: Selecting the folder whose icon will be changing.

7. Select the icon in the Get Info or Inspector panel and press Ô-V to paste in the new icon (see Figure 17-11).

• Figure 17-11: The same folder with its new image.

8. Close the Get Info or Inspector panel by clicking the red circle in the upper-left corner.
To restore an item’s icon to its default:

1. Select the item whose icon you want to restore.
2. Bring up the Get Info panel (press ⌘-I).
3. Select the icon in the Get Info panel.
4. Press Delete to delete the icon.

The fastest way to change icons is to use the free FinderIconCM (www.pixture.com/macosx.php, free) contextual menu. After you install it, you can Control-click the icon you like and choose Finder Icon ➪ Copy to copy it to the Clipboard. Then Control-click the item receiving this new icon and choose Finder Icon ➪ Paste. FinderIconCM also lets you create a library of icons to repeatedly use (so you can skip the Copy step) or create a new icon by merging two others (see the “Making your own icons” sidebar). All in all, FinderIconCM is a great tool to use, and you can’t beat the price (free!).
In this technique, we delve into the Address Book, which is much more useful and important than you might think. It “only” manages a list of people and contact information, but that’s a pretty big task. More importantly, the Address Book ties into the Mail application and is even represented in the Tiger’s new Dashboard. So using and mastering this one application is well worth your time.

**Getting to Know the Address Book**

The Address Book has been around since the beginning of OS X. The new features added in Panther and Tiger make it even more useful. Those features include

- Printing mailing labels and envelopes
- Autoformatting phone numbers
- Creating your own default templates for records
- Listing relations, friends, and associates for the people in your Address Book
- Smart Groups, for easily making dynamic groups of people
- Recording birthdays, which can appear in an iCal calendar

If you use the Address Book a lot, make sure that you back up the contents just in case of disaster. The Address Book database is stored in your Home directory (in the Library/Application Support/AddressBook folder), but you can manually back it up by choosing File→Back Up Address Book in the Address Book.
One good reason to use the default applications that Apple includes with the operating system (such as the Address Book, Mail, and iTunes) is how well they work together. Take the Address Book, for example. If you use it to store and manage your contacts, you'll appreciate how nicely it works with Mail or with the faxing software. Most of what the Address Book does is self-explanatory. In this technique, we cover a few tricks and habits that you might not know . . . but might find useful.

If you have Bluetooth and a Bluetooth-enabled cellular phone, you can dial phone numbers by using the Address Book (see Technique 55).

Customizing the Template

When you add contacts to your Address Book, you're given a default template with set fields of records that can be entered for each contact, such as name and e-mail address. In all likelihood, these preset fields and formats don't adequately reflect the information that you want to record or use. The first thing that you should do with the Address Book is to customize this default template.

To customize the default Address Book application:

1. Open the Address Book application.
2. Choose Address Book: Preferences or press ⌘, (that’s a comma).
3. In the Preferences dialog that appears, click the Template pane (see Figure 18-1).
4. Change any existing fields that you don’t like to ones that you will use.

For example:

► If you want the template to have a home phone field by default but no work phone, change the work phone listing by clicking the word work next to Phone and selecting home from the drop-down list that appears.

► If you want to list a person’s spouse instead of friend or assistant, click the word next to Names (this is “friend” by default) and select the appropriate alternative from the drop-down list that appears.

► If AOL Instant Messaging (AIM) isn’t the instant messaging application that you use most often, change it to another from the drop-down list, as shown in Figure 18-2.

5. Delete all the fields that you won’t be using by default by clicking the red minus sign next to an item to remove it.

Your Address Book records must have the First (Name), Last (Name), Company, Image, and Note fields. These are the only ones that can’t be deleted.

6. Add multiple fields of the same type by using the green button with the plus sign on it.

If you want several phone options or e-mail listings in your default template, click the green plus button to add another field of that type. Then select a description from the drop-down list. For example, add another e-mail address by clicking the green button next to Email (marked as “home”). Then select Work, Other, or Custom from the new field’s drop-down list.
7. Use the drop-down list at the top of the window to add any other fields that you want.

Use the top drop-down list, shown in Figure 18-3, to add new fields (such as a birthday or nickname) or standard ones that you’ve removed (e-mail addresses and phone numbers).

8. When you finish creating the template, close the Preferences window by clicking the Close button or pressing \(\text{Ô}-\text{W}\).

After you finish defining the Address Book template, go to the Phone panel, where you can establish the default format for phone numbers (see Figure 18-4). If you check the Automatically Format Phone Numbers box, those numbers that match the default format are formatted, while others (like international numbers) are safely left alone.

Creating Your Own vCard

The Address Book uses the vCard format, which is the default format for personnel records. If you create your own record in the Address Book (the application creates a record for you automatically), you can export the record as a vCard and e-mail it to friends or co-workers. They can then import it into their own contacts application whether they use Address Book or another application, such as Microsoft Entourage, which saves them the trouble of typing the information.

1. Open the Address Book application.

2. Navigate to your record by choosing Card ➪ Go to My Card.

You can see a card in Figure 18-5.
Creating Your Own vCard

• Figure 18-5: My default Address Book record.

You can have more than one record for yourself (or anyone), but you can mark only one as your official record in the Address Book. This way, you can make different records for personal or business purposes.

3. Click the Edit button at the bottom of the card panel.

You can toggle between edit and view mode with the Ô-L keyboard shortcut.

4. Edit your information, adding, changing, and removing fields as necessary.

You can add other fields to the card by using the Add Field option under the Card menu.

5. Add your image — if you want — by double-clicking the image icon.

Double-clicking the image icon in the edit mode brings up the image panel (see Figure 18-6). With it, you can

► Drag an image file from the Finder into the window.

► Use an attached video camera to take a snapshot of yourself.

If you have a FireWire video camera connected to your computer — like one you would use for video conferencing with iChat — your mug appears in this window. You can capture yourself by clicking the Take Video Snapshot button.

► Click the Choose button to navigate to and select the image to use.

• Figure 18-6: The image panel lets you add a graphical or pictorial representation of yourself to your card.
Technique 18: Addressing Your Addresses

After you select your image, click the Set button to apply the changes. Then you return to the Card panel, where you can continue editing your record.

6. **When you’re done editing your record, click the Edit button to complete the changes.**

7. **Choose File ➤ Export vCard.**

8. **Save the vCard (see Figure 18-7).**

You most likely want to use your name as the name of the file (with no file extension) and save it in your Documents directory or other subfolder of your Home directory.

After you create your vCard, you can attach it to e-mails so that people can add your record to their virtual Rolodexes (whether or not they use Address Book). In fact, adding and editing your own card is a great way to feel comfortable with the process and the application for when you start adding other people’s information. If someone e-mails you a vCard, add it to your Address Book by dragging and dropping it onto the application.

Technique 34 covers the ⌘-Y shortcut (found within the Mail application) that creates an Address Book entry for the sender of the currently selected (or viewed) e-mail.

Creating and Using Groups

Every record in your Address Book can also be a member of one or more groups. (They don’t have to be, though; a record can be independent of all groups.) Defining groups brings you three main benefits:

- Better organization for finding a record
- Ability to send an entire group (like your family) updated contact information with the click of a button
- Ability to send e-mails to a defined set of people, such as everyone in your department, by referring to the group name in the Mail application

You can create a group in four ways:

- Using the New Group From Selection tool
- Manually
- Duplicating an existing group
- Using Tiger’s new Smart Groups feature

Hold down the Option key when you have selected a person’s record in the Name column to see what groups that person is in.

Using the New Group From Selection tool

A quick way to create a new group is to choose File ➤ New Group From Selection.

1. Make sure you are in Cards and Columns mode by pressing ⌘-1 (see Figure 18-8).

Address Book supports three modes (all available through the View menu): Cards and Columns, Card Only, and Directories. Cards and Columns is the best for creating groups.
Creating and Using Groups

2. Click the All option under Group to display every record.

3. Ô-click the names listed in the Name column to select the group members.

4. Choose File ➪ New Group From Selection (see Figure 18-9).

A new group is created in the Group column. This new group’s name (“Group Name” by default) is highlighted, ready for you to type the new name.

5. Enter the new group’s name.

6. Press Return to complete the transaction.

Creating a group manually

To create a group manually:

1. Make sure that you’re in Cards and Columns view mode; choose it from the View menu or press Ô-1.

2. Click the plus sign in the lower-left corner to create a new group.

3. Type the new group’s name in the new, highlighted field that appears (see Figure 18-10).

4. Search or browse through the Address Book names, adding people to the new group by dragging their cards onto the group name.

To delete a group member, select the member’s name from under the Group listing and then press Delete. Press Return at the prompt that appears (see Figure 18-11) to remove the user only from this group (not from the whole Address Book).
**Technique 18: Addressing Your Addresses**

1. **Select the existing group in the Group listing (the left column).**
2. **Choose Edit ▸ Copy or press ⌘-C.**
3. **Choose Edit ▸ Paste or press ⌘-V to create a copy of that group.**
4. **Rename the new group (called *Old Group Name copy*) by double-clicking the group’s name.**
5. **Edit the group’s members by using the steps outlined in the preceding section.**

**Creating Smart Groups**

Tiger has an entirely new way to create a group in the Address Book: Smart Groups. They’re much like the Finder’s Smart Folders, iPhoto’s Smart Albums, or iTunes’ Smart Playlists. (Tiger is one smart cookie.)

To create a Smart Group:

1. **Choose File ▸ New Smart Group.**
   You can also Option-click the plus sign in the lower-left corner of the Cards and Columns view.
2. **In the resulting prompt, give the group a name (see Figure 18-12).**

**Duplicating an existing group**

If you want to create a new group that contains some of the members of an existing group (like the immediate family subset of your extended family group), you might want to simply duplicate the existing group and edit members accordingly. Here’s how:

1. **Select the existing group in the Group listing (the left column).**
2. **Choose Edit ▸ Copy or press ⌘-C.**
3. **Choose Edit ▸ Paste or press ⌘-V to create a copy of that group.**
4. **Rename the new group (called *Old Group Name copy*) by double-clicking the group’s name.**
5. **Edit the group’s members by using the steps outlined in the preceding section.**

With multiple criteria, another drop-down list appears, giving you the option to require *any* or *all* of the criteria. If you select *all*, each condition makes your search narrower. If you select *any*, each condition makes your search broader.

4. **Click OK when you’re ready to create the smart group.**

The Smart Group creates two groups of every record that matches your conditions. Both groups have the same name:

- A normal group with a normal icon
- A smart group (with the special smart group icon) at the bottom of the group list (as shown in Figure 18-14)
• Figure 18-14: Two Family groups are created: one normal and one smart.

5. To edit the members of the group manually, use the plain group.

Click the normal group’s icon and you can delete and add records as you would any other group.

Deleting a record from the Smart Group itself — the one with the special Smart Group icon — deletes that record from the entire Address Book. Deleting a record from the plain group (the one created by the Smart Group) is safe.

6. To edit the Smart Group criteria, Option-double-click the smart icon and reuse the prompt.

Because Smart Groups are so amazingly smart, they automatically update themselves as your address book data changes. For example, if your friend marries your brother and you change her last name in Address Book, her record is added to the Family group. If you later add another person’s record (like when your uncle finally gets a computer), that record also is added to the group, if the Smart Group’s conditions are met.

7. After changing a Smart Group’s conditions, update the normal group by copying the contents of the Smart Group into the plain group.

Other Cool Address Book Tricks

Apple put a lot of thought into the Address Book, and it has its fair share of cool tricks. Here are the ones that you should know, in case you don’t:

✔ If you change your contact information, use the Send Updates option (under the File menu) to automatically e-mail your new information to others. By selecting among the groups you have already created, you can notify your friends and family every time you move or change Internet providers.

✔ Click the address link for a home page to go to that site.

✔ Click the caption next to a person’s e-mail address to open a contextual menu so that you can send the person an e-mail (see Figure 18-15).
Click the caption next to a person’s phone number to see it in large type.

Add a phonetic field to records to remind yourself how a name is pronounced. (It’s up to you to master the International Phonetic Alphabet.)

Click the caption next to an address to be given the option of seeing a map for that address via MapQuest.

Print labels or envelopes by pressing Ô-P when you have one or more cards selected (see Figure 18-16).

Figure 18-16: Address envelopes (including both the to and from addresses) directly from the Address Book.
Managing Information Effectively

In this technique, we delve into just a few of the applications that you can use to manage your miscellaneous information. You probably already use Microsoft Office for word processing and spreadsheets, and maybe you use iPhoto for your images, but where do you store that important note or that quote you liked? Instead of writing this stuff down and throwing it in a desk drawer where it’s never seen again, use the tools that we cover here.

The first application we discuss is Stickies, which has been around in Mac OS X for a while now. Then we move on to the Dashboard’s own version of Stickies. After that, we look into a commercial product called StickyBrain. Finally, we list a few scrapbook-like applications that you can use to manage and organize sporadic bits of information, create to-do lists, make outlines, and so forth.

Storing Information as a Sticky Note

If you aren’t already using Stickies — an Apple application that comes with Tiger — you’re missing out on a useful little tool for storing little tidbits of info. Stickies creates small text files with sticky note–like behavior. Unlike using TextEdit, with Stickies you can create color-coded notes, quickly make a note by using Services (see Technique 29), and keep a note at the front of your screen while you’re using another application.

Some good Stickies tips include the following:

- In the Finder and any Cocoa application (such as Mail, Safari, TextEdit, and the Address Book), create a new sticky note out of highlighted text by pressing Ô-Shift-Y.
- Change a note’s formatting based upon its purpose or category. You can use many colors for your sticky notes, and you can change both the note background and the font color. Use different colored sticky notes for different purposes (even though Figure 19-1 is in grayscale, you get the idea). You can change a note’s color by using the Color menu, and you can alter the fonts by using the Font menu or the Font palette (which you can access by pressing Ô-T).
Technique 19: Managing Information Effectively

Figure 19-1: You can assign colors to sticky notes to help you remember whether they’re personal, work related, and so forth.

When you find a note color and style that you like, choose Note ➪ Use as Default option under the Note menu. Then, when you create a new note, it will automatically be formatted in your preferred style (existing notes will not be affected).

Check the spelling in a note from the contextual menu (Control-click a note) or choose Edit ➪ Spelling.

Stickies supports Services (see Technique 29), meaning that you can access many different shortcuts from within the Stickies application. You can also interact with Stickies from other applications that support Services, like Mail (see Figure 19-2).

Have a sticky note float above other applications by clicking it and pressing Ô-Shift-F or choosing Floating Window from the Note menu. A floating sticky note is never hidden by other applications: It always appears at the “front” of the screen.

Stickies can store more than just text. You can also put images, videos, and sounds in them. This capability makes Stickies much like the long-gone Scrapbook application.

Figure 19-2: Services provide quick access to common tasks.

Stickies Lite: Using Dashboard

Dashboard, the widget-running tool that’s associated with Exposé, has its own version of Stickies. The main advantage of Dashboard Stickies is that you can invoke it no matter what you’re currently doing.

However, Dashboard Stickies isn’t as feature-rich as Stickies proper. A Dashboard sticky note:

- Isn’t accessible via Services or the Make New Sticky Note keyboard shortcut.
- Lacks a spell checker.
- Has fewer font options.
- Can’t float so that it’s available while working in other applications.

But if these aren’t features you use or need, and if what you really want is instantaneous access, Dashboard is the tool for you. Here’s how to use Dashboard Stickies:
1. Open Dashboard by pressing F12 or by using an assigned hot corner.

You can set the keys and hot corners for Dashboard in the Dashboard & Exposé System Preferences panel. F12 is the Dashboard shortcut by default. See Technique 15 for more.

2. Click the Stickies icon to create a new note (see Figure 19-3).

• Figure 19-3: Create a new sticky note by using the Dashboard control bar.

3. Type your text. (You probably could have figured that out.)

Click the circle arrow in the lower-right corner for formatting options (see Figure 19-4).

• Figure 19-4: The (somewhat limited) formatting options for a Dashboard sticky note.

4. Click the Stickies icon again to create a new note.

5. Use the same keyboard shortcut (F12) or hot corner to hide Dashboard.

You can click any non-Dashboard window, use the Dock, or invoke the application switcher to leave Dashboard.

Stickies Pro: Using StickyBrain

If you like Stickies, you’ll really like StickyBrain, from Chronos (www.chronosnet.com, $40). StickyBrain takes the idea behind Stickies and turns it into a full-fledged, potent application.

StickyBrain has basic sticky notes plus the following enhancements:

✓ Calendars
✓ To-do lists
✓ Built-in templates and reference notes
✓ Contextual menu and Services support
✓ The ability to search through your notes to find specific text

Chronos has released version 3 of this application, which features

✓ A Mail-like interface (see Figure 19-5)
✓ Integration with .Mac
✓ Tabbed note viewing (like tabbed Web browsing)
✓ Faster searching
✓ iPod synchronization
✓ The ability to search your sticky notes by using a menu bar prompt

• Figure 19-5: StickyBrain’s main viewer window looks and behaves a lot like the Mail application.
Here are a few tips if you use StickyBrain:

✓ Keep your notes organized into appropriate folders (refer to Figure 19-5).

✓ Choose a note category from the Library panel to limit your searches to only those notes.

✓ Use the StickyBrain Services in applications that support Services. The StickyBrain Services allow you to quickly generate specific types of notes (see Figure 19-6).

✓ Use the StickyBrain contextual menus in applications that don’t support Services.

✓ Customize the main viewer toolbar, as you would a Finder window.

.Mac members receive a free version of StickyBrain 2! This is one of the many benefits that come with your $100 membership. Check out Technique 42 for more details.

**Figure 19-6: StickyBrain installs a number of great Services.**
Working with Files

This, the third part of the book, is all about your stuff: where to put it, how to file it, and what to do with all the things that fill up a computer. In this technique, we talk about files (as opposed to folders or applications) and Tiger. We should, therefore, talk a little bit about how the operating system treats your stuff. Being able to comprehend and make the most of this relationship (between the operating system and your files) goes a long way toward being able to use your computer more effectively.

We begin by discussing a file’s properties. This includes Tiger’s naming conventions, locking files, adding comments, and more. We conclude with how to solve some common file problems that most users encounter eventually. In the process, we get a little technical but not overwhelmingly so. After all, the benefit of owning a Mac is that you don’t need to be a rocket scientist to use it.

Understanding a File’s Properties

The files on your computer have many properties, such as name, extension, size, and type. You’ll work with filenames more than any other property, but understanding and manipulating the other file properties effectively is also important. Doing so can make the time that you spend on your computer more efficient and secure.

Most of a file’s properties can be parameters for advanced searches (see Technique 21).

You can discern some file properties, such as name, extension, size (depending on how the window is customized), type, and default opening application, just by looking at the file in the Finder (see Figure 20-1).

Save Time By

- Comprehending how Tiger treats files
- Working with the Get Info panel
- Troubleshooting common file problems
We discuss the Get Info panel extensively in this technique (and you use it often in day-to-day Tiger usage), so you really should get to know your way around it. In this technique, we go through its subparts and how they relate to you and your stuff. Note that each item on the Get Info panel has a right-pointing arrow next to it: Click that arrow to expand its section and see more information, as shown in Figure 20-2.

These and other properties are viewable and editable in the Get Info panel. If you aren’t familiar with this panel, it’s about time to become so. After you select a file, you can bring up the Get Info panel by

- Control-clicking and choosing Get Info from the contextual menu.
- Pressing Ô-I.
- Choosing File→Get Info.

Hold down the Option key while using one of these methods to open an Inspector panel. It’s almost exactly like the standard Get Info panel except that it changes to represent the currently selected item. The standard Get Info panel stays focused on the originally selected item.

The General panel

The General panel shows you the basics, almost all of which can appear in the list view mode of the Finder window. The only three things that you can change here are

- **Stationery Pad**: If you select the Stationery Pad check box, the currently selected file becomes a template with its own special icon (see Figure 20-3). When you open a Stationery Pad file, Tiger creates and opens a copy of it, allowing you to work with the copy without altering the original.
• Figure 20-3: Template files use a slight modification of the default file type.

Locked: If you enable the Locked check box, the file is safeguarded against changes or incidental deletions. A locked file’s icon features a small padlock (see the bottom file icon in Figure 20-4). Locked files can be opened but not deleted nor altered.

Label: New to Tiger is the ability to change an item’s Label by using the Get Info panel.

The locked icon

• Figure 20-4: Locked files have a little padlock on their icons.

The More Info panel

Tiger introduces the More Info section (see Figure 20-5). Although there’s nothing for you to change here, it can be very useful. Depending on the item you’ve selected, the More Info panel might display the following:

- The last time the item was opened
- An image’s size in pixels (see Figure 20-5)
- The original source of a downloaded file (see Figure 20-6)
- Copyright information (for applications)
Technique 20: Working with Files

- Figure 20-5: The new More Info panel is below the General panel.

The Name & Extension panel

You likely know what a file’s name is and what it means. (If you don’t, perhaps it’s time you pick up Bob Levitus’s Mac OS X Tiger For Dummies, Wiley Publishing, Inc.) You can change a file’s name by these three methods:

- Click the filename (not the icon but the actual filename) in the Finder and type the new name.
- Select the item, press Return, and type the new name.
- Type the new name in the Name & Extension text box of the Get Info panel (see Figure 20-7).

- Figure 20-6: Quickly find the origin of a downloaded file by using the More Info section.

- Figure 20-7: The Name & Extension section of a file’s Get Info panel.
Tiger has very few rules for how to name a file, and here they are:

- Filenames shouldn’t begin with a period.
- Filenames can’t contain a semicolon.
- Filenames shouldn’t contain a slash.
- The maximum filename length is 255 characters, although you might not be able to see a filename this large under many conditions.
- Two files within the same directory can’t have the same name.

Strangely enough, you can change the name or even the location of a file without disrupting the Recent Documents listing in the Finder and applications. This is because the operating system uses a different method of referring to files rather than the more obvious name and location.

Although a file’s extension is an issue that has been mostly hidden from Mac users over the years, it’s critical for many reasons. The file’s extension (and kind, which is related) dictates what application is used by default to open it. (See “The Open With panel” section.) You can change a file’s extension by

- Changing the file’s name in the Finder, if the extension is also shown
- Hide or show a file’s extension by checking the appropriate box in the Name & Extension panel (refer to Figure 20-7).
- Typing the filename and its new extension in the Name & Extension section of the Get Info panel

When you change a file’s extension, Tiger displays a prompt (see Figure 20-8) confirming whether you truly want to make this change because it affects what application opens it. Unfortunately, you can’t avoid this prompt — Tiger is trying to behave in your best interest. Most commonly, you might change the extensions on text files, Web pages, and downloaded files. Doing so isn’t really a problem — primarily it just affects what application opens the file by default — and you can also change the file’s extension back, if necessary.

![Figure 20-8: Before you can change a file’s extension, you must confirm the action through this prompt.](image)

The Open With panel

The Open With panel shows you what application opens a file by default. The drop-down list also allows you to change this setting for a particular file. The Change All button lets you enact the change for every file of this type. See Technique 25 for more techniques for opening files.

The Preview panel

The Preview panel, as you might expect, shows you a preview of the file. For many file types (such as text files, spreadsheets, and Web pages), you see only the file’s icon. For image file types, this panel shows a thumbnail of the image itself (see Figure 20-9). With movies and sound files, you can actually play them by clicking the Play button of the preview (the right-pointing triangle, Figure 20-10).

![The Preview panel of the Get Info panel is replicated by the column view mode of a Finder window, where the final column is used for the preview.](image)
The Ownership & Permissions panel

The Ownership & Permissions panel of the Get Info pane is its most complex panel because it’s based on a UNIX concept. (See the “UNIX permissions” sidebar if you really want to know more.) The first rule for this area is to leave it alone unless you really know what you’re doing.

Permissions are a sticky subject. Toying with them without fully understanding the ramifications can affect the security and operability of your system.

UNIX permissions

The UNIX operating systems have an elaborate set of permissions for files and folders based on who owns a file and who can do what with it. The first issue you can control is the specific user and group that owns a file.

By default, the owner of a file is whoever created it — in Tiger, that means your short username for most of your stuff. Permissions are also based on groups. Again, by default, this is the group that the owner is a member of. Of course, a user can be part of many different groups, too, in which case one of those groups will be used.

The UNIX command for changing an owner — which must be entered by using the Terminal — is

```
chown owner filename
```

Of course, you need to be an administrative-level user to do this. To change the group, you use either of the following commands:

```
chgrp group filename
chown owner:group filename
```

The second controllable file permissions issue is who can do what with the file. The options are read, write, and execute (for a file) or search (for a directory). Each of these options can be specified for the owner, for the group, or for everyone. The options for a specific file are represented in the Terminal by a string of eight letters, as shown in the figure here. Starting from the left, the first letter represents owner write, and the string is read across in the following order: read, execute; group write, read, execute; and everyone write, read, execute. A w means writable, r means readable, and x means executable/searchable. A dash means that the permission isn’t granted, and an initial d indicates that the file is actually a directory.
In the figure, for example, the file `558129 ch20.doc` has read permissions for everyone and write permissions for `larry`. The owner is `larry`, who is part of the group `larry`.

Assuming that you have the permission to do so, you can change permissions by using `chmod`. The syntax is

```
chmod permissions file
```

The permissions are assigned by using a three-digit number (although they can also be adjusted by using an alphabetic system). The first of the three numbers represents the owner’s permission, the second is the group, and the third is everyone else (others). Each number is made by adding up the write permissions (worth 4), read permissions (2), and search/execute permissions (1). A file with 777 permissions is writable, readable, and executable by everyone. To give yourself write and read permissions and everyone else just read permissions on a file, use

```
chmod 622 filename
```

For more information on any of these tools, type `man chmod`, `man chgrp`, or `man chown` in the Terminal.

### The Spotlight Comments panel

Adding comments to files, folders, and applications has been part of the Mac operating system for years, although most people don’t use them much. Tiger has two features that can make them more useful: finding files by words in their comments with Spotlight and showing comments in a Finder window. As an example:

1. Select the file in the Finder.
2. Press `Ô-I` to bring up the Get Info panel.
3. Click the arrow for the Comments box if it isn’t currently pointing down.
4. In the box, type any comments that you want to add (see Figure 20-11).

![Figure 20-11: Add comments to a file by using the Get Info panel.](image)

5. Close the panel by clicking the red Close button in the upper-left corner.
6. Set your window to list view by clicking the icon in the toolbar or by pressing `Ô-1`.
7. Customize the window settings by choosing View ➪ Show View Options or by pressing `Ô-J`.
8. In the list of options, enable the Comments check box.
9. Close the View Options panel by pressing `Ô-J` or clicking the red Close button.

You should now see your comments in the Finder window (see Figure 20-12).

![Figure 20-12: With Tiger, you can show comments in the list view mode.](image)

You can use comments to remind yourself of the purpose or contents of a file. If a comment is too long to view in the window, hover your cursor over it to view the whole thing in a pop-up window.
5. Go ahead and delete the file as you normally would.

If you don’t want to see the confirmation prompt every time you go to empty the Trash, disable the Show Warning Before Emptying the Trash check box under the Finder’s Advanced preferences.

Ejecting stuck disk images

A somewhat common occurrence is that you can’t eject a disk image (whether a mounted hard drive, a CD-ROM, or whatever). This usually happens because Tiger thinks that the disk is currently in use. Even if you promise Tiger that it isn’t, your options are limited. Here are three good ways of solving the problem:

- Quit all open applications and try again.
- Log out and log back in by using the Apple menu or by pressing Ô-Shift-Q (but not by using Fast User Switching).
- Ignore the problem for now. The next time you reboot, you’ll be able to eject the image without issue.

A file can’t be deleted if it’s currently in use. This is almost always because the application that the file was being used in is still running (and the file itself might still be open). Close the file and application and try again.

Finding the original for an alias

If Tiger can’t find the original file that an alias refers to, it gives you a prompt (see Figure 20-13) with three options:

- Figure 20-13: The error prompt for when Tiger can’t find an alias’s original file.
Delete Alias: Obviously, this option gets rid of the alias, which fixes the problem.

Fix Alias: If you select what’s behind door number two, you are presented with a window (see Figure 20-14) so that you can select a new original for this alias.

- Figure 20-14: You can use this dialog to navigate to the file an alias should point to.

OK: If you click OK or press Return, nothing happens.

You can also select a new original for an alias (whether there’s a problem with it or not) by clicking the Select New Original button under the Get Info’s General panel (see Figure 20-15).

Sharing files with another OS

This technique isn’t really a problem-solver for Mac users — because Tiger is such a great operating system — but rather for those less fortunate souls not running Mac OS X. While sharing files on other operating systems (whether through a network or a disc), you can ease potential conflicts by abiding by these rules:

- Use filenames that are shorter than 32 characters in length.
- Stick to alphanumeric characters in a filename.
- Avoid using spaces in the filename. (Hint: Use an underscore instead.)
- Keep the file’s extension as part of the filename.

The last point is important because many operating systems used to or still do rely on a file’s extension to know what application should be used to open it.

- Figure 20-15: You can change the original for an alias by pulling up the Get Info panel while the alias is selected.
Regardless of how well you organize your stuff and how on top of things you stay, you inevitably go looking for something that you just can’t find. Old-school Mac users might be familiar with Sherlock (the file detective), and Panther users should know about the Find tool, but Tiger has taken looking for stuff to a whole new level. Tiger has done away with Sherlock and incorporated the Finder’s Find utility into a Finder window. On top of this, Tiger has added the truly amazing Spotlight utility and the ability to save searches as Smart Folders.

The most frequently used search method is the Search box, present in the Finder windows. This is an easy and fast way to locate what you need. On a more advanced level, you can use the Finder’s Find tool, which is an extension of the basic Finder window search. From there we unfold Smart Folders, which are saved searches, like Smart Playlists in iTunes. Next we introduce our latest love, Spotlight. Spotlight is to searching what the Great Wall of China is to decorative lawn edging.

**Basic Finder Window Searches**

For simple searches, you can’t beat the Finder windows. Although the search capability has been part of the Finder window for some time, Tiger has added some new features. The Search box, by default, appears in the upper-right corner of the Finder window (see Figure 21-1).
Use the Search box to perform a case-insensitive search on the names of the folders, files, and applications located on your hard drives. The Finder window search turns up any match found anywhere in a name. For example, searching for cat brings up files such as Catalog.pdf, subcat.php, or Pictures of My Cats. Even better, the search returns documents with the word cat (or variations of it) in them!

2. If you see the file that you’re looking for before the search is finished, click the Stop button (which bears an X) in the lower-right corner of the window to stop the search.

While the Finder continues its search, it shows the results in the top panel and the status in the bottom of the window.

A new feature in Tiger is that search results are now grouped by kind. So all the AppleScripts that match the search are grouped together, as are all the images, applications, and so forth. To hide any kind of group, just click the triangle next to the group name.

3. To cancel the search, click the Stop button (the X) in the Search box.

Clicking the Stop button in the Search box stops the search, wipes out any results, and returns the Finder window to its previous directory.

4. After the search is completed or you’ve stopped it, scroll through the results to see which files matched the search (see Figure 21-3).

The Finder instantly begins searching your hard drive. Even so, you can continue to type in the full file or folder name.

• Figure 21-2: If the Search box disappears, you can retrieve it with the double arrows.

To use the Search box:

1. Click in the Search box and begin typing the name of the file or folder that you want to locate.

Alternatively, you can use the Ô-Option-F keyboard shortcut to select the Search box.

If you don’t have a Search box in your window’s toolbar, you can customize the toolbar to add it (see Technique 12). If the current window doesn’t have a toolbar at all, choose View ➪ Show Toolbar.

The Finder instantly begins searching your hard drive. Even so, you can continue to type in the full file or folder name.

• Figure 21-3: The search results, organized by file type.

Attempting to scroll through the search results, let alone open one of these files, while the search is still going is a pain because the window and its contents keep changing. We
Technique 21: Finding Things in Tiger

Recommend either stopping the search if you see what you were looking for or waiting for it to complete.

When it comes time to review the search results, keep these tips in mind:

- To limit your search to a specific area, click the labels at the top of the results window (see Figure 21-4). By default, you can search in three areas: Servers, Computer, and Home. If you store all your stuff within your Home directory (as you should be doing), clicking the Home button should appropriately limit your search.

- To find out more about a particular result, click it once to select it. You see the item’s location — called its path — at the bottom of the search window.

- To get more information about most items, click the Get Info icon on the right side of the window (see Figure 21-5). The Get Info icon is the light blue circle with a lowercase i in it. You’ll see these along the right side of window. Alternatively, if you’ve added a Get Info option to your window’s toolbar (see the solid blue circle with the white i at the top of the window), you can click it.

- To see a slideshow of the matching images, click the Play icon in the Images bar.

- Image results can be listed in either icon or list view, by using the buttons in the Images title bar.

- Open any file, application, image, or what-have-you by double-clicking it.

- If you didn’t find the file you want, try a different search term or use the Find window for a more advanced search.

You can also further alter your searches by clicking the plus symbol to the right of the Save button. This lets you add criteria to your searches, turning this into a more formal Find, which you discover more about if you keep reading.

Using a Find Window

For more sophisticated searches, use Finder’s built-in Find command. This has replaced Sherlock’s Find Files feature (if you used Macs that far back). It’s accessible by using the universal Ô-F keyboard shortcut or by choosing File→Find in the Finder. Find in Tiger just takes the simple window search several steps further.

The Find tool lets you establish multiple parameters for your search beyond just the file’s name or its
contents. You can even use ranges and conditionals with many of the parameters, greatly expanding the possibilities.

For starters, use the row of locations at the top to choose what parts of the computer should be searched (see Figure 21-6). By default, your options are

- **Figure 21-6: The Find Finder window.**

  - **Servers:** Includes all mounted volumes, such as CD-ROMs and even mounted servers.
  - **Computer:** Includes all the hard drives on the computer.
  - **Home:** This, sensibly enough, is just your Home Directory.

If you don’t specify an area to search, Tiger searches every place it can think of. You can limit your search to a specific folder by navigating to that folder and then pressing Ô-F. That folder is then listed as an option label at the top of the Find window.

Underneath the search locations are parameters you can set. By default, the Find window opens with two default parameters. You can easily add more by clicking the plus sign or subtract one by clicking the minus sign. For each item, you use the drop-down list to select your first criteria. Then, more drop-down lists or text boxes appear, letting you add more details to that search (for example, a part of a name or a range for a date).

The available criteria include

- **Kind:** The Kind drop-down list lets you limit the search to whether the file is of a certain type. The list of types is alias, application, folder, document, sound (audio file), image, or movie.

  - The second Kind menu lets you choose specific kinds of items: documents, images, PDFs, music, and so on. It also has an Others option, where you can specify very particular kinds, like an alias, a Photoshop gradient, or an iCal To-Do item. These options are based on the kinds of files and information found on your Mac.

- **Last Opened, Date Modified, or Date Created Dates:** If you have a sense of one of these three dates as they relate to the desired item, this is a great way to locate it. In the Find tool, you can use

  - The first drop-down list to select which date you want to work with
  - The second list to decide whether the file should have a specific date or fall within a range
  - Use the third list (if given the option) for setting that range

Using dates, you can search for a file whose relevant date is

  - Today
  - Within a certain time period relative to today (see Figure 21-7)
  - Before a particular date
  - After a particular date
  - On a particular date

- **Keywords:** Keywords are what’s known as *metadata*, information used to describe a thing. A keyword might be *Image* or *Document*.

- **Label:** If you use the Labels feature, you can also search over whether the file has a particular label. See Technique 11 for more.
choose megabytes or gigabytes from the third menu that appears.

**Other:** This might be the most specific option you can choose, but you have to really know what you’re looking for to use it. When you select Other, a sheet appears with a vast list of criteria (see Figure 21-9). From here you can factor in such things as: the number of pages in a document; the ISO speed that was used to take a digital image with a camera; or a specific font. Note that this Other is different from the Other in the Kind drop-down list, which lists different kinds of files, not their properties like this Other does.

> • Figure 21-8: The drop-down lists let you further limit a search.

**Filename:** Unlike the window Search box, the Name text box gives you the secondary option of selecting whether the entered text should start, end, exactly match, or simply be in a matched filename (see Figure 21-8). With this, you can more effectively fine-tune the returned results.

> • Figure 21-7: The date drop-down lists are very flexible, allowing you to specify dates or a range.

**Contents:** The Find by Contents feature searches through the contents of a file (for example, a Word document, a plain text file, or even an HTML page) for matching text. This is clearly the most exhaustive search that you can execute.

**Size:** If you know the approximate size of the item in question, you can add a *size is greater than* or *size is less than* search criterion. Unfortunately, you can’t add two size options at the same time to create a range of acceptable values. The size text box is listed in kilobytes but you can also

Because Other offers so many search attributes, you can literally search the Other search list! Use the Search box in the upper-right corner of the Other sheet to quicken the hunt. Mark any Other criteria as a favorite and it's a quick option in your list of search criteria.

The following section shows an example of a Find search, which you then save as a Smart Folder.

**Working With Smart Folders**

All in all, Tiger is a whole lot *smarter* than Panther. You now have Smart Mailboxes and Smart Albums and Smart Groups (in the Address Book) and, in the
Finder, Smart Folders. Like anything else that’s “Smart,” the premise is that you save a set of criteria as the definition of that folder’s contents. As the stuff on your computer changes, the contents of this folder are dynamically updated to represent the current status.

Pay attention to this little detail: Smart Folders contain aliases to stuff that’s located elsewhere on your computer. It doesn’t contain the actual stuff. So, if a Smart Folder tracks images of a certain size, the images that fit the size range appear in the Smart Folder, but those are just aliases. You still find the real images in their original location on the computer.

Smart Folders are just saved searches, so this example shows you how to create a Smart Folder that lists the most recently viewed Microsoft Office documents:

1. Open a Find window by either pressing Æ-F in the Finder or choosing File ➪ Find.
2. Click the Home button at the top of the window to narrow the search.
3. For the first criteria, select Kind and then Documents from the second list (see Figure 21-10).
   You could also select Other from the second list and then specify a document type, such as Microsoft Word document.
4. For the second criteria, select Last Opened from the first list and select This Week from the second list.
5. Click Save.
6. At the prompt (see Figure 21-11), save the search by taking the following actions:
   a. Give it an appropriate name.
   b. Save it where it makes the most sense.
   c. Decide whether you want this Smart Folder in your Sidebar.
7. To change the criteria for a Smart Folder, open it in the Finder, and then click the Edit button.
Searching for Things with Spotlight

The final tool we cover for performing searches is also new to Tiger: Spotlight. Spotlight has a number of benefits over a simple Finder search. It

✓ Searches through your e-mail
✓ Searches through your Address Book
✓ Scours your iCal calendars
✓ Finds matches based upon songs in your iTunes library
✓ Is always available no matter what application you’re in

The Spotlight tool is accessible through the little blue magnifying glass in the upper-right corner of your display (at the end of the menu bar). But enough talk. Start using it!

1. Click the Spotlight icon.
2. Enter a term (or terms) in the Spotlight Search box (see Figure 21-12).
3. Assuming you found what you were looking for, you now have two options:
   ▶ Quickly selecting it by clicking the item in the list.
   ▶ Clicking the Show All link to bring up the Spotlight results window (see Figure 21-13).
4. The next time you click Spotlight, the previous results are still there, so click the X to clear them.

It’s really that simple! But you can improve upon your Spotlight success by doing these things:

✓ Memorize the two keyboard shortcuts to quickly access Spotlight. By default, you can launch and access Spotlight by pressing Ô-Space. You can go straight to the Show All search results window by using Ô-Option-Space.

✓ Open the Spotlight preference panel and customize its behavior. You can open Spotlight Preferences by choosing this last item from the basic search results window. You can also access it by going to the Spotlight System Preferences panel. If you don’t want Spotlight searching for certain things (such as Applications, Movies, or System Preferences), deselect the appropriate check boxes here to exclude those items from searches (see Figure 21-14).

✓ Change the Spotlight keyboard shortcut if it conflicts with exiting software. Third-party launching tools, like QuickSilver and LaunchBar, use the Ô-Space keyboard shortcut. If you use an application that already looks for Ô-Space, change the assigned shortcut either in that application or for Spotlight, again using the System Preferences panel.
Restrict Spotlight access to specific directories by using the Privacy pane. Also under Spotlight’s System Preferences (see Figure 21-14) is a section where you can tell Spotlight what folders it shouldn’t search. If you don’t want items in certain directories showing up in searches, don’t give Spotlight that option.

Alter search criteria in the Show All search results box. The Spotlight search results are displayed by group, as they are in a Finder window search. By using the labels on the right side of the screen, you can further adjust the search results (see Figure 21-13).

• Figure 21-13: View every item that applies to your search by clicking the Show All link.

• Figure 21-14: Customize Spotlight’s search behavior by using the System Preferences panel.
Slimming Down Your Hard Drive

Save Time By
- Avoiding installing unnecessary applications
- Deleting junk from your hard drive manually
- Using third-party applications to remove the deadweight
- Understanding what not to throw away

It never fails to happen: All that extra space you thought you’d never fill up is suddenly gone. Sadly, that’s just as true whether you’re talking about a new house, apartment, or that 60GB hard drive that you believed would allow you to download the whole Internet to your computer. Eventually, the time comes to either clean house or upgrade.

Knowing what you can get rid of and how to do it saves you the time and expense of upgrading a hard drive (and makes your computer perform slightly better). This begins with doing nothing: that is, not installing applications and files that you won’t use. After that, you need to look at getting rid of the files on your hard drive that you no longer need. You can do this manually with a little prudent knowledge. Third-party applications are also available to help you remove the hidden system files you no longer need. Finally, we send up some warning flares to remind you of the things that you absolutely, positively shouldn’t get rid of.

Avoiding Unnecessary Installations

During the Tiger installation process, you can customize your installation so that only the features you need are installed. A new Tiger installation can take anywhere from a few hundred megabytes to multiple gigabytes.

Because you can’t easily uninstall parts of Tiger, you’re better off not installing them in the first place — assuming you won’t need them, that is. The worst offenders, in terms of hard drive space, are

Printer drivers: Tiger supports many common printers — which is great — but it does so at a huge cost of hard drive space. Installing all the printer drivers would take nearly 1GB. This is definitely one area where you should use some judgment about what to install and what to leave out. Three good options are

- If you don’t have a printer, don’t install any printer drivers.
- If you have a printer, see whether the manufacturer provides a driver for your specific model by checking the support, software, or
drivers section of its Web site. That driver might be only a few megabytes in size and therefore much smaller than the one-size-fits-all driver provided by Apple for that manufacturer’s printers.

- If the printer manufacturer doesn’t provide a driver for your specific model, install only the drivers for your make of printer.

Language Translations: Language Translations allow your Mac to display system controls (menus and such) in languages other than English. Although it’s great that Apple recognizes the global, multilingual community, if all the people using your computer speak the same language, avoid Language Translations. These take 400 or more megabytes.

Fonts: Tiger can install fonts for you to use a dozen non–Indo-European languages with your Mac. These fonts enable you to read Japanese, Chinese, Korean, and other languages in your applications. Naturally, if you don’t see that happening, you don’t need to install these fonts.

Be prudent when installing applications. Most installers give you the option of customizing the installation process (as Photoshop does in Figure 22-1) so that unnecessary pieces don’t clutter up your computer. As a general rule, hard drive-hogging applications — for example, Adobe Photoshop or Apple’s Final Cut Pro — give you more flexibility to customize installation.

Many installers, including Tiger, allow you to dictate what gets installed. If you won’t use something, don’t install it. If you later realize that you need something you didn’t install, you can always add it by running the installer again.

As a general rule, Mac OS X doesn’t use uninstallers for the operating system or for individual applications. Thus, after you’ve installed the junk . . . er, files . . . on your computer and realize that you no longer need them, you must delete them manually. You might want to do some judicious weeding in these four general areas: your Home folder, the Applications folder, the System folder, and other disk drives and partitions.

Use Ô-Delete to send a selected item (or items) to the Trash.

Back up the contents of your computer before going hog-wild deleting items that you believe to be unnecessary. A good backup makes restoring items a snap if you inadvertently delete something important in your housecleaning frenzy. See Technique 49 for everything you need to know about backups.
Technique 22: Slimming Down Your Hard Drive

Pruning your Home directory

Your Home directory is where you’re most likely to get rid of extraneous stuff. Fortunately for you, it’s generally the safest place to make cuts as well. Here’s what you can do:

- Clean up the contents of your Desktop folder.
- Delete anything that you no longer want in the Documents folder.
- Free up some space in the Movies, Music, and Pictures folders.

If you actively use iPhoto, your Home directory can quickly fill up with pictures. When you have 650MB or more of photos, burn a CD (or two, for safe keeping) of your albums, and then delete these files from your hard drive to save space.

- Get rid of anything that you don’t want in the Public folder unless it’s still needed by others on your computer or network.
- Remove files from the Sites directory. The Sites directory is where you store Web pages. These directories become easily cluttered with old versions of files. Remove them to save some room here and there.

If the contents of the Movies, Music, or Pictures folders are managed by iMovie, iTunes, or iPhoto, you’ll be better off deleting these files from within those applications because they have associations with the physical files.

The archive alternative

If you like the idea of keeping all your stuff on your Mac but don’t like how much space it requires, try archiving old files. Any file that you don’t access frequently but still want kept around can be compressed by using the Finder’s Create Archive tool (under the File menu). If you later need to access an archived file, double-clicking the archive expands it for you.

Although an archive can cut down on the amount of space a file takes up, it won’t work on every type of file. Specifically, PDFs, movies, and some image types are not compressible.

Thinning out no-longer-required applications

Applications can take up a huge amount of space on your computer. If you’re actually using the applications, it’s no big deal. But after you’ve stopped playing a certain game or found a better alternative to an application, you might want to get rid of it. Because you normally won’t find an uninstaller for an application, here are the steps to take:

1. Locate the application’s file or folder within the Applications directory.

Simple applications are wrapped in a single icon, which can be deleted (such as Internet Explorer). More involved applications have their own folders (for example, Netscape Navigator).

2. Move the file or folder to a temporary location.

Instead of deleting the files immediately, we recommend temporarily setting them aside as a just-in-case measure. You can either

- Create a folder on the Desktop for this purpose.
- Move them onto an external driver or CD.

3. Open the Library folder of your Home directory.

If you really want to clean house, get rid of the corresponding application stuff that was placed within your directory. This includes supporting materials and preferences.

4. Check these folders folder for files associated with the application and move any applicable items to the temporary folder:

- **Application Support**: Only a few applications have files here, but if you want to be thorough, it’s worth checking out.
- **Preferences**: Pretty much every application adds at least one file to your Preferences folder. Although these files are small, they’re still worth getting rid of.
5. Wait a few days. Then, if you don’t see any problems caused by moving these files, delete the temporary folder.

A fast way to max out your hard drive is to perpetually download and install demos and shareware. Game demos are particularly large. Personally, we don’t install shareware or demos of applications that we don’t reasonably expect to buy. Doing so only wastes time and clutters up the hard drive.

If you installed an application, you should be able to safely remove it. Applications installed by Tiger shouldn’t be messed with. This includes items in the Applications folder such as System Preferences and Internet Connect.

Cleaning out your System and Library folders

If you check out the size of your system files, stored both in the Library and the System folders, you’ll see that they take up a lot of space (in Figure 22-2). That being said, you don’t want to go traipsing through there to remove files. The reward for clearing up some room is normally slight, but the risk that you take will be grave. As the worst case, you would trash something that renders your computer inoperable. For the most part, you’re better off leaving these files alone.

Some applications also store resources in the /Library/Application Support folder. Although you need to be extra careful when deleting stuff from this directory, doing so can pay off. For example, GarageBand—which we love having but rarely play with—takes up 55MB for the application itself and 2.1GB (!!!) for sound files in the /Library/Application Support folder.

However, here’s one thing that you can do with system files: If you performed an Archive and Install installation of Tiger, the installer creates a Previous Systems folder to store the old system files. If everything’s running okay with the new operating system, you can delete this entire folder.

• Figure 22-2: A minimal installation of Tiger can put at least 1GB of files in the System folder.

Don’t remove anything (anything!) from the System or the Library folders unless you really, really know what you’re doing and have backed up the entire computer.

Cleaning other volumes

Some computer users have already established multiple volumes for their computer. This is accomplished by either

☑ Installing extra hard drives
☑ Partitioning larger hard drives into separate volumes

If you’ve done this, you’re probably using the other volumes purely for storage purposes (because the main volume is running the operating system and should have your Home directory). Your other volumes, therefore, are a good place to get rid of no-longer-needed files.
Technique 22: Slimming Down Your Hard Drive

OmniDiskSweeper, by the good people at the Omni Group (www.omnigroup.com, $15), offers a good bang for very little buck. It basically replicates the process of going through the Finder and removing large files but gives you a nicer interface. It also warns you about deleting potentially critical files.

mrclean (http://arcobaleno2001.interfree.it, free) searches your computer for duplicate files (based on filename, file size, type, and so on). Often these are sizable documents such as MP3s, images, and movies.

Be certain to check out the utilities that Technique 54 lists. Besides performing routine maintenance, many help with disk bloat by weeding out hard-to-find system files and logs.

Hands Off: What Not to Trash

You might be the type who’ll gladly spend a day tinkering just to clear up a little space, but here are some rules that you should never break:

- Don’t delete or rename the Applications or Utilities folders.
- Don’t delete or rename your Home folder.
- Don’t delete or rename the Desktop or Library folders in your Home directory.
- Don’t touch the System or Library folders.

The consequences of doing one of the mentioned Don’ts range from an inability to launch an application, to an inability to login, to an inability to boot into your Mac! Do you want to take that risk? We thought not.

Classic and OS 9

If you’re still running Classic or dual-booting into OS 9 (gasp!), you can trim down files particular to that operating system. Some considerations include the following:

- Drop OS 9 applications for which there are good OS X alternatives. There’s no reason to keep two applications that do the same thing.
- If you’re using Classic, there are many system extensions that you won’t be using. For example, if you won’t be using QuickTime or a printer within Classic, you can drop many megabytes of deadwood. Getting rid of these saves space and makes Classic launch faster.
- Keep all your files within your OS X Home directory. You can still access them from OS 9.
- Best of all, get rid of OS 9 and Classic as soon as possible, and then delete all those files!

Diet Tools: Third-Party Applications

If you’d rather spend your weekend cleaning the attic and not your hard drive, you can invest in one of many third-party applications that facilitate the process. (The process of cleaning up your hard drive, that is. You’re on your own when it comes to cleaning up the attic.) In truth, these applications make more of a quantitative than a qualitative decision. Whereas you might know that you no longer need a particular document or no longer like a particular song (an MP3 file), the following tools earmark files whose size and lack of use might merit removal:
Part IV

Improving Application Performance

The 5th Wave  By Rich Tennant

AFTER INSTALLING OSX 10.2, NED AND LORETTA SELECT THE COMPUTER'S BACKGROUND

“Oh—I like this background much better than the basement.”
Launching Applications Fast

You might think that opening (or launching, starting, or however you want to say it) an application is so simple that you couldn’t possibly improve on it. But surprisingly, you can use many techniques and tools to improve on this common procedure. Putting some time and effort into mastering the easiest ways to open applications goes a long way toward expediting how you use your computer.

The first timesaving technique is to have Tiger automatically open an application when you log in to the computer. Then we go over the multitude of ways you can launch applications (such as from the Finder or Dock), some of which you probably already know. Finally, you read about a couple shareware tools designed to open applications in faster ways.

Auto-Launching with the Accounts Panel

The Accounts panel, which is part of your System Preferences, does more than just allow you to manage the computer’s users. You can also pop open the Accounts panel to adjust some of the computer’s behavior for their accounts. The relevant subsection for opening applications is the Login Items panel. Follow these steps to access it:

1. **Select System Preferences from the Apple menu.**
   This opens the System Preferences application.

2. **Click Accounts under the System heading.**
   This opens the Accounts panel, where you want to be.

3. **Click your account in the left column of the Accounts panel to select it.**

4. **Click the Login Items tab (see Figure 23-1).**
Technique 2 includes a brief introduction to using Login Items. Because it’s such a useful idea, we cover it again, and more thoroughly, here.

To make a program launch automatically when you log in to your computer, add it to the Login Items list. You can add items to the Login Items list in two ways:

- The slow way:
  1. Click the plus button at the bottom of the panel to access an Open dialog.
  2. Navigate to the application you want to add and select it (see Figure 23-2).
  3. Click the Add button or press Return.

- Drag an application’s icon from its folder onto the Login Items panel.

The quickest way to add applications to the Login Items panel is to drag them there from the Finder.

After you add an item to this listing, you can choose to have it open in hidden mode by marking the check box next to its name (as shown in Figure 23-3). Hiding a Login Item just means that the application will be hidden when you log in. Essentially, it will be as if you opened the application and then selected Hide Application from the application menu. This is a good option for behind-the-scenes utilities that you don’t need to be aware of.
To remove an application from the Login Items panel, you have only one method:

1. Select the item in the list by clicking it.
2. Click the minus button at the bottom of the window to remove the item.

You might be wondering, “How do I decide what applications to automatically start?” The answer to this depends on what kind of computer you have and how you use it.

If you have a laptop, you probably don’t want to overdo it with Login Items. But most Mac users will benefit from these rules:

- Add utilities and shareware that provide perpetually necessary services (for example, LaunchBar or system clock replacements).
- Add applications that you’ll always use first thing on your computer (such as Mail or Eudora).
- If you set your e-mail client to open first and you have an always-on Internet connection (cable, DSL, whatever), your Mac can download your e-mail while it’s continuing to open other applications. When all is said and done, your apps will be up and your mail will be waiting for you.
- Include applications that you use every day (like Safari or iTunes).
- Add utilities that you should run on a daily basis (maybe Virex or Backup).
- Add applications that take a long time to load (like Photoshop) if there’s a good chance you’ll use them on a nearly daily basis.

Many applications, such as Virex, have options within their preferences panels (see Figure 23-4) that have a similar effect to adding the application to the Accounts panel Login Items listing. Use the preferences panel to add these to your Login Items list (because, in this particular case, the item being added is the VirexLogin utility, not Virex itself).

Launching with the Finder

Even though you can launch applications in the Finder, knowing all your options can go a long way toward speeding up this very common task.

- The fastest way to open an application is to never shut it down. Because of how Mac OS X handles memory, you’ll notice very little performance loss by keeping applications open, and you’ll never have to wait for the application to launch again.

The most common (but not necessarily the most convenient) way of opening an application is to use Finder windows. You can either

- Navigate your way to the Applications directory.
- Set up your preferences so that the Applications folder is automatically listed in the Finder window’s left-side section (see Figure 23-5).
You can launch an application by opening a file that uses that application as its default, by dragging the file onto the application's icon, or by using the contextual menu’s Open With prompt. We go into great detail about ways to open files in Technique 25.

Here’s a common sequence for easily opening an application by using only the keyboard:

1. Navigate to the Finder by pressing  
2. Press  
3. Type the first few letters of the application’s name to highlight it.
4. If necessary, press Tab to go to the next application (if it wasn’t highlighted in Step 3).
5. If you need to open the application’s folder, press  (in icon view mode) or  (in list and column view modes).
6. After you select the application, press  to open it.

**Launching with the Dock**

The Dock can serve many purposes (such as linking files and folders or displaying the Trash), but the left side of the Dock is strictly for your applications. This area is where open applications reside (flagged by an upward-pointing triangle, as shown in Figure 23-7), as well as any other application that can be permanently linked there.

![Dock indicating open applications](image_url)
Here are two things to consider with respect to applications and your Dock:

- What applications to dock there
- How best to arrange the docked items

As a general rule, dock every application that you use on a frequent basis. Considering all the ways you have to access applications, making sure the right applications are docked should be obvious to you. What’s more important is the organization scheme you choose. Larry prefers to organize his Dock this way, as shown in Figure 23-8:

- Figure 23–8: Larry’s Dock (in case you’re curious).

- Keep perpetually running, but infrequently accessed, utilities on the far left.
- Keep applications with similar uses grouped together (such as Web development tools or multimedia software).
- Place the applications that you use most often as close to the middle of the Dock as possible.
- Items in the center of the Dock seem to have a more stable location. When the Dock expands and contracts, these items move around less on your screen.

Marc has the following suggestions (see Figure 23-9):

- Figure 23–9: Marc’s Dock.

- Dock a select few items that are always running, such as System Preferences, CPU Monitor, and LaunchBar.
- Dock the essential iApps from Apple: Safari, iCal (whose Dock icon also reminds you of today’s date when the application is open), Mail, and Address Book.
- Add the productivity applications, depending on what kind of work you do with your Mac. Because Marc is a software engineer, the productivity applications that he uses most often are the Terminal, BBEdit, Xcode, and so forth. If you’re a graphic designer, you’d probably have things like Photoshop, Illustrator, or InDesign here instead. If you’re working with the bread-and-butter applications, it’s the place for Word, Excel, PowerPoint, and so on.
- Dock entertainment applications, such as iPhoto, iTunes, and iChat.

Marc’s main goal is to have stable positions for the items that he needs to reach most often. After a while, you get a feeling for where in the Dock a particular application is located, and you can find it instinctively with the mouse, just like menu items on the menu bar.

Here’s what you need to know about working with the Dock:

- To dock an item, drag its icon to the Dock from the Finder.
- When you do so, the other Dock items make way for their new roommate.
- To remove any Dock item — particularly all those that Apple installs there by default — drag its icon off the Dock (while it isn’t running).
- You can add any currently running application to the Dock by dragging its icon from one location to another or by Control-clicking the Dock icon and selecting the Keep in Dock option from its contextual menu.
- The Finder icon will always be on the far-left side of the Dock. It can’t be moved nor removed. The same applies to the Trash on the far right.
- Running applications that aren’t always part of your Dock will be added to the right side of the Dock.

If you remove an icon from the Dock while the application is running, the item will be removed from its permanent location in the Dock even though it will look like it’s still there (because it’s running).
**Other Ways to Launch Applications**

Although the Finder and the Dock are the most frequently used way of launching applications, they certainly aren’t your only options. Favorites, aliases, and Recent Items are all timesavers for this task.

**Favorites and aliases**

Another way to launch your applications is to create aliases of them and place those aliases in convenient locations. This is the principle behind Favorites, a feature worth using. (Check out Technique 17 for coverage of Favorites and aliases.)

If you add a slew of applications (perhaps organized by purpose) to your Favorites, you can then dock your Favorites folder and quickly launch these apps (see Figure 23-10).

**Recent Items**

After you close an application, you can reopen it from the Recent Items submenu under the Apple menu (see Figure 23-11). To adjust how many items are listed here, use the Appearance panel under System Preferences.

**Launching with Shareware Tools**

Many third-party applications exist explicitly for the purpose of launching other applications.

LaunchBar ([www.obdev.at/products/launchbar](http://www.obdev.at/products/launchbar), $20 for personal use, free for limited use) is a utility designed to always run on your computer. The first time it runs, it logs every application on your hard drive (along with your files, Safari bookmarks, Address Book contacts, and more). To launch an application, you simply

1. Press ⌘-spacebar to bring up LaunchBar.

   ⌘-spacebar is also set to launch Spotlight. If you’ve changed the LaunchBar shortcut, use your new one instead.
2. Type the keyboard shortcut for the application in question (what you type will appear in the LaunchBar prompt).

For example:
- M for Mail
- ME for Microsoft Excel
- S for Safari
- BB for BBEdit
- PH for Photoshop

3. Select the application that you want to launch from the list if it isn’t already highlighted (see Figure 23-12).

4. Press Return to launch the application.

- Figure 23-12: LaunchBar presents a list of potential candidates.

### Alternative launching utilities

Here are some popular alternatives to LaunchBar that offer similar functionality. Although we adore LaunchBar, you might appreciate the lower price (sometimes free) and different feature sets of these applications.

- **HimmelBar** (http://softbend.free.fr/himmelbar/index.html, donationware) creates a menu bar icon that provides customizable lists. With it, you can access applications and more without going through Finder windows.

- **Quicksilver** (http://quicksilver.blacktree.com, free), like LaunchBar, provides keystroke access to applications and other things on your Mac.

- **XBar** (http://macosx.syr.edu/spottedsoftware/XBar.html, free) is like a mini-Dock whose sole purpose is to launch applications.

- **DragThing** (www.dragthing.com, $29) also duplicates the Dock but on a very advanced level, letting you create multiple, customized Docks so that each can serve a different purpose (like list a different set or category of applications).

- **Namely** (http://homepage.mac.com/asagoo/namely/index.html, free) is like a more minimal version of LaunchBar, letting you launch applications by entering very simple abbreviations.

- **F10 Launch Studio** (http://chronosnet.com, $29) is strictly an application-launching utility but automatically finds your applications and has a beautiful interface.
24 Technique

Switching among Open Applications

Understanding how to launch applications (see Technique 23) is useful — but still something you’ll probably do only once a day per application. You’ll probably spend a lot more time switching among open applications, hiding them, and (when the time is right) quitting them.

In this technique, we take you through the best, fastest, and easiest ways to work with your open applications. We begin with switching: how to effectively toggle from one application to another. After that, we quickly address hiding open applications (which overlaps a bit with switching) and quitting them.

Switching among Open Applications

Because you’ll probably have about a half-dozen applications open at all times, being able to quickly switch from one to another is a critical skill to master. Several methods for application switching are built into the operating system, and you can also make use of third-party tools to expand the possibilities.

Switching apps with Tiger

Perhaps the best way to switch from one open application to another is to use the ⌘-Tab keyboard technique. We cover this in other techniques, but it bears repeating:

1. Press and hold down the ⌘ key.
2. While continuing to hold down the ⌘ key, press the Tab key once to bring up the list of open applications (as shown in Figure 24-1).

• Figure 24-1: Pressing ⌘-Tab presents you with a list of open applications.
3. Continue holding down the ⌘ key and tab to the application you want:
   - Press Tab to sequentially highlight each open application (they’ll be in order of most recently on down). Each time you press Tab, the next application is selected.

   In Figure 24-2, the Finder is highlighted.

   ![Figure 24-2: The currently highlighted icon is surrounded by a white border and displays its name beneath it.]

Using the ⌘-Tab technique cycles through the open applications in the order of most recent usage. The application that you were using before the current, active one is highlighted first . . . then the one before that and so forth. If you just want to switch back and forth between two applications, quickly press and release ⌘-Tab once.

   - To select an application in reverse order, press Shift-Tab.

4. After you highlight the application that you want to switch to, release the ⌘ key to make it active.

To abort the application switching, press the Escape key at any time while still holding down the ⌘ key.

Mac OS X also has a nice variation on the ⌘-Tab trick that uses the mouse.

   1. Press and hold the ⌘ key.
   2. While continuing to hold down the ⌘ key, press the Tab key once to bring up the list of open applications.
   3. While still holding down the ⌘ key, move your cursor over the application that you want to switch to (it’s highlighted).

4. Release the ⌘ key to make that application active.

   Use the cursor with ⌘-Tab to quickly access another application. If you have a dozen or so applications open, this might be faster than continuing to press Tab until you reach a more latent app.

Alternatively, these keyboard shortcuts work after you press ⌘-Tab once, while continuing to hold the ⌘ key:

   ✓ Press the End key to go to the last item.
   ✓ Press the Home key to go to the first item.
   ✓ Press the tilde (~) to go backwards (same as ⌘-Shift-Tab).

The other preferred method for switching among open applications is to use Exposé. Technique 15 covers this tool in detail, but here’s what you really need to know:

   ✓ Exposé shows all the windows (either documents or Finder windows) for every open and unhidden application with just one keystroke combination or hot corner. (The keystroke or hot corner varies, depending on how you’ve set your preferences.)
   ✓ Exposé shows all the windows for the currently active application with a different keystroke and hot corner.
   ✓ A third key combination or hot corner takes you to the Desktop.
   ✓ A fourth key combination shows you the Dashboard (see Technique 15).

Although Exposé focuses on windows and documents, it can easily be used to switch from one application to another. Just do this:

   1. Trigger Exposé by using the key combination or hot corner to bring up every non-hidden document or window (see Figure 24-3).
By using the mouse, two other easy ways to switch from the current application to another are available:

- Click the second application’s icon in the Dock.
- Click a visible window (for example, a document) in the second application.

### Switching apps with shareware

If you want validation that switching among open applications is a critical concept, just look at the number and variety of third-party applications designed for this very purpose. A quick search on VersionTracker reveals many utilities, such as LiteSwitch X ([www.proteron.com/liteswitchx](http://www.proteron.com/liteswitchx), $15).

The following applications aren’t necessarily switchers. They’re actually advanced launching tools that allow you to assign keys to open particular applications. Because of this, they can also be used to switch to another application:

- **LaunchBar** ([www.obdev.at/products/launchbar](http://www.obdev.at/products/launchbar), $20 for personal use, free for limited use)
- **DragThing** ([www.dragthing.com](http://www.dragthing.com), $29)
- **Keyboard Maestro** ([www.keyboardmaestro.com](http://www.keyboardmaestro.com); free for the Lite version, $20 for the full)
- **QuicKeys** ([www.cesoft.com](http://www.cesoft.com), $100)

We discuss these programs and others, particularly LaunchBar, in more detail in Technique 23 and elsewhere in the book. Google or VersionTracker turn up many launching and switching applications for your consideration.

### Hiding Applications

Being able to hide an application is a more important concept than you might initially think. Hiding or minimizing an application that you’re temporarily not using makes for a less cluttered Mac, which makes you more productive.
Hidden applications appear in the Ô-Tab application listing but not in Exposé.

Here are several ways to hide active applications:

- While the application is active, press Ô-H. This works for most, but not all, applications.
- While the application is active, choose Hide ApplicationName from the application’s menu (see Figure 24-5).

![](image1)

- Figure 24-5: Every application should have a Hide option.

- While in any application, click and hold on another application’s Dock icon (see the BBEdit icon in Figure 24-6). Then choose Hide from the contextual menu that appears.
- While in most applications, press Ô-Option-H to hide every other application. You can also hide every other application by using the Hide Others option in the application menu (refer to Figure 24-5). Hiding every application but the currently active one really cleans up your screen. It’s very helpful when your active application has a lot going on (like many windows, palettes, and documents).

![](image2)

- Figure 24-6: You can hide applications that aren’t even active just by using the Dock.

- If you’re switching to another application, you can hide the application that you’re currently in by holding down the Option key while clicking the second application’s Dock icon or document window. If you hold down both the Ô and Option keys while clicking, every other application is hidden.

- Press and hold down the Ô-Option keys while clicking the Desktop or the Finder icon in the Dock to go to the Finder and hide every other application.

You can also hide an application by using the Ô-Tab switching technique:

1. **Hold down theÔ key and press Tab once to activate the switcher.**
2. **Highlight the target application with one of these actions:**
   - While still holding down theÔ key, press Tab (or press Shift-Tab) until the target application is highlighted.
   - Put the cursor over the icon.
3. **While still holding down theÔ key, press H.**
4. **Release theÔ and H keys simultaneously.**
Quitting Applications

You might be thinking, “Why do I need to read about quitting applications? I know how to do that.” Although you probably know at least one way to quit your applications, you might not know the easiest or best way. Here’s a quick rundown of your options:

- While the application is active, press ⌘-Q.
- While the application is active, choose Quit from the application’s menu.
- While in any application, click and hold the application’s Dock icon (see Figure 24-7). Choose Quit from the contextual menu that appears.

Logging Out and Shutting Down

The most drastic way to quit every application is to log out, restart, or shut down your computer. If you choose one of these options, Tiger automatically closes every open application, assuming you don’t have unsaved documents still open.

- Press ⌘-Shift-Q logs you out but asks you for confirmation (see Figure 24-8).
- Pressing ⌘-Option-Shift-Q logs you out without asking for confirmation.

If you log out with Fast User Switching, all your applications remain open.

Force-Quitting

If an application is stuck, quitting it the usual way simply won’t work. Instead, you need to use Force Quit. You can force-quit an application in either of two ways:

- Press ⌘-Option-Escape to bring up the Force Quit window.
- Choose Relaunch from the contextual menu. You can bring up the contextual menu either by holding Option-Control and clicking the Dock icon or by holding the Dock icon and pressing the Option key.

Fortunately, applications rarely freeze up, so you shouldn’t need to use these techniques very often.
The Macintosh operating system has many ways to open your files efficiently, and this number increases tenfold if you add third-party tools such as LaunchBar to the mix. In this technique, you see several ways to achieve the same end result. Like most timesaving techniques, many options are available; it’s really up to you to determine which works most efficiently for your computing habits.

Opening Files with the Finder

As you probably already know, you can open any file by double-clicking it, in which case it automatically opens by using the default application for that particular file type. If you’d rather open the file without your hands leaving the keyboard, press Ô-O instead.

If you use an input device with programmable buttons (such as a trackball or a multi-buttoned mouse), program one of the buttons to behave as a double-click. This button saves a step (literally a click) whenever you need to open a file. Check the software or manual that came with your input device to see whether it’s programmable — and if so, how.

Entering a file?

Here’s one place where we think Windows users have an advantage. To open a file in Windows, a user simply selects the file and then presses Enter (the Mac Return key equivalent for PC users). When Mac users press Return, they can rename the file. This makes little sense because, frankly, files are opened much more often than renamed. But we’d be surprised to see Apple make this change — and the concession to Microsoft — after so many years.

However, clicking once on a file and pressing Return is the fastest way to rename it. The alternative — clicking once on a file, and then clicking again on its name but not so quickly as to be a double-click — is much slower and often inadvertently opens the file.
Opening Files with Specific Applications

Double-clicking a file in the Finder usually works just fine for opening files, particularly when the file is set to open in the application of your choosing. However, the default application often isn’t the one that you want to use in a specific instance. For example, you might normally open HyperText Markup Language (HTML) files in Safari, but maybe you want to edit a particular HTML file in BBEdit. Likewise, images open in Preview by default, but maybe you want to use Adobe Photoshop to tweak a particular image. Here are some steps to automatically open files with a specific application. At the end of this technique, we reveal how to set the default application for a file or a file type. This is helpful if you often need to change the application used to open a type of file.

Using the Finder Window toolbar to open files

In Technique 12, we demonstrate the how’s and why’s of tweaking the default Finder window setup. One recommended addition is to put the most commonly used applications there (see Figure 25-1). This makes opening a file with that application a simple case of dragging and dropping the file onto the icon.

• Figure 25-1: By placing an application in the window’s toolbar, you can quickly open a file by dragging it onto the icon.

A neat trick that results from Tiger’s window structure is that the folders in the Sidebar spring open if files are held over them. Therefore, you can drag a file onto the Applications icon, which in turn opens the Applications directory. Then you can drop the file directly onto the appropriate application.

Using the Dock to open files

Another easy method of opening a file with a particular application is simply to drag the file onto the application’s icon in the Dock. For this method to work, the application must either

- Permanently reside in the Dock
- Be open

Technique 13 provides guidelines for creating an efficient Dock.

Out of kindness (or maybe insolence), the Dock tries to make room for the files that you drag there, moving your application’s icon out of the way in the process. To prevent this behavior, hold down Ô while dragging your files, and the Dock remains motionless.

Using Favorites to open files

If you place a link to your Favorites in the window’s toolbar, you can pop that open and find your favorite application, just like we suggest you can by using the Applications folder. (Technique 17 shows how to set up your Favorites folder to contain your most-often-used applications, files, and folders.)

The spring-loaded folder technique works with folders in the Sidebar but not with those in the Dock. So although you might keep the Favorites folder docked, trying to drag a file onto it doesn’t work.

If you haven’t yet customized your Favorites folder, run — don’t walk — to Technique 17 and do it now.

Opening files with a contextual menu

This method of opening a file in a specific application is perhaps the best. Control-click a file’s icon, and you’re prompted by a contextual menu that offers a list of common actions that you can do with the file, such as get info about it and archive the file (see Figure 25-2).
One of these menu items, Open With, gives you immediate access to other applications with which you might want to open the file. The resulting submenu (see Figure 25-3) lists the current default application at the top along with the other potential candidates. If the application that you’re looking for isn’t listed, choose Other (at the bottom) and use the resulting Open dialog to find and select the right app.

If you have a programmable input device, we recommend programming one of the buttons as a Control-click, allowing you to access a contextual menu with just the one hand. By default, most two-button mice use the right button (also referred to as the second mouse button) as a Control-click.

LaunchBar (www.obdev.at) is far and away one of our favorite third-party applications for the Mac. Its ease of use, impressive speed, and very reasonable cost ($20 for personal use; free for limited use) make it a must-have in our minds, particularly if you want to shave seconds off common tasks. By following these steps, it can quickly open files in the appropriate application:

1. **Press** ⌘-spacebar to activate LaunchBar.
2. **Type** the shortcut for the application that you want to open a file with (the keys you enter will appear in LaunchBar’s prompt).

In this example, the letter B represents BBEdit (see Figure 25-4).
Technique 25: Opening Files Faster

3. From the Finder, drag the desired file onto the launch pad.

4. From the pop-up menu that appears, select Open with Application (in this case, Open with BBEdit; see Figure 25-5).

Opening Files within an Application

If you have an application open, you can expedite opening files from within it. For starters, every application uses the ⌘-O shortcut to bring up the Open dialog (shown in Figure 25-6).

The standard navigational keyboard shortcuts (such as ⌘-D for the Desktop) work within the Open dialog. You also can click the folders and files in the Sidebar for immediate access to commonly used directories.

Recalling Recent Items

After you access a file, it becomes much, much easier to bring it up again. Tiger has (or can have) a memory of your actions in the Recent Items menu, found in the Finder and in many applications.
Recalling Recent Items

Recalling files from the Apple menu

The Apple menu has gone through many changes over the years. In OS X, it’s more or less off-limits to user customization. However, one tweakable feature that remains is the Recent Items submenu (see Figure 25-7).

- Figure 25-7: The Apple menu can track recently used applications and files.

Recalling files from application menus

This might be a chicken-or-egg debate, but either the Apple menu inspired similar behavior in many applications, or vice versa. Regardless, most of Tiger’s commonly used applications include their own Recent Items menu. Examples include BBEdit, Acrobat Reader, and Photoshop. Usually, you find a
Recent Items (or similarly named) submenu listed under the File menu. Some applications, such as the Microsoft Office products, just list the recent files at the bottom of the File menu instead.

**Setting the Default Application for Files**

The default application to be used when opening a file is indicated by the file’s icon in the Finder. Each application has its own look for corresponding files. As usual, double-clicking (or using the keyboard equivalent, ⌘-O) automatically opens the file in the assigned application. But what if you want to change the default application? In Tiger, you can manage file types by using the ubiquitous Get Info window by following these steps:

1. **Select the file in the Finder.**
2. **Click the file and press ⌘-I (or choose File ➪ Get Info) to bring up the Get Info window (see Figure 25-9).**

   Reach the Get Info window by Control-clicking the file and selecting Get Info from the contextual menu that appears.

3. **Click the arrow next to Open With to expand that panel, if it isn’t already visible.**
4. **Select the default application to use from the pop-up menu.**

   If the application isn’t already listed, select Other at the bottom and navigate to the appropriate application.

5. **(Optional) Click the Change All button to set this application to always open files of this particular type.**

   If you have only a file or two that should always be opened with a specific application (such as a really large PDF that you want opened with Acrobat Reader instead of Preview), don’t click Change All in the Get Info window.

   A few applications — Adobe Acrobat Reader and Microsoft Internet Explorer, just to name two — can automatically associate certain file types with themselves. Peruse the application’s Preferences for the appropriate setting.
26 Saving and Printing Files

This part of the book is all about your applications — not what they specifically do, but those common elements that you’ll run across in every application. This includes saving and printing your documents.

Although you probably know what you’re doing when it comes to these issues, in this technique you might find a better way to do those common tasks. We begin by discussing how to navigate and use Save dialogs quickly. Then we go into printing your documents. Finally, we cover how to turn any document into a PDF file, which is a widely accepted file format for sharing documents on Macs and PCs alike.

Saving Files

Regardless of what application you’re using, when you go to save an untitled document, you’re presented with a Save As dialog. (See one in Figure 26-1.) The Save As dialog appears as a sheet, meaning that it drops down from the top of the document window.

• Figure 26-1: Tiger’s Save As sheet as it appears in Microsoft Word.
The keyboard shortcut for Save is ⌘-S. Some applications have a shortcut of ⌘-Shift-S for Save As.

Tiger uses a Save As dialog format that is very similar to the Finder window format:

- The top section is for the document’s name.
- The down-arrow button (next to the name) enables you to display or hide (see Figure 26-2) your other options.

![Figure 26-2](image)

*Figure 26-2: Save dialogs can be minimal, or you can click the down arrow to see more options.*

Some applications, such as Microsoft Word (refer to Figures 26-1 and 26-2), provide

- An Options button linking to that application’s Save preferences panel
- A drop-down list that allows you to save the document in another file format (see Figure 26-3)

What is available in an application’s Save preferences panel (if it has one) varies; normally you can select a default file format and how often to perform automatic backups.

The left side of the fully expanded Save As dialog displays volumes at the top and your favorite places at the bottom. This is the same setup that you can find in your Finder windows.

Because the Save As dialog uses the same format as your Finder windows, customizations made to the Finder windows are reflected in your Save As dialogs. (See Technique 12 for customization tips.) Placing some of your favorite directories in the Finder’s Sidebar lets you more easily use both Finder windows and Open or Save As dialogs.

Another nice feature of the Save As dialog is that you can use it in either list mode (as shown in Figure 26-4) or column mode (refer to Figure 26-1). In fact, the Finder keyboard shortcuts — ⌘-2 for list view or ⌘-3 for column view — work in Save As dialogs!

![Figure 26-3](image)

*Figure 26-3: Some applications allow you to specify a file format other than the default.*

Save your documents in the most logical place. (See Technique 16 for organizing your Home directory.) If you’re looking for a quick, temporary storage location, use the Desktop.
Here are some tips for getting the most out of your saves:

- Use the Sidebar navigation area to quickly access your favorite common areas.
- Press ⌘-D to go to the Desktop.

The Default Folder X shareware program (www.stclairsoft.com/DefaultFolderX/index.html, $35) brings many useful features to the Save dialogs. For example, with it you can save documents to open Finder windows or delete and rename existing folders and files without exiting your application.

- Press ⌘-Shift-H to go to your Home directory.
- Use the Tab key to move forward from one area of the Save As dialog to another.
- Press Shift-Tab to move backward from one area to another.

The Tab and Shift-Tab keyboard shortcuts move you from the document title window to the Sidebar to the main window area. A colored box indicates the currently active area.

- The directory drop-down list at the top lists the hierarchy for the current folder.
- The directory drop-down list at the top also lists the most recently used folders (check it out in Figure 26-5).

- Click and drag the lower-right corner to resize a Save As dialog.
- Most of the keyboard shortcuts that function in a Finder window also work inside Save As dialogs, including:
  - ⌘-[ (opening brace) to move back (in list view)
  - ⌘-↑ to move up one folder (in list view)
  - ⌘-↓ to move into a selected folder (in list view)
  - ⌘← to move back one folder (in column view)
  - ⌘→ to move into a selected folder (in column view)

Save your work frequently! Although your Mac will rarely crash, you certainly don’t need to risk it. Also get in the habit of saving your work before interruptions such as switching applications, printing, and leaving your computer.
Marc's cool trick for navigating in Save dialogs

If you don’t like trying to navigate all over your computer system to save a file or if you’re frequently saving multiple files to the same area (like if you’re, um, writing a book), here’s a cool trick:

1. Bring up the Save As dialog for the application that you’re working in.
2. Go to the Finder.
3. Open the folder where you want to store the document in a Finder window.
   
   This trick makes the most sense (time-wise) if you already have the destination folder open in a Finder window.
4. Click and hold the folder proxy icon in the Finder window (see the sidebar “Using proxy icons”).
   
   The proxy icon is the representation of that folder at the top of the Finder window, next to the folder’s name.
5. Drag the folder icon onto the Save As dialog.
   
   The dialog now shows that folder as the destination for the file being saved.

If you like this technique, you can really speed it up by using a drag and drop in conjunction with Exposé (see Technique 15) or the Finder’s Ô-Tab trick to quickly go back and forth between the Finder and the primary application.

You can drag folders or files from the Finder into a Save As dialog. The dialog moves to the new location, and the name of the file that you dragged is entered into the filename text box, saving you some typing if you want to overwrite an existing file.

**Using proxy icons**

Proxy icons are the little icons you see next to folder names in Finder windows (see the icon to the left of **OS X Tiger TT** and document names in document windows (see the icon to the left of **software** in the second image). If you’ve never touched a proxy icon before, you don’t know how unbelievably useful they can be.

Proxy icons are essentially iconic representations of the things themselves. So the icon in the Finder window represents that directory, and the icon next to a document’s name represents the document. The reason proxy icons rule is that they give you an easy way to move stuff around. For example, you can drag an item's proxy icon onto an e-mail to attach that file. Or you can drag a Finder window’s icon into a Save dialog to quickly navigate to that directory.

The only trick with proxy icons is grabbing them. As you know, you can use the title bar (in a document or window) to move that document or window around or to minimize it (by double-clicking the title bar). But because the proxy icon is part of the title bar, how can the computer distinguish between those actions involving the title bar and those involving the proxy icon? To indicate that you want to grab the proxy icon and not the title bar, you have to hold the mouse still for about half a second after clicking the proxy icon. This indicates to the system that you want to drag the proxy icon and not move the window. Master this simple technique and you’ve gained a valuable skill!

**Overwriting existing files**

Existing files in Save As dialogs appear in gray, indicating that you can’t use that filename without overwriting another document. In the past, to force a used name on the document that you were saving you had to type it manually. Now, selecting a grayed-out file automatically enters that filename as the saved document’s name.
Be careful when you use an existing filename in Save As dialogs. Doing so wipes out the previous document, leaving you without any recourse for recovery.

**Printing**

Although different printers have different features (like the ability to print in color or on both sides of a page), there are some great timesaving techniques that work regardless of the hardware being used.

The following examples use Larry’s printer, but the thrust of these tips should still apply to whatever printer you’re using.

**Customizing print settings**

Many print drivers come with the ability to create and save your print settings. This is very useful if you frequently need to print documents in certain ways. For example, you might adjust:

- The number of copies to print
- What pages to print
- The quality of the printing
- Whether to use two-sided printing (if possible)

Larry has a few different settings created already. One is for printing a lower-quality draft of something double-sided. This is great for spititng out large documents that don’t require the best quality. On the opposite end of the spectrum, Larry uses a setting for printing photos in color and on glossy paper.

For most printers, arranging this is a matter of following these steps:

1. Choose File ▸ Print in any application.

The keyboard equivalent of Print is ⌘-P.

2. In the Print dialog that appears, adjust all the settings as desired. (See some choices in Figure 26-6.)

![Figure 26-6: Go through your printer’s options and adjust each accordingly.]

3. Select Save As from the Presets drop-down list.

4. In the Save Preset dialog that appears, enter a distinctive and descriptive name for these settings, like One Page Draft (see Figure 26-7) or Color Photo.

![Figure 26-7: Give your printer settings a descriptive name.]

The next time you want to print something with these preset settings, you can select them in the Print dialog from the Presets drop-down list.
Previewing your documents

Using the Preview option turns a document into a PDF (Portable Document Format) and sends it to the Preview application. From there, you can scroll through the multiple pages, print it, save the file as a PDF, or convert it to another format. This functionality works in any OS X application that can print. To find out more, see “Creating PDFs” later in this chapter.

Desktop printing

In short, desktop printing is the ability to print documents (or start the print process) by using the Finder instead of an application. It works by creating an alias to your printer. When you drag a file onto this alias, Tiger

- Prints the file if its format is readable by Preview (images and PDFs).
- Launches the file’s default application and then prints the file if its format isn’t readable by Preview (Microsoft Office documents, as an example).

Using desktop printing can save you a lot of time if you frequently need to print documents that you might not be currently viewing or editing — in other words, if you print documents separately from working with them.

To create a desktop printer, follow these steps:

1. Launch the Printer Setup Utility, found in the Applications: Utilities folder.
   You should see a list of available printers.

   2. If your printer isn’t listed, add it to the list.
      Click the Add button and follow the prompts to add a printer already connected to your Mac. See Technique 40 for adding a networked printer.
      After you’ve added the printer, it appears in the list of available printers.

   3. Select your printer by clicking its name in the list.


   5. In the Save dialog that appears, give your printer a descriptive name and save it to your Desktop.

   6. If you want, move the printer alias from the Desktop to your Dock, a Finder window Sidebar, or the Finder window Toolbar so it’s more readily available.

After you create a desktop printer (even if you Dock it), just drag any document from the Finder onto the Desktop Printer icon to print it.

Creating PDFs

One of the coolest features of OS X is that it uses the Portable Document Format as a standard technology. The benefits of this are

- Easy viewing of PDFs via Preview, which is the OS X default media viewing application
- Easy creation of PDFs without the need for expensive software

With little fanfare, a cool feature called PDF Workflow was added to the Mac OS X operating system. With PDF Workflow, you can broaden your PDF options. Instead of saving a document as a PDF, you could

- Save it in a specific folder without prompting.
- Attach the PDF to an e-mail.
- Open the PDF in Adobe Acrobat Reader.
After you turn on PDF Workflow, you can add different shortcuts, which will be available through the print sheet’s Actions button. To enable PDF Workflow, follow these steps:

1. **Open your Home directory in a Finder window.**

2. **Navigate to the Library folder.**

3. **Create a new folder called PDF Services.**

   The PDF Services directory is Tiger’s link to PDF Workflow functionality. You use it to add all the different features you want to the PDF Workflow menu.

   PDFU, from If Then Software ([www.ifthensoft.com](http://www.ifthensoft.com), free), automates the PDF Services directory creation and adds several useful starter services for you (see Figure 26-8).

   - **Figure 26-8:** The Save As PDF button can work as a pull-down menu instead.

After you create the PDF Services folder, here’s what you can do with it:

- **Add aliases to other folders there, giving you a very quick way to save a PDF file to that folder.**

- **Add aliases to applications there.**

  For example, if you drop a Mail application alias into the PDF Services folder, selecting Mail from the pop-up menu creates a PDF that is then immediately attached to a new, blank message in Mail. You simply have to add a recipient and subject to the message, and then you can fire off the PDF.

- **Programmers and scripters can add both AppleScripts and UNIX scripts to the folder.**

  After you’ve done so, selecting the added PDF Workflow option runs that script using the created PDF.

  For example, you could create an AppleScript that moves the PDF onto a network server or performs some type of post-processing.
Save Time By

🌟 Memorizing the shortcuts for cutting, copying, and pasting
🌟 Understanding how to use the Clipboard
🌟 Expanding the Clipboard with shareware
🌟 Picking up some new tricks

You might be thinking to yourself, “Why is a whole technique devoted to cutting, copying, and pasting? I already know how to do that just fine.” Although this is probably true, the topic is so important that you really ought to make sure you know every possible option and method available.

In this technique, we give you everything that you absolutely must know about editing a document: cutting, copying, and pasting (with a little selecting thrown in). This begins with the basic and not-so-basic shortcuts. After that, we discuss the Clipboard itself: what it is, how it works, and how this affects you. At the same time, we introduce a couple new tools that expand the functionality of the Clipboard. Finally, we show you a few other related tricks and get into Tiger’s Find Clipboard.

### Copying and Pasting with the Keyboard and Mouse

Editing is so common in everything that you do on computers these days that if you haven’t already mastered the editing shortcuts, you’re selling yourself short. The options on the Edit menu are fairly common whether you’re talking about the Finder (see Figure 27-1) or BBEdit (see Figure 27-2).

<table>
<thead>
<tr>
<th>Option</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo Copy of “Microsoft Office 2004”</td>
<td>⌘Z</td>
</tr>
<tr>
<td>Cut</td>
<td>⌘X</td>
</tr>
<tr>
<td>Copy “579630 fg2901.tiff”</td>
<td>⌘C</td>
</tr>
<tr>
<td>Paste</td>
<td>⌘V</td>
</tr>
<tr>
<td>Select All</td>
<td>⌘A</td>
</tr>
<tr>
<td>Show Clipboard</td>
<td></td>
</tr>
<tr>
<td>Special Characters...</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 27-1: The Finder Edit menu is rather basic.*
The Edit items apply to whatever you have selected, including:

- Files, folders, icons, or applications in the Finder
- Text
- Images

Of the Edit menu options, these are the most important:

- **Select All** highlights all the content in a window, document, or whatever so that you can copy, cut, or delete it.
- **Copy** puts a copy of the selected material on the Clipboard.

### Keyboard Shortcuts

- **Select All**: ⌘-A
- **Copy**: ⌘-C
- **Cut**: ⌘-X
- **Paste**: ⌘-V
- **Undo**: ⌘-Z

You really, really, really must memorize these commands. If you prefer using the mouse, these keyboard shortcuts are duplicated on Edit and contextual menus (as shown in Figure 27-3).

Most applications use the ⌘-Shift-Z shortcut for Redo. Others use ⌘-Y.
Cut, Copy, Paste

Help
Cut X
Copy C
Paste V
Font... D
Paragraph... M
Bullets and Numbering...

Look Up
Hyperlink...
Scripts
Quick Access
Move To
Copy To
Make Alias In
Spotlight
Search Dictionary.com
Search Thesaurus.com
Search Google
Search eLibrary
Shop at Amazon.com

• Figure 27-3: The Edit options are frequently available on contextual menus.

You can use your mouse for some neat editing tricks. After you select an item, click it and begin dragging, and then

✔ Drag the item anywhere else to perform a cut and paste.
✔ Drag the item to the Trash to delete it.
✔ Hold down the Option key while you drag to create a copy of the selection in a new location (copy and paste).
✔ Move the item to a new volume (in the Finder) or document (in an application) to create a copy in the new location.
✔ Hold down the ⌘ key to move the item to a new volume without copying it (in the Finder).

✔ Hold down the Control key before you release the mouse button to be given options when moving the selection from one document to another within an application. After selecting some text, say in a Word document, begin dragging it to another location. After you arrive at your destination, press the Control key and release the mouse button to see a menu of options (see Figure 27-4).

• Figure 27-4: Contextual menus work within the Finder and other applications while dragging stuff around.

All these tricks work with text and other content in documents. Most also work with files and folders in the Finder.

You can also select items (in the Finder or in an application) by using these techniques:

✔ Select a range of contiguous items by continuing to hold down the mouse button while dragging around a group of items.
✔ Click to mark the beginning and then Shift-click to mark the end to select a range of items.
✔ ⌘-click to add an item to the current selection (like another file in a Finder window).

You can press ⌘-click to deselect a selected item (for example, to deselect one item from a range of already selected items).
Understanding the Clipboard

The Clipboard is an area of memory that stores the most recently copied or cut stuff. The Clipboard has been a part of the Mac operating system for a good long time and is a simple and essential tool. Here are some basic rules of how it works:

- The Clipboard can contain only one selected item at a time. The Clipboard has no history. It can remember a group of files or a paragraph of text or whatever, but it can only ever store one level of copying or cutting.
- The Clipboard’s contents are remembered across the entire operating system and every application. Even if you quit or open an application, the Clipboard’s contents remain available.
- The Clipboard’s contents are changed only when you cut or copy something else. The Clipboard isn’t emptied by any other option, including pasting or deleting.
- The Clipboard’s contents are dropped when you log out, shut down, or restart your computer.

You can always view the current contents of the Clipboard by choosing Edit ➪ Show Clipboard in the Finder. See an example in Figure 27-5.

![Figure 27-5: If you forget what’s on the Clipboard, view its contents in the Finder.](image)

Clipboard Shareware Alternatives

The main limitation of the Clipboard is its single-item storage. It’s nice but limited. You don’t need to be a power user to be hindered by its lack of history and single-use nature. If you want just a little bit more, here are some more potent options.

- **CopyPaste-X** ([www.scriptsoftware.com/copypaste](http://www.scriptsoftware.com/copypaste), $30) provides you with a Clipboard that can automatically store ten items and also includes a Clipboard Editor to alter the stored contents.
- **iPasteboard** ([http://ipasteboard.brunoblondeau.com](http://ipasteboard.brunoblondeau.com), $15), like CopyPaste-X, is closer to the old Scrapbook utility from OS 9 and earlier. It provides unlimited Clipboards whose contents are retained even after restarts.
- **iPaste** ([www.iggsoftware.com/ipaste](http://www.iggsoftware.com/ipaste), $13) is a variation on the Clipboard, allowing you to create a virtual, permanent Clipboard in which you can store many types of items. Then, by using contextual menus or keyboard shortcuts, you can paste these often-needed items into documents, e-mails, and the like.
- **XShelf** ([http://homepage.mac.com/khsu/XShelf/XShelf.html](http://homepage.mac.com/khsu/XShelf/XShelf.html), free) is more like the Mac OS 9 Scrapbook but can be used in place of the Clipboard. Instead of using Cut, Copy, and Paste, you drop selected items onto the application (shelving them for later). When the time comes to use the stored text, image, or what-have-you, drag it off of the shelf and into its new location.
- **ClipboardSharing** ([www.lagercrantz.ath.cx/software/clipboardsharing](http://www.lagercrantz.ath.cx/software/clipboardsharing), donationware) lets you share a Clipboard’s contents from one Mac to another over a network.
- **Share Clip** ([http://homepage.mac.com/bnej/shareclip](http://homepage.mac.com/bnej/shareclip), free) is like ClipboardSharing (letting you share text over a network) but works with the Mac OS, Windows, and Linux.
- **Plain Clip** ([www.bluem.net/downloads/plain-clip_en](http://www.bluem.net/downloads/plain-clip_en), free) removes all formatting from copied text.

Copy and Paste Tips and Tricks

To wrap up this technique, we want to discuss a few editing tips and tricks that you should be familiar with.
Copying items within the Finder

You can use Copy and Paste to copy an item in the Finder to another location without cluttering up the Desktop with windows. Here’s the skinny:

1. Open a new Finder window.
2. Select the item or items that you want to duplicate.
3. Press Ô-C to copy your selection.
4. Navigate within the same window to the destination folder.
5. Press Ô-V to paste the copied items there.

If you duplicate an item within a folder, the Finder automatically adds the word copy to its name. This is because two items within the same directory can’t have the same name. If you duplicate an item multiple times, the word copy, followed by sequential numbers, is added to the duplicates’ names.

Using the Find Clipboard

One of the interesting features in Tiger is the Find Clipboard, which is an independent Clipboard that stores text for which the user has been searching. The great thing is that it is also system-wide and works in every Apple application plus a few others (you have to try it to be sure) while still leaving your Clipboard contents unchanged.

Often, people copy a word from a document and then open the Find dialog and paste the word there. This replaces any other text in the Clipboard, which might still be needed. With the Find Clipboard, you can do the same thing much quicker and without ever opening up the Find panel. Here’s how:

1. In an application such as Safari, Mail, or TextEdit, select some text.
2. Press Ô-E. Ô-E is the keyboard shortcut for the Use Selection for Find command.
3. Open the Find panel for that or any other application.
   If the current application supports this feature, this text is automatically inserted into the Find dialog, and you can simply press Return to begin the search.
4. Press Ô-G to search again using the same Find text.
   For example, you might want to do this if the first found occurrence wasn’t exactly what you were looking for.

Instead of using the Find prompt at all, use Ô-G to search for the selected text automatically. Strange as it might seem, with the Find Clipboard and the Ô-E shortcut, you can actually use Find Again to find text even if you haven’t run the search previously. This is another time-saving benefit of the Find Clipboard!
Either because of a lack of need or because of a lack of good, inexpensive tools, font management has long been a terrain where everyday Mac users did not tread. While graphic designers used high-priced applications to manage their fonts, the rest of us were left out in the cold. Now, thanks to the Font Book application, you can add wacky fonts to your Word documents or (more importantly) make your applications load faster by enabling and disabling fonts as needed.

In this technique, we cover pretty much everything you need to know about fonts including installing, viewing, and managing them. Along the way, we show you our own special tricks for working with fonts in the easiest way possible.

**Fonts Supported in Tiger**

To get the most out of fonts on your system, you should fully understand how Tiger deals with fonts, particularly because this has changed significantly in OS X.

Tiger supports several types of fonts:

- **Cross-platform fonts**
  
  There are many cross-platform fonts, but the most common are either TrueType or OpenType. These types of fonts were originally made by Microsoft. They are very common and provide good results on the monitor and in lower-quality DPI (dots per inch) printings.

- **PostScript fonts**
  
  PostScript fonts, created by Adobe (and also called *Type 1 fonts*), look great at even high-quality (professional level) printings.

- **Data fork suitcase fonts**: `.dfont`
  
  Similar to OpenType fonts, data fork fonts are new to Mac OS X. Theoretically, these fonts have the best qualities of both Microsoft’s TrueType and Adobe’s PostScript fonts.
Technique 28: Managing Fonts

• Figure 28-1: Add fonts to your system by placing them within your personal Fonts folder.

Mac TrueType fonts

Mac OS 9 and earlier used various TrueType and bitmapped (think crude and jagged) fonts.

That’s a pretty broad range of options, meaning that you have an enviable list of options. Fonts from Windows computers work on your Mac, as do old OS 9 fonts that you might still use in some documents.

Installing Fonts

Although your Mac comes with a few dozen fonts out of the box, you can — and probably will — add more. You can find fonts by purchasing them (either online or in a good software store) or by downloading free ones from the Web.

Some of the better online font resources include

- FontFreak.com: www.fontfreak.com
- Adobe: www.adobe.com/type/main.jhtml
- MyFonts.com: www.myfonts.com
- Famous Fonts: www.smackbomb.com/famousfonts
- Fonts.com: www.fonts.com

To install a font, all you need to do is drop the font file into the appropriate location. You can install fonts in either of the following places:

- ~/Library/Fonts (where ~ refers to your Home directory; see Figure 28-1)
- /Library/Fonts

Fonts used by your Classic system are stored in the /System Folder/Fonts directory where your OS 9 installation resides. The great thing about this is that OS X automatically finds and supports fonts that are installed in OS 9.

Any fonts that you install are usable the next time you open an application. (For the Finder, this means that the font is usable after you either restart your computer, log in and log out, or manually quit and restart the Finder.)

Viewing Fonts

After you install your fonts, you have several options for viewing them. Although every individual application will (or should) show you a list of available fonts, Tiger’s tools go a step further by showing you what the fonts look like and providing more powerful levels of tinkering. The operating system offers three tools for looking at your fonts: Character Palette, the Font panel, and Font Book.
Character Palette

Character Palette was new in Jaguar and replaced the old Key Caps utility. It’s like Font Book but has the added advantage of being accessible via the menu bar at the top of the display. To set up your preferences so that you can activate Character Palette from the menu, just follow these steps:

1. Bring up System Preferences.
2. Select the International panel.
3. Click the Input Menu tab.
4. Select the check box next to Character Palette, as shown in Figure 28-2.

5. Select the Show Input Menu in Menu Bar check box at the bottom of the window.

Following these steps creates an icon on the menu bar. Clicking it brings up some options (as shown in Figure 28-3).

Character Palette (shown in Figure 28-4) is a useful tool for accessing particular characters. For example, use Character Palette if you want to insert a symbol (such as a star, asterisk, and so on) into a Word document or add a character with an umlaut or tilde in an e-mail. Character Palette provides a much faster interface for hunting down these peculiar items.

You can also access Character Palette by choosing Edit ➪ Special Characters from the Finder. To access special characters, use the free CharViewer (www.macparc.ch/mirror/CharViewer) or the fancier PopChar X (www.macility.com/products/popcharx, $30).
To find a particular character and insert it in the current document, just follow these steps:

1. **Within Character Palette**, use the View drop-down list at the top of the panel to select the appropriate alphabet.

   You’ll most likely want to use the Roman alphabet unless you have a need to access Japanese, Korean, or Chinese characters. The Unicode View shows many other symbols and characters such as mathematical symbols, signs of the zodiac, and Cyrillic letters.

2. **Click the By Category tab** if it’s not already highlighted.

3. **Use the Add to Favorites button** at the bottom of the Character Palette window to add a frequently used character to your list of favorites. Then you can quickly insert these into documents by clicking the Favorites tab to view them. This is the best, most efficient way to repeatedly access nonstandard characters.

4. **Use the menu at** the left to select a category.

5. **In the panel on the right, find the character** that you’re looking for and click it to highlight it.

6. **(Optional) Click the arrow next to the Character Info label** to find out more about the highlighted character and to see related characters.

   For example, if you’re looking for a special accented character, select Roman for the View and select Accented Latin as the Category, which brings up the list of possible characters. The top-right column shows primary options, and the Character Info section shows variations for each option (uppercase, lowercase) and similar characters.

7. **(Optional) Click the arrow next to Font Variation** to see the character in other fonts.

   **Double-click the character that you want to insert.**

   The selected character is inserted into your document where the cursor is located.

---

**New to Tiger** is the Keyboard Viewer, which shows all the characters of a font as they appear on a keyboard. You might find this to be an easier, more natural way to see what characters or symbols are available (see Figure 28-5).

---

![Figure 28-5: Tiger’s Keyboard Viewer.](image)
Font panel

The Font panel is a solid tool for viewing, selecting, and tweaking fonts. It’s available in all Cocoa (native to Mac OS X) applications, like Stickies, TextEdit, Mail, and Safari.

Applications that support the Font panel, such as Mail, Stickies, and TextEdit, often use the Ô-T keyboard shortcut for accessing the Font panel.

The primary purpose of the Font panel is to allow you to select and customize the font used in an application. The basic view (as shown in Figure 28-6) shows the different font collections, families, and sizes available. Set the font face and size to use:

- Make selections in the Collection, Family, and Typeface columns. (Navigate the Font panel like you would a Finder window in column view mode.)
- In the Size column, enter a value or use the slider to adjust the size. Move the slider up to increase the font size; move it down to decrease the font size.

If you’re looking for a particular font but you’re not sure which collection or family it belongs to, use the Search button at the bottom of the window to find it.

The Font panel’s greatest asset is the Actions button at the bottom left (the thing that looks like a cog or a gear with a downward-pointing arrow next to it), which creates a menu of useful options (see these in Figure 28-7). The effect of the options change depending on whether you’ve already selected a font, but your choices include:

- Add to Favorites: If you add a font to your Favorites (Font Favorites, not the other Favorites that your system uses), you can easily access it in any application. Your Favorite fonts are listed in the second column when you select Favorites from the Collections column in the Font panel. The wonderful thing is that the Favorites doesn’t just recall the font itself, but also the size and any special effects applied. So if you like a certain style for an e-mail or a heading in a text document, you can quickly retrieve it time and again.
Technique 28: Managing Fonts

Edit Sizes: The Edit Sizes menu allows you to set the default sizes available for your fonts.

Manage Fonts: This option brings up Font Book.

Font Book

You can use the Font Book utility to view and manage your fonts. Font Book consists of a window that lists the groupings or categories of fonts in the left column, the specific fonts for that grouping in the middle column, and a preview of the font in the right column (although the preview can be disabled).

If you double-click any font in the Finder, it opens in Font Book, where you can view and manage it (see Figure 28-8). You can also access Font Book from within your Applications folder or from the Font panel (by choosing Manage Fonts from the Actions menu).

To preview any font, follow these steps:

1. Start by clicking the appropriate collection in the Collection column.
2. Select the font family in the Font column.
3. (Optional) Click the arrow next to the font’s name to expand the font listing, and then select a specific subfont.
4. Adjust the view size in the right column by moving the slider or using the Size drop-down list.
If you want, you can have Font Book preview a font by using specific text. After you select your font, choose Preview ➪ Custom or press ⌘-3. In the third column (where the font is normally previewed using the alphabet and numbers), type the text that you want to use as the sample (see Figure 28-9).

![Figure 28-9: You can use Font Book to preview specific text in a font.](image)

Font Book has a Search box in its upper-right corner, which allows you to quickly find a font by name or family.

Double-clicking a font’s name in the Font column opens a new window showing a preview of the font. You can open multiple preview windows, allowing you to compare fonts.

**Managing Fonts**

You can always install and uninstall fonts simply by manually removing them from a Fonts folder and then replacing them when needed. Although this is effective, it’s unnecessarily slow and cumbersome. Instead, use Font Book to manage your fonts. With Font Book, you can

- More quickly install fonts.
- View every font on your Mac at once. (This is a timesaver because fonts might be found in many locations.)

- Disable fonts without having to delete them (which makes applications load faster).
- Create font groupings so that particular applications (such as Adobe Photoshop) have access to fonts not required by other applications.
- Find duplicate fonts (Edit ➪ Resolve Duplicates) to eliminate redundancies.
- Uninstall fonts without searching all over your hard drive for the actual files.

To create a collection

1. **Click the plus sign at the bottom of the Collection column.**

   In the Collection column, a new listing appears with a name like “New-0” already highlighted for you.

2. **Type a name for the collection (see Figure 28-10).**

   ![Figure 28-10: Give your collection a meaningful name.](image)

3. **In the Collection column, click All Fonts to view every font.**

4. **Drag each font that you want to add from the Font column onto your new collection.**

   Use the D/E buttons (disable/enable) in the bottom of the second column to deactivate or activate fonts and collections as needed. Deactivating fonts and collections makes your applications load faster (because it doesn’t have to access all those fonts) and makes selecting a font easier (because you’re searching through a smaller list).
Font Book in Tiger has added many new features that you'll appreciate if you already used the application, like

- Smart Collections (such as Smart Albums in iPhoto or Smart Groups in Address Book)
- A utility for validating fonts
- Built-in AppleScripts (see Figure 28-11)

![Figure 28-11: Use Font Book’s AppleScripts to simplify tasks.](image)
29
Getting to Know
Services

Services have been around since the introduction of OS X, but surprisingly few Mac users know about them or use them with any regularity. Services are like the geeky younger brothers of contextual menus: not as impressive at first, but pretty cool after you get to know them. The minutes you spend reading this chapter will greatly improve your productivity because Services cut to the chase in performing many common tasks.

In this technique, we give you the all-in-one treatment for Services. We begin with a quick introduction to the concept: what they are, how you use them, and where they work. Then we present a more advanced coverage of the topic, going over our best tips and techniques. Finally, we point you toward some resources for adding to your currently available Services.

What Are Services?

Services are little tools, usually chosen from a menu or keyboard shortcut, that are essentially a part of the operating system, which makes them available in many of your applications. Services work by providing the functionality of one application as an option in another application. Some common examples of what Services can do are

- Opening a file
- Sending selected content in an e-mail
- Creating a new sticky note from selected text
- Having your computer speak selected text
- Opening a URL in your Web browser
- Searching in Google for selected text

Services are normally applied to the current selection. Most often, this is text, but it could also be a selected file or folder in the Finder. You’ll also find that what Services are available (unavailable Services appear in gray text) depends on the application you’re using and the content you select.
Technique 29: Getting to Know Services

Services are listed as menu choices on the application menu, whether in the Finder (as in Figure 29-1) or in Safari (see Figure 29-2). Because of their unique nature, Services function only in certain applications (see the sidebar, “Cocoa and Carbon applications”) so you cannot use them all of the time.

At the time of writing, all these applications (and many more besides) support Services:

- Finder
- Mail
- Safari
- iTunes
- BBEdit
- Stickies
- StickyBrain (a Stickies-like utility)
- Camino (a Web browser)

To tell whether an application supports Services, select some text in a document or window and then peruse through the Services menu. If all the options are in gray (folders won’t be in gray, although their contents will be), the answer is no (see Figure 29-3). If any of the options are selectable, you’re good to go!

Your Mac comes with a good dozen Services right out of the box, and you can add more with shareware (see the later section, “Adding Services”).
Cocoa and Carbon applications

Two Mac OS X terms that you might hear with some frequency are Cocoa and Carbon. These came about in part to ease the transition from OS 9 to OS X. Carbon applications are OS 9 tools that have been modified to work in OS X; for example, Microsoft Office. Cocoa applications are written specifically for OS X and take advantage of its technology (Safari, Mail, and others). Although both of these application types run in OS X — and you don’t really need to know whether an application is Cocoa- or Carbon-based — remember that almost all Cocoa applications support Services, but some Carbon applications don’t.

Grasping the Best Services Techniques

The world of Services is still expanding, but good, useful Services are already available. (Services are provided by one application to other applications that support Services.)

Here is a quick tour of our favorites. In each of these cases, we focus on what functionality an application provides:

- **BBEdit**: BBEdit offers a Service that opens a selected file in BBEdit. For example, select any file in the Finder and then choose Services ➪ BBEdit ➪ Open File (see Figure 29-4). It automatically opens that file — even if it isn’t a standard BBEdit file type — in the popular text editor. Alternatively, BBEdit’s Open Selection Service creates a new document by using selected text. You can use this to take HTML code or text from a Web page and start a new BBEdit file with it.

- **Grab**: The Grab utility is useful for taking screen shots, and it can run independently of any other application (see Technique 45).

- **Mail’s Send Selection and Send File**: Two Mail Services let you send selected text or files as part of an e-mail. You can use either of these actions:

  - **Figure 29-4**: The BBEdit Services menu has two useful tools.

  Grab also provides a highly specific, and frankly odd, Service: The Grab Service can be used to perform screen captures. However, because Services can’t create files, you have to use the Grab Service to place a screenshot within another document. Figure 29-5 shows a screenshot of a Finder window placed in a TextEdit document.

  - **Figure 29-5**: The Grab Service can place a screenshot within a document.
Select a file in the Finder and then choose Finder ➪ Services ➪ Mail ➪ Send File.

This brings up the Mail application. A new e-mail is already created with the file attached.

Select some text in any application that supports Services and then choose Application ➪ Services ➪ Mail ➪ Send Selection.

This brings up the Mail application. A new e-mail is created with the selected text in the body.

Mail’s Send To: This Mail Service automatically creates a new e-mail message addressed to the selected text (presumably an e-mail address).

Make New Sticky Note: The Make New Sticky Note Service creates a new sticky note from selected content (be it text or an image; see Figure 29-6).

TextEdit’s New Window Containing Selection: This Service, similar to Make New Sticky Note, launches TextEdit and creates a new document by using the selected text.

Open URL: The Open URL Service opens the selected URL in a new browser window in your default Web browser, saving you these steps:

1. Copying the URL to the Clipboard.
2. Navigating your way over to the Web browser.
3. Opening a new browser window.
4. Highlighting the browser’s address/location bar.
5. Pasting the URL.
6. Pressing Return to load the page.

Get in the habit of actively checking which Services options are available. New Services can be added without your knowing it (when you install applications), or you might just forget how useful a tool they really are.

Services provide huge timesaving potential for any Mac user. The next time that you have a few minutes to kill, play with the Services menu!

Services and their keyboard shortcomings

Services have one drawback: An application’s keyboard shortcuts have precedence over those used by the Services menu. This means that unlike the rest of the Mac OS X user interface, these shortcuts are really inconsistently usable.

For example, the Search with Google Service, activated by the ⌘-Shift-L keyboard shortcut, might work in one application but not another: That second application might already use ⌘-Shift-L for something else. Frankly, we think that Apple’s Services should take precedence, but no one at Apple is returning our calls on the issue.

If a shortcut acts unpredictably in some applications, this is why.
Adding Services

You can obtain a few freeware and shareware applications that add to and improve on the default set of Services. These Services add functionality in any application. For example:

- **DEVONtechnologies** offers several free Service tools ([www.devon-technologies.com/products/freeware/freeware.php](http://www.devon-technologies.com/products/freeware/freeware.php)), such as
  - *AntiWordService*, which allows you to open Microsoft Word documents in any Cocoa text editor
  - *BlueService*, which enables you to send text to a Bluetooth device (assuming your computer is Bluetooth-enabled and the device is nearby)

**Bluetooth is a wireless technology that works over a limited range. We discuss it in good detail in Technique 55.**

- *CalcService*, which performs calculations
- *EasyFind*, which is a search tool
- *HotService*, which allows you to use Devon’s Services through a keyboard shortcut
- *WordService*, for common conversions of text (like changing the case or switching between straight and curly quotation marks)

- **The SearchGoogle Service** ([http://gu.st/proj/SearchGoogle.service](http://gu.st/proj/SearchGoogle.service), free) automatically searches Google (by using your default Web browser) for the selected text.

  Despite its name, the SearchGoogle Service can also perform searches at Amazon.com and the iTunes Music Store.

- **CleverKeys** ([www.cleverkeys.com](http://www.cleverkeys.com), free) looks up definitions and synonyms online and links to Amazon.com for shopping purposes. It installs as both a Service and a contextual menu, so it works even in those applications that don’t support Services.

- **ICeCoffEE** ([http://web.sabi.net/nriley/software](http://web.sabi.net/nriley/software), free) adds a number of Services but also makes all your Services available as contextual menus (in applications that support Services).

Most of these tools come with their own installers. You can install tools without installers by dropping them in the `/Library/Services` directory. (Most Services require you to log out and log back in for them to take effect.)
Part V

Cranking Up Your Internet Activities

The 5th Wave

By Rich Tennant
Surfing with Safari

Whether you’re surfing the Web for personal or business use, having the right tools and knowing how to get the most out of them goes a long way toward improving your experience. Safari is Apple’s default Web browser, and it should be your preferred tool for browsing. Not only is it free with Tiger, but it’s also a pretty good browser.

This technique shows most everything you need to know about using Safari quickly and easily. (Searching with Google and managing bookmarks merit their own techniques.) Although Web surfing is largely a mouse-driven activity, we begin with some useful keyboard shortcuts that you ought to know. Then we cover the different Safari preferences settings and why and how you should set them. After that, you find out about the AutoFill tool, which saves you countless minutes that you would otherwise spend filling out Web forms. Finally, we introduce to you Safari’s new feature — support for RSS (Really Simple Syndication) — which can save you lots of surfing time!

If you use Safari often, check out Technique 31. It covers many customization tools for tweaking Safari’s behavior and adding features.

Navigation Shortcuts

You can surf the Net without using an input device (your mouse, trackball, or whatever), but the Web is still a mostly mouse-driven world. Despite that, you might find these navigation-related keyboard shortcuts really useful:

- Ô-N: Creates a new browser window.
- Ô-T: Opens a new tab in the current window.
Safari supports tabbed browsing, which is the ability to open multiple Web pages within a single browser window. We discuss this in detail in “Working with tabbed browsing.”

- Ô-[ (opening brace): Goes back one page.
- Ô-] (closing brace): Goes forward one page (to a page you have previously visited).

Back and forth navigation is represented by two sets of keyboard shortcuts. The standard Mac shortcuts that use braces ([ and ]) work like they do in the Finder. The standard shortcuts for other browsers (using Ô plus the left- and right-arrow keys) also function.

- Ô-L: Highlights the address bar (or location window) and places the cursor in it.
  If no browser window is open, this command opens a new browser window and places the cursor in the address bar (see Figure 30-1).

For most Web sites, you can skip the www at the beginning of the URL without consequence. You can almost always skip the http:// part. In fact, you can access many common Web sites by using a bare minimum of typing: apple, microsoft, espn, adobe, and so forth. (Whether this works for you depends on your browsing history, but it’s worth trying.)

**Standard Shortcuts**

All the common Tiger keyboard commands work in Safari:

- Ô-O: Opens a file (if you want to open a saved Web page from your hard drive).
- Ô-W: Closes the open window.
- Ô-S: Saves a document.
- Ô-P: Prints the open document.
- Ô-A: Selects everything.
- Ô-C: Copies selected text to the Clipboard.
- Ô-X: Cuts selected text (which is much less useful in Safari than in other applications).
- Ô-V: Pastes Clipboard contents where the cursor is.
- Ô-Z: Undoes the last action.
- Ô-Shift-Z: Redoes the last undone action.
- Ô-F: Brings up the Find dialog (see Figure 30-2).
Other Shortcuts

These keyboard shortcuts can save you time and steps:

- **Ô=E**: Adds a selection to the Find Clipboard.
  
  The Find Clipboard (see also Technique 27) is a separate Clipboard from the standard one. You can add text to it by pressingÔ=E (after selecting text) and then perform searches by pressingÔ-G.

- **Ô=G**: Finds the next occurrence of text after using Find at least once.

- **Ô-Shift-G**: Goes to the previously found item.

- **Ô-H**: Hides Safari.

- **Ô-Option-H**: Hides every other application.

- **Ô-Q**: Quits Safari.

- **Ô-, (comma)**: Brings up the preferences panel (see Figure 30-3).

- **Ô- (equal sign)**: Increases text size.

  The Increase Text Size keyboard shortcut is technically pressing theÔand + keys at the same time. But because pressing the Shift key to make the plus sign is inconvenient, you can get away withÔ=.

- **Ô-- (minus sign)**: Decreases text size.

- **Ô-K**: Sets Safari to block pop-up ads.

- **Ô-: (colon; you could also think of this asÔ-Shift-:)**: Brings up the Spelling dialog (see Figure 30-4).

- **Ô-; (semicolon)**: Checks your spelling (without opening the Spelling dialog).

  Turn on the Check Spelling as You Type option (on Edit ➤ Spelling) to look smarter when you fill out forms. After it’s enabled, text you enter in forms is spell checked automatically.

- **Ô-D**: Brings up the Add Bookmark prompt.

- **Ô-Shift-D**: Adds a bookmark without using a prompt.
Technique 30: Surfing with Safari

Setting Preferences

Adjusting the Safari preferences goes a long way toward improving your Web-browsing experience. Most of the options are easy to comprehend, so we discuss those that most directly improve how quickly and easily you can use the application. Specifically, we focus on the features that you can adjust within the General, Tabs, and Security sections of the preferences panel. (You encounter a couple of the other sections later in this technique and in the next one.) To address the Safari preferences, press ⌘-comma or choose Preferences from the Safari menu.

Setting General preferences

The General panel (refer to Figure 30-3) affects your entire Internet surfing experience. The best timesaving techniques here are

- **Set your default Web browser.** Although you might use many different browsers at once (particularly for graphic design or Web development), you should identify a primary browser. The benefit is that every URL you click in an e-mail, iChat session, or document automatically opens in your preferred Web browser. Strangely, this setting is in the Safari browser, not an Internet preferences panel (so you use Safari to make Firefox your default Web browser).

- **Set new windows to open with an empty page.** Save yourself loading time by choosing Empty Page from the New Windows Open With drop-down list. Every time you press ⌘-N (new browser window), a blank window is opened, ready for you to type the address. When you want to go to your home page or bookmarks, just press ⌘-Shift-H or ⌘-Option-B, respectively.

- **Set your home page.** Your home page can be anything — not necessarily a traditional, customizable site like Yahoo!, Apple.Netscape.com, or the one provided by your ISP.

Mice and Safari

A couple of mouse features can improve your Web surfing experience.

A mouse with a scroll wheel lets you simply rotate the wheel to move up and down within a Web page. This saves you the time and hassle of switching back and forth between your mouse and the keyboard. Your mice even scroll sideways within a page if you hold down the Shift key while using the scroll wheel. Some mouse software (like Kensington's MouseWorks, www.kensington.com) lets you set the scroll wheel to act as a button click if you press it.

If you have a programmable mouse, you can set one of the buttons to act as a Control-click, enacting the contextual menus. What you see in the contextual menu depends upon what you Control-click:

- If you just click a Web page without selecting any text, you can view the HTML source, save the page, or print it.

- If you select some text and press Control-click, you can copy that text or use it as a Google search term.

- If you Control-click an image or a link, you’re given different options, such as opening the link in a new window or downloading the image to your computer.

You can use the mouse in even more innovative ways if you use Cocoa Gestures (www.bitart.com/CocoaGestures.html, free). This shareware application lets you associate commands with mouse movements made while holding down the primary mouse button. For example, you can set Cocoa Gestures so that if you hold down the mouse button and move the mouse to the left, Safari goes back to the previous page. Gestures are an odd concept to wrap your head around, but you’ll love them after you start using them. They let you perform common tasks without switching over to the keyboard or moving your cursor up to the proper buttons.
In the past, Larry made Google his home page, but now he’s just as likely to use www.espn.com (which must be checked several times per day).

Your home page — like your Home directory in the Finder — can be quickly viewed by pressing the Ô-Shift-H keyboard shortcut. (Both shortcuts only work within each specific application.)

Set where Safari saves downloaded files. When your browser downloads a file, you want as little interruption as possible:

- Use the Save Downloaded Files To drop-down list to have Safari automatically download files to either the Desktop (where you can easily find them) or to a spare hard drive or partition (where they’re out of the way).
- In the Remove Download List Items drop-down list, select the Upon Successful Download option to have downloaded items automatically removed after a download is successfully completed.
- Clear the Open “Safe” Files After Downloading check box, so that you aren’t interrupted.

If you do this, you can easily see and access your downloaded files by Ô-Option-clicking the Desktop (which hides all other applications in the process).

Set Safari to open links from applications in a new window. Select the In a New Window radio button.

Without this option selected, every URL that you click in any application wipes out the contents of the current browser window. (If you click several links within an e-mail, as an example, each replaces its predecessor.) To look through them all, you would need to do some savvy navigation within the same browser window. Avoid the hassle and just have Safari create a new window for each new link. They’re easy enough to cycle through (Ô-) or close (Ô-W) anyway.

To adjust the appearance of the browser window, you can show/hide the address bar, status bar, and Bookmark Bar by either using the options on the View menu or by using the keyboard shortcuts (Ô-Shift-| to toggle the address bar off and on, Ô-/ for the status bar, and Ô-B for the Bookmark Bar).

Working with tabbed browsing

Tabbed browsing is a relative newcomer to the world of Web browsers, and it’s a most welcome addition.

Tabbed browsing lets you have multiple documents (Web pages) nicely organized and displayed within one document window. Each page has its own tab that you can click for access quickly and easily. This helps keep things organized during regular use and lets you access bookmarks in novel ways.

To set up tabbed browsing:

1. Click the Tabs icon on the Safari preferences panel (see Figure 30-5).

   - Figure 30-5: Enable tabbed browsing from the Tabs panel.

2. Select the Enable Tabbed Browsing check box.

3. Make sure that the Select New Tabs As They Are Created check box is deselected.

   One of the biggest benefits of tabbed browsing is that you can click links without disrupting the flow of reading through a page, so selecting this
option defeats that purpose. If you want to immediately view a tabbed link, hold down Ô-Shift while clicking a link. Otherwise, leave this check box clear so that each tab appears in the background.

4. Make sure that the Always Show Tab Bar check box is also deselected.

The tab bar automatically appears and disappears as needed, so you don’t need to have it always hanging around. (That just uses up screen space.)

If you find all of these shortcuts hard to remember, just be certain to keep the status bar visible. It shows you what each action does before you take it. For example, if you hold down the Ô key while hovering over a link, the status bar reads Go to whatever-URL-the-link-is in a new tab behind the current one. Ô-click the link and Safari does just that.

To use tabbed browsing:

✔ Hold down the Ô key while clicking a link to view it in a tab (see Figure 30-6).

✔ Hold down the Ô and Shift keys while clicking a link to view it in a new tab immediately. (In other words, open the new tab in front of the existing tab.)

✔ The Ô-Shift→ shortcut rotates one tab to the right.

The Ô-Shift-[ shortcut also rotates one tab to the right.

✔ Pressing Ô-Shift← rotates one tab to the left.

The Ô-Shift-[ shortcut also rotates one tab to the left.

✔ Hold down the Option key while clicking a link to view it in a new window (as opposed to a tab).

If tabbed browsing is enabled, holding down the Option key when you click a link opens that link in a new window, as opposed to opening it as a tab. If tabbed browsing isn’t enabled, holding down the Option key when you click a link downloads the link to your computer.

✔ Use Option-Shift-click to open a link in a new window in front of the active window.

The keyboard shortcuts for tabs come down to this: Ô means a new tab, and Shift means that the new tab should be selected (opened in front). Option makes a new window, so pressing Option-Shift makes a new window in front of the others.

If a browser window has multiple tabs

✔ Pressing Ô-W closes the current tab.

✔ Clicking the little X icon next to the tab’s title closes that tab. (This goes for any tab and not just the active one.)

✔ Clicking the window’s red button in the upper-left corner closes the entire window and every tab in it.

✔ Control-click a tab’s title to see a contextual menu (see Figure 30-7). With this menu you can close that tab or all the others, or reload that tab or every other.
Setting Safari to block pop-up windows saves you a lifetime of effort spent closing annoying little windows. You’re still on your own with the Geico commercials (and that stupid gecko), though!

**Caching, history, cookies, and you:**

*Your browsing history*

Web browsers use many concepts behind the scenes so you can surf the Web faster:

- **History** records places you visit. You can access them again by either using the History menu or letting the application automatically complete the URL when you begin typing it.

  You can clear the entire history by using the Clear History option at the bottom of the History menu. (You can’t set a default number of days or pages to track.)

- **Cache** saves text, images, videos, and other content to your hard drive. The next time the page is loaded, Safari can recall content from the disk without waiting to download it again.

  Most browsers let you limit the size of the Web page cache saved by your browser (which keeps your cache from getting too big). However, Safari doesn’t let you adjust the amount of disk space used by its cache. (In fact, Safari provides few of the usual browser options for such advanced concepts as refreshing the browser and managing your history.) Instead, you simply empty the cache when you feel like it. To empty the cache, either choose Safari > Empty Cache or use the Option-E shortcut. Either of these makes Safari rebuild each page directly from the source, without relying upon any cached materials. This is particularly useful if you’re creating Web pages and want to ensure that Safari is reflecting the most recent changes.

- **Cookies** are controlled on the Security tab. There you can adjust how Safari handles cookies, or you can view stored cookies by clicking the Show Cookies button. In the resulting window, you can delete any cookies by selecting them from the list and clicking Remove (or by clicking the Remove All button to really sweep away the cookie crumbs).

(continued)
If you’re security-conscious (or paranoid), you have a couple of cover-up options:

- Wipe out your cache, history, cookies, AutoFill values, and Google searches all in one fell swoop by choosing Safari ➪ Reset Safari.
- Always make yourself invisible by enabling Private Browsing on the Safari menu. With this feature on, no record is kept of your activities, such as the sites you visited or the files you download.

**Saving Time with AutoFill Forms**

Surfing the Internet often comes down to filling out forms. Passwords, Search boxes, order pages, and other forms require you to constantly enter the same information again and again. You can save yourself tedium and time with Safari’s AutoFill Forms feature.

Select the check boxes on the AutoFill panel of the preferences dialog (as shown in Figure 30-8) to enable three types of AutoFill:

- **Using Info from My Address Book Card:** This option lets Safari fill in your name, company name, e-mail address, phone number, and mailing address, using the information you’ve established in your Address Book record.

  This AutoFill option saves the most time and creates the fewest security risks.

- **Usernames and Passwords:** Safari can help with two types of username/password combinations:
  - The most common are those associated with login forms, like when you log in to Amazon.com or NewYorkTimes.com.
  - Less common are combinations that limit access to Web pages or sections of a Web page.

  These use a separate pop-up window (although it isn’t the same kind of browser pop-up window used by advertisers), not a standard Web-based form.

  In both cases, Safari — if you let it — remembers the username and password for each individual Web site.

- **Other forms:** This catchall option records (if you want it to) the text you entered in, er, other forms. These values might be for a preferences page of a Web site or an address entered into MapQuest.

After you enable AutoFill, it automatically fills in values when you encounter personal information forms (if the Web site’s form inputs are named logically so AutoFill recognizes them). If the AutoFill doesn’t immediately engage, use the ⌘-Shift-A shortcut to activate it.
Managing Usernames and Passwords

The AutoFill tool marks in yellow the form inputs that it fills out. If you have multiple options for an input (for example, you might have several e-mail addresses), begin typing the first few letters of the one that you want and then select it from the option menu that appears.

For usernames and passwords, and for other forms, Safari automatically fills these out at a Web site by using the values you entered in the previous visit.

Managing Usernames and Passwords

When you first encounter a site that requires a username and password, create a username and password and then submit them. Safari then asks you whether you want to save this password as an AutoFill entry, giving you three options (check them out in Figure 30-9):

1. Click the Edit button next to User Names and Passwords of the AutoFill panel (refer to Figure 30-8).
2. In the resulting panel, select the site whose values should be forgotten (see Figure 30-10).
3. Click the Remove button.
4. Repeat Steps 2 and 3 as necessary.
5. Click Done when you finish.

AutoFill can slow down Safari’s performance in some instances (because Safari must spend time looking to autofill forms there). If you find that a particular Web site is becoming too slow (Safari hangs a bit before loading it), delete the AutoFill record for that site by using the AutoFill preferences panel. Just click the Edit button next to Other forms, select the problematic Web site from the list, and click Remove.

For almost every instance, choosing to have Safari remember the values is the smart move, saving you the time of re-entering that information upon your next visit. If the site in question is of a particularly sensitive nature (such as your online banking), you might want to ask Safari not to remember the values and never prompt you again. If you aren’t certain what to do, opt for door number three (Not Now), and you’re prompted again the next time that you enter that username and password.

To have Safari forget some remembered values

For almost every instance, choosing to have Safari remember the values is the smart move, saving you the time of re-entering that information upon your next visit. If the site in question is of a particularly sensitive nature (such as your online banking), you might want to ask Safari not to remember the values and never prompt you again. If you aren’t certain what to do, opt for door number three (Not Now), and you’re prompted again the next time that you enter that username and password.

To have Safari forget some remembered values

For almost every instance, choosing to have Safari remember the values is the smart move, saving you the time of re-entering that information upon your next visit. If the site in question is of a particularly sensitive nature (such as your online banking), you might want to ask Safari not to remember the values and never prompt you again. If you aren’t certain what to do, opt for door number three (Not Now), and you’re prompted again the next time that you enter that username and password.

To have Safari forget some remembered values

For almost every instance, choosing to have Safari remember the values is the smart move, saving you the time of re-entering that information upon your next visit. If the site in question is of a particularly sensitive nature (such as your online banking), you might want to ask Safari not to remember the values and never prompt you again. If you aren’t certain what to do, opt for door number three (Not Now), and you’re prompted again the next time that you enter that username and password.
Marking Pages with SnapBack

A really, really, really great feature in Safari is SnapBack, which is kind of like a temporary bookmark. There are two different SnapBacks in Safari: one for the main page of a Web site and another for your Google searches. With SnapBack, you can designate a place as a SnapBack page and then return to that page immediately without being forced to navigate back through all the intermediary pages.

An alternative to both the SnapBack and the History features is to use the browser window's title bar. Ô-click the title and you see a menu of previously visited pages (Figure 30-11), like the path hierarchy of a Finder window.

Figure 30-11: See, and quickly go back to, places you’ve been in a Web site by Ô-clicking the browser window title.

Safari automatically manages the two SnapBack pages:

When you go to any site, Safari marks it for SnapBack. After you browse from there, the orange SnapBack arrow appears. Clicking it returns you to the original page. This also works for bookmarks you load.

Here’s an example of how you might use this feature:

1. Open Amazon.com in Safari.
2. Click the Books tab.
   The original URL is now marked for SnapBack.
3. Navigate through the Browse Subjects pages to access the books on, say, Mac OS X.
4. Mark the resulting page for SnapBack by choosing Mark Page for SnapBack on the History menu.
5. View all the books you want and add them to your cart as desired.
   We highly recommend picking up a few copies of Mac OS X Tiger Timesaving Techniques For Dummies (Wiley Publishing, Inc.).
6. Return to the original Mac OS X books page (what you set in Step 4) by clicking the orange SnapBack arrow.

Every Google search page is marked for SnapBack. The Google Search box appears next to the address bar (you can show and hide it by using the View menu) and has its own SnapBack, entirely independent from the location/address SnapBack.

Here’s an example of how you might use this technique:

1. Click in the Google Search box to place your cursor there.
2. Enter your search terms and press Return.
   For example, you can search for “Larry Ullman” or “Marc Liyanage.”
3. Click any link returned by Google to visit that page.
4. If you need to return to the Google search results page, click the SnapBack icon found in the Google Search box.

The keyboard shortcuts for working with SnapBack are

Ô-Option-K: Marks a page for SnapBack.
Ô-Option-P: Goes to the SnapBack page.
Ô-Option-S: Returns to the Google search SnapBack.
Working with Really Simple Syndication

New to Safari 2.0 is support for RSS, which stands for Really Simple Syndication. Some Web sites provide RSS feeds of their content. When you access these feeds by using Safari or another RSS reader, you’re presented with a synopsis of that site’s content (see Figure 30-12). The specific details depend upon the content provider, but normally you see headlines, short summaries, and posted dates. If you’re interested in pursuing an item, click its link to go to the full account.

- Figure 30-12: Viewing the New York Times’ RSS feed for sports stories.

If you regularly visit certain sites, are a news junkie, or have specific interests (such as the latest Mac or iTunes info), using RSS can be the most efficient way to access information. You can use RSS to get a quick glimpse of what a site has to offer without extraneous images, advertising, or even outdated and previewed content!

You can access an RSS feed in different ways:

- If a site offers an RSS feed, there’s usually a link somewhere on the site. Click this link so that it opens in Safari.

- Use the existing list of RSS bookmarks. Safari comes with dozens of RSS feeds bookmarked for you. You can access them through the All RSS Feeds category (see Figure 30-13) or through the organized RSS Feeds folder.

- Figure 30-13: Safari has pre-bookmarked a ton o’ RSS feeds for you.

- Have your browser autodetect the RSS feed. If a site is set up properly, it contains HTML tags in the head section that announce the RSS feeds to the browser. When visiting a site with RSS feeds, Safari shows an RSS icon in the address bar.

- Bookmark RSS feeds yourself. To Safari, an RSS feed is much like any other Web site, meaning that you can bookmark it — and organize your RSS bookmarks — as you would any other page.

After you find the RSS feeds you like, here’s how you can most easily read them:
Use the RSS preferences panel (see Figure 30-14) to adjust RSS settings. Specific important concepts are having Safari automatically:

- Update your feeds
- Color new articles
- Remove outdated articles

Use the Search box on the right side of the browser window to restrict the list of articles. The Search box works much like a Finder window Search box.

Move the Article Length slider all the way to the right to see the longest possible description of each item.

Click one of the Sort By links to change how the items are ordered. This is particularly useful if you’re viewing links from multiple feeds or from a large date range.

Use the Recent Articles links to restrict items to a specific time period. This is good for both restricting the results to the most recent items as well as trying to find an older item.

If you’re big into RSS but Safari’s handling of it doesn’t do much for you, check out Pulp Fiction from Freshly Squeezed Software (http://freshlysqueezedsoftware.com/products/pulpfiction, $25). This application is like a cross between the Mail application and how Safari does RSS. A demo is available for you to test drive the full version, and a free, scaled-down “lite” version is also available.

• Figure 30-14: Safari has a separate preferences panel for adjusting how it treats RSS feeds.
Safari is the official Web browser of the Apple world. Fortunately, it’s also a really good browser, with many smart features. Another advantage that the Safari browser has over its competition (the exception being Firefox) is the number of ways you can customize its behavior to suit your needs. This technique introduces a dozen or so utilities that customize how Safari runs and what features it has. These alterations run the gamut from tweaks that everyone can appreciate to specialized hacks that only Web developers might want.

For starters, we cover some tools for changing the surfing experience as a whole. From there we focus specifically on applications that improve Safari’s searching capability. Then you see a couple utilities that improve how Safari handles bookmarks. Finally, we devote a section to using JavaScript with Safari in ways you might not have come up with yourself.

Most of these utilities either have their own installer or are separate applications that you run just like any other. In a worst-case scenario, you might have to use a README file that tells you how to get the utility working. Just understand that the changes won’t take effect until the next time you start Safari. As for undoing the effects of these utilities, most of them also have a tool for resetting the changes. With some, you must delete a file installed in a special location.

### Improving Your Surfing Experience

This first category of Safari hacks affects how Safari as a whole looks and behaves. Some of the applications and modifications you see here are mostly cosmetic, but others can save you heaps of time. You may not need to tap into all these resources but should certainly appreciate what a couple of them has to offer. The most useful resources to know are the following:

**Techniques**

- Altering the overall surfing experience
- Changing your search tool
- Making bookmarks easier to work with
- Using JavaScript for special tricks
Cascading style sheets: If you're comfortable with cascading style sheets (CSSes), create your own style sheet and set Safari to always use it (on the Advanced preferences panel). How much or how little you dictate in the style sheet is up to you. In-depth coverage of CSSes is outside the scope of this book, but if you want to read up on the subject, check out Cascading Style Sheets For Dummies, by Damon Dean and company (Wiley Publishing, Inc.).

Safari Aquafier (www.scifience.net/aquafier.html, donationware): It replaces the brushed metal look of Safari’s windows with a brighter, more pleasing appearance. In essence, it changes the overall look of the Safari application.

SafariSpeed (www.scifience.net/safari-speed.html, donationware): SafariSpeed perks up your browsing experience by doing two things:

- It removes a delay built into Safari that loads pages after a quick pause.
- It turns off Safari’s support for favorite icons (customized icons that represent a site and appear next to its address, in your bookmarks, and so forth).

To make these changes, you just need to run the SafariSpeed application once.

Safari Enhancer (www.lordofthecows.com/safari_enhancer.php, free): Safari Enhancer does a lot for your browsing experience. For starters, it enables the Debug Menu (see Figure 31-1, and also check out the sidebar) and lets you control your overall and favorite icon caches. It also tweaks how hyperlinks appear, lets you drop the brushed metal appearance of Safari, and adds a few modifications to the Search box. In short, Safari Enhancer does what several other utilities do, but in one fell swoop. Just run the application and select the appropriate options in order to enhance Safari as you see fit.

Figure 31-1: You can enable the Debug Menu in Safari by using third-party tools.

Safari’s Debug Menu

If you’re a really techie user, you’ll appreciate this little trick: Safari has a Debug Menu, which isn’t present by default. The easiest way to make this menu visible is to use Safari Debugger (www.scifience.com/debugger.html, donationware), an AppleScript that lets you enable or disable the Debug Menu. (For the record, many of the other applications that we list in this technique also enable the Debug Menu.)

The Debug Menu offers many features that Web developers can use, including:

- The ability to have Safari identify itself as a different browser
- Import and export bookmarks from other browsers
Help debugging JavaScript problems
A tool for testing how pages load

The menu has quite a few other features, and even the most basic Safari user can appreciate the Debug Menu's option of listing all of Safari's shortcuts.

Saft (http://haoli.dnsalias.com/Saft, $10): Saft brings oodles of features to Safari. Here’s a quick list of some of the most useful features:

- You gain the ability to search your browsing history.
- Saft lets you use the Search box for non-Google searches.
- It installs the Debug Menu.
- Saft has an expanded PDF export feature, letting you customize what kind of PDF Safari can create.

Pith (www.blacktree.com/apps/pith/index.html, free): If you tend to have a lot of Web pages open at once, you’ll really like Pith. This little utility uses a window to show the list of currently open sites. Switching from one to another is then just a matter of clicking an icon instead of trying to hunt through multiple browser windows. Another nice benefit is that if Safari crashes, Pith can recall all of the previously open sites.

SafariSource (www.tildesoft.com/Misc.html, free): SafariSource works with SIMBL (see the sidebar) to do one thing: provide a color syntax highlighting when you view the source of a Web page. So instead of looking at all black code, HTML tags appear in one color, HTML attributes in another, plain text in a third, and so on.

For Web designers, this extra nicety is an absolute must!

What is SIMBL?
SIMBL (Smart InputManager Bundle Loader) lets you alter how some applications in Mac OS X function. It provides an interface through which different plug-ins can tie into applications such as Safari, iChat, and the Terminal. You can get SIMBL from http://culater.net/software/SIMBL/SIMBL.php, although it also comes in the Safari Source download.

To install SIMBL, the SIMBL.bundle file is placed with a SIMBL folder in the /Library/InputManagers directory. Then plug-ins can be stored in the /Library/Application Support/SIMBL/Plugins folder (you can also install SIMBL into your own Home directory).

In this technique, we mention three plug-ins for SIMBL: SafariSource, PithHelmet, and fiwt. Another good one is iCar (iChat Auto-Reply, www.pygmysoftware.com/software/icar), which makes iChat’s auto-reply feature work better with AOL Instant Messenger. More subtle plug-ins are around, such as InvisRay (www.davidestes.net/invisray.html), which changes the transparency of windows.

PithHelmet (www.culater.net/software/PithHelmet/PithHelmet.php, free): PithHelmet takes the idea of pop-up blocking one step further. It can block advertisements, Flash and Shockwave animations, and sounds. With it you can also more finely tune your cookie settings (for example, allowing cookies only from the site you’re visiting).

Safari Extender (http://batista.org/extender.html, $10): Safari Extender works as a contextual menu within Safari. It has a slew of tab-related features (if you’re tab-happy) and a few Mail-related shortcuts. It also lets you easily increase or decrease the font size and load or not load images in a Web page.

fiwt (www.nondeterministic.net/hack/fiwt, free): Another SIMBL plug-in, fiwt (find it while typing) lets you search for text on a page without bringing up the Find dialog. After you load a Web page, start typing the word you’re looking for and fiwt highlights the first occurrence. Press the backslash key to find the next occurrence.
Safari Search Enhancements

One important category of enhancements is searching. You can customize how Safari’s Search box functions. The default Google Search box — at the end of the address bar — is fantastic, but you can make it even better by using these products:

- **AcidSearch** ([www.pozytron.com/acidsearch](http://www.pozytron.com/acidsearch), free): This fine product adds different “channels” to your Search box, letting you search Google Images or Google News (see Figure 31-2). It also lets you search other search engines instead of Google.

- **Sogudi** ([www.atamadison.com/w/kitzkikz.php](http://www.atamadison.com/w/kitzkikz.php), free): Sogudi is a lot like SafariKeywords, letting you quickly search sites by using abbreviations. One difference is that it lets you perform these searches from the address bar. It also allows you to just quickly access your favorite sites (like going to [www.apple.com](http://www.apple.com) by just typing a in the address bar and then pressing Return).

Contextual menus and Services offer shortcuts for Search with Google and Open URL, thanks to Safari. With these, you can quickly start common Safari tasks from within other applications. See Techniques 14 (on contextual menus) and 29 (on Services) for more. Shareware utilities like LaunchBar and QuickSilver also tie into Safari for searching and accessing bookmarks.

Bookmark-Related Utilities

When you have several dozen bookmarks, keeping them organized, finding particular ones, and making sure they’re still valid becomes nothing short of a chore. For better or for worse, Safari comes with a few dozen bookmarks out of the box (not even counting the RSS feeds)! To make your bookmarking life easier and more productive, use these utilities and be certain to read Technique 32.

- **SafariSorter** ([http://dearjerry.home.mindspring.com/raisinland/SafariSorter/SafariSorter.html](http://dearjerry.home.mindspring.com/raisinland/SafariSorter/SafariSorter.html), free): SafariSorter simply alphabetizes all your bookmarks and folders. It has a surprising number of preferences that you can set for alphabetization rules and the like (see Figure...
If you have certain folders that are organized in a special way (like the Bookmarks Menu or the Bookmarks Bar), you can exclude these. Really, a very nice little application!

**Figure 31-3:** SafariSorter automatically organizes your bookmarks per your instructions.

- **Safari Menu** ([www.edot-studios.com](http://www.edot-studios.com), free): You know how you’ll be working in Microsoft Excel and absolutely, positively must check out ESPN.com? Well, Safari Menu is the tool for you. This utility creates a menu of your bookmarks that is always available through the menu bar, saving you a couple steps (switching to Safari, opening a browser window, viewing the bookmarks collection, finding the bookmark, and double-clicking it).


- **SafariBookmarkChecker** ([www.coriolis.ch/article22.html](http://www.coriolis.ch/article22.html), free): Another one of our favorites, you can use the SafariBookmark Checker to make sure that URLs that you’ve bookmarked are still good. It’s amazingly fast and gives you a nice report on which bookmarks were no longer reachable (see Figure 31-4).

**Figure 31-4:** Check whether bookmarks are still good by using SafariBookmarkChecker.

New in Safari 2.0 is the ability to search your bookmark collection. Use the Search box at the bottom of the Bookmarks window to find the URL you’re looking for.

**What Your Parents Never Told You About JavaScript**

JavaScript, which is most commonly used to add features to Web pages, can be used independently of Web sites and pages. By bookmarking JavaScript code, you create a bookmarklet, adding functionality to your Web browser. We show you how to create a simple bookmarklet, and then point you toward other good resources.

To clear up a common misconception, JavaScript and the Java programming language have nothing to do with each other. Java is a very popular object-oriented programming language used to make applications that (theoretically) run on many different operating systems. JavaScript is a Web-based tool. (Technically, JavaScript is now called ECMAScript, although no one ever calls it that.)
Creating a print button

You probably find yourself printing the occasional Web page, but it’s such a pain to choose File→Print or press ⌘-P. Instead, make a JavaScript print button. Here’s how:

1. **Open a browser window in Safari.**

2. **Type** javascript:window.print(); **in the address bar, but don’t press Return** (see Figure 31-5).

![Figure 31-5: You can type JavaScript code in the address bar to make a bookmarklet.](image)

3. **Drag the globe icon (left of the word javascript)** onto the Bookmarks Bar.

4. **At the prompt, give the bookmark a good name**, like Print.

5. **Click the Print icon in the Bookmarks Bar anytime** you want to print a page.

Downloading existing bookmarklets

If you don’t know how to code JavaScript or you simply don’t want to spend the time, *use somebody else’s work*. Here are four great resources for bookmarklets:

- **Apple** ([www.apple.com/applescript/safari/bookmarks.html](http://www.apple.com/applescript/safari/bookmarks.html)): Apple has provided a couple good examples in the Safari AppleScript pages. Some tie into Sherlock (which doesn’t exist in Tiger), but you’ll probably find the iTunes ones to be quite handy.

- **Entropy.ch** ([www.entropy.ch/links/welcome.php#BookmarksBar_B bookmarklets](http://www.entropy.ch/links/welcome.php#BookmarksBar_B bookmarklets)): This book’s very own Marc Liyanage has a gaggle of bookmarklets available on his Web site (where you can also stare in wonder at the vast number of bookmarks he has amassed). His bookmarklets are especially great for Web developers, with utilities that
  - Validate the HTML or CSS of a page
  - Show tables and DIV elements
  - Let you send the current URL to someone in an e-mail
  - Resize the browser window

- **Jesse’s Bookmarklets Site** ([www.squarefree.com/bookmarklets](http://www.squarefree.com/bookmarklets)): This site has some very nice bookmarklets, particularly for Web developers.

- **Favelets** ([http://tantek.com/favelets](http://tantek.com/favelets)): Along with the standard HTML and CSS validation bookmarklets (or favelets, as this site calls them), you can find nice ones for translating the current page into other languages.

To install other people’s bookmarklets, all you normally have to do is drag the link onto your Bookmarks Bar. Because bookmarklets are meant to be quick and useful, consider creating a folder (or several) on the Bookmarks Bar in which you can store them.
Managing Bookmarks Better

Surfing the Internet would be a much more tedious process if it weren’t for the advent of bookmarks. Bookmarks (or Favorites, as they’re also called) are URLs that you save in a browser and then organize the way you like for easy access. We don’t discuss bookmarks much in previous techniques because they really merit their own discussion, particularly if you use multiple browsers.

The focus in this technique is the Safari Web browser, which we recommend you use as your default. We first talk about bookmark management within Safari, and then we go into sharing bookmarks across multiple browsers (which is a good thing whether you actively use multiple browsers or just switched to a different one). Finally, we wrap up with some tips and techniques for bookmark management that you might want to employ.

Managing Bookmarks in Safari

Because we assume that you’re using Safari as your primary Web browser, we cover bookmarks in that application most specifically. Safari’s bookmarks tools have taken the best qualities from every other browser and wrapped them into one package. With Safari, you have three bookmark locations:

- **The Bookmarks window (see Figure 32-1):** The Bookmarks window is the least accessible (it just requires an extra click to access it) but helps to manage all your bookmarks. The Bookmarks window is where you store the majority of your bookmarks, and it’s also where you can add, edit, or delete bookmarks that appear on the Bookmarks Bar and Bookmarks Menu.
Technique 32: Managing Bookmarks Better

• Figure 32-1: Use the Bookmarks window to manage and access sites.

❖ The Bookmarks Menu (see Figure 32-2): The Bookmarks Menu lists bookmarks, which you can access by selecting a site from the list. Figure 32-2 shows two bookmarks on Larry’s menu.

❖ The Bookmarks Bar (see Figure 32-3): This is an area intended for your most frequently used bookmarks because they can appear in your browser window at all times, making them the easiest to access. The Bookmarks Bar can display individual URLs (like Apple and Amazon in Figure 32-3) and folders of sites (News and Localhost). It also provides a link to the Bookmarks window (the open book icon on the far left).

A fourth related tool is the History menu. This menu doesn’t contain bookmarks per se but is rather a history of pages that you’ve visited. Those URLs you’ve been to appear on the History menu and within the Bookmarks window (the fifth item under Collections in the left column of Figure 32-1). The History menu displays the most recent few pages visited, followed by other pages grouped by the date on which you were there.

To add bookmarks, access the Bookmarks window or Bookmarks Bar. To create new folders for organizing your bookmarks (in the Bookmarks window), you can use the Bookmarks Menu (refer to Figure 32-2) or the following keyboard shortcuts:

❖ ⌘-D: Creates a bookmark for the current page.
❖ ⌘-Shift-B: Toggles to show and hide the Bookmarks Bar.
❖ ⌘-Option-B: Displays the Bookmarks window.
❖ ⌘-Shift-N: Creates a new folder within the Bookmarks window.

Safari comes with many bookmarks and folders already grouped into News, Mac, Kids, Sports, and more. This is important because creating a folder for each category of Web page that you want to bookmark helps you find your bookmarks faster. Some good folders you might want to add are Work, Mac OS X Software, Local Interest, and any other types of pages that you visit frequently.
Bookmarking a page

To bookmark a page, follow these steps:

1. **Load the page in your Web browser.**
2. **Press Ô-D.**

   This brings up the Add Bookmark prompt, as shown in Figure 32-4.

   ![Figure 32-4: Use the Add Bookmark prompt to mark a page.](image)

3. **If desired, enter a new title for this bookmark.**

   The default bookmark name comes from the title of the page as it appears in the browser window’s title bar. For some pages, this is quite long or not very descriptive, so you might want to devise a new name that makes sense to you.

4. **Use the drop-down list to select the location for the bookmark.**

   An important part of managing your bookmarks is placing them in the right folder in the first place. If you’ve adequately organized your bookmarks, you already have a folder available to store them in.

   ![Tip: You can immediately add a site to your Bookmarks Menu or Bookmarks Bar by choosing the appropriate location from the Add Bookmark prompt’s drop-down list (refer to Figure 32-4). More immediately, you can add a site to your Bookmarks Bar by dragging the site’s icon (found just to the left of the URL in the address bar) onto the Bookmarks Bar.](image)

Using the Bookmarks window

The Bookmarks window is a special browser page that you can use to view and manage your bookmarks. The left column (Collections; refer to Figure 32-1) shows the different groupings of bookmarks that you have. These include Bookmarks Bar, Bookmarks Menu, History, the folders that came with Safari, and the folders that you create. When you select an item in the Collections column, its contents are listed in the right side of the window.

Here are some tips and techniques for working with this window:

- Create a new folder by pressing Ô-Shift-N or clicking the + button at the bottom of the window.

- Depending upon which plus sign you click, you can create a new primary folder (by clicking at the bottom of the Collections column) or a new secondary folder (by clicking at the bottom of the Bookmark column). If you click the + underneath the Bookmark column, a new folder is created within the currently selected Collection.

- Alphabetize your folders by dragging and dropping them to reorder them.

- Don’t mess with the folders named Imported IE Favorites or Imported Netscape/Mozilla Favorites, if you have them. Leaving these folders intact lets you access bookmarks that you’ve set in those browsers.

- Nest related folders inside each other to maintain order without cluttering up the main set of collections. For example, you might want to create a Software folder inside the Mac folder or add a Movies folder to Entertainment.

- Rename a folder by pressing Return after you select it.

- If you want to copy a bookmark from one location to another (from one folder to another or from the Bookmarks window to the Bookmarks Bar), hold down the Option key as you move it.
You aren’t really limited to a certain number of bookmarks on the Bookmarks Bar, but if the titles of all the bookmarks run longer than the width of the browser window, some bookmarks won’t be shown. Instead, double arrows appear at the far-right side of the bar, and you need to click them to access the other bookmarks. This behavior is exactly the same as it is with Finder window toolbars if the window isn’t wide enough to show every tool.

To manage the Bookmarks Bar

1. Open the Bookmarks window by pressing Ô-Option-B.
2. Click the Bookmarks Bar title at the top of the Collections column.
3. In the right pane, delete any bookmark or folder that you don’t want to appear on the Bookmarks Bar by pressing Delete.
4. Add any bookmark by dragging it from another location into the Bookmarks Bar listing.
5. Arrange the bookmarks by clicking and dragging them to suit your preferences.

You can also add pages to the Bookmark Bar by dragging the URL directly onto the bar in the browser window. You can remove items by dragging them off, and you can rearrange the order by clicking and dragging the bookmark names.

One of the best features of the Bookmarks Bar is the ability to group bookmarks into folders. For example, Safari already comes with the News folder on its Bookmarks Bar, containing links for CNN.com, The New York Times, BBC NEWS, and more. Folders on the Bookmarks Bar are marked with a down-pointing triangle, which displays a pop-up menu of the bookmarks in that folder when you click it, as shown in Figure 32-5.
Managing Bookmarks in Safari 247

• Figure 32-5: Bookmarks Bar folders are presented as pop-up menus.

Here’s how to add a folder to your Bookmarks Bar:

1. Open the Bookmarks window by pressing Ô-Option-B.
2. Click the Bookmarks Bar title at the top of the Collections column.
3. Create a new folder by pressing Ô-Shift-N or by clicking the + sign at the bottom of the Bookmark column.
4. Give the new folder a name.
5. Drag all the bookmarks that you want to add to the folder.

   If you hold down the Option key while dragging a bookmark into a folder, a copy of the bookmark is placed there, and the original remains.

6. If desired, click the Auto Click box, which appears between the Bookmark and Address columns.

The Auto Click feature means that instead of providing a drop-down list of bookmarks in the folder, clicking the folder name in the Bookmarks Bar automatically opens every bookmark at once, using multiple tabs.

Use bookmark folders to create groups of related bookmarks. Use the Auto Click feature to make a collection of related bookmarks to be opened together (see Figure 32-6).

• Figure 32-6: Auto Click folders open all at once in a multitabbed browser window.

Setting bookmark preferences in Safari

You can control Safari’s bookmarks somewhat by using the Bookmarks preferences panel (see Figure 32-7), which you can access by choosing Safari ➤ Preferences and clicking Bookmarks. With it, you can decide whether to add Address Book or Bonjour bookmarks to any of three places: the Bookmarks Bar, the Bookmarks Menu, or the Collections panel of the Bookmarks window.
Technique 32: Managing Bookmarks Better

- Click a bookmark on the Bookmarks Bar to open it in a new tab.
- Click a Bookmarks Bar folder to open its contents at once in separate tabs.
- Use the Bookmarks Menu to access bookmarks stored there.
- Click the open book icon on the far left of the Bookmarks Bar to access the Bookmarks window.
- Choose the Open in Tabs option at the bottom of the Bookmarks Menu (refer to Figure 32-2) to open every menu bookmark at once (within a single browser window but in separate tabs).

One of the coolest features of Safari is that it automatically numbers your Bookmarks Bar bookmarks in order from left to right so they’re accessible via a keyboard shortcut. For example, in Larry’s Bookmarks Bar (as shown in Figure 32-8), the Apple bookmark is launched by pressing Ô-1, My Excite is launched by pressing Ô-2, and so forth. Folders are skipped in the numbering sequence so that (again referring to Figure 32-8) PHP is associated with Ô-6.

You can also tell Safari to include the Bookmarks Bar on the Bookmarks Menu. This is worthwhile mainly if you don’t already display the Bookmarks Bar.

Accessing Safari Bookmarks

After you organize and create all your bookmarks, you need to access them with ease. Here’s all the information you need to know:

- Click a bookmark on the Bookmarks Bar to open it.
- Click a folder on the Bookmarks Bar to view the list of bookmarks in it (and then select from the options, refer to Figure 32-5).

New to Safari 2.0 in Tiger is the ability to search through your bookmark collection. At the bottom of the Bookmarks window is a standard Search box (see Figure 32-9). As you enter search terms, Safari returns the qualified bookmarks (using folder names, URLs, and descriptions to compare against). Using the Search box’s drop-down list, you can even limit your search to specific collections.

* Figure 32-7: Add Address Book and Bonjour bookmarks automatically using the Bookmarks preferences panel.

If you select the Include Address Book check box next to the Bookmarks Bar heading, for example, Safari loads all the URLs stored in the Address Book as a folder on your Bookmarks Bar. Each URL is accessible through the person’s name with whom it’s associated.

* Figure 32-8: The Ô shortcuts for the Bookmarks Bar start with 1 and are numbered from left to right.

This trick works for all the bookmarks not in folders and even works if no browser window is open!
Sharing Bookmarks across Browsers

The biggest downfall to using multiple Web browsers or switching to a different browser is trying to re-establish all your bookmarks. Fortunately, some of the Web browsers have acknowledged this and can automatically import bookmarks from other applications.

- Safari automatically imports Internet Explorer and Netscape/Mozilla bookmarks. (They appear as folders in the Collections panel of the Bookmarks window.)
- Camino, Mozilla, and Netscape automatically list Internet Explorer bookmarks.
- Opera can import bookmarks from other applications in certain formats.

In Technique 42, we go over iSync, which is an Apple tool. One of its features is the ability to synchronize your Safari bookmarks with your .Mac account, letting you access all your bookmarks online when you’re away from your computer. It lets you synchronize Safari bookmarks across multiple computers as well.

If you have only a few bookmarks to move around, your best bet is to drag and drop them from one application to the other. Or, you can investigate one of the many bookmark-management applications available (most of them aren’t free) if you’re in a serious bookmark quandary. For example, if you’re moving from another browser to Safari or want to import someone else’s Safari bookmarks into your Safari, Safari Enhancer (www.lordofthecows.com, free) adds an Import Bookmarks option on a Debug Menu that the utility can add to Safari.

In Technique 31, we discuss several applications that modify Safari’s behavior. Along with Safari Enhancer, you find out about Safari Sorter, Safari Menu, and SafariBookmark Checker.

Transferring your bookmarks to a new Mac

Different applications can access the bookmarks managed by other applications because bookmarks are stored as text files on your computer. Specifically:

- Safari uses an eXtensible Markup Language (XML) file stored in ~/Library/Safari/Bookmarks.plist.
- Camino uses an XML file stored within your Application Support folder.
- Mozilla uses a HyperText Markup Language (HTML) file stored with the ~/Library/Mozilla directory.
- Internet Explorer uses an HTML file stored within the ~/Library/Preferences/Explorer directory.

This system has two benefits for you, the end user. First, you can easily transfer all your bookmarks from one computer to another just by copying over the appropriate file. Second, you can manually tweak your bookmarks by editing these files in any text editor.
Bookmarks Tips and Tricks

In this section, we mention a couple other cool bookmark tips.

You can make a bookmark as a file on your computer by dragging the URL from your browser’s address bar onto the Desktop (or anywhere else). This creates a special **webloc** file type, which is like an alias to that Web site (see an example in Figure 32-10).

After you do this

- Open that file to open the Web site in your Web browser.
- Add the file to your Startup Items to automatically load the URL when you log into your computer. (See Technique 2 for more on Startup Items.)
- Add the file to your Favorites (see Technique 17) or a docked folder (see Technique 13) to keep it out of the way, yet easily accessible.

One of our favorite shareware applications, LaunchBar ([www.obdev.at/products/launchbar](http://www.obdev.at/products/launchbar); free for limited use, $20 for personal use), can be used to open many things, including your favorite Web pages. As we demonstrate in detail in Technique 23, LaunchBar lets you perform tasks by typing a key combination. For starters, you can use LaunchBar to open or switch to applications, but LaunchBar also reads through and indexes all your bookmarks, making them only a couple keys away. To try this, follow the example in Technique 23 but use a logical keyboard combination for one of your bookmarks (like CT for Chicago Tribune).

- Figure 32-10: URLs saved on your computer have a special icon.
The World Wide Web wouldn’t be half as useful without the search engines that make its content findable. Throughout the history of the Internet, several search engines have been popular, but the current reigning champ is Google.

Most search engines help you find what you need, but there’s a lot to be said for Google in particular. Knowing how to use it and all its options goes a long way toward improving the speed and accuracy with which you find stuff. We start this technique by going through some more advanced Google navigation tips. Then you discover how nicely Safari and Google work together. Lastly, this technique mentions a handful of different tips that, although not universally useful, are quite handy to know.

**Doing Basic Google Searches**

Google is one of those wonderful tools that people can use on a basic or advanced level. In other words, any Joe Bag-o’-Doughnuts can use it for everyday purposes, whereas rocket scientists can really tweak the heck out of it. Basic searches involve typing a few words (or just one) in the Search box and then clicking the Google Search button. Beyond this, here are some rules to follow that you might (or might not) be aware of:

- **The more keywords you use, the more specific the search is.** Too-general searches tend to return an unwieldy number of results.

- **Google, by default, returns only results that include all the search words.**

- **Be as precise with your keywords as possible.** It’s far, far more likely that Google will return too many results than too few, so you should be as specific as you can when you have a good sense of what you’re looking for.
Technique 33: Speedy Searches with Google

- Use the OR keyword to make a less restrictive search. Google normally requires that every search term be in a search result, but you can overrule this behavior by typing OR between each word. Note: The OR keyword should be in uppercase letters, and be sure to add a space after it.

- Use a plus sign (+) before a word to indicate that the word is required (see Figure 33-1). Although Google always searches for every word, it skips common terms and numbers. By using the plus sign before a word (without a preceding space), you can insist upon its use.

- Order your keywords by importance. The order of your keywords affects the results of the search. Enter the most important terms first.

- Skip common words. Google automatically ignores very common words, such as conjunctions (and), articles (a, an, the), being verbs (are, is), and interrogatives (who, what, why), so you might as well save Google the trouble and not use them in the first place.

- Place phrases within quotation marks (see Figure 33-2). Using phrases is a much more exact way to execute a search. For example, searching for Larry Ullman turns up about 118,000 search results, whereas searching for “Larry Ullman” returns only 31,000.

- Use a minus sign (-) to rule out a keyword. For example, if you want to search for apples — the fruit, and not the computers — you could use apple -computer -mac as your search terms. Remember: Do not include a space between the search term(s) and the minus sign(s).

- Google is a case-insensitive search by default. This means that word, WORD, Word, and WoRD are all treated the same. Save yourself some effort by not wasting time fixating on the proper capitalization of your search terms.

Doing Advanced Google Searches

After you master the basics, here are some fancier tools that you can use:

- Use the OR keyword to make a less restrictive search. Google normally requires that every search term be in a search result, but you can overrule this behavior by typing OR between each word. Note: The OR keyword should be in uppercase letters, and be sure to add a space after it.

- Use a plus sign (+) before a word to indicate that the word is required (see Figure 33-1). Although Google always searches for every word, it skips common terms and numbers. By using the plus sign before a word (without a preceding space), you can insist upon its use.

- Order your keywords by importance. The order of your keywords affects the results of the search. Enter the most important terms first.

- Skip common words. Google automatically ignores very common words, such as conjunctions (and), articles (a, an, the), being verbs (are, is), and interrogatives (who, what, why), so you might as well save Google the trouble and not use them in the first place.

- Place phrases within quotation marks (see Figure 33-2). Using phrases is a much more exact way to execute a search. For example, searching for Larry Ullman turns up about 118,000 search results, whereas searching for “Larry Ullman” returns only 31,000.
If you’re bored one day, search for yourself on Google. This is called Ego Surfing. Or, if you want a real challenge, try Googlewhacking — finding two words which, when searched in Google, return only one record.

To further limit your searches without relying upon keywords, check out Google’s directory feature. The Google directory, which is accessible at www.google.com/dirhp, breaks the Web down into a series of categories. To limit search results, search within a category.

Use the site: restrictions to search a particular site. The site: keyword restricts a search to a specific Web address or domain type. For example:

- You can limit your searches to schools with site:edu.
- Search only a particular country realm with site:ch (ch stands for Switzerland).

To find the domain name abbreviation for a country (or find what country an abbreviation represents), head to www.iana.org/cctld/cctld-whois.htm. There you can find out that .tv is Tuvalu and the Vatican is .va.

- Check out United States government pages with site:gov.

Finally, Google provides an advanced search page that can be accessed by clicking the Advanced Search link. This page has numerous other options, the two best of which are

- In the Date drop-down list, you can restrict the returned records to a certain date range.
- In the Occurrences drop-down list, you can specify where in a page the search should run:
  - Selecting In The Title dictates that the keywords must be found in the page’s title.
  - Selecting In The Text dictates that the keywords must be found within the page’s text (ignoring links and titles).

Doing Specialized Google Searches

Google’s default search takes place within the Web, meaning that it looks through Web pages. You can also have Google search for or through the following:

- Images: http://images.google.com
- Newsgroup postings: http://groups.google.com
- Mail-order catalogs: http://catalogs.google.com
- News articles: http://news.google.com
- Specific technical topics (like BSD, Apple, and Microsoft): www.google.com/options/specialsearches.html
- University Web pages: www.google.com/options/universities.html

Google also has the ability to search for specific file types. You can request a specific type of file by adding the filetype:type designation to your search parameters, where type is the file extension. You can omit a specific type with -filetype:type.

The types of files that Google can search for are

- Adobe Portable Document Format (.pdf)
- Adobe PostScript (.ps)
- Lotus 1-2-3 (.wk1,.wk2,.wk3,.wk4,.wk5,.wk1,.wks,.wku)
- Lotus WordPro (.lwp)
- MacWrite (.mw)
- Microsoft Excel (.xls)
Technique 33: Speedy Searches with Google

the browser window (as shown in Figure 33-3), which in turn offers some other nice features.

- Figure 33-3: Add a Google Search box to your browser.

Safari’s Google Search box has its own SnapBack capability. The SnapBack feature (which we discuss in Technique 30) creates a temporary bookmark of a page so that you can quickly access it again.

1. Place your cursor in the Google Search box.
   You can use your mouse to access the Google Search box directly — or press Ô-L to move to the address bar — and then press Tab to highlight the Google box.

2. Enter your search terms.
3. Press Return.
4. The search results display in the main part of the browser — check out the results all you want.
5. When you’re done browsing, click the orange arrow in the Google Search box to snap back to the search results page.

Alternatively, you can use the Ô-Option-S keyboard shortcut to go to the Google SnapBack page.

The Google Search box even keeps track of recent searches, as shown in Figure 33-4. Click the magnifying glass icon in the Google Search box to view and access recent searches.
Google is much more than just a search engine. The fine folks at Google have been continually adding new widgets and features over the years, expanding its capabilities. Here are some of our favorites.

**Google Tips and Tricks**

Google, the *dictionary*

You can use Google to look up a word for you.

1. Open Google in your Web browser.
2. Type `define word` or `define phrase`, replacing `word` or `phrase` with the actual word or phrase that you want defined.
3. Click the Google Search button.

If you’re using Safari, you can just type `define word` or `define phrase` in the Google Search box and then press Return.

4. You find the definition listed first in the search results, by the heading Web Definition (see Figure 33-5).

If you use `define: word` (note the colon), Google instead takes you to a page of definitions, without any other search results.

5. If desired, click the More Definitions link to see, surprisingly enough, more definitions.

Alternatively, if you do an ordinary search for a single word and Google can find a definition for it, this word is underlined in the blue bar at the top of the Google window (check out Figure 33-6). Click that word to view its definition.

Google, the *mathematician*

Did you know that Google can do your math homework for you? Okay, maybe not, but it *can* perform basic calculations. See Table 33-1 for the operators and terms you’ll usually use. (Most of them are common sense.)
Technique 33: Speedy Searches with Google

Google’s calculator is very flexible (and maybe even a little strange). You can enter long numbers with or without the commas (indicating thousands) and returned results use spaces instead of commas.

- 67% of 5,000
- \sqrt(625)

Google, the unit converter

Do you remember how many pints are in a gallon or how many meters are in a furlong? If not, use Google’s measurement conversion capability to help you out. All you need to do is type your conversion as a phrase in the Google Search box. Here are some examples of things you could enter:

- Ten miles in kilometers
- Teaspoons in a quarter cup
- One hundred yards in meters (see Figure 33-8)

Google can handle logarithms, trigonometric functions, and more. Here are some rules to abide by:

1. Use parentheses to avoid operator precedence issues. For example, \((4+2)*3\) instead of just \(4+2*3\).

2. Conclude a statement with an equal sign to indicate what result you’re looking for. For example, \((4+2)*3=\).

Each of the following Google searches returns the desired mathematical results:

- \(12,908,308,089/4,979\) (as shown in Figure 33-7)

Google, the linguist

Google can be your own personal translator.

1. Click the Language Tools link.
2. Enter a selection of text in the Translate Text box.

Table 33-1: Google Mathematical Terms

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
<td>2+2</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
<td>5–3</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
<td>2*2</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
<td>9/3</td>
</tr>
<tr>
<td>^</td>
<td>Exponent</td>
<td>2^3</td>
</tr>
<tr>
<td>%</td>
<td>Modulus</td>
<td>5%3</td>
</tr>
<tr>
<td>% of</td>
<td>Percentage</td>
<td>75% of 300</td>
</tr>
<tr>
<td>sqrt</td>
<td>Square root</td>
<td>\sqrt(81)</td>
</tr>
<tr>
<td>!</td>
<td>Factorial</td>
<td>4!</td>
</tr>
</tbody>
</table>
3. Use the drop-down list to select what kind of language conversion to perform.

Right now, Google’s translation service isn’t as potent as Babel Fish (http://babelfish.altavista.com), but it’s worth considering. As of the time of this writing, you’ve got these choices:

- English
- German
- Spanish
- French
- Italian
- Portuguese

Plus Japanese, Korean, and Chinese are in beta testing even as we write.

4. Click Translate to see the result.

Alternatively, you can have Google translate an entire Web page by entering its URL in the Translate a Web Page box.

Google’s Language Tools page also lets you set the default language to use in Google and shows the many Google home pages for various countries around the world.

Google, the investor

Google provides you with stock quotes if you enter ticker symbols in the search box. Alternatively, if a search turns up a company’s Web site, Google also provides a link to the stock quote (see Figure 33-9).

Apple

Apple The Apple Store iPod iTunes Mac QuickTime Apple Support Mac OS X ... Site Map | Search Tips. Visit the Apple Store online or at retail locations. ... Description: Apple’s main homepage. Category: Computers > Systems > Apple > Macintosh.

Google, the cartographer

If you enter a street address in Google, it provides you with links to Google Yahoo!, and MapQuest maps for that address.

Google, the (fill in the blank)

Google is so potent and changes so often that we can’t possibly cover every feature the search engine has. It hides dozens of tools and tricks behind its simple interface. Here are just a couple more features that we recommend checking out:

- Froogle (http://froogle.google.com), an e-commerce tool.
- Google Answers (http://answers.google.com), a pay-for-use consulting resource.

To see what other tools Google has in the works, check out the Google Labs page (http://labs.google.com). One such forthcoming edition (which might be out by the time you read this) is Google Suggest (http://www.google.com/webhp?complete=1&hl=en), which auto-completes your keywords as you type them, offering up suggestions. Each word is even listed along with the estimated number of search results!
Along with surfing the Internet, the ability to send and receive e-mail might be the most common reason people use computers today. Sadly, until the Mac operating system turned over the OS X leaf, there was no such thing as an Apple-made e-mail application. Today’s Tiger user can rest assured that Apple’s solution — Mail — isn’t only available and free, but it’s pretty darn good, too.

This technique distills the abundance of information on Mail into the most critical bundle for timesaving techniques. You don’t get much in the way of introductions or basics here except as they apply to using this application more efficiently. This technique begins with some keyboard shortcuts and then goes into setting some preferences. We follow this with tips on organizing your mailboxes and performing searches within them. Finally, we tack on some information about signatures (the kind you put at the bottom of an e-mail message, not your John Hancock), and a few other useful Mail-related tidbits that didn’t fit in elsewhere.

Mail has received a pretty thorough overhaul in Tiger, adding new features and a new appearance. One of the most important new features is Smart Mailboxes, which follows in the footsteps of Smart Albums in iTunes and Smart Folders in the Finder. You might also appreciate the improved account information (such as how much server disk space an account requires) and the Connection Doctor (which helps you figure out why Mail isn’t getting new messages).

Using Keyboard Shortcuts

E-mail is overwhelmingly a keyboard-based technology. (You can probably compose an entire e-mail by using just your mouse and the Character Palette, but don’t plan on doing anything else that day.) If you memorize the right keyboard shortcuts and figure out how to navigate around the application, you can get away with barely using your mouse, if at all. Mail has a lot of keyboard shortcuts. Most are convoluted, so this technique sticks to the most useful.
If you can’t recall a keyboard shortcut, just peruse through the menus to remind yourself.

**Navigation shortcuts**

Certain keyboard commands are critical for getting around within Mail, saving you from having to jump over to your mouse. These are:

- **Tab**: Use the Tab key to move from the message window (where your e-mails are listed) to the Preview panel (where an e-mail is displayed) to the Search box.
- **↑**: Use the up arrow to view the previous message (while in the messages window).
- **↓**: Use the down arrow to view the next message (while in the messages window).
- **Page Up**: Use Page Up to go up within a message (while in a message).
- **Page Down**: Use Page Down to scroll down within a message (while in a message).

- **⌘-N**: Move to specific mailboxes, where \( N \) is one of the following numbers:
  - 1: Inbox
  - 2: Outbox (which you might or might not have listed in Mail)
  - 3: Drafts
  - 4: Sent
  - 5: Trash
  - 6: Junk

**Other shortcuts**

Besides the navigation shortcuts just listed, you’ll want to memorize just a few other, general-purpose ones:

- **⌘-N**: Creates a new e-mail message.
- **Delete key**: Sends the selected message to the Trash.
- **⌘-R**: Creates a reply to the selected message.
- **⌘-Shift-R**: Creates a reply to all the recipients of a message.
- **⌘-Shift-F**: Forwards a message.
- **⌘-Shift-V**: Pastes Clipboard text as a quotation (see Figure 34-1).

![Figure 34-1: Mail can paste text as a quotation, which is marked with a vertical bar.](image)

- **⌘-Y**: Adds the sender of the selected message to your Address Book.
- **⌘-Shift-D**: Sends an e-mail.
- **⌘-Shift-A**: Attaches a file to the e-mail.
- **⌘-Shift-N**: Retrieves new e-mail.
- **⌘-Shift-M**: Shows and hides the Mail drawer.
- **⌘-K**: Empties the Trash.
- **⌘-Option-N**: Creates a new viewer window.
All the standard Mac shortcuts work within Mail as well: Ô-S (Save), Ô-W (Close), Ô-P (Print), and so forth. See Technique 10 for more.

**Customizing Mail’s Appearance and Behavior**

We trust that you can make your way through Mail’s preferences panel without any handholding. But because you might not yet appreciate the ramifications of some of the options, we give you a heads-up on a few of them.

The Junk Mail and Rules sections of the preferences panel are important to merit their own discussions. We focus on them — and their usage — in Technique 35.

**Setting General preferences**

The General panel (as shown in Figure 34-2) is fairly simple, but a couple facts are worth mentioning:

- Strange as it might seem, you can use the Mail application to set your default e-mail client to be something other than Mail. You probably don’t want to do this, though.
- Use the Check for New Mail drop-down list to control how often Mail checks for new messages.
- If you have a persistent (always-on) Internet connection, have Mail automatically fetch your new messages, saving you the step. If you use a dialup connection, disable this and do it manually when you’re online.
- If you have a .Mac account, you can now synchronize your Accounts, Rules, Signatures, and Smart Mailboxes across multiple Macs.

**Setting Composing preferences**

You use the Composing panel (see Figure 34-3) to set your preferences for how Mail behaves when you write e-mail. Because you’ll write messages frequently, it’s a good idea to pay attention to these options.

- Figure 34-2: Mail’s General preferences panel.
- Figure 34-3: Mail’s Composing preferences affect how you write and reply to e-mail.
On this panel, you can make Mail do the following:

- **Check spelling as you type:** This doesn’t really save you time, but it makes you look more professional, and that’s got to be worth something.

  If Mail catches a spelling error, the error is underlined in red. Control-click the underlined word to bring up a contextual menu of options for fixing the boo-boo (see Figure 34-4).

- **Automatically complete addresses:** As you type, Mail looks up addresses for you by using your Address Book and/or a Lightweight Directory Access Protocol (LDAP) server, if you have one. With this method, you need to type only a few letters and then select the appropriate address.

- **Include selected text (if any) when replying:** Assuming that you selected the Quote the Text of the Original Message check box, you can set up Mail to quote original text in your reply in one of two ways:
  - Simply replying quotes the entire message in your reply.
  - Selecting a section of text and replying to the message quotes just that section in your reply.

### Customizing the Mail toolbar

Just like the Finder window toolbars, you can (and should) customize Mail’s toolbar so that it sports the features you use most often. To bring up the customization window (see Figure 34-5), you can either

- Choose View → Customize Toolbar.
- Control-click the toolbar and choose Customize Toolbar from the contextual menu that appears (see Figure 34-6).
Technique 34: Mastering Mail

- Click the oval-shaped white button in the upper-right corner to rotate among various versions and sizes of the toolbar (icons only, text only, plus different sizes of each).

Customizing the messages window

Another area of the Mail application that you ought to customize is the message window itself, which is the area where your messages are listed. From the View menu (as shown in Figure 34-7), you can dictate what columns are listed and also adjust the sorting column.

- Figure 34-7: The View menu lets you customize the message window layout.

Like with standard Finder windows, you can also adjust how the columns are sorted by clicking the column headers. Furthermore, you can rearrange the columns by clicking and dragging them.

Be certain to use the Organize by Thread option (available on the View menu or by clicking the Threads button on the toolbar), particularly if you use message groups and news lists. If you have this turned on, Mail automatically sorts incoming messages by thread (think of a thread as a more

Use the Mail toolbar for a while to see what tools you never use and which ones you use frequently, and then adjust the toolbar accordingly. Of course, you can tweak the toolbar’s settings at any time.

The default set gives you an idea of what you want to accomplish. Basically, by dragging and dropping icons onto the toolbar, you can

- Add items that you use but might not remember the keyboard shortcut for.
- Organize items into similarly themed groups.
- Use separators and spaces to divide groups.
- Place a Search box on the right.

Using both icons and text in the toolbar provides you with two visual clues as to what a button is. The small size setting lets you put more items in the toolbar.

While we’re discussing the toolbar, we should let you know of these universal toolbar shortcuts:

- Click the oval-shaped white button in the upper-right corner of the Mail application to show and hide the toolbar.
formal subject declaration), using the e-mail headers. Even the heated political discussions you have with your uncle are kept organized because repeated messages on the same topic are grouped together.

Maintain a neater Inbox by using the Organize by Thread option (on the View menu). Multiple e-mails on the same topic are listed as one item. Clicking the item shows all the e-mails that are part of that thread. Clicking the arrow next to the thread subject expands and contracts that listing, like the list view in a Finder window.

**Customizing the New Message window**

Another area for customization is the New Message window. You can customize the toolbar and customize the default layout of a new message. Just do this:

1. Press Ô-N to create a new message.
2. Control-click the message’s toolbar to bring up the contextual menu.
3. Choose the Customize Toolbar option.
   This brings up the Customize Toolbar sheet.
4. Customize the toolbar as you want it for individual messages.
   Things to consider putting there are
   - The Send button
   - The Attach button, for attaching files
   - The Address button, to bring up your addresses
5. Click Done when you’re, well, done.
6. Click the Actions menu, which appears to the left of the Account menu.
7. Choose Customize from the menu that appears (see Figure 34-8).
8. Select the check boxes next to the text boxes that you want to appear as defaults (see Figure 34-9).
   Even if you don’t set a text box, such as Carbon Copy (Cc), to appear as a default in your message window, that doesn’t mean it isn’t an option. You can make text boxes visible to individual messages by using the View (refer to Figure 34-7) or Action (refer to Figure 34-8) menus.
9. Click OK when you finish.

If you view an e-mail you’ve received in its own window, this is a fourth (yes, fourth!) window you can customize.
• Figure 34-9: Customize what fields a new message has to suit your needs.

**Understanding and using mail headers**

An e-mail actually begins with a hidden series of lines called *mail headers*, which are used for many purposes, including:

- Identifying the sender
- Identifying the recipient
- Indicating the subject line
- Marking the time and date when the e-mail was sent
- Flagging the message as it’s handled by mail servers

Tiger’s Mail and any other e-mail client turn most of these headers into a more user-friendly display, like the headers that you see in the messages window or in the Preview panel for a single message. However, you can still get a more techie viewpoint of a message, if you’d like.

To show all the headers for a message, use the ⌘-Shift-H shortcut or choose View Message Long Headers. For example, the following image shows how a Junk e-mail might appear in Mail.

By viewing the Long Headers version of the message, you get something like what appears in the following figure.

Similarly, you can have Mail display a message as the raw source, invoked by choosing the View→Message→Raw Source or with the ⌘-Option-U keyboard shortcut.

The raw source view helps you look at messages written in HTML that aren’t displaying properly. You can also weed out spam by checking out either the raw source or the long headers. For example, if a message has an @aol.com return address, but was never sent through an AOL mail server, that means that the address was faked.
Organizing Your Mailboxes

Organizing your mailboxes is as important to efficiently handling your e-mail as organizing your Home directory is to handling your stuff. If you want to be able to find anything again, you better put it in the right place. By default, Mail has several mailboxes:

- **In**: Stores incoming messages waiting to be read.
- **Drafts**: Stores messages that you’re composing. If you save a message before sending it, a copy is placed in the Drafts box. This message remains there until it is sent.
- **Trash**: Holds messages that you delete. Use Ô-K to empty the Trash, or you can set the Mail application to do this automatically.
- **Junk**: Holds e-mail marked as junk. (See Technique 35 for more on how to use Mail to snuff out spam.)
- **.Mac Account**: Shows only if you have a .Mac account. You really don’t need to concern yourself with this one too much.

Most of these boxes are subdivided for your multiple accounts (see Figure 34-10). If you want to view all the messages for all the accounts at once, click the main Inbox icon. If you want to view only the new or sent or trashed messages for a particular account, click the appropriate subfolder.

![Figure 34-10: Click the arrow to access a box’s subfolders.](image)

Before you get too heavily invested into Mail, add new folders to the On My Mac box so that you can store and organize the messages you keep. Later in this technique, you see how to create the very handy Smart Mailboxes.

Creating and maintaining a good organization scheme with your mailboxes makes finding messages — particularly using searches — much, much faster.

All your mailboxes appear in the Mail drawer, which is a panel that resides on either the left or right side of the main viewer window. But the Mail drawer is more than just a collection of mailboxes. Here are some tips for working with the Mail drawer:

- Click the Actions icon at the bottom of the window (it looks like a cog) to access common tools (see Figure 34-11).
- From the Actions menu that appears, choose the Use Small Mailbox Icons option so that the mailbox takes up less room.
- Use Ô-Shift-M to show and hide the Mail drawer.
As soon as you enter text into the Search box, Mail begins searching. This slows down the process. Set all your search parameters first and then enter your search terms.

2. Use the Mail drawer to select a specific mailbox or subfolder to search.

If you’re looking for an e-mail that you sent, begin with the Sent mailbox. If the message was sent from a particular address, select that subfolder instead. If you expect that you would have stored the e-mail in the Jobagadonuts folder under Clients, select that. When you do this, all the messages in that box or folder appear in the messages window. You can also Ô-click to select multiple mailboxes.

3. Enter your search term or terms in the Search box.

As you type, the search results appear in the main window.

4. Limit your search by using the labels at the top of the search results window (see Figure 34-12).

Performing Searches

Inevitably, you’re going to need to hunt down that message your boss sent you two weeks ago (in which he changed the project) or the one from your mother (in which she reminded you of her birthday). Fortunately, Mail has a sweet search engine built into the application. Here’s the easiest way to use it:

1. Don’t begin by typing anything in the Search box!

You can manually back up any single mailbox or folder by dragging its icon from the Mail drawer into the Finder. This creates an mbox file, which is a standard format that you can import back into most e-mail applications.

Figure 34-11: The Actions menu lets you create new mailboxes, delete e-mail, and more.

You can manually back up any single mailbox or folder by dragging its icon from the Mail drawer into the Finder. This creates an mbox file, which is a standard format that you can import back into most e-mail applications.

Performing Searches

Inevitably, you’re going to need to hunt down that message your boss sent you two weeks ago (in which he changed the project) or the one from your mother (in which she reminded you of her birthday). Fortunately, Mail has a sweet search engine built into the application. Here’s the easiest way to use it:

1. Don’t begin by typing anything in the Search box!
Creating and Using Signatures

Signatures, in e-mail terms, are footers that appear at the bottom of people’s e-mail addresses (as shown in Figure 34-13). People use signatures to add contact information, Web links, or disclaimers (in company e-mails). Here’s how you can create and use signatures in Mail:

1. Open the Mail preferences panel.
2. Click the Signatures icon (see Figure 34-14).
3. Select an account in the left column.

In the Tiger version of Mail, you can create signatures for a specific account or for any account. If you want to create a signature not associated with a specific account, click the All Signatures item in the left column.

4. Click the plus sign under the middle column.

A new signature is created in the middle column, with a name like Signature #1.

5. Give the signature a name.

After you click the plus sign in Step 4, the default signature name that appears is already highlighted, so typing replaces it.

6. In the rightmost column, type all the text that you want to use as your signature (see Figure 34-15).

You can create pseudo-searches by using Rules. See Technique 35 for some examples of using Rules.

We also cover Smart Mailboxes at the end of this technique.
Discovering the Best Mail Tips and Tricks

The following sections include some of the best Mail-related tips and tricks.

Mail is one of the applications that Automator supports out of the box. Technique 61 shows how you can create repeatable processes involving the Mail application.

Using the Dock icon

The Mail’s Dock icon is your friend. Not only does it indicate how many new messages you have, but you can also use it to perform (or at least start) common tasks. After you Control-click the Mail icon to bring up its contextual menu (see Figure 34-17), you can do the following things:

- Figure 34-16: Mail automatically adds signatures to new messages if you want.

- Figure 34-15: Add a new signature here.

You can add as much text as you want. Separate multiple lines by pressing Return. The signature should be informative and communicative — not showy and bulky — so follow these general rules:

- Begin your signature with two dashes and a space (--) on the first line, which helps mail readers understand that your signature is beginning. However, people use this practice less and less.
- Use plain text.
- Restrict yourself to four to seven lines.
- Avoid long lines (more than 80 characters).
- Resist the urge to create elaborate graphics using spaces and keys.

7. Close the preferences panel when you finish.

In the Signatures panel, you can automatically associate signature behavior to specific accounts. Just click the account in the leftmost column, and then use the Choose Signature drop-down list (see Figure 34-16) to determine a signature policy for that account. If a created signature isn’t listed, click the All Signatures item and then drag the signature from the middle column onto the account name in the left column.
Discovering the Best Mail Tips and Tricks

**Figure 34-17: The contextual menu for the Mail icon in the Dock is a wonderful timesaver.**

- Retrieve new messages.
- Create a new e-mail. (You’re taken to the Mail application, where a new message window is opened for you.)
- Choose what document to view (for example, the Viewer window or an open e-mail).

The number of new messages in your Inbox also appears as part of the Mail icon in the application switcher palette.

**Sending attachments**

You have a choice of many ways to add attachments to an e-mail:

- Press ⌘-Option-A to bring up the Open dialog (while composing an e-mail).
- Choose File ⇒ Attach File.
- Click the Attach button on the message toolbar.

If your message doesn’t have an Attach button, customize the message toolbar (see “Customizing Mail’s Appearance and Behavior,” earlier in this technique).

- Drag and drop a file from the Finder or other application onto the message.
- Drag and drop a file from the Finder onto the Mail’s Dock icon, which creates a new message window with the file already attached to it.

---

For a cool technique on dragging and dropping by using Exposé, check out Technique 15.

When sending attachments, you ought to seriously consider compressing anything that you send. Compression both cuts down on the size of the file and makes it easier for the receiver to distinguish between the message and the attachment. (Some attachments are displayed inline in the message itself rather than as an icon that the recipient has to click to open.) The easiest way to compress any file or folder is to select it in the Finder and choose File ⇒ Create Archive.

**Creating Smart Mailboxes**

New in Tiger and Mail 2.0 is the ability to create Smart Mailboxes. These are simple dynamic mailboxes that you define with a set of rules. The contents of that mailbox vary, always representing the messages that match your set of rules. The previous search section shows how you can quickly turn a search into a Smart Mailbox. Here’s another way to create a simple Smart Mailbox:

1. **Choose Mailbox ⇒ New Smart Mailbox.**

   You can also use the Action menu in the Mailbox drawer.

2. **Give the Smart Mailbox an appropriate name (see Figure 34-18).**

   In this example, we created a Smart Mailbox that stores all the e-mails coming from family members. So the mailbox name is *Family Emails*.

   ![Smart Mailbox](image)

   **Figure 34-18: The Smart Mailbox prompt.**

3. **Edit the first condition.**
Using the first drop-down list (refer to Figure 34-18), select Sender Is Member of Group. Then select Family from the second drop-down list.

This example assumes that you’ve already created a Family group in the Address Book. If you haven’t, head on over to Technique 18 to see how.

4. **If you want, add more criteria by clicking the plus sign and using the menus and prompts.**

   For example, if you want this Smart Mailbox to store only unread messages from family members, add that as a criterion.

5. **When you finish, click OK.**

   The new Smart Mailbox is created and added at the bottom of the other Smart Mailboxes.

   If you want, reorder your Smart Mailboxes by clicking and dragging their folders.

   ![Double-click any Smart Mailbox folder icon to see and edit its governing rules.](image)
Stopping Spam in Its Tracks

Spam is nothing short of a pox on the world of the Internet and e-mail. Unwanted and unsolicited e-mail is slowing down networks, costing businesses billions of dollars, and cluttering up mailboxes. Okay, maybe it is or isn’t all of that, but it is a pain and a fact of e-mail life. Despite the overwhelming existence of this plague, you can take steps to fight this time-waster. In this technique, we put forth two approaches to spam:

- Handling it after you receive it in your mail application
- Avoiding it in the first place

The first two sections of this technique focus on the Apple Mail program specifically. The concluding section discusses software, techniques, and steps that you can follow to take a bite out of the amount of spam that you receive. These ideas are useful regardless of what application you use for e-mail.

Fighting Spam with the Junk Mail Button

One of Mail’s strongest suits is its ability to identify and filter out spam. We can’t think of a single reason why you wouldn’t want to use this feature. It’s a breeze to get going and, over time, teaches itself to be more accurate at guessing which messages are spam.

1. **Open the Mail preferences panel.**
   
   You can do this by either choosing Mail > Preferences or by pressing `⌘`, (comma).

2. **Click the Junk Mail icon (see Figure 35-1).**
Technique 35: Stopping Spam in Its Tracks

3. Make sure that these options are selected:
   - Enable Junk Mail Filtering
     This check box should be enabled in new installations of Tiger. Keep it that way.
   - Leave It in My Inbox
     Use the training mode for about a month (depending upon how much e-mail and junk you receive).

After about a month of use, open the Junk Mail preferences and select the Move It to the Junk Mailbox (Automatic) radio button under When Junk Mail Arrives. By having the Junk Mail filter move spam to the Junk mailbox (found below the Trash, as shown in Figure 35-2), you won’t have to look at those e-mails, but you can review the messages later.

4. Select these check boxes:
   - Sender of Message Is in My Address Book
     This exempts these senders’ messages from filtering. Presumably people in your Address Book don’t send you spam, so these messages shouldn’t be filtered. People — like those in your Address Book — who are assumed to send valid e-mail are on a white list (the opposite of a black list).

People in your Address Book might end up unintentionally sending you viruses (particularly if your friends run Windows). Viruses can be handled by using the Rules feature, which we discuss in the upcoming section, “Creating and Using Rules.”
Sender of Message Is in My Previous Recipients

This makes those recipients’ messages exempt from filtering. Spam is often sent from different permutations of an e-mail address; therefore, you aren’t likely to get spam from the same address twice. Enabling this option helps to avoid false positives (mail that has been incorrectly identified as spam).

Trust Junk Mail Headers Set by Your Internet Service Provider

Many ISPs use their own software to filter spam. Some providers automatically block those from ever reaching you. Others send the messages anyway but mark them as spam. In those cases, you want Mail to trust the preliminary spam designation. In the worst case, you just need to fish non-spam messages out of the Junk mailbox later.

5. Close the Junk Mail preferences panel.

What, exactly, is spam?

Spam is unsolicited junk e-mail sent to many people at once. These messages usually are about:

- Get-rich-quick schemes
- Physical enhancement products
- Sexually explicit content
- Trendy products or ideas

Businesses might send out spam-like messages as well, but these don’t qualify as spam if they fit both of these criteria:

- Users can opt out of receiving the messages.
- The messages advertise actual products or services.

Such e-mails also tend to come from a company with which you’ve had previous interactions.

If an e-mail is spam, you need to fight it by using the methods in this chapter. If it’s an advertisement from a business that you know and probably have ordered from before, simply following the opt-out instructions should stop the messages from coming.

Creating and Using Rules

The Junk Mail filter does an admirable job identifying spam, but it isn’t perfect. Fortunately, it isn’t the only tool that you have in your arsenal. Mail also includes the Rules feature. To use it, you establish certain criteria (for example, if the subject contains certain words) and then decide what Mail should do when messages meet criteria (such as move the e-mail to a specific folder or highlight it in a particular color). Using Rules is like having a really great personal assistant go through your inbox before you start looking at the messages. Here are just a few uses of Rules:
4. In the dialog that appears, type the Rule’s name in the Description text box.

Give your Rule a descriptive name, indicating what it does or what it applies to (an e-mail address, a particular virus, a certain subject).

5. Create the Rule’s criteria.

For each criterion, perform these steps.

- Select Any from the first drop-down list.
- Select Subject from the second first drop-down list.
- Select Contains from the third drop-down list.
- Type the text in the text box, as shown in Figure 35-5.

Rules are case-insensitive by default.

Another use is to create a Rule to handle particular types of spam. For example, when the latest Windows virus hits, Larry might get a couple hundred e-mails (because his address is on computers around the world). When he sees a wave of messages entitled Wicked Screensaver or Your Application, within a matter of minutes, he sets Mail to start trashing these. Here’s how:

1. Bring up the Mail preferences panel.

2. Click the Rules icon (see Figure 35-4).

3. In the Rules dialog that appears, click the Add Rule button.

   • Figure 35-4: Use the Rules panel to create and manage Rules.

4. In the dialog that appears, type the Rule’s name in the Description text box.

   Give your Rule a descriptive name, indicating what it does or what it applies to (an e-mail address, a particular virus, a certain subject).

5. Create the Rule’s criteria.

   For each criterion, perform these steps.

   - Select Any from the first drop-down list.
   - Select Subject from the second first drop-down list.
   - Select Contains from the third drop-down list.
   - Type the text in the text box, as shown in Figure 35-5.

   Rules are case-insensitive by default.

   You can set as many criteria as you need. Just click the plus sign to add another criterion. The SoBig virus sent out e-mails titled That Movie, Your Application, Thank You, and so forth. For this Rule, Larry set up multiple criteria so that if the subject of an e-mail contains any of these phrases, it’s picked up by his Rule.

   • Figure 35-5: Add as many criteria as you want to a Rule.

6. Under Perform the Following Actions, select Move Message from the first drop-down list and Trash from the second to move the message to the Trash (see Figure 35-6).

   • Figure 35-6: The Perform the Following Actions section allows you to specify what happens when a Rule is triggered.
Figure 35-6: The last step when creating a Rule is to indicate what to do when the criteria are met.

7. Click OK to create the Rule.

Stopping Spam before It Gets to You

The bulk of this technique revolves around dealing with spam after it hits your mailbox (acknowledging that “spam happens”). But a more critical — and difficult — task is cutting down on the amount of spam that you receive. The quickest way to stop spam is to not have an e-mail address, but that’s a drastic step that most people aren’t willing to take these days. Here is some more practical advice:

Never respond to the spam that you receive. This just lets spammers know that they’ve hit an active e-mail address.

Absolutely, positively don’t follow the Click Here to Unsubscribe or Reply to Unsubscribe suggestions included in spam. These steps only confirm for the spammers that they had a valid e-mail address. The likely result? You get even more spam!

Try to keep your e-mail address off the Internet. Many spammed addresses come from spiders that scour the Internet looking for someone@address.com text. These are normally found on contact pages of Web sites or on public message boards. If you do use a resource that publishes users’ e-mail addresses (which is common), set up a separate e-mail address for this purpose.

Use separate e-mail addresses. A smart move is to have one e-mail address for your friends and family, which is used (hmmm) only for your friends and family. Create a second e-mail address for work or school. Then, create a separate e-mail address that you use only for riskier behavior (like posting messages online). When this address becomes overrun with spam, delete it and create a new one.

One of Mail’s best features is its ability to easily manage multiple e-mail accounts. Using temporary e-mail accounts in the war against spam is far less of an inconvenience than you might expect.

Render Web bugs useless. Some spammers use a trick called a Web bug to validate your e-mail address. When you open a piece of spam with this special hidden graphic in it, it relays a message back to the spammer letting him know that the e-mail address is valid. By turning off the loading of graphics (under the Viewing preferences panel, shown in Figure 35-7), you can circumvent this trick. For legitimate e-mails, a quick click on the Load Images button renders them complete.

Don’t use an AOL, Yahoo!, MSN, or Hotmail e-mail account. The big providers of e-mail service (commercial or free) are major targets for spammers. These users are frequently hit not because their address got put on a list but simply because spammers use every combination of names and popular domains — for example, @aol.com — that their spam software can come up with.

Watch what you sign up for online. Most registration forms require your e-mail address and then assume you want to receive e-mail from that business. Although this isn’t spam (technically), it’s often e-mail that you don’t want. Look for opt-out boxes during registrations.
Press Ô-A to select every message.

3. **Looking at the Subject names and From addresses, Ô-click any messages that might not be spam to deselect them.**

   You or the Junk filter might have erred in marking a message. In those cases, you don’t want to bounce the message.

4. **Double-check to make sure that all the highlighted messages are spam.**

5. **Click the Bounce icon on the toolbar or press Ô-Shift-B.**

6. **Click OK at the prompt (see Figure 35-8).**

7. **Review the remaining messages (which you deselected in Step 3) and click the Not Junk button (see Figure 35-9) to tell Mail that a message wasn’t spam.**

   After you bounce an e-mail, it’s moved from the Junk mailbox into the Trash. When you empty the Trash, those bounced e-mails will also be deleted.

**Bouncing spam**

Recent studies suggest that one effective method of stopping spam is to indicate that e-mail address wasn’t valid. You can do this by bouncing the e-mail back to the sender. When you bounce a message, it indicates to the sender (or the sender’s computer) that the e-mail address doesn’t exist. With luck, this gets you off the offender’s list. Here’s how Larry handles this:

1. **Click the Junk mailbox to view its contents.**

   Over the course of the day, Larry’s Junk mailbox gets filled up with the messages that Mail thought was junk or that he manually marked as junk.

   • Figure 35-7: Not loading graphics in your e-mails might help minimize the amount of spam you receive.

   Pay attention to your ISP’s spam controls. Most ISPs provide a method for reporting spam. By participating in this process, you help ISPs stop spam before it gets to you.

   Pay attention to the law. The United States government and many states are working hard to cut down on spam. The FTC also tracks spam, and some states are starting to sue spammers. Pay attention to what laws have been passed and what recommendations these government agencies have.

   • Figure 35-8: Mail confirms that you want to bounce these messages.

   After you bounce an e-mail, it’s moved from the Junk mailbox into the Trash. When you empty the Trash, those bounced e-mails will also be deleted.

   • Figure 35-9: If Mail wrongly marks a message as junk, there’s a Not Junk button to undo that flag.

   The Not Junk button is just as important as the Junk button in teaching Mail how to identify bad e-mail.
There’s a good chance that some bounced messages will be returned to you with a Mail Undeliverable (or similar) message. This just indicates that the original sender’s e-mail address was bogus. You can either delete the undelivered messages or make a Rule to automatically send undelivered mail to the Trash.

Other spam tools

You can use many other applications to combat spam. Here are six popular choices:

- **SpamSieve** ([www.ccommand.com/spamsieve/index.shtml](http://www.ccommand.com/spamsieve/index.shtml), $25) is a very solid piece of software that adds junk-mail-filtering capability to other e-mail applications (such as Mail, Eudora, Mailsmith, and Entourage).

- **JunkMatcher** ([http://junkmatcher.sourceforge.net](http://junkmatcher.sourceforge.net), free) uses a handful of tools (such as regular expressions and existing blacklists) to very accurately identify spam. In fact, the only slight against JunkMatcher is that it might be too effective; it often has false positives until you more narrowly define its criteria.

- **Spamfire Pro** ([www.matterform.com](http://www.matterform.com), $40) filters all your mail before it gets to your e-mail application.

- **SpamCop** ([www.spamcop.net](http://www.spamcop.net)) provides you with spam-filtered e-mail for $30 per year and has tools to set up spam-filtering software for entire companies.

- **Mailblocks** ([www.mailblocks.com](http://www.mailblocks.com), $10) routes all your existing e-mail addresses through a new Mailblocks address, filtering out the spam in the process. It works with most major e-mail applications, including Mail, and is ridiculously cheap.

- **SpamSlam** ([www.ilesa.com](http://www.ilesa.com), $25) uses two of the best spam-stopping techniques:
  - Filtering spam based upon content (which is what Mail does)
  - Requesting confirmation of e-mails from senders not in your Address Book (the first time the person send you an e-mail)
Chat is Apple’s answer to America Online’s Instant Messenger (AIM) application. The application works by using your .Mac account or an AIM account, if you have one. You can use it to communicate with other iChat users or AIM denizens.

In this technique, we assume that you understand the fundamentals of using iChat, so we focus instead on some of the little extras that make using the application more productive. We begin with the keyboard and mouse shortcuts that you should use, and then we go through some of the customizing techniques that you might not know about. Finally, we go through a few specific tips for common tasks.

**Keyboard and Mouse Shortcuts**

iChat doesn’t offer you many shortcuts. The principle is very basic: Type some text and press Return. But you ought to know about the following shortcuts:

- **Option-Return**: Creates a carriage return (letting you start a new paragraph).

  By default, pressing Return sends the typed text within an instant message (IM) window. Therefore, to insert a return into a message (so that text goes onto the next line), use Option-Return.

- **Ô-L**: Logs you out.
- **Ô-N**: Creates a new, private chat room.
- **Ô-K**: Creates a hyperlink.
- **Ô-1**: Brings up your Buddy List window (see Figure 36-1).
• Figure 36-1: Larry’s Buddy List (while logged in to his .Mac account) shows that his buddy Larry (using an AIM account) is logged in.

⌘-2: Brings up the Bonjour window.

Bonjour is Apple’s technology that instantly recognizes other computers, hardware and users on your network. iChat’s Bonjour window shows other AIM and .Mac users who are currently online and on the same network as you.

⌘-Shift-G: Shows and hides the groups bar.

⌘-Option-E: Sends an e-mail to the selected user.

⌘-Option-F: Opens the prompt for sending a file.

⌘-I: Gets the info of a user selected in the Buddy List.

The Get Info panel for a particular user serves two purposes. First, it displays some of that person’s Address Book information (see Figure 36-2). Second, you can use it to associate specific actions with this user (see Figure 36-3). For example, you can configure a user’s Info setting so that a specific sound is played when that person comes online or sends you a message.

⌘-Shift-I: Gets the information for a user in an IM.

⌘-Shift-A: Adds a buddy.

⌘-S: Saves the chat transcript.

With the mouse — iChat is admittedly not a mouse-driven application — the most important pointers are these:

✓ Click a person’s name in your Buddy List to select her.

✓ Double-click a person’s name in the Buddy List to send him an instant message.

✓ Click the red button in the upper-left corner of the IM window to close the message.
Technique 36: Innovative iChat

• Figure 36-4: iChat’s Menu Bar menu lets you control the application without making it active.

Customizing iChat

Rather than go through all the preferences settings—which you can do very well on your own—we concentrate on some of the most important and interesting customizing options. All these fall under the useful or cool categories:

✔ Use Bonjour to help iChat automatically recognize people on your local network (see detailed instructions in Technique 39).

✔ Enable the Show Status in Menu Bar option (choose iChat ➤ Preferences ➤ General) to control iChat without opening the application. Figure 36-4 shows the Menu Bar menu.

✔ Add a new icon to represent you during chat sessions by dragging it onto your icon in the Buddy List window.

✔ Click your icon in the Buddy List window for a choice of icons that you’ve used (as shown in Figure 36-5).
Customizing iChat

Choose your icon from the list of icons you’ve used in the past.

- Add a background to your IM by dragging an image onto it.
- Have iChat use sounds to let you know when certain people come online or send you messages.
- Have iChat check your spelling while you type (hint: to make you look smarter than you are!).
- Customize your status to make it more specific and useful.

Your status is the message others can see that indicates your availability. iChat comes with the default status options of Available, Away, and Current iTunes Track, but you shouldn’t have to restrict yourself to those. Follow these steps to create a custom status:

1. Click the status text below your name.
2. In the drop-down list that appears (see Figure 36-6), select Custom from either the Available or Away sections.
3. In the resulting text box, enter your new status label.
4. Press Return to make this status active (see Figure 36-7).

Larry has created a Taking a Nap status for this example.
Technique 36: Innovative iChat

- Figure 36-7: Larry’s new status takes effect immediately.

Alternatively, you can use the Edit Status Menu option (refer to Figure 36-6) to create and manage multiple status options at once (see Figure 36-8). Select a message and click the minus sign below it to delete it. Click the appropriate plus sign to add a message. Double-click a message to edit it. Press Return (or click OK) when you’re finished.

- Figure 36-8: The Edit Status menu is a fast way to add or remove multiple statuses.

Logging iChat sessions

If you want to remember an idea or URL that someone gave you or you want proof that someone said something, save your instant message session. To save a session while you’re in it, either choose File ▶ Save or press Ô-S. You’re given a prompt so that you can save the file on your computer. (By default, the filename is Instant Message with Username.)

Because of the unique format of an iChat session, you can’t just open it in any old text editor. To view the iChat logs, you can either

- Open them in iChat. (This happens automatically if you double-click the saved file.)
- Use Logorrhea (http://spiny.com/logorrhea, free). This application parses iChat logs and provides other nice tools for searching through them.

Transferring Files with iChat

Did you know that you can use iChat as a quick and easy way to transfer files? It’s remarkably simple:

1. Begin an Instant Message conversation with a user.
2. Switch to the Finder.
   Press Ô-Tab, click the Finder Dock icon, or click the Desktop itself to switch from iChat to the Finder.
3. Browse for the file that you want to attach.
4. Drag the file from the Finder onto the IM window in iChat.
   Drag the image into the text box area (where you type) — not the main window itself.
If the file is already open (like a Word document in Microsoft Word), you can attach the file by dragging its proxy icon (the icon of the file that appears in the title bar next to the file’s name) onto the IM window. You can also use the Exposé or the Ô-Tab drag-and-drop techniques that we discuss in Techniques 15 and 10, respectively. Another option is just to copy the file in the Finder (select it, press Ô-C), and then paste that into your IM box.

5. Add some text (if desired) and press Return to send the file.

Depending upon the other user’s instant messaging client, you normally have to wait a bit while iChat requests approval from the receiver. Then the file appears in the main window of the Instant Message, along with its name (see Figure 36-9 for the sender’s IM window).

![Figure 36-9: The file appears with its icon in your iChat.](image)

Here are a few other facts that you should know about sending files in iChat:

- You can send files to people running iChat or AIM.
- The File feature, in conjunction with Bonjour, makes a great way to send files to other people on your network (for example, co-workers).

If you send images in iChat, they appear in the IM window, as shown in Figure 36-10. If you resize the IM window, the image also is resized.

![Figure 36-10: Images can be included inline (in the message) during an IM.](image)

**Using the Videoconference**

The latest version of iChat is technically called *iChat AV* because of its audio/visual capabilities. With it, you can videoconference or audioconference with other iChat users. (It’s like Buck Rodgers come to life!) Besides being really, really cool, this means that you can have free, long distance phone calls — while playing solitaire — or, if you’re writing a book, videoconference with your coauthor in Switzerland, hypothetically.

*iChat AV in Tiger is extra special! You can videoconference with up to *three* other people at once. (Previously you were limited to a one-on-one chat.) You can also audioconference with up to *ten* people!*

![Image of videoconference setup](image)
To use iChat AV’s videoconferencing feature, you need:

- A FireWire video camera (like Apple’s iSight)
- At least a 600 MHz G3 processor
- A high-speed Internet connection

If you don’t meet the requirements and really want to give videoconferencing a whirl, check out iChatUSBCam (www.ecamm.com/mac/ichatusbcam, $10). It makes iChat work with many USB cameras (which are much cheaper than FireWire ones) and lowers the processor requirements.

If you want to use only the audio aspect, the requirements are more lax:

- A USB or built-in microphone
- A 56 Kbps dialup connection or better

You can easily set up an iChat AV audioconference or videoconference. To use iChat AV, do the following:

1. **Connect a supported camera, if you have one.**
   Apple created the iSight ($149) specifically for this task, but any FireWire camera should work.

2. **Open iChat.**

3. **Under iChat’s Audio menu, make sure that Camera Enabled and Microphone Enabled are marked (see Figure 36-11).**

4. **Select someone to conference with from your Buddy or Bonjour List.**
   The other iChat user has one of two icons (which appears next to his iChat icon in the Buddy or Bonjour List) indicating his capability for audio or video chatting:
   - A **green telephone** indicates that he’s ready for audio.
   - A **green camera** indicates that he’s ready for video.

5. **Begin an audio- or videoconference by clicking the green symbol next to the person’s name.**
   The user gets an invitation to join you for a conference, which he can either accept or decline. While the call is being set up, you see your own image so that you can adjust the camera framing.
If you have a camera and/or microphone but your partner does not, you can still start a one-way video- or audioconference. The person on the other end of the conference sees and/or hears you, and both of you can use the regular text Chat feature. To use this, select the other person in the Buddy List, and choose Invite to One-Way Video/Audio Chat, either from the contextual menu of the Buddy List entry or from the Buddies menu.

Here are some tricks to keep in mind when using the AV features:

- In the Video preferences panel (see Figure 36-12), lower the Bandwidth Limit for video to 500 Kbps to improve the audio quality.

Press ⌘-Option-S to take a snapshot from the video feed.

You can resize the video image or make it full-screen, but this slows down the performance of your computer.

If you connect a video camera to your computer for videoconferencing, you can also use it to take a snapshot. You can use this snapshot as your representative icon in the operating system and certain applications. See Technique 18 to find out how to do this in the Address Book.

Creating URLs

As you probably know, iChat automatically turns any typed or pasted URL into an active Web link. When it does so, it displays the URL text as the link name by default (see Figure 36-13). But you can create links with specific names if you want.

1. In the iChat instant message window, type some text that you want to be the name of the link.

In order for iChat to automatically process URLs, they must include the initial http://, https://, ftp://, and so forth. Just using www.sitename.com doesn’t work.
2. Select the text.
3. Press ⌘-K.
4. In the resulting prompt, type the URL for the link (see Figure 36-14).
5. Press Return or click OK.

Dragging a site’s proxy icon (the icon which appears next to the URL in the location bar) from the Safari browser into iChat creates a link for that Web site by using its name.

• Figure 36-14: Use the ⌘-K shortcut to make a named link.
Part VI

Optimizing Your Network

The 5th Wave

By Rich Tennant

I've never seen a spreadsheet so dense with color and data.

Oo-look! Stare long enough at the center and a 3-D image of a bird in flight pops out.
Pretty much every computer is connected to a network of some kind or another, whether this network is a home setup, at the office, or just logging on to the Internet with your modem. In this technique, we discuss some of the tricks to getting your Mac online. We cover everything that you need to know to quickly create new locations, and then we go through modem settings. Finally, we cover some tips and tricks that are helpful if you frequently switch locations (in other words, if you move your Mac or change your networking configurations).

**Defining a Location**

To connect your Mac to any network, including the Internet, you need to define a location. A location is a saved setting that defines your network information. You normally base a location on where your computer is physically located because the network particulars change depending upon where you are at:

- If you have only one computer that never travels (a desktop machine), you need to define and use only one location.
- If you have a laptop that travels at all, you want to create multiple locations. You might have locations for:
  - Your home cable or DSL modem
  - A dialup connection at home
  - The network at your office
  - When you visit your aunt and uncle in another state
  - Traveling out of town for work

When you move your computer — and therefore change networks — add a new network instead of altering your existing network settings. (That is, unless you’ve moved permanently or no longer need the original settings for some reason.)
If you opted for any Internet service at all when you first used Tiger (or if you upgraded to Tiger), you already have a location named Automatic. If you want to use your computer in a new location (for example, if you take your laptop into work), you have to add another. To add a location, follow these steps:

Every user of a networked Mac can use every location created by any user.

1. **Open System Preferences and click the Network icon.**
   
The Network icon is displayed under Internet & Network (see Figure 37-1). After you click it, the Network panel appears.

2. **Make sure that the Network panel is unlocked.**
   
   If the padlock icon in the lower-left corner of the Network panel appears locked, you need to unlock it. Just click it, enter your administrative password at the prompt, and then press Return. After you do this, you can make changes to the Network settings.

3. **Select New Location from the Location drop-down list (see Figure 37-2).**

   ![Figure 37-2: Adding a new location.](image)

   You can duplicate, rename, or delete networks by selecting Edit Locations from the Location drop-down list. This brings up a prompt for managing your locations. But you can’t delete the Automatic location; it’s your default.

4. **Enter a descriptive name for this location in the prompt that appears (as shown in Figure 37-3) and then click OK.**

   This is Larry’s location for when he visits Bethany Beach, Delaware. Because this is the only Bethany he knows, it’s a descriptive enough name. You might also use *At the Office* or *Home Broadband.*

5. **Select Network Port Configurations from the Show drop-down list.**

6. **Deselect any ports that this connection doesn’t need (see Figure 37-4).**

   ![Figure 37-4: Selecting network ports.](image)
Defining a Location

**Figure 37-3:** Give this location a name that lets you know where and when to use it.

![Image of a window titled "Network" with options for network ports selected, including "Internal Modem," "Built-in Ethernet," "AirPort," and "Built-in FireWire." There is also a lock icon labeled "Click the lock to prevent further changes." A "Help" icon is visible at the bottom right of the window.]

- **Figure 37-4:** Configure the network ports after adding a new location.

Your computer connects to networks using a single port (access point). What port you use depends upon what ports your computer has and what ports the network supports. Ports include

- Your modem
- A built-in Ethernet connection
- An AirPort or AirPort Extreme card
- A Personal Computer Memory Card International Association (PCMCIA) card (wireless or not)
- An Infrared Data Association (IrDA; infrared) connection
- A FireWire port
- Bluetooth
- A USB port

The Network panel automatically enables every port for a new location, but you don’t need to keep them all on because most locations won’t use multiple ports. Disable each port that you won’t use by following these steps:

a. Select the port in the window.

b. Disable the port. You can either clear the check box (to disable the port without deleting it) or click the Delete button and then click Delete at the prompt.

Disabling a port and deleting it has the same effect. However, some ports can’t be deleted (such as your internal modem and built-in Ethernet), but others can (such as a second modem or a FireWire port).

**7. Choose Show→Network Status.**

You see the name of the port being used (like Built-in Ethernet) and a red, yellow, or green bubble, along with some text (refer to Figure 37-2).

**8. Check whether your network is already fully functioning in this new location.**

- If you see a green bubble and the message that you’re already connected to the Internet, you’re good to go.
- If you see a yellow or red bubble, the port is active but an Internet connection hasn’t been made. You need to either configure the port or dial up to the Internet via your modem (as we describe in the “Fixing Port Problems” sidebar).
Technique 37: Getting Your Mac Online

3. From the Show drop-down list, select your modem (probably Internal Modem).

4. On the PPP tab (see Figure 37-5), enter
   - The dialup settings that your ISP provided you
   - Your password (so every user can use this connection)

9. Click the Apply Now button to use this network immediately.

10. Click the padlock icon to ensure that the network settings aren’t changed.

If you ever have trouble with the Network panel, click the Assist Me button at the bottom of the window or click the question mark icon (bottom right) to bring up Mac help.

Using a Modem

If you’re dialing up to get your Internet access, properly configuring your modem improves the experience. To configure the modem, either

- Select Internal Modem from the Show drop-down list in the Network panel (if you have an internal modem).
- Select the appropriate port from the Show dropdown list (if you have an external modem).

To optimize your modem’s configuration, we recommend the following steps:

1. Open the Network System Preferences panel.
2. From the Location drop-down list, select your location.

5. Click the PPP Options button.

   The PPP Options dialog appears. (See Figure 37-6.)

6. Configure your dialup settings.

   Keep yourself online by
   - Setting Tiger to prompt every so many minutes (30 at the most) to maintain the connection.
   - Deselect the Disconnect If Idle For xx Minutes option.

   If you frequently have trouble dialing in, set Redial to 4 or 5, with a 5- or 10-second interval between redials.
The first four options in the PPP Options dialog have a big effect on when you go online and whether you stay online. Dialup connections are notorious for kicking off users. Fine-tune these settings to minimize those occurrences. For example, if you get disconnected after about 15 minutes, set the prompt to every 10 minutes to maintain the connection.

7. Click OK to return to the Network preferences dialog.

Don’t worry about the TCP/IP and the Proxies tabs — you probably don’t want to mess with them.

8. Use the Modem tab to make your life easier (see Figure 37-7):
   - Select the Off radio button next to Sound if you get tired of hearing the end-of-the-world-like dialing-up noise.
   - Under Connection, decide whether you want to be interrupted by incoming calls.

Show the modem status in the menu bar (see Figure 37-8) to control your connection without using the Network panel.

![Figure 37-7: Adjust the modem’s behavior in the Modem tab.](image)

![Figure 37-8: The Modem menu lets you go online with ease.](image)
Technique 37: Getting Your Mac Online

Switching locations on the fly

If you have multiple locations set up, you can easily switch from one to the other without going through the Network panel:

- The Location menu (see Figure 37-9) is under the Apple menu. To switch locations, just choose from the list of options there.

![Figure 37-9: Quickly switch networks from the Apple menu.](image)

Networking Tips and Tricks

Setting up a network connection isn’t the hardest thing in the world. After you create one, numerous networking tips and tricks are at your disposal. We highlight the best of them here.

What’s a protocol anyway?

Networks make use of protocols. These are guidelines for computers to speak to each other. Tiger supports just about every protocol you can name, including:

- AppleTalk: AppleTalk has been around for years and used to be how a Mac talked to other Macs and peripherals. People well-versed in the protocol still use it, but its popularity is dwindling.
- TCP/IP (Transmission Control Protocol/Internet Protocol): TCP/IP is the primary protocol for computers connecting to the Internet.
- PPP (Point-to-Point Protocol): PPP is used by modems to connect to the Internet.
- PPPoE (Point-to-Point Protocol over Ethernet): This protocol uses an Ethernet connection but simulates a dialup PPP session.
- HTTP (HyperText Transfer Protocol): HTTP is the default protocol for Web pages, which makes sense because you access sites by using http://. Similar to HTTP is HTTPS, which is a secure Web connection.
- FTP (File Transfer Protocol): FTP is a very common way to transfer files over the Internet (for example, to upload pages to a Web site). FTP is normally accessed by using an FTP application such as Fetch or Transmit. SFTP, a secure version of FTP, is replacing FTP for many users.
- SMB (Server Message Block): SMB is the most common way to share files with Windows users.

You can also find Bonjour, which is a special technology created by Apple to let computers automatically identify other computers and peripherals. It isn’t a protocol, but it uses these other protocols to function. We discuss this in Technique 39.

Switching locations on the fly

If you have multiple locations set up, you can easily switch from one to the other without going through the Network panel:

- The Location menu (see Figure 37-9) is under the Apple menu. To switch locations, just choose from the list of options there.

![Figure 37-9: Quickly switch networks from the Apple menu.](image)

Networking Tips and Tricks

Setting up a network connection isn’t the hardest thing in the world. After you create one, numerous networking tips and tricks are at your disposal. We highlight the best of them here.

What’s a protocol anyway?

Networks make use of protocols. These are guidelines for computers to speak to each other. Tiger supports just about every protocol you can name, including:

- AppleTalk: AppleTalk has been around for years and used to be how a Mac talked to other Macs and peripherals. People well-versed in the protocol still use it, but its popularity is dwindling.
- TCP/IP (Transmission Control Protocol/Internet Protocol): TCP/IP is the primary protocol for computers connecting to the Internet.
- PPP (Point-to-Point Protocol): PPP is used by modems to connect to the Internet.
- PPPoE (Point-to-Point Protocol over Ethernet): This protocol uses an Ethernet connection but simulates a dialup PPP session.
- HTTP (HyperText Transfer Protocol): HTTP is the default protocol for Web pages, which makes sense because you access sites by using http://. Similar to HTTP is HTTPS, which is a secure Web connection.
- FTP (File Transfer Protocol): FTP is a very common way to transfer files over the Internet (for example, to upload pages to a Web site). FTP is normally accessed by using an FTP application such as Fetch or Transmit. SFTP, a secure version of FTP, is replacing FTP for many users.
- SMB (Server Message Block): SMB is the most common way to share files with Windows users.

You can also find Bonjour, which is a special technology created by Apple to let computers automatically identify other computers and peripherals. It isn’t a protocol, but it uses these other protocols to function. We discuss this in Technique 39.

Networking Tips and Tricks

Setting up a network connection isn’t the hardest thing in the world. After you create one, numerous networking tips and tricks are at your disposal. We highlight the best of them here.

What’s a protocol anyway?

Networks make use of protocols. These are guidelines for computers to speak to each other. Tiger supports just about every protocol you can name, including:

- AppleTalk: AppleTalk has been around for years and used to be how a Mac talked to other Macs and peripherals. People well-versed in the protocol still use it, but its popularity is dwindling.
- TCP/IP (Transmission Control Protocol/Internet Protocol): TCP/IP is the primary protocol for computers connecting to the Internet.
- PPP (Point-to-Point Protocol): PPP is used by modems to connect to the Internet.
- PPPoE (Point-to-Point Protocol over Ethernet): This protocol uses an Ethernet connection but simulates a dialup PPP session.
- HTTP (HyperText Transfer Protocol): HTTP is the default protocol for Web pages, which makes sense because you access sites by using http://. Similar to HTTP is HTTPS, which is a secure Web connection.
- FTP (File Transfer Protocol): FTP is a very common way to transfer files over the Internet (for example, to upload pages to a Web site). FTP is normally accessed by using an FTP application such as Fetch or Transmit. SFTP, a secure version of FTP, is replacing FTP for many users.
- SMB (Server Message Block): SMB is the most common way to share files with Windows users.

You can also find Bonjour, which is a special technology created by Apple to let computers automatically identify other computers and peripherals. It isn’t a protocol, but it uses these other protocols to function. We discuss this in Technique 39.

Networking Tips and Tricks

Setting up a network connection isn’t the hardest thing in the world. After you create one, numerous networking tips and tricks are at your disposal. We highlight the best of them here.

What’s a protocol anyway?

Networks make use of protocols. These are guidelines for computers to speak to each other. Tiger supports just about every protocol you can name, including:

- AppleTalk: AppleTalk has been around for years and used to be how a Mac talked to other Macs and peripherals. People well-versed in the protocol still use it, but its popularity is dwindling.
- TCP/IP (Transmission Control Protocol/Internet Protocol): TCP/IP is the primary protocol for computers connecting to the Internet.
- PPP (Point-to-Point Protocol): PPP is used by modems to connect to the Internet.
- PPPoE (Point-to-Point Protocol over Ethernet): This protocol uses an Ethernet connection but simulates a dialup PPP session.
- HTTP (HyperText Transfer Protocol): HTTP is the default protocol for Web pages, which makes sense because you access sites by using http://. Similar to HTTP is HTTPS, which is a secure Web connection.
- FTP (File Transfer Protocol): FTP is a very common way to transfer files over the Internet (for example, to upload pages to a Web site). FTP is normally accessed by using an FTP application such as Fetch or Transmit. SFTP, a secure version of FTP, is replacing FTP for many users.
- SMB (Server Message Block): SMB is the most common way to share files with Windows users.

You can also find Bonjour, which is a special technology created by Apple to let computers automatically identify other computers and peripherals. It isn’t a protocol, but it uses these other protocols to function. We discuss this in Technique 39.

Networking Tips and Tricks

Setting up a network connection isn’t the hardest thing in the world. After you create one, numerous networking tips and tricks are at your disposal. We highlight the best of them here.

What’s a protocol anyway?

Networks make use of protocols. These are guidelines for computers to speak to each other. Tiger supports just about every protocol you can name, including:

- AppleTalk: AppleTalk has been around for years and used to be how a Mac talked to other Macs and peripherals. People well-versed in the protocol still use it, but its popularity is dwindling.
- TCP/IP (Transmission Control Protocol/Internet Protocol): TCP/IP is the primary protocol for computers connecting to the Internet.
- PPP (Point-to-Point Protocol): PPP is used by modems to connect to the Internet.
- PPPoE (Point-to-Point Protocol over Ethernet): This protocol uses an Ethernet connection but simulates a dialup PPP session.
- HTTP (HyperText Transfer Protocol): HTTP is the default protocol for Web pages, which makes sense because you access sites by using http://. Similar to HTTP is HTTPS, which is a secure Web connection.
- FTP (File Transfer Protocol): FTP is a very common way to transfer files over the Internet (for example, to upload pages to a Web site). FTP is normally accessed by using an FTP application such as Fetch or Transmit. SFTP, a secure version of FTP, is replacing FTP for many users.
- SMB (Server Message Block): SMB is the most common way to share files with Windows users.

You can also find Bonjour, which is a special technology created by Apple to let computers automatically identify other computers and peripherals. It isn’t a protocol, but it uses these other protocols to function. We discuss this in Technique 39.

Networking Tips and Tricks

Setting up a network connection isn’t the hardest thing in the world. After you create one, numerous networking tips and tricks are at your disposal. We highlight the best of them here.

What’s a protocol anyway?

Networks make use of protocols. These are guidelines for computers to speak to each other. Tiger supports just about every protocol you can name, including:

- AppleTalk: AppleTalk has been around for years and used to be how a Mac talked to other Macs and peripherals. People well-versed in the protocol still use it, but its popularity is dwindling.
- TCP/IP (Transmission Control Protocol/Internet Protocol): TCP/IP is the primary protocol for computers connecting to the Internet.
- PPP (Point-to-Point Protocol): PPP is used by modems to connect to the Internet.
- PPPoE (Point-to-Point Protocol over Ethernet): This protocol uses an Ethernet connection but simulates a dialup PPP session.
- HTTP (HyperText Transfer Protocol): HTTP is the default protocol for Web pages, which makes sense because you access sites by using http://. Similar to HTTP is HTTPS, which is a secure Web connection.
- FTP (File Transfer Protocol): FTP is a very common way to transfer files over the Internet (for example, to upload pages to a Web site). FTP is normally accessed by using an FTP application such as Fetch or Transmit. SFTP, a secure version of FTP, is replacing FTP for many users.
- SMB (Server Message Block): SMB is the most common way to share files with Windows users.

You can also find Bonjour, which is a special technology created by Apple to let computers automatically identify other computers and peripherals. It isn’t a protocol, but it uses these other protocols to function. We discuss this in Technique 39.
Ordering your ports

If you have several ports active in a single location — for example, an AirPort and an Ethernet connection — they can be active at the same time. The important thing is that you can order these to give preference to the most reliable connection.

If you have multiple ways of connecting to the Internet, you can order the connections so that your computer uses the strongest option first, if it’s available:

1. Open the Network panel in System Preferences.
2. Select Network Port Configurations from the Show drop-down list.
3. Click and drag any port to reorder the list.

Dialing with a calling card

If you’re in a hotel or somewhere else where you might incur huge charges by dialing into an ISP, have hope. You can use your calling card to dial up. Most calling cards have a sequence of steps like this:

1. Dial the calling card number (1-800-888-8888).
2. Wait for the prompt, and then enter your member number (2222222).
3. Wait for the prompt, and then enter the phone number to call (555-555-5555).

If you place all these numbers together, your modem dials them all at once, missing the prompts. To wait for prompts, use commas to indicate two-second pauses. For example, you might change the modem telephone number to be 18008888888,2222222,5555555555. Use this as the Telephone Number value on the PPP tab (when you show the modem configuration in the Network panel). You’ll probably want to use this in a new location, for when you travel.

Using FireWire over IP

You can network two computers with a FireWire cable. This feature is quite useful for transferring data between two Macs, if you

- Don’t have an Ethernet cable
- Have a FireWire cable
- Don’t want to reboot one of the machines to use FireWire target mode

Follow these steps to network with FireWire:

1. Plug a FireWire cable into both computers.
2. Open the Network System Preferences panel.
3. Select Network Port Configurations from the Show drop-down list.
4. Select the Built-In FireWire check box.

   If Built-In FireWire isn’t available as an option, follow these steps to add it:
   a. Click the New button.
   b. Give the connection a descriptive name.
   c. Select Built-In FireWire from the drop-down list.
   d. Click OK.
5. Click Apply Now (see Figure 37-10).

After you network two Macs with a FireWire cable, you can follow the steps in Technique 40 to share a Mac’s Internet connection, using the FireWire connection as the port. Then the second computer can either access the Internet through the first computer or access files stored on the first computer.
• Figure 37-10: Enable the FireWire port in order to share an Internet connection through it.
Wireless networks have increased in popularity in recent years partly because the technology has improved and the prices have come down. Simultaneously, the sales of Apple laptops have increased, and many people use laptops as their primary computers instead of a conventional, wired desktop machine. The joys of a wireless connection can be seen in homes, college campuses, airports, and coffee shops. The wireless world is no longer restricted to people who have money to burn or a degree in Information Technology.

If you have the right hardware, creating and using a wireless network is amazingly simple. But you can still gain more knowledge to facilitate your wireless networking habits. In this technique, we first discuss what you want in a base station and network card. Then we go over the basic steps of creating an AirPort network. After that, we go over encryption, which is an essential security concept. Finally, we show you some tips for speeding up your wireless network.

**What to Look for in a Wireless Network**

Wireless networking requires two physical devices:

- An access point (a base station or router) that connects to the Internet (via a modem or over broadband) and passes along this connection to the computers
- A wireless network card for each computer to receive the information transmitted by the base station

Your computer needs both a network card (like AirPort Extreme) and the software for that card to work on your operating system in order to function. The AirPort software comes with Tiger. The hardware is built-in for some higher-end models, and optional for others (labeled AirPort ready by Apple, meaning that the AirPort card must be purchased separately). If you want to use a non-Apple network card, make sure that the manufacturer also provides Tiger-compatible software.
In simplified terms, the access point (AP) is like a radio station sending out signals, and the network cards are like antennas, catching those signals out of the air.

In this section, we use the terms router and base station synonymously. Technically, a router connects networks, like connecting a number of computers in a home or office to the Internet. A base station is a transmitter/receiver that’s used to handle wireless signals. Base stations and routers often serve other purposes, like assigning IP addresses to computers, creating a firewall (see Technique 41), and connecting peripherals, such as printers. Manufacturers blur the lines in these definitions as well. For example, Larry’s access point is called a router by D-Link (who makes it), but Marc’s access point is an Apple AirPort Express. Both provide wired and wireless connectivity to Macs and PCs alike.

If you can plug a printer into your access point, you can make your Mac even more wireless. And Bonjour makes it easy for your Mac to find and use networked hardware (see Technique 39).

- **iTunes broadcasting**: AirPort Express can act as an intermediary between the iTunes collection on your Mac and your home stereo. By connecting this device to your receiver, you can play your MP3s throughout the house!

- **Ethernet ports to support wired computers**: Most access points can network computers either wirelessly or by using a standard Ethernet cable. Having a couple Ethernet ports is useful if you have computers without wireless cards or if a visitor wants to hop on your network via a computer that doesn’t have a wireless card.

- **A long range**: There’s a big difference between a base station’s advertised range and its true range. The true range is also affected by the materials used in the building where the network is (concrete and steel are killers), the distance the network covers, and how many/what kind of dense objects the connection must go through. You want a true range that’s the size of your building but not so large that it’s easily picked up by neighbors. Most base stations can broadcast up to around 100 feet, which is fine for apartments and smaller houses. People in bigger or multi-storied buildings might require multiple base stations to cover the entire area.

- **Built-in firewall**: Most routers have a firewall or a Network Address Translation (NAT) system to protect your computer. See Technique 41 for more information.

- **The ability to use a modem instead of an Ethernet Internet connection**: Most access points connect to the Internet via a broadband connection. More expensive routers also provide modems to use a dialup connection as a backup system. Alternatively, you can use a modem as a primary Internet connection if one is built into your access point.

- **Support for encryption**: Encryption is critical to maintaining a secure wireless network. See “Understanding Encryption” later in this technique for more.

- **Support for a printer**: The latest AirPort Base Station and the AirPort Express both include a USB port to plug in a printer, letting you network this device. (More expensive printers have Ethernet connections so that they may be plugged into any router.) Sure, your base station is wired to the printer, but your desktop model or laptop is freed.

You don’t have to use the Apple AirPort Base Station or AirPort Card in order to have a wireless network. In fact, you can pretty much get most base stations to work with most network cards. When choosing a base station, look for the following features:

- **Built-in firewall**: Most routers have a firewall or a Network Address Translation (NAT) system to protect your computer. See Technique 41 for more information.

- **The ability to use a modem instead of an Ethernet Internet connection**: Most access points connect to the Internet via a broadband connection. More expensive routers also provide modems to use a dialup connection as a backup system. Alternatively, you can use a modem as a primary Internet connection if one is built into your access point.

- **Support for encryption**: Encryption is critical to maintaining a secure wireless network. See “Understanding Encryption” later in this technique for more.

We recommend buying a network card and base station from the same manufacturer to ensure that you can use encryption on your network. Encryption schemes can be incompatible between different manufacturers’ hardware. You also get better technical support if the network card and access point are made by the same people.
The ability to extend the antenna: Some base stations can have their ranges expanded by adding to or otherwise extending the antenna.

Support for the 802.11g wireless protocol: Two protocols are widely available:

- 802.11g supports faster transfer speeds (54 Mbps) but has the annoyance factor of disruption from cordless phones and microwave ovens. Apple’s AirPort Extreme and AirPort Express can use either 802.11g and 802.11b.
- 802.11b (Wi-Fi) is an older protocol that’s used by basic AirPort.

A faster wireless protocol is headed down the pipeline, but it isn’t here at the time of this writing.

Upgrading to the 802.11g protocol doesn’t make file downloads or Web surfing faster. The faster transfer speed improves transfers only between computers and devices within your network. The 802.11b standard already is faster than your Internet connection.

Made by Apple: Although you can use many different kinds of hardware with your Mac, you have the least work and the most compatibility if you purchase Apple AirPort products. Furthermore, most Macs are made to take an AirPort or AirPort Extreme Card without using up a PC Card slot (a common expansion area on desktop computers) or USB port.

Creating an AirPort Network

Because Apple believes that you don’t need to be a rocket scientist to use its computers or equipment, setting up an AirPort network isn’t a Herculean task. In fact, even accessing a non-Apple base station with an Apple AirPort Card is pretty easy, thanks to the AirPort Setup Assistant. Here, then, is how you create your wireless network with this utility:

1. Install the AirPort card on your Mac.

   If you’re installing the AirPort card yourself, follow the manual’s instructions exactly. Be absolutely certain that the computer is off and cooled — and that you discharge any static electricity before touching your computer’s innards.

2. Turn on your Mac (if it isn’t already) and make sure that you already have a working Internet connection.

   The base station uses the same Internet connection information as your Mac (because it replaces your Mac for connecting to the Internet). Before proceeding, make sure that your Mac can already access the Internet. If you’ve never connected to the Internet with your computer, your ISP provides this information for you.

3. Install and turn on your base station.

   Follow the manual’s instructions that come with your base station. This might involve installing the antenna and then plugging in the power cord. (Yes, it’s usually that simple.) If you use a modem to connect to the Internet, you need to connect the base station’s modem port to a phone jack. If you use a broadband connection, you need to run an Ethernet cable from the base station to the cable or DSL modem.
Technique 38: The Wonderful World of Wireless Networking

**Place your base station in a central location (as central as possible) to provide the maximum range throughout your home, office, or apartment. Try to keep it clear of walls (and out of closets) and away from electronic equipment that puts out or interferes with radio-like waves. This includes stereo speakers, microwaves, and cordless phones.**

4. **Run the AirPort Setup Assistant on your Mac by double-clicking its icon in the Utilities folder.**

5. **On the second page (see Figure 38-1), select what you want to do and then click Continue.**
   - If this is your first time establishing an AirPort network, choose the first option, and then follow the prompts.

   There are a number of steps here, depending upon what decisions you make. The assistant gives you detailed instructions along the way. If you are ever unsure about an option, use the default choice recommended (or selected) by the assistant.
   - If you're modifying an existing AirPort network, choose option number two.

If you have trouble connecting to an existing network after running through the AirPort Setup Assistant, select Other from the AirPort menu bar tool to be prompted (see Figure 38-2) for the network's name, password, and password type (like WEP 40/128-bit hex).

**Closed Network**

| Choose a security type and enter the name of the AirPort network to join with an optional password. |
| Network Name: | default |
| Wireless Security: | WEP Password |
| Password: | 1234567890 |

**• Figure 38-2: Use this prompt to manually add a wireless network.**

6. **Enjoy your wire-free world!**

   To create an entirely non-AirPort network (where Apple makes neither the base station nor the wireless card), you go through similar steps but use the software provided by your hardware's manufacturer instead. You should have good instructions in the manuals that come with the base station and network card.

**Understanding Encryption**

One problem with wireless networks is their increased security risk. When you use a wireless connection, all the transmitted data is floating around the airwaves, ready to be intercepted. With that in mind, we present a list of things that you should know about security on wireless networks:

- **Use encryption.** Your encryption options depend on the networking hardware and software in use:
  - **Use WPA Personal encryption if you can.** WPA (Wi-Fi Protected Access) is an improved encryption that corrects some flaws of WEP (see the next item). If your network card and...
Finding Networks

Away from home or the office, you don’t have much of a wireless experience if you can’t find a network. The availability of wireless networks creates hotspots — public areas where users can hop onto live connections. Some hotspots are intentionally free and legal to use; others require an hourly usage charge; and still others you can use for free (thanks to someone’s lapse in security) even though doing so is technically illegal. Good places to find wireless networks include

- Coffee shops
- Bookstores and libraries
- Airport concourses
- Hotel lobbies

Remember that an available network isn’t the same as a network that you can legally use. And, note that if you can access a network, other computers on a network — and a network administrator — can see and potentially access your computer, too. So don’t think that you’re safe or stealthy by using what should be a private network.

Another good reason to use and require WEP encryption on your wireless networks is that it prevents neighbors from piggybacking your connection. Without the proper key, other computers can’t use your access point.

The easiest way to find available networks is to adjust your Network settings accordingly:

1. Open System Preferences.
2. Click the Network icon, under Internet & Network.
3. Select your network card from the Show menu.
4. Click the TCP/IP tab.
5. In the resulting window (see Figure 38-3), select Using DHCP from the Configure IPv4 drop-down list.

Dynamic Host Configuration Protocol (DHCP), a very common protocol, is the preferred method for most routers, wireless networks, and broadband connections. It lets your Mac receive its connection information from the connection provider rather than establishing set parameters.
Technique 38: The Wonderful World of Wireless Networking

6. Click the AirPort tab (if you’re using an AirPort Card).

7. In the resulting pane (see Figure 38-4), select Automatic from the By Default, Join drop-down list.

Using this option lets your computer automatically log in to the strongest network.

If you find your computer automatically joining the wrong network (like your neighbor’s instead of your own), you can set it to automatically join a specific network. Just choose Preferred networks from the menu in the AirPort tab and enter all the requisite information in the boxes that appear.

8. If you want, select the Show AirPort Status in Menu Bar check box.

This option makes seeing and switching among the available networks easier by using a menu bar tool (as shown in Figure 38-5).

9. Click the Apply Now button to enact the new settings.

Figure 38-3: Use DHCP to let your computer find network connections.

Figure 38-4: Let your computer choose the strongest network by not specifying one to join automatically.

Figure 38-5: The AirPort menu bar tool shows available networks and lets you quickly switch among them.
You can use many other tools to facilitate the process of finding networks. For starters

- **MacStumbler** ([www.macstumbler.com](http://www.macstumbler.com), **free**): MacStumbler is a free (woo-hoo!) utility that finds wireless access points. Unfortunately, it only works with the Apple AirPort Card.

- **iStumbler** ([www.istumbler.net](http://www.istumbler.net), **free**): iStumbler is another free utility for finding hotspots. It works through an AirPort card or through Bluetooth.

- **JiWire** ([www.jiwire.com](http://www.jiwire.com), **free**): JiWire is similar to WiFinder, listing over 50,000 hotspots available in over 90 countries.

- **WiFi Finder** ([www.kensington.com](http://www.kensington.com), **$30**): The WiFi Finder is a little device that finds wireless networks. It requires no other software and works independently of your Macintosh.

- **WiFinder** ([www.wifinder.com](http://www.wifinder.com), **free**): WiFinder is an online resource for finding publicly available wireless networks based upon geographic location. You can perform searches there, and it even lists both free and pay access points.

Being able to find a wireless network doesn’t mean that you can connect through it. Secure networks use some sort of encryption (see earlier in this technique), meaning that you need a password or key in order to connect. So although you might be able to see an available wireless network, you might not be able to use that network.
Bonjour is Apple’s protocol for instantly recognizing other computers and devices on the same network. In this technique, we give you the skinny on what Bonjour is, what you can do to configure it on your Mac, and how it works with some popular software and hardware. If you’ve never had to try your hand at networking, you might not appreciate how much easier Bonjour makes things, but by reading these pages you will see how simply you can network printers, share music, and use iChat.

Why You Should Use Bonjour

Bonjour, simply put, is the most valuable timesaving tool that you can use if you need to network computers and devices. Furthermore, Bonjour brings some nice added features to many of the applications that you use daily. However, if you have a single computer that isn’t connected to any network, you can’t benefit from Bonjour.

If you have multiple computers or a network, you can use Bonjour easily perform tasks like these:

- Find computers by name — not Internet Protocol (IP) address
- Locate people in iChat
- Listen to other music collections in iTunes
- View iPhoto pictures on another person’s Mac
- Use a printer not connected to your computer

In the non-Apple world, the Bonjour concept is referred to as Zeroconf, for zero configuration. For more information on the technology as a whole, see www.zeroconf.org.
Setting Up Bonjour

You don’t have to do anything to begin working with Bonjour, but you can make your computer more identifiable to others on the network by giving it an appropriate Bonjour name. Although your computer will have a default Bonjour name, here’s how to create your own:

1. Open System Preferences and click the Sharing icon (under Internet & Network).

In the Sharing panel that appears (as shown in Figure 39-1), your computer name appears in the Computer Name text box.

Your default Bonjour name is your computer name plus the suffix .local.

• Figure 39-1: The Sharing panel controls how your computer is identified.

2. Click the Edit button.

3. At the prompt (see Figure 39-2), enter a new Bonjour name in the Local Hostname text box.

Only letters, numbers, and hyphens are allowed in a Bonjour name. Fortunately, this prompt doesn’t let you enter characters that it doesn’t like.

• Figure 39-2: Use the prompt to create a new Bonjour name.

4. Click OK.

5. Close System Preferences.

If Bonjour doesn’t recognize a computer, it names that computer Macintosh.local.

Using Bonjour with Software

Bonjour works with many applications, adding cool new features to already fantastic tools. Most of these applications come from Apple, but an increasing amount of third-party software supports Bonjour. Here’s a highlight of what each application brings to the table:

✔ iChat: iChat finds people on your network who are available for instant messaging, chatting, and video- or audioconferencing. Bonjour automatically adds available people and removes them when they go offline. To do this, see the upcoming section, “Using Bonjour with iChat.”
Technique 39: Sharing the Wealth with Bonjour

If you use wireless networking in a public area, are in a large network, or dial up to a network by using a modem, you could easily become overwhelmed with the number of people that Bonjour finds.

**iTunes:** iTunes might take the cake for cool Bonjour features. It just has one Bonjour feature, but it’s a good one: Bonjour on iTunes lets you listen to other people’s music. To do this, see the upcoming section, “Using Bonjour with iTunes.”

**iPhoto:** The most excellent photograph management application has a new feature in version 4: You can share images over a network by using Bonjour.

You can buy the latest version of iPhoto in one of two ways. On the expensive side, if you buy a new Mac, it comes with the latest version of iPhoto. The more economical path is to purchase iLife for $50 (store.apple.com), which gives you the latest versions of iPhoto, iMovie, iDVD, and GarageBand.

**Safari:** Safari can access local Web addresses by using Bonjour. To enable this, select one of the three Include Bonjour check boxes in the Bookmarks preferences panel (as shown in Figure 39-3). Then you see bookmarks for sites that Bonjour finds added to your Bookmarks Bar, Bookmarks Menu, or Collections in the Bookmarks window. (See Technique 30 for more on Safari.)

**SubEthaEdit** (www.codingmonkeys.de/subethaedit, $35): SubEthaEdit (apparently its former name, Hydra, was just too easy to spell) is a text editor that allows people to work together on the same document at the same time without worrying about messing up each other’s work. You can use it over the Internet or on a network with the help of Bonjour.

**Transmit** (www.panic.com/transmit, $25): This popular File Transfer Protocol (FTP) client lists local FTP servers using Bonjour. Because it also supports Secure File Transfer Protocol (SFTP), Transmit is a good way to transfer files to networked users who’ve enabled Remote Login.

**BBEdit** (www.barebones.com/products/bbedit/index.shtml, $179): The best of all possible text editors now supports Bonjour for finding FTP and SFTP servers on your network. It’s much like Transmit except that it’s also a text editor.

**Games:** Many games coming out now use Bonjour to find other players. Aspyr (www.aspyr.com) was one of the first developers to start using this feature.

**World Book Encyclopedia** (www.worldbook.com): This encyclopedia application — which ships for free with some new computer purchases — lets students share their work.

![Figure 39-3: Larry has added Bonjour bookmarks to his Collections so they appear in the Bookmarks window.](image)

**Using Bonjour with iChat**

To automatically add available people and remove them from iChat when they go offline, follow these steps:

1. Enable Bonjour Messaging by either
   - Selecting the Use Bonjour Messaging check box when you start iChat AV for the first time (see Figure 39-4).
• Figure 39-4: When you first use iChat, you’re given the option to enable Bonjour.

- Choosing iChat → Preferences and then clicking the Accounts icon. Then select the Bonjour account in the Accounts preferences panel (see Figure 39-5) and edit the Account Information settings.

2. Open the Bonjour window by using either
   - The Window menu
   - The ⌘-2 keyboard shortcut

When you launch iChat or turn on Bonjour in iChat, Bonjour automatically finds other users on your network who are online. These people are displayed in the Bonjour window (see Figure 39-6), which behaves almost exactly like your Buddy List.

• Figure 39-6: Bonjour in iChat managed to find Larry’s other self!

3. Chat, instant-message, or send a file to a found Bonjour person as you normally would.

When you use Bonjour, you now have two lists (windows) of people you can chat with: your Buddy List and the Bonjour window. You can work with both windows — and the people listed in them — exactly the same. Double-click a person’s name to send an instant message, Control-click a name to see a contextual menu, and so forth.

Marc has found that using Bonjour with iChat during business meetings is surprisingly useful and productive. After you have everyone recognized in your iChat, you can easily transfer files back and forth through the Instant Message window.

• Figure 39-5: You can always turn Bonjour on and off in iChat through the preferences panel.

• Figure 39-6: Bonjour in iChat managed to find Larry’s other self!
Using Bonjour with iTunes

To set up Bonjour and iTunes so that you can listen to other people’s music (if they are sharing) and share your music with them, follow these steps:

1. Open iTunes.
2. Choose iTunes \(\Rightarrow\) Preferences and click the Sharing icon.
3. In the resulting Sharing panel (see Figure 39-7), enable the Look for Shared Music check box.
   
   This setting actually lets you see other people’s music — and while you’re sharing yours, you might as well look for theirs, too.

   • Figure 39-7: Enable sharing in iTunes to let others see (and hear) your good taste in tunes.

4. Enable the Share My Music check box.
5. Under the Share My Music check box, set iTunes to share either your entire library or just selected playlists.
6. In the Shared Name text box, give your music a meaningful name.

7. Decide whether you want to require a password.
   
   By setting a password, you can let your friends listen in but keep your mean co-workers or annoying sibling out. If you set a password, users see your collection listed but can’t see any specifics until they enter the correct password (see Figure 39-8).

   • Figure 39-8: You can password-protect your playlists if you want to share your music selectively.

8. Click OK to save the sharing settings.
   
   Now other users who’ve enabled the Look for Shared Music option can see your music collection and playlists in their Collections window (see Figure 39-9).

   A nice message reminds you that sharing music is for personal use only. In other words, this feature isn’t meant to be used as a radio station or as a way to steal music.

   Click the down arrow next to the collection name to view the playlists.

   You must keep iTunes open and your computer awake for people to continue listening to your music. To see how many people are connected to your tunes, look at the Status heading at the bottom of the iTunes Sharing preferences panel (see Figure 39-10).
Using Bonjour with iPhoto

To set up Bonjour and iPhoto so that you can see other people’s photos and they can see yours, follow these steps:

1. On the computer that’s sharing the images, open iPhoto.
2. Open the iPhoto preferences panel and click the Sharing icon.
3. In the resulting Sharing panel (see Figure 39-11), enable the Look for Shared Photos check box.

If other people have enabled Bonjour sharing within their iPhoto application, you’ll now be able to peruse their albums.

4. Enable the Share My Photos check box.
5. Under the Share My Photos check box, set iPhoto to share your entire library or just selected albums.
6. In the Shared Name text box, give your collection a meaningful name.
Technique 39: Sharing the Wealth with Bonjour

The shared name is for the benefit of other people on your network, so that they know whose files they’re accessing.

7. Decide whether you want to require a password.

By setting a password, you can let be more judicious in letting people see your photographs. If you set a password, users see your collection listed but can’t see any specific albums or images until they enter the correct password.

8. Now other users who’ve enabled the Look for Shared Photos option can see your collection and albums in their collections window.

Using Bonjour with Hardware

You can use Bonjour with hardware as well as software. In these cases, instead of finding people in iChat or music in iTunes, Bonjour helps you access networked devices, such as

- A printer not even connected to your Mac
- Shared volumes on other computers

As of the time of this writing, Bonjour can locate

- Other Macs (running OS 10.2 or later)
- Printers

You can use Bonjour to find a printer on your network or to find a printer connected to another computer on your network. Brother, Canon, Epson, Hewlett-Packard, Lexmark, and Xerox create printers that support Bonjour.

- Storage devices (such as Redundant Array of Inexpensive Disks, or RAID)
- TiVo units
- Digital cameras
- Scanners

For specific information on using Bonjour to find other computers and printers, see Technique 40.
Your Mac can interact with other computers on your network in many ways. For the beginner, this normally means accessing some other computer to view a Web page or retrieve files. But by making judicious use of Tiger’s Sharing features, you can easily and securely share your wealth — files, connected hardware, and even your Internet access — with others as well.

This technique focuses on the many types of sharing that your Mac can do. We begin by addressing the security risks involved with these features. From there we move on to Web sharing, which involves hosting Web sites on your Mac. Then we dig into file sharing — a great way to move documents around. After that, you see how easily you can share your printer or Internet access with other users.

If you find yourself frequently turning the different sharing tools on and off, consider SharingMenu, (www.mani.de/en, free). This shareware (in every sense of the word) creates a menu bar item that gives you quick access to the various sharing options offered by Tiger.

**Safe Sharing**

Sharing your computer creates some security risks. By letting others access your computer, you run the risk of them doing bad things, ranging from stealing information to crashing the system. Bad things don’t always happen . . . but they can. Here’s a nonscientific hierarchy of the most-secure to least-secure sharing options. You enable these (except Internet access) on the Services tab of the Sharing dialog of System Preferences:

- No sharing at all
- Personal Web Sharing
- Printer Sharing
- Internet access
You can feel pretty safe sharing Web sites, printers or Internet access. These don’t require usernames or passwords, and they don’t allow access to your Mac’s operating system or the file structure at large.

- Personal File Sharing
- Remote Login
- Windows Sharing
- FTP Access
- Remote Apple Events
- Apple Remote Desktop

The most prudent decision that you can make is to turn on only those sharing services that you need — and only when you need them. Turn off services when they aren’t necessary. Most importantly, never give out the username and password of a Mac’s administrator. If others must log on to your computer, set up a basic, non-administrative user for this purpose. (Use the Accounts panel under System Preferences to create the new user.)

Sharing a Web Page

Personal Web Sharing is Apple’s fancy description of hosting Web sites. Little did you know that your Mac has a very sophisticated Web-hosting tool built into it. With this feature, you can develop Web sites on your Mac — and, if your ISP allows it, you can host sites that are available to anyone in the world.

Personal Web Sharing lets you access Web pages running on your own computer and also lets other computers on your network or the Internet access them. If you develop Web sites, you can fully build them on your computer and then upload them to a live server after they’re finished.

Personal Web Sharing lets you run static HyperText Markup Language (HTML) pages from your Sites directory, but it doesn’t have to stop there. With this tool — after the proper configuration — you can also run the following Web development tools:

- PHP scripts
- JavaServer Pages
- Common Gateway Interface (CGI) scripts
- WebObjects pages
- WebDAV

For more information on any of these Web development tools, search Google or check out O’Reilly’s MacDevCenter (www.macdevcenter.com). Marc has created an installer for adding PHP to your Mac (check out the Mac OS X software section of www.entropy.ch), and Larry has written many books about PHP (by using a Mac as his primary test computer).

To turn on and use Web sharing, follow these steps:

1. Open System Preferences.
2. Click the Sharing icon under Internet & Network.
3. Enable the Personal Web Sharing check box (see Figure 40-1).
4. Place the files for your site within your Sites folder (in your Home directory).
5. Open Safari on your computer.
6. Go to http://localhost/~username (see Figure 40-2).

If you attempt to go to http://localhost in your Web browser and it reports that the address can’t be found, Personal Web Sharing isn’t turned on.
What's in a Name (Or URL?)

After you enable Web sharing, you have many ways to access your Web site. From your own computer, you can point your browser to one of these two locations:

- http://localhost/~username
- http://127.0.0.1/~username

The word localhost and the IP address 127.0.0.1 are two different ways to refer to your own machine (and they always refer to just your own computer). If your computer is on a network (online, that is), it has a second IP address that is unique to your computer — 127.0.0.1 is how every computer refers to itself. You can also use this second IP address to find your machine in the Web browser.

- http://your.ip.address/~username (for example, http://192.168.0.100/~username)

From another computer, your Web site can be accessed through

http://your.ip.address/~username

**Advanced Apache management**

Personal Web Sharing is really just the Apache Web server — the most popular (and arguably the best) Web server application available. From the Terminal application, you can control Apache with

- sudo apachectl start to turn on Personal Web Sharing
- sudo apachectl stop to turn off Personal Web Sharing
- sudo apachectl graceful to restart Personal Web Sharing

Your Personal Web Sharing (Apache) relies upon the /etc/httpd/httpd.conf file to control its behavior. You can modify this file if you know what you're doing. (You should probably back it up first, just in case.) For example, if only one user on your machine will use Personal Web Sharing and you'd rather use http://localhost or http://127.0.0.1 instead of http://localhost/~username or http://127.0.0.1/~username to access those pages, you can change these settings. You can also edit the httpd.conf file to turn on and off features you might want, such as support for PHP or WebDAV.
Fun with File Sharing

If you want to share your stuff with other computer users or make it easier for them to share their stuff with you, use file sharing. The two main tools for file sharing are

- **Personal File Sharing**: Personal File Sharing is an easy way to let other Mac users access the Public folders found within every user's Home directory on your Mac.

- **Windows Sharing**: You need to use Windows Sharing to let a Windows user access your files or use a Mac printer.

From Windows, the user can go to `\your.ip.address\username` and then log in with your username and password. For this reason, you might want to create a new account without administrative privileges. (Choose System Preferences ➤ Accounts to create the new user, making sure that the Allow user to administer this computer option isn’t enabled.)

Read on to discover how to easily use Personal File Sharing to transfer files between two Macs.

**Personal File Sharing**

To turn on Personal File Sharing, follow these steps:

1. **Open System Preferences.**
2. **Click the Sharing icon under Internet & Network.**
   The Sharing window appears.
3. **Select the Personal File Sharing check box (as shown in Figure 40-3).**
   After you turn on Personal File Sharing, text appears at the bottom of the Sharing window (above the padlock icon) that tells you how to access your computer.
4. **Place files to be shared within your Public folder (in your Home directory).**

5. **As a security measure, go back to the Sharing panel and turn off Personal File Sharing after the files no longer need to be shared.**

   When you disable Personal File Sharing, you’re given an option of how quickly to disconnect it and what message to send to connected users. These messages appear as alerts in the Finder of connected Mac users.

Now that you’ve enabled Personal File Sharing and made some files available, other users can access the files. To do so, follow these steps:

1. **On another Mac, choose Network from the Finder’s Go menu or press Ô-Shift-K.**
2. **In the resulting window (see Figure 40-4), double-click the icon for the computer you want to access.**
3. **In the resulting prompt (as shown in Figure 40-5), select Guest.**
   You don’t need to enter a username or password.
• Figure 40-4: In the Network window, open the computer you want to access.

• Figure 40-5: Log in as a Guest to access just the Public folders.

New to Tiger is an Actions drop-down list in the login prompt that appears when you log in as a registered user (see Figure 40-6). One possible action is to change a remembered password. Another (Options) brings up a window of different security-related settings you can tweak.

4. In the resulting Finder window (see Figure 40-7), double-click the user’s folder that you want to access.

• Figure 40-6: The new and improved login prompt has an Actions menu.

• Figure 40-7: If the Mac has multiple users, decide which user’s public files you want to access.

5. Double-click the mounted network drive on your Desktop to open it in a Finder window (see Figure 40-8).

After you successfully log in to a networked computer, it appears like a removable drive on your Desktop, although with a special network icon. After you open this in a Finder window, you can

► Transfer files to that computer by dropping them in the Drop Box folder.
Technique 40: Share the Love: Sharing Files, Printers, and More

- Transfer files from that computer if they’re available in the Finder window (like the Ch_40_figures folder in Figure 40-8).

- Figure 40-8: The contents of Larry’s Public folder.

6. Drag the mounted drive icon from the Desktop onto the Trash in order to log off of the server once you are done.

Print Sharing

Between Bonjour (see Technique 39) and Printer Sharing, sharing one printer on a network is surprisingly easy. Here’s how to set it up:

1. Make sure that the printer is turned on and connected to the primary computer that will be doing the sharing.

2. On the primary computer, open the System Preferences.

3. Click the Sharing icon under the Internet & Network heading.

4. Select the Printer Sharing check box.

To use a shared printer from another Mac:

1. On the secondary computer, open the Printer Setup Utility (in the Utilities folder).

2. Click the down arrow next to Shared Printers (see Figure 40-9).

- Figure 40-9: Shared printers should automatically appear in the Printer Setup Utility.

3. Select the shared printer and click the Make Default icon.

4. Print to the shared printer as you would to a connected printer.

The next time you go to print a document, the networked printer appears as the default printer (as long as it’s turned on and connected and the primary computer is on). You can send your document to this networked printer as if it were connected to your Mac.

Sharing Your Internet Connection

A pretty cool feature built into Tiger is the ability to share an Internet connection. This means that one Mac can be online (through a dialup modem, cable modem, DSL, or other type of Internet connection), and another computer can access the Internet through the first computer’s connection.

If you have multiple computers but use a modem dialup connection or don’t have a router to allow multiple computers on a broadband network, use Internet Sharing.

Here’s how to set up and enable Internet Sharing:

1. Open System Preferences and click the Network icon.

   The Network panel appears.

2. Select Network Port Configurations from the Show drop-down list (see Figure 40-10).
• Figure 40-10: Check your active network ports before sharing a connection.

3. Make sure that at least two ports are active (to make them active, select them in the list box):
   - You need one port that provides this computer with Internet access (from your telephone, cable, or DSL modem).
   - You need another port for connecting the second computer to this one.

4. Click the Apply Now button to activate the settings.

5. Select Network Status from the Show drop-down list and make sure you have an active Internet connection.

   There’s no point in trying to share something you don’t have, so make sure the sharing (or host) computer is actually online first. Use the information in Technique 37 to get your Internet connection up and running if any problems occur.

6. Select Sharing from the View drop-down list.

   The following steps use the Sharing panel.

7. Click the Internet tab.

8. In the Share Your Connection From drop-down list, select the port where you get your Internet connection.

   This might be your AirPort or other wireless card, your modem, or your built-in Ethernet port.

9. In the To Computers Using list, select the check box next to the port through which the second computer will connect (see Figure 40-11).

   For example, this might be your built-in Ethernet port or a FireWire port.

10. Click Start.

11. In the warning prompt that appears, click Start (see Figure 40-12).

12. Go to the Energy panel and set your computer so that it doesn’t sleep.
Technique 40: Share the Love: Sharing Files, Printers, and More

2. On the second Mac, open System Preferences and click the Network icon.
   The Network panel appears.

3. Select Network Port Configurations from the Show drop-down list.

4. Make sure that the appropriate port is active.
   This should match the port selected in Step 9 in the preceding step list.

5. Click the Apply Now button to activate the settings.

For the other Mac to use this shared Internet connection, follow these steps:

1. Connect the two computers by using the appropriate cable and access ports.
   The choice you made in Step 9 in the preceding list (the sharing port) dictates what kind of connection to make. So you might connect from one FireWire port to another or from one Ethernet port to another.
Network Security

If your Mac is on a network, you need to be mindful of security. Whether your computer is on a company’s intranet or just uses a modem to dial up to the Internet, if your computer ever talks to another computer you have to be a little careful. Mac OS X is fairly secure in its default state (much more so than, say, um, Windows), but that doesn’t mean you can’t still use a trick or two.

In this technique, we suggest taking three steps to protect your Mac. First, we show you what to do to secure your Mac using Tiger. Second, we recommend that you run a firewall. Finally, we recommend some tools you can use to check for potential security violations. By following a few simple rules, you can use your computer without worrying about unwanted intruders.

**Keeping Your Mac Secure**

Network security is first and foremost a matter of turning off features you aren’t using. The Sharing System Preferences panel (see Figure 41-1) lets you turn different features on and off by selecting or deselecting the check boxes on the Services tab. Each of these features adds functionality — but at the cost of decreased security. The most secure rules for sharing your computer are

- Leave all Sharing options turned off at all times, if you can.
- If you must use a type of sharing, enable it only as long as it’s necessary.
- Try to use the most secure type of sharing for what you need to accomplish.

Note the list of the hierarchy of security at the beginning of Technique 40. For example, using the FTP Access options is less secure than Remote Login, but you can use both for the same purposes.

- Use a firewall to protect your computer (see the following section).
through every port. (A *port* is a gateway into a computer.) If you need to turn on some Sharing features, you can explicitly open those ports to make the sharing feasible.

To enable a firewall, follow these steps:

1. **Open System Preferences.**
2. **Click the Sharing icon, under the Internet & Network heading.**
3. **In the Sharing panel, click the Firewall tab.**

   If you want something a little more user-friendly than the built-in firewall, check out Firewalk X 2 ([http://pliris-soft.com](http://pliris-soft.com), $35) or ContentBarrier X ([www.intego.com](http://www.intego.com), $60). Both are easy-to-use products, but they essentially provide the same functionality as the built-in firewall (and at a higher price).

4. **On the Firewall tab, click the Start button (see Figure 41-2).**

---

**Using a Firewall**

A *firewall* is a special type of security device that creates a barrier between your computer and other computers. You can normally create a firewall by using a combination of hardware and software. A firewall allows your computer to do everything it needs to do but prevents other computers, *Trojan horses* (software that does malicious things under false pretenses), and the like from getting into your computer or your data.

**Software firewalls**

Earlier versions of Mac OS X had a built-in firewall but didn't provide a good graphical user interface to it. Most users resorted to using third-party applications to easily manage their firewall. Fortunately for all of us, Tiger includes a firewall configuration tool, also found in the Sharing panel.

To protect your computer from outside intrusions, turn on the built-in firewall. The firewall is *exclusionary*, meaning that it denies access
A firewall doesn't affect any outgoing traffic (things you do) except for your FTP application. If you have your firewall enabled, you might have difficulty accessing remote servers via FTP unless you select the Use Passive FTP Mode (PASV) check box on the Proxies tab of the Network panel (see Figure 41-3).

• Figure 41-3: Enable PASV to use FTP when your Mac is behind a firewall.

5. If you use any of the Sharing services, make sure the appropriate check box for that service is selected on the Firewall tab of the Sharing panel.

► Select the iChat Bonjour check box (see Figure 41-4) if you want others to recognize you by using Bonjour with iChat.

For Bonjour to work, it needs the freedom to scan certain ports. If you have a firewall enabled, other iChat users can’t see you unless you grant that access.

► Select the iTunes Music Sharing check box if you want others to listen to your iTunes collection.

iTunes Music Sharing won’t work for other users unless the proper port is open.

• Figure 41-4: At the bottom of the window are the options to let iChat and iTunes find your computer.

► Select the iPhoto Bonjour Sharing check box if you want others to see your iPhoto pictures.

If you need a little assistance understanding how any item works, move your mouse over the item’s description. A yellow box appears, displaying more information (see Figure 41-5).

Hardware firewalls

You can put your computer behind a firewall with a router on your network, such as an AirPort Base Station. Routers create Network Address Translation (NAT) firewalls for your network. Essentially, the router appears as the machine being online: It’s part of the wide area network (WAN). All the computers connected to the router are

► Hidden from the WAN
► Part of the local area network (LAN)

If you have more than one computer at home, school, or the office, spending $100 (or often less) on the right router might be your easiest option.
Some routers let you bypass the firewall for a particular computer through specific ports (see Figure 41-6). This is useful if you play games online, do video conferencing, and the like.

**Blocking access to specific Web sites**

If you’d like to keep people on your computer from accessing specific Web sites, you can do so by modifying the `/etc/hosts` file. Here’s how:

1. **Open the Terminal.**
2. **Type** `sudo pico /etc/hosts`  
   This step opens the `hosts` file in the `pico` editor. Adding information to this file adjusts how your computer accesses Web sites.
3. **Enter the administrator’s password.**
4. **At the end of the file in your text editor, add** `127.0.0.1 someurl.com`  
   Replace `someurl.com` with the actual URL you want to ban, such as `google.com` or `espn.go.com`. (You should omit the initial `http://` and `www`. You can add as many items as you want here by using this syntax, with each going on its own line.
5. **Press Control-X to exit.**
6. **Press Y at the prompt to save the changes.**
7. **Press Return at the final prompt.**
8. **Restart your Mac.**

The next time any user attempts to go to the named URL in any browser, he is redirected back to his own computer. This results in either a default, meaningless Web page being displayed or a Server Not Found error message. This is a great way for parents to keep kids out of particular sites, for corporations to keep employees out of certain sites, or to play practical jokes.

**Checking for Security Problems**

If you’re really paranoid (er, security conscious), you can use an application to monitor network activity on your Mac. The intention of such software is to notify you of behind-the-scenes activity, so you’re alerted if something unexplained is going on. These tools won’t catch people trying to break into your...
computer, but they see whether something on your computer is trying to access the Internet without your knowledge. This could happen with Trojan horses and some applications. (See the sidebar, “Applications and your network.”)

**Applications and your network**

Some applications use a network connection without you knowing it. For example, an application might harmlessly check for software updates or check other computers on your network to ensure that multiple copies of the same software (that is, the same single-use serial number) aren’t being used repeatedly. If you want to stop this behavior, run these commands in the Terminal:

```bash
sudo ipfw add 0 deny tcp from any to any 3464
sudo ipfw add 0 deny tcp from any to any 2222
```

You enter the administrator’s password once, but both ports are blocked.

Here are some popular tools for keeping an eye on your computer’s network traffic:

- **MacScan** ([http://macscan.securemac.com](http://macscan.securemac.com), free): MacScan looks for the various types of malicious software that lingers on your computer and tries to make connections to the outside world. If it finds any, you’re notified and given the option to remove the offending application.

- **The SecureMac.com Web site** ([www.securemac.com](http://www.securemac.com)) is generally good at keeping you informed of network and general security-related issues.

- **Little Snitch** ([www.obdev.at/products/littlesnitch](http://www.obdev.at/products/littlesnitch), $25): Little Snitch alerts you when any application attempts to use a network connection. You can then allow the connection to occur, deny it, or tell Little Snitch what to do when this happens.

- **Nmap** ([www.insecure.org/nmap](http://www.insecure.org/nmap), free): Nmap scans your computer for potential security holes, including open ports (gateways into your computer). It can work on an entire network or just a single computer.
Your Guide to .Mac: $100 Well Spent

If you want an argument in favor of getting a .Mac account — or already have an account and want to discover a few new tricks — this is the technique for you. A .Mac membership isn’t cheap (currently $99 per year), but we have begrudgingly come to the conclusion that it’s worth it. (And we aren’t paid by Apple to say that.) If you aren’t so sure, sign up for the free (free!) 60-day trial membership and see for yourself.

If you need a little arm-twisting, read the first section of this technique, which covers the best reasons to pony up the money for a membership. Next, you discover a few things about iDisk and how easy it is to use. Finally, we show you how to synchronize your Address Book contacts, iCal calendars, and Safari bookmarks with .Mac so that they’re always available online . . . and backed up, to boot!

Top Ten Reasons to Use .Mac

If you require a little convincing (and that’s okay: 100 bucks isn’t chump change), here are our top ten best reasons to spend the money. A .Mac account

10. Lets you use iChat without creating an AOL account name.
9. Brings added functionality to many of Apple’s applications.
8. Stores your Address Book contacts and Safari bookmarks so that they’re available and backed up online.
7. Offers you a Web presence (everyone needs a Web page).
5. Shows you special tips and tricks for using your Mac.
4. Gives you a pretty good backup utility.
3. Gives you a remote 250MB disk space.
2. Provides you with e-mail (and a Simple Mail Transfer Protocol [SMTP] server) while traveling.
Your .Mac e-mail can be read via your mail client (Mail, Eudora, whatever) or online through the .Mac Web site. The online Webmail is really, really nice and easy to use, even providing you with access to your contacts if you synchronize your Address Book online. For more information, head to www.mac.com, log in, and then click Mail. If you’re confused by anything, click the Help link for a useful pop-up window of assistance.

And from the home office in Kirksville, Missouri, the number one reason to invest in a .Mac account is

1. **Offers up a very healthy amount of freebies, discounts, and other extras.**

Perhaps in response to some of the criticism that Apple has received over .Mac’s initial release, Apple has been very, very good about offering other goodies as they become available. These include

- Many free games
- Free versions of commercial applications
- Book excerpts
- Discounted software (including games)
- Additional resources for existing software, like hundreds of dollars worth of free GarageBand loops
- Discounted hardware
- VersionTracker.com memberships (both free and discounted)

VersionTracker.com, whose name appears a few times in this book, is perhaps the best Web site for finding Mac software. It has the most comprehensive and up-to-date listing of applications by category (such as Audio, Games, Multimedia, and Utilities) and type (Shareware, Freeware, Commercial, and Update). Whether you’re looking for a specific application or one that suits a certain purpose, head to VersionTracker.com.

- Free online training videos

We were both skeptical when we first signed up, but we have both gladly (and independently) rejoined year after year because it was well worth it. Plus you get an @mac.com e-mail address. How cool is that?

You can set up an existing .Mac account or sign up for a free trial from the .Mac System Preferences panel (as shown in Figure 42-1).

**Figure 42-1:** Use the .Mac panel to sign up for, set up, or manage a .Mac account.

## I Like My iDisk: Storing Stuff Online

Your .Mac membership comes with iDisk, which offers up to 250MB of remote storage. Your iDisk can be used to

- Host Web pages
- Back up important files
- Share files with other users
- Give yourself remote access to some of your stuff
- Download software from Apple and other developers
Currently the .Mac account comes with a total of 250MB of disk space. This space must be allocated separately to your e-mail and to your iDisk, which you do through the www.Mac.com Web site (under Account). Even if you allocate 20MB of space for e-mail, which should be more than enough, you still have 230MB for your iDisk. You can buy more space if you need it.

An iDisk is a pretty handy thing if you have a fast Internet connection. If you don’t, you might not find the iDisk to be that grand, particularly if you need to dial up every time you need to access the thing.

To use your iDisk, you must mount it on your computer first. As always, you have many ways of doing this:

- Press Ô-Shift-I in the Finder.
- Choose Go ➪ iDisk ➪ My iDisk in the Finder (see Figure 42-2).

Your iDisk mounts as an icon on your Desktop. After you open this icon, you can work with the iDisk like any other folder in the Finder (as shown in Figure 42-4). Your iDisk is organized like your Home directory, with a couple exceptions:

- Your Documents, Music, Pictures, Movies, and Library folders are private. They aren’t directly available to other users.
- If you store items in the Documents directory, only users who have username and password access to your iDisk can see them. This is a good place to store files that you might need to retrieve while traveling.

- Your Sites folder is where your Web pages go.
• Figure 42-4: The root level of Larry’s iDisk.

The URL http://homepage.mac.com/your_username points directly to your Sites folder. This URL is case-insensitive, so http://homepage.mac.com/YOUR_USERNAME and http://homepage.mac.com/Your_Username also work.

✓ The Public folder is for sharing files with others. (See the section titled “Making your iDisk secure,” later in this chapter.)

✓ The Backup folder is where the Backup application stores files. You can download files from the Backup folder by using the mounted iDisk, but only the Backup application can modify this folder’s contents (by adding or deleting items).


Making your iDisk secure

The Public folder of your iDisk is automatically accessible to the world at large. Be careful with it. Follow these steps to secure the folder:

1. Open System Preferences.
2. Click the .Mac icon (under the Internet & Network heading).
3. In the .Mac panel that appears, click the iDisk tab (see Figure 42-5).

You use the iDisk preferences panel to tweak your iDisk settings. It takes a few seconds to load each time you click it while it attempts to synchronize with your iDisk.

4. Make sure that the Read Only radio button is selected under Your Public Folder.

You can give people the option of both downloading (the Read Only radio button) and uploading (the Read & Write radio button) files to your Public folder. There’s really no need to let users write to your iDisk unless you have to do some serious file sharing and don’t want to use one of the many other file sharing tools available (see Technique 40).

5. Select the Use a Password to Protect Your Public Folder check box.

By selecting this check box, you require users to enter a password to access this folder. You’re given a prompt (as shown in Figure 42-6) to enter the password.
Using another .Mac member’s iDisk

You can easily access another .Mac member’s iDisk with Tiger. The iDisk submenu (under the Finder’s Go menu, refer to Figure 42-2) gives you these options:

- **Other User’s Public Folder**: To mount another user’s Public folder, you need only his .Mac username. Mind you, you can download files from a person’s Public folder, but you can’t add files to it, delete files from it, or otherwise change the Public folder’s contents (unless you choose the Other User’s iDisk option; see the next bullet). If the folder is password protected, you’re prompted to enter that password before you can read (download) any files.

- **Other User’s iDisk**: To mount someone else’s iDisk, you need her .Mac username and password. If you have this, you can control that disk as if it were your own.

**iDisk syncing: Using a local copy of your iDisk**

While you’re in the iDisk panel, you can decide whether you want Tiger to maintain a local copy of your iDisk. This means that your computer keeps a backup of your iDisk on your Mac. Larry personally finds this to be a little annoying and completely unnecessary for these reasons:

- **In all likelihood, your iDisk is a backup of stuff already on your computer.**
- **If you have this set to automatically update, a good amount of time is spent by your Mac syncing your iDisk with the local copy. This is really annoying.**
- **If you have to manually update the copy, you need to remember to do so.**

Feel free to use this feature if you must, but Larry turned it off almost immediately and hasn’t missed it since. That being said, if you’re on a slow Internet connection and you use the iDisk for storage, you can drop things in your local copy of the iDisk and then update the online version the next time you connect.

**Close System Preferences.**

You can’t turn off the sharing capability of the Public iDisk folder. The best you can do is password-protect it and remember not to place sensitive information there!
**Synchronizing Data with .Mac**

One benefit of having a .Mac account is that it provides you with an offsite location to store some of your most important information. But .Mac does more than just that: It even synchronizes certain types of data, so that any changes in the data can be harmoniously updated elsewhere. Synchronization provides three really keen benefits:

- A backup of your valuable data
- The ability to use these items on multiple computers
- Online access to your bookmarks and Webmail contacts

In Mac OS X.3 (Panther), you can synchronize data with your .Mac account by using the iSync application. In Tiger, synchronization works from within the .Mac System Preferences panel.

After you synchronize your data from one Mac (computer A) to your .Mac account, you can then update the data on a second Mac (computer B) by using the same .Mac account. This is great if you’ve just acquired a new computer or you regularly use two different Macs. Furthermore, by synchronizing through .Mac, changes made to your data on one computer (say, a person’s e-mail address in Address Book) can be updated on the second computer without the risk of losing other important information (like all the other Address Book data). For this to work, you need to log in to the same .Mac account on both computers (by using the .Mac section of System Preferences).

Using .Mac’s synchronization feature can guarantee that you always have the most up-to-date version of your Address Book, Safari bookmarks, and iCal data on the computer that you’re using.

To use .Mac synchronization across two computers, follow these steps on both computers:

1. Open the .Mac System Preferences panel.

2. Set your .Mac username and password, if you haven’t already (see Figure 42-8).

3. Click the Sync tab.

4. On the Sync tab, select the Synchronize with .Mac check box and select an option from the drop-down list (see Figure 42-9).
5. **Select the check box next to any data type you want synchronized.**

Here is where you select what information you want to be synchronized, choosing from Safari Bookmarks, Address Book Contacts, and iCal Calendars, Keychains, Mail Accounts, and so forth. If you don’t use any of these, you don’t need to synchronize them.

6. **Click the Sync Now button.**

The first time you run the application, it takes a little time. You know it’s completed when it shows a Last Sync date and time on the left side (see Figure 42-10).

If the synchronization process encounters any problems, it tells you what you can do. Usually, when a data conflict occurs, you can either

- Replace one set of data.
- Merge the two data sets. (This is the safest route.)

.Mac is kind enough to remind you in the Advanced pane which computers have synchronized their data and when. You can also “forget” a computer (like one you got rid of) by selecting it from the Registered Computers box and then clicking the Unregister button. (See Figure 42-11.)

![Figure 42-10: The .Mac panel shows the last time synchronization occurred.](image1)

By selecting the Show Status in the Menu Bar check box, a sync icon appears on your menu bar. By clicking it, you can quickly synchronize your data without going through the System Preferences area.

![Figure 42-11: Manage your synced computers in the Advanced panel.](image2)
Part VII

Fast and Furious Multimedia

The 5th Wave

By Rich Tennant

Jerry and Lyle attempt to load the newest version of "Toast," CD-burning software.

OK, I got the Sunbeam firewired to the iMac. Try putting the CD in the slot again.
iTunes: Rockin’ in the (Partially) Free World

Of the many free applications that Apple has included with its operating system, iTunes is the shining star. The first of the iLife products, iTunes has become so popular that even Windows users now have it. (Who would’ve thunk it?) All iTunes does is manage and play music, but that’s a pretty useful thing. If you’ve never used iTunes before, this technique shows you the fastest ways to use the application. If you’re a seasoned iTunes veteran, you’re still bound to discover many new, efficient techniques.

This technique begins with the most critical preferences settings and how to adjust the iTunes window itself. Afterwards, you see how to manage your music collection. Finally, we cover how to spend your life’s savings at the iTunes Music Store.

Also see Technique 47, which specifically discusses burning CDs from iTunes, as well as Technique 39, which covers using iTunes with Bonjour.

Tweaking Your Preferences

After you get iTunes up and running, you should immediately customize your preferences to make it work exactly as you’d like it to. If you used the Setup Assistant, many settings already are determined. Our best advice for tweaking iTunes follows. We take you step by step through the preferences panels, omitting only the cosmetic issues:

1. Open the iTunes preferences by pressing ` `, (comma) or choosing iTunes ➤ Preferences.
2. In the On CD Insert drop-down list box of the General panel (as shown in Figure 43-1), choose from four options of what iTunes should do when you insert a CD:
   - Show the songs on the CD.
   - Begin playing the CD.
Technique 43: iTunes: Rockin’ in the (Partially) Free World

- Import the songs from the CD (copy them to your music collection).
- Import the songs from the CD and then eject the disc.

You most often want to leave this on the Show Songs setting. That being said, if you’re about to rip your entire music collection onto your computer, set iTunes to import the songs and eject the CD to facilitate the process.

You can also set the Finder to automatically open audio CDs in iTunes. See Technique 47 for instructions.

- Figure 43-1: The General panel lets you decide what to do when CDs are inserted and how to work with the Internet.

3. Customize what features iTunes displays.

While you’re in the General panel, you can set several check boxes to adjust which features iTunes has and how music is displayed:
- Show Party Shuffle
- Show Radio
- Show Genre When Browsing
- Group Compilations When Browsing
- Show Links to Music Store

The Show Links to Music Store option puts a little arrow within a circle next to songs and artist names within the Library and your playlists. Clicking any of these circles takes you to the iTunes Music Store page for that artist. If you Option-click these circles, iTunes takes you to the Browse page for that artist within your own Library. This is a quick way to find, for example, all the Ani DiFranco songs you have in your collection.

If you don’t use any of these, by all means disable them, saving yourself some screen space. For example, if you don’t have a high-speed Internet connection, you probably won’t use the radio, so why bother showing it?

The General panel also lets you choose whether iTunes should automatically check for updates. If you regularly update your software with Tiger’s Software Update tool (see Technique 51), you can update iTunes from it, meaning that you don’t need iTunes to update itself.

4. Click the Audio icon at the top and select the Sound Check check box (see Figure 43-2).

This setting ensures that iTunes automatically adjusts the song volume so that it maintains a consistent level. Opting for this saves you the hassle of constantly adjusting the volume.

If you don’t use AirTunes, disable the Look for remote speakers connected with AirTunes check box. No reason your Mac should look for something you don’t have, right? On the other hand, if you travel with a laptop, you might be able to tie into a friend’s AirTunes.
5. Click the Importing icon at the top (see Figure 43-3) and set your import configurations.

These values are critical if you import a lot of music from CDs. The Import Using drop-down list affects how large the files are and where you can play them. The Setting drop-down list also affects how large the files are and how good they sound. For more on these settings, see the sidebar “A word on music formats,” elsewhere in this chapter. Finally, the Create File Names with Track Number check box dictates whether CD track numbers are used in filenames.

A cool feature of iTunes is the ability to look up CD and song names online. However, you don’t necessarily need to be connected to the Internet to use this. If you import a CD, you can look up the songs later. The next time you’re online, select the entire imported CD and then choose Advanced➪Get CD Track Names.

6. Click the Sharing icon at the top (see Figure 43-4) and decide whether you’re a borrower, a lender, or both.
8. Click the Advanced icon (see Figure 43-6). Here, you can

- Use the Change button to tinker with the Music folder location.

If you move your music files from one drive to another or want to use iTunes on a different music collection, change the Music folder location on the Advanced preferences panel.

- Set the Streaming Buffer Size to Large. (You really should.)

- Select the Keep iTunes Music Folder Organized check box. (Trust the app.)

There are two schools of thought when it comes to letting iTunes manage your music files. If you don’t want to think about this process at all, let iTunes do the work and don’t go meddling in the Music folder yourself. On the other hand, if you like a more hands-on approach, turn off the Keep iTunes Music Folder Organized option and you’ll never have your files rearranged just because you made some edits to a file in the iTunes application (like changing a song or album name).

The Sharing panel has two main settings:

- **Look for Shared Music** controls whether iTunes should look for other music collections on your network. If your iTunes finds other people’s music collections, they appear as a blue-colored playlist in the left column. You can then access any of those songs — and potentially the playlists — that the user created.

You can’t change the information of a song on another user’s computer, alter a rating, increase the play count, or copy songs to your computer. If a particular song was purchased through the iTunes Music Store, you need that user’s access information to play it.

- **Share My Music** determines whether you let others listen to your iTunes. If you decide to share your music — and you really ought to, to be nice — you can decide whether to share the entire library or just specific playlists (and therefore, specific songs). While you’re at it, give your share a descriptive name and password-protect it if you want to make sure that only friends tune in. After you turn on this feature and click OK, you’re given the Sharing Music Is for Personal Use Only prompt (as shown in Figure 43-5) where you should select the Do Not Show This Message Again check box.

• Figure 43-5: Yes, yes. Stealing music is bad. We get it!

Technique 39 shows you — using detailed instructions — how to share your music with other users on your network.

7. **Skip the Store panel for now.**

This pertains to the iTunes Music Store, which we discuss later in the chapter.
Select the Copy Files to iTunes Music Folder When Adding to Library check box. (Again, let iTunes do the work.)

You can override the iTunes setting that copies music to your folder when added to your library by holding down the Option button when you drag a song into iTunes. That way, you can listen to a track with iTunes without making it part of your permanent collection.

If you have an iPod, click the iPod icon (see Figure 43-7).

There are two subsections to the iPod preferences:

- **On the Music tab**, adjust your settings so that it best works with your iPod.
  
  If you have an iPod that can hold your entire iTunes collection, opt for Automatically Update All Songs and Playlists. If you have to be particular about what goes on your iPod, choose either the manual option or establish particular playlists that are synchronized with your iPod.

- **On the General tab**, establish how Tiger should recognize your iPod.
  
  The first choice is to open iTunes when your iPod is attached. The second choice (Enable Disk Use) lets you see the iPod on your Desktop so that you can store other data there.

After you tweak all your settings, click OK.

Enjoy iTunes!

---

**A word on music formats**

Before you import music into iTunes and onto your computer, you have to make a few decisions. These decisions affect the size that each file takes up on your computer and the sound quality that it provides. Note that there’s generally a direct relationship between the two: the higher the quality, the larger the file size. All the important sound settings can be made using the two drop-down lists on the Importing preferences panel.

iTunes supports multiple audio formats:

- **AAC**: AAC is the default setting for iTunes. It provides a better quality than MP3 at a smaller file size. The only drawback to AAC is that not all computers or players can recognize the format. If you play your music as MP3s in a CD player or don’t use an iPod as your portable device, avoid this format until it’s better supported.

- **AIFF**: AIFF is an uncompressed standard format for sound files on the Macintosh. It provides great quality but at a high price in terms of disk space. A CD is in AIFF format normally, taking up around 700MB (as opposed to 70MB in MP3 format).

- **Apple Lossless**: Relatively new to iTunes is the Apple Lossless format. This format provides a sound quality rivaling AIFF but at around half the disk space. If you want to keep audio files in a pure form, this is a good choice, but your music collection requires a ton of disk space and it limits how many songs can be put onto your iPod (and only newer iPods support this format).
Technique 43: iTunes: Rockin’ in the (Partially) Free World

- **MP3**: MP3 is the format that started the whole digital music boom. It turned music into files one-tenth of their normal size without significantly sacrificing sound quality. Although AAC is better quality at about the same file size, MP3 is a more universal format still.

- **WAV**: WAV is the Microsoft version of AIFF. Yuck!

iTunes lets you adjust some of the specific audio settings by choosing Custom from the Setting drop-down list. You find three drop-down lists for configuration:

- The **Stereo Bit Rate** affects both your file size and the sound quality.

  The higher the bit rate, the higher the quality and the bigger the file. The 128 Kbps is the default setting, but you might want to up this some, particularly if you’re likely to burn audio CDs from your iTunes collection, in which case there will be potentially noticeable quality loss. Larry normally opts for a setting of 192 Kbps, which is a nice compromise between quality and file size.

- Leave both the **Sample Rate** and **Channels** settings on Auto. There’s no need to mess with these.

### Redecorating the iTunes Window

Before doing your thing with iTunes, you ought to customize the iTunes window. Start with which version of the window you’d like to see:

- **The full-screen version**: You can see this version in Figure 43-8.

- **The optimal version**: To view the full iTunes screen optimally (so that it takes up as much space as needed or as it can), Option-click the green button in the upper-left corner of the window.

- **The minimized version**: Switch to this format by clicking the green button. Click the green button again to go back to the full-screen version. You can see this version in Figure 43-9.

Within the minimized version, you can still see the song name and time. Click the song name to rotate among song, artist, and album. Click the time to rotate among song length, how much of the song has been played, and how much is remaining. Click the small circle on the right to switch between the display and the equalizer. If multiple tasks are going on (like importing a CD or copying music to an iPod), clicking this circle cycles through that information as well.

- **The really small version**: If you’re in the minimized version, you can make it smaller by resizing the window, using the lower right-hand corner. Figure 43-10 shows the really small version.
If you want to control iTunes and nothing more, use this window version.

Within the full-screen version, you can do a lot to customize the window.

1. Bring up the View Options window (as shown in Figure 43-11) by choosing Ô-J or choosing Edit ➪ View Options.

2. Select check boxes for every column you want to view.

3. Deselect the check boxes for every column that you don’t need (or don’t need regularly).

   Yes, we’re talking about the Beats Per Minute column.

The only column that you can’t remove or even move is the Song Name. It isn’t even listed in the View Options window (refer to Figure 43-11).

4. Click OK to close the View Options window.

5. In the iTunes window, click and drag the column names to rearrange them.

6. Control-click any column heading to bring up its contextual menu (see Figure 43-12).

7. Choose Auto Size All Columns to adjust the column widths automatically.

You can also add and remove columns via the contextual menu if you don’t feel like using the View Options prompt.

After you import or purchase a slew of music, you need to be able to manage and navigate through it with ease. In this section, we cover the best techniques, without any of the beginner step-by-step stuff you’ve probably already figured out.
If you use multiple Macs and you’re annoyed by never having the right song on the right Mac, check out syncOtunes (http://homepage.mac.com/oligrob/syncOtunes/syncOtunes.html, donationware). This little app synchronizes your collections, saving you oodles of time comparing lists and manually importing tracks. Similarly, hundreds of AppleScripts are available at Doug’s AppleScripts for iTunes (www.malcolmadams.com/itunes/index.php) that perform various useful tasks.

Editing song information

You can edit information for individual songs in many ways:

✔ Select a song and press ⌘-I to bring up the Get Info panel.

✔ Click within any one field to change just that field.

✔ Select multiple songs and press ⌘-I to edit information for several songs at once.

With this method, you only want to tweak broad factors, like the artist name, the year of release, the album name, and the genre.

If you keep your music organized, editing songs becomes really quick thanks to iTunes’ AutoFill feature. From your existing library of artists, albums, and genres, iTunes guesses what you’re typing in these fields and fills it in for you.

Searching for tracks

iTunes supports two methods for finding specific songs: browsing and searching. Our three best tips for finding a song or artist are

✔ Click the Browse button (it looks like an eye, in the upper-right corner) or press ⌘-B to open and close the browsing panels (see Figure 43-13).

Use the Browse tool to browse by artist or album. If you enable Show Genre when browsing in the General preferences panel, you can also browse by genre.
Select a playlist in the left column to browse or search within it.

By default, the Search and Browse tools look through an entire collection, but you can limit both of these by selecting a playlist and then searching or browsing.

Creating playlists

You can save yourself a lot of time, or just kill some time, by playing around with playlists. Here are some of the cool things that we’ve come to appreciate:

- Press Ô-Delete to remove a song or playlist without getting the confirmation dialog. (Deleting a song from a playlist doesn’t remove it from your collection; to do that, remove a song from the Library list.)

- Create a new playlist by
  - Selecting a bunch of songs and then Shift-clicking the Add button.
  - Selecting a bunch of songs and dragging them into a blank area in the Source column.
  - Selecting a bunch of songs and pressing Ô-Shift-N.
  - Selecting a bunch of songs and choosing File ➪ New Playlist from Selection.

- Option-click the Add button to create a Smart Playlist. Standard playlists have set songs in them (selected by dragging the song from the Library into the playlist). Smart Playlists let you set parameters (such as the artist name, the year the song was released, your ranking of the song, the genre, and more). iTunes then creates a playlist that matches your criteria. You can further limit your Smart Playlist to a certain length, like eight hours of total music (say, if you’re taking an eight-hour road trip).

If you’re trying to work between multiple playlists or between a playlist and your Library, use multiple iTunes windows. Just double-click the space to the right of a playlist’s name to open that playlist in its own window. Then you can easily drag files from the one window to the other.

Controlling iTunes

If you frequently sit at your computer while listening to iTunes, you quickly come to realize how often you feel compelled to skip a song, remind yourself who the artist is, or rate an unrated track (if you’re addicted to the ratings). Constantly switching from the application you’re in over to iTunes to perform one menial task is a complete waste of time. So to put those precious moments back into your day, use a utility that lets you control iTunes without leaving the application you’re using:

- **iTunes:** One way to gain easy, constant control over iTunes is to use the minimized or really small version of the iTunes window. If you select the check box for the Keep Mini Player on top of all other windows option in the Advanced preferences panel, then the iTunes player always is visible. Because the Mini Player doesn’t take up much screen space, it shouldn’t interfere, even in front of the Web page you’re viewing or the Word document you’re editing.

- **SizzlingKeys** (http://yellowmug.com/sk4it, free): SizzlingKeys is Larry’s personal favorite. Not only is it free (mmm . . . free), it’s highly customizable. One feature is that it can briefly display a box when each new track starts (see Figure 43-15), letting you know what’s coming. You can also skip, repeat, and rate songs by using easy-to-remember keyboard controls.

- **Figure 43-15:** SizzlingKeys can present information on the currently playing track.
Girc (http://homepage.mac.com/the_macman/hazard/girc.html, free): Girc is more than just an obscure name, it’s also a floating toolbar for controlling iTunes. It’s a wee little guy so it won’t interfere with other applications.

Blowing Your Paycheck at the iTunes Music Store

The iTunes Music Store looks like it just might be the most popular (legal) music downloading software around. It was an immediate hit with Mac users, and even our lesser Windows brethren can finally understand exactly the kind of things that we’ve been crowing about for years: 50 percent innovation, and 50 percent really, really cool.

To use the iTunes Music Store (we just call it the iTMS for short), you need either an Apple ID or a .Mac account. First, click the Music Store option in the Source column. Then click the Sign In button next to Account (on the far right of the screen) and you’re taken through these steps that follow. If you have a .Mac account, Apple most likely already has your credit card, saving you a step (for better or for worse).

Within the preferences panel, click the Store icon to adjust a few of its preferences (see Figure 43-16). This is what you need to know:

- If you don’t want to be tempted, deselect the Show iTunes Music Store check box.
- If you’re of the instant gratification type, opt for 1-Click shopping.
- If you prefer larger debits on your credit card, go with the Shopping Cart.

If you use the iTMS shopping cart, the Music Store playlist becomes an expandable folder that shows both your purchased music and your shopping cart. You can add items to the shopping cart over multiple sessions and buy them all when that paycheck comes in.

If you’re on a slow network connection (read: modem), select the Load Complete Preview Before Playing check box to improve your preview quality.

Within the iTMS itself (see Figure 43-17), here are a few shortcuts with which you should familiarize yourself (so that you can spend more time buying). These are

- Option -[ (opening bracket): This shortcut takes you back a page.
- Option -] (closing bracket): This shortcut takes you forward a page.

The Option -[ and Option -] shortcuts also work to move forward and back among the panels of the Preferences and Get Info panels. It’s an almost universal Mac shortcut (for Apple applications, at least).

- Click the house icon: This takes you to the iTMS main (home) page.
- Click the Browse button (the eye): This lets you browse the entire iTMS by genre, artist, or album.
- Open the Search box drop-down list: This lets you limit the scope of your search.
Use the Search drop-down list to make your searches faster and more accurate. Better yet, use the Power Search for extended searching.

You can drag songs from the iTunes Music Store into a playlist. This is a great trick you can use to keep a list of what songs or albums you’re thinking of purchasing. Just:

1. Create a new playlist with a meaningful name (like iTunes Music Wishlist).

2. While you’re in the iTunes Music Store, bookmark any song by dragging it into your playlist.

3. Click your playlist to view all the songs in your wishlist (see Figure 43-18).

4. Purchase any song in your wishlist by clicking the Add Song link in the Price column.

If you start your playlist name with a special character, like • (created by Option-8), it appears at the top of your list of playlists, right after the list of Smart Playlists.
Working with iPhoto

If you have a digital camera and you’re not using iPhoto already, you’re really missing out. iPhoto is a simple, yet effective, application for managing your digital photographs. In this technique, we shy away from the basics (such as importing and viewing images), instead focusing on the best and quickest ways to do specific things within the application. Then we address your digital library: what to do with all those images you’ve imported over the years. Finally, we demonstrate a couple techniques for posting your images as an online, viewable catalog.

iPhoto used to be a free download, available to all Mac users. The only way to get iPhoto now is to either buy the iLife package ($79) or a new Mac. (iLifes comes installed on new Macs.) In this technique, we use iPhoto 5, so some of the features might not be available to you if you’re using an older version of the application. (Versions 4 and 5 both brought significant new features to the application.)

Best iPhoto Practices

The basics of using iPhoto are easy to master, but you can do a number of little things to use the application more productively. We go through these in somewhat random order.

Preferences

Some of the settings in the iPhoto’s General preferences panel affect your productivity, such as

- What to do with a double-click:
  - Open in Edit view
  - Open in a new window
  - Open in another application (see Figure 44-1)
Whatever you decide to do with the double-click setting, click the Select Application button to choose your external editor, such as Photoshop Elements. After you do so, you can just Control-click an image to bring up a contextual menu that offers you the option of editing the image in your external editor (see Figure 44-2).

- **Rotate**: Different cameras display rotated images in different directions (clockwise versus counterclockwise). Change your rotate button to match your camera so you can easily adjust how the image is displayed.

- **Mail**: One of the nice features in iPhoto is the ease in which you can e-mail a picture to someone. For this feature to work, however, iPhoto must know what mail application you use. Establish that here, select an image in the main iPhoto window, and then click the Email icon to be prompted (see Figure 44-3) for how the photo should be formatted when you send it.
Creating a new Photo Album quickly

The iPhoto application uses Photo Albums to help you organize your digital images. Even though all your images are primarily stored in the Photo Library — the first item listed in the left column — subsets can be grouped into albums, organized based upon theme, location, and so forth. (Think of Photo Albums as the equivalent of the iTunes playlist.) You can create a new Photo Album by choosing New Album from the File menu and then dragging all your images into this new folder, but this method is faster:

1. Open iPhoto.
2. Select Library in the left column to view all your images.
   
   If you want to create a new Photo Album by using the last imported group of photos, begin by clicking the Last Roll icon instead. You can even set, using the preferences panel, how many previous rolls to list in the Source column.

3. %-click images to select the images for the Photo Album.
4. Drag these images into the blank area in the left column, below the Trash.
   
   You see a green plus circle appear, along with the number of images being moved in a red circle.

5. The new album (called untitled album) appears with the photos in it.
6. Double-click the new album’s name to change it.
7. Delete the default name, type a new one, and you’re done!

You can also create a new album by dragging a folder of images from the Finder into the Source list column. The album is created with the same name as the folder, and all the images are imported automatically.

Creating a Smart Album

As of version 4, iPhoto has the ability to create Smart Albums. Just like Smart Folders in the Finder or Smart Playlists in iTunes, to create a Smart Album you generate a list of criteria and iPhoto populates that album with matching images. Furthermore, iPhoto dynamically updates the contents of your Smart Albums as your digital library changes. To create a Smart Album:

1. Open iPhoto.
2. Choose File → New Smart Album.
3. In the corresponding prompt (see Figure 44-4), give the album an appropriate name.

4. Use the menus to define the first criterion.
   
   Your criteria can be based upon a number of factors, such as
   - Album name (photos from particular albums can be used in a Smart Album)
   - Text or comments
   - Date (specific dates or even ranges)
   - Filename
   - Keyword
   - Rating
   - Roll name
   - Image Title
   
   For each factor, which option you select in the first menu dictates what other menus or prompts are given.
For the Smart Albums to be most effective, you have to add descriptive data to your images as you would to songs in iTunes. This includes adding descriptive titles, keywords, and comments, as well as rating images.

5. To add another criterion, click the plus sign and repeat Step 4.

You can add as many criteria as necessary.

6. If you have multiple criteria, select either All or Any from the Match drop-down list.

Selecting All makes the criteria exclusive, meaning that every criteria must be matched. This should decrease the number of photographs in your album. Selecting Any makes the criteria inclusive, increasing the number of photographs in the album.

7. Click OK.

Within the General preferences panel, you can enable two other Smart-like albums. One displays the last \( X \) number of rolls — a roll is a group of images imported at the same time — and the other displays the images taken and imported over the past \( Y \) number of months.

 Editing images with ease

After you import your images, you might want to tweak them. You can accomplish this by using iPhoto’s basic tools or with an external application, such as Adobe Photoshop, Adobe Elements, or the open source The GIMP. We don’t have space in this book to discuss basic editing techniques, but here are our best editing-related tips:

- Set your preferences for a default action when you double-click (refer to Figure 44-1); otherwise, use the contextual menu (refer to Figure 44-2). If you want to use iPhoto for your editing, make this explicit in your preferences (by selecting Opens in Edit View under Double-Click). If you’d rather use another application, set the double-click to launch that (by using the Select button after selecting Opens in Other). In either case, when you want to edit an image by using something other than the default tool, Control-click to see your options.

- After you edit a photo, you can undo the effects by selecting Revert to Original from the contextual menu that appears when you Control-click an image. This feature works even after you’ve quit and returned to iPhoto because iPhoto doesn’t let you make alterations to the original photo. Instead, it creates a copy of the image and makes changes to it.

- If your camera can take pictures in the RAW format, you can use them in iPhoto 5. With the RAW format, the camera records a more literal version of the image (in layman’s terms). If you really know what you’re doing when it comes to editing images, you can use iPhoto 5 to adjust the exposure, color saturation, and the like.

 Working with Your Digital Library

If you take a lot of digital photographs, your hard drive will quickly fill up with images. This isn’t ideal for your computer and, more annoyingly, will bog down iPhoto every time you use it. From the experience of importing and managing several thousand photos (no, we aren’t making that up), here’s our best timesaving advice for importing, managing, and storing your digital photographs.

 Importing images

One of the ways in which iPhoto has grown is its streamlined importing capability. You can now hook up your camera to your Mac (depending upon the camera and the Mac) and import your images directly into iPhoto.
Technique 44: Working with iPhoto

1. Make sure that you can view most of the images and you can see the orientation clearly.
   Use the Zoom slider to present the images at an appropriate size.

2. Select all the images that need to be rotated clockwise.
   You can select multiple images by Ô-clicking.

3. Click the Rotate button.
   Remember to use the iPhoto Preferences to set the default rotation direction.

4. Select all the images that need to be rotated counterclockwise.

5. Hold down Option while clicking Rotate.
   You can easily edit the information — the title, date, and comments — for a group of images using the Photos ➪ Batch Change option.

After an image is in iPhoto, you can

➤ Drag it into Photoshop or another application for editing.
➤ Click the Desktop button to set the selected image as your Desktop (see Figure 44-5).

Managing your images more efficiently

After downloading a batch of images, you usually want to rotate the ones in portrait orientation first. We recommend this timesaving procedure:

You can import an image from a disc (instead of a camera) by dragging the folder containing the images into the photo viewing area of iPhoto. The application will use the folder’s name as the film roll name. If your folder is nested with subfolders, each subfolder becomes its own film roll.

The process of importing images is straightforward enough, but be aware of a few tips:

➤ Let iPhoto erase the camera contents after each transfer. As Marc has painfully discovered, if you use your camera’s media card for photos and movies (which many cameras are now capable of), you can easily forget the movies and accidentally delete them by manually reformatting the media. By letting iPhoto take care of deletions, your photos will be deleted, but everything else will remain untouched. Just select the Erase Camera Contents after Transfer check box before clicking the Import button (under the Import tab).

➤ Use a media reader adapter instead of a direct connection to your camera. For very little money — $10 to $20 — you can purchase a media adapter so that you can access your virtual “rolls of film” without using your camera. In all likelihood, such a connection would be much, much faster than the likely USB cable that your camera uses, particularly if you pick up a FireWire model. After you mount a media card, you can import the images by dragging them from the Finder into iPhoto.

➤ Have iPhoto store your photographs in your Pictures directory. That’s what it’s there for, after all. Plus, your images will be backed up with the rest of your Home directory.

➤ iPhoto 5 can also manage video clips that your camera records.

• Figure 44-5: Use the tools in the bottom bar to quickly do common tasks with an image.
Create a printable book of photographs, with titles.

E-mail it to a buddy by clicking the Mail icon.

Deleting an image in iPhoto doesn’t actually delete the image from your hard drive. You must choose iPhoto’s Empty Trash to formally remove the photograph (which also deletes the image from your computer).

How many megapixels are enough?

Today's digital cameras take images starting at 2 megapixels and easily going up to 5 or 6 megapixels, even for consumer-level cameras. But how many megapixels do you really need to use? All digital cameras let you adjust the size (in number of pixels) and quality (based upon format and compression) of the pictures that they take. Choosing a lower image size has many benefits:

- You can fit more images on whatever media your camera uses.
- You use far less hard drive space.
- It doesn’t slow down iPhoto the way choosing larger images does.
- You get smaller file sizes, which makes placing images on the Web or e-mailing them easier.

Use the maximum number of pixels only if you plan on printing the images in sizes larger than 5 x 7 inches. Images with small file sizes result in poor image quality in a print that size.

Our advice is to use an image size around 2 to 3 megapixels but at the highest image quality. This gives you a high-enough resolution for editing and lets you use an image as your Desktop without stretching — but still gives you a very printable picture.

Storing your images to save space and time

You don’t want to keep all your photographs in iPhoto at all times for three reasons:

- Digital images take up an incredible amount of hard drive space.

- iPhoto’s performance suffers.
- Finding images is much harder.

If your Photo Library is getting large (over 600MB), burn your archived images to a CD to save space:

1. Select the Library in the Source column to select the entire photo library.

2. Click the Information button (which bears an i) at the bottom of the column.

The Information panel (see Figure 44-6) shows you how large the selected library is on your hard drive.

Figure 44-6: See how much space your collection takes up by using the Information panel.

You can archive a subsection of your library by clicking one of the groupings under Library (Early Photos, 2002, 2003, and so on).

3. Select Share’s Burn Disc to archive the library to a disc.

4. Insert a blank CD-R.

iPhoto prompts you for one.

5. Confirm that the images will all fit on a disc (see Figure 44-7).

If the disc is full, you see the disc icon highlighted in red, indicating that the images won’t all fit. If the disc icon is green, you’re okay to continue.
Technique 44: Working with iPhoto

If you need help managing your libraries, check out

- **iPhoto Buddy** ([http://nofences.net/iphotoBuddy](http://nofences.net/iphotoBuddy), free): iPhoto Buddy makes managing multiple iPhoto libraries easier. You can work with subsections of your digital collection, even if they're located on different media (your hard drive, CDs, and so forth).

- **iPhoto Diet** ([http://pages.cpsc.ucalgary.ca/~fuhrer/personal/freestuff](http://pages.cpsc.ucalgary.ca/~fuhrer/personal/freestuff), free): iPhoto Diet can save you a lot of hard drive space by helping to delete original versions of images that you have rotated or edited.

- **iPhoto Library Manager** ([http://homepage.mac.com/bwebster/iphotolibrarymanager.html](http://homepage.mac.com/bwebster/iphotolibrarymanager.html), free): This application works much the same as iPhoto Buddy but is AppleScript-able.

### Creating an Online Photo Album

Putting your photos online is really easy if you have the right software. If you have a .Mac account, you can put your photos online by following these steps:

1. Select a photo album in the left column.
2. Click HomePage (or choose Share ➪ HomePage).
3. Edit the page title, picture frame style, and so forth from the Publish HomePage dialog (see Figure 44-9).

   You can determine what theme your published album should use by selecting one from the theme list on the side of the Publish HomePage window.

4. Click the Publish button.

   iPhoto uploads all the images, which takes a few minutes, depending upon your connection speed and the number and size of the photos you are publishing. The beauty of this system is that iPhoto automatically resizes the images to be more Web-friendly and creates a page of thumbnails.

6. If all the images won’t fit, select a subset of images by clicking the different listings in the Source column (see Figure 44-8).

7. After you decide on the files you want to archive, click the Burn button.

8. After the CD has been made, delete the photos from your library.

9. Insert the CD at any point in time to review the stored images.

**Figure 44-7:** If you see a Disc Full message, you can’t burn all the images onto one disc.

**Figure 44-8:** With a blank disc in your drive, iPhoto will show how much room will be taken up on it.
• Figure 44-9: Quickly customize how you want your Web site to look.

You can publish only up to 48 images at once by using these steps. If you have more images than that in a photo album, break them up into multiple albums.

5. When iPhoto is finished, it gives you the URL for your new site (see Figure 44-10).

You can also use the .Mac Slides Publisher tool to turn your online pictures into a screen saver for other Mac OS X users.

If you don’t have a .Mac account, you still have options. Both of these tools generate the Web pages for you, but you need to have your own Web site in order to make them public (or be able to host Web sites on your computer, see Technique 40). After one of these applications creates the pages, just upload them to their final destination. (Your ISP — which will most likely provide a limited amount of free Web space — or Web hosting company will provide you with the requisite details.)

✔ Use Image Capture. The Image Capture application can also build Web pages for you. After you connect a camera, open Image Capture. Then choose Build Web Page from the drop-down list. The Web pages themselves will be created and stored in your ~/Pictures folder.

✔ Use My Photo Album (www.x-industries.com/mpa) or JAlbum (http://jalbum.net). These free applications can both create the HTML pages necessary for you to put your albums online.

✔ Use a commercial tool such as SnapMania (www.snapmania.com). There are many commercial online photo galleries available. SnapMania comes to mind because Marc has helped create it, but you can easily find others by searching Google.
Whether you want to show some cool on-screen feature to a friend, you need to do some debugging work with tech support, or you’re writing a book, being able to quickly and easily take shots of your screen is a valuable trick to know. You can always whip out your camera, take a picture of the screen, have the film developed, and scan in the photograph, but we think that you’ll prefer the techniques that we outline here.

We start by going over the built-in system tools that Tiger has to offer: Screen Capture and Grab. After that, we give special attention to Snapz Pro X, the granddaddy of screenshot applications. Even if you don’t think you have a need to capture what’s happening on your Mac, many Mac users eventually do and reading just the first couple of pages certainly comes in handy.

**Taking Screenshots with Screen Capture**

Screen Capture is part of the operating system, which means that it is available in every application that works with OS X. Screen Capture is triggered by several keyboard shortcuts:

- To capture the entire screen, press Ô-Shift-3.
- To capture part of a screen, press Ô-Shift-4.

The cursor then turns into a crosshairs icon. Click and drag over an area (see Figure 45-1) to select it. When you release the mouse button, the image is taken, and you hear a snapshot sound.

Don’t be confused by the Image Capture program found in the Applications directory. Despite its name, this application doesn’t capture screenshot images. Its actual role is to import images from a digital camera. You can also use it to network and share a digital camera or scanner.
Taking Screenshots with Screen Capture

Figure 45-1: The Screen Capture tool highlights in gray the area to be captured.

The keyboard shortcuts for image capturing are listed under Keyboard Shortcuts of the Keyboard & Mouse System Preferences panel.

You can capture just a window or an object by using the last method in the preceding list. Alternatively, follow these steps to get a more precise screenshot:

   Again, the cursor turns into the crosshairs icon.

2. Press the spacebar.
   The cursor turns into a camera icon.

3. Move the camera cursor over the window or object that you want to capture.
   When you move the cursor over an object, it becomes highlighted.

4. After you highlight the window that you want, click the mouse anywhere on the window or object to take the screenshot.

You can take screenshots of items in the background as long as you can see a piece of them. For example, if you’re in Microsoft Word and can see a corner of a Finder window, you can get a screenshot of the whole Finder window by highlighting and taking a shot of just the visible portion.

Here are a few facts that you should know when using this method:

- Screen Capture saves the screenshots as PNGs. No other format options are available. That being said, you can use the Preview application’s Save As feature (under File) to covert a PNG to a JPG, TIFF, PDF, and more.

- The screenshots are automatically saved to your Desktop with such useful names as Picture 1 and Picture 2.

- You can’t capture the cursor.

- Unlike digital cameras, which normally allow you to adjust the size of the picture taken in pixels, you can’t change the resolution of shots in Screen Capture. You can adjust the size of your screenshots only by adjusting the resolution of your monitor.

- With the Ô-Shift-4 shortcut, you can toggle back and forth between a section of the screen and a window by continuing to press the spacebar.

- With the Ô-Shift-4 shortcut, press Escape to cancel the operation.

- If you hold down the Control key while triggering the screenshot utility (using either Ô-Shift-3 or Ô-Shift-4), the image is sent to the Clipboard and isn’t saved as a file.

Hold down the Control key to send the captured image to the Clipboard. Then you can paste this image into an e-mail, a document, or an iChat session.

If you want to place an image within the document you’re working on rather than create an image as a file on your computer, here’s how:

1. In your document, place the cursor where you want the image to go.

2. Toggle over to the application where you want to take the screenshot.

3. Capture the image while holding down the Control key.
   Holding down the Control key copies the image to the Clipboard. You can use Ô-Control-Shift-3 to capture the entire screen or Ô-Control-Shift-4 to capture a section of the screen or an entire window.

4. Toggle back to your document.
5. Press `V to paste the captured image from the Clipboard into your document.

If you live within the Terminal, you can even take screen captures while in that application. To find out how, type `screen capture` within a Terminal window. By using different flags, you can: capture the entire screen or just a window or selection; capture the cursor or not; choose the file name of the image; copy the capture to the clipboard; and more. It’s crazy, just crazy.

**Taking Screenshots with Grab**

The other Tiger option for taking screen shots is Grab. Grab is located, appropriately enough, in the Utilities folder. It has certain benefits over the built-in Screen Capture tool. With it, you can

- Capture the cursor.
- Decide what cursor to view.

If you want a cursor in your screen shots, select the cursor type from Grab’s Preferences panel (see Figure 45-2).

- Figure 45-2: Use the Preferences panel to tell Grab what cursor to capture, if any.

**Capture images in TIFF format.** Whereas Screen Capture takes only PDFs, Grab takes only TIFs. You can use Preview to export an image in a different format.

- Use a more intuitive menu system rather than keyboard shortcuts.

Grab comes with its own keyboard shortcuts, which are also duplicated in the Capture menu (see Figure 45-3). These are

- `V-Shift-A`: Captures a selection of the screen.
- `V-Shift-W`: Captures a window.
- `V-Z`: Captures the whole screen.
- `V-Shift-Z`: Brings up Timed Screen (see Figure 45-4).

& Figure 45-3: Use the Capture menu in lieu of or to remind you of the keyboard shortcuts.

Timed Screen captures let you take images while you’re in the process of doing something. This is the easiest way to capture complex actions, like dragging a document onto an application’s icon.

- Figure 45-4: Grab can take delayed snapshots.
After Grab has done its magic, it loads the image as a new document. This can then be saved as a file anywhere on your computer by pressing Ô-S or selecting Save from Grab’s File menu.

In the earlier “Taking Screenshots with Screen Capture” section of this technique, we discuss how to capture images and paste them into a document. If you’re using an application that supports Services (such as TextEdit or Mail), you can accomplish the same thing by using the Grab tool as a Service. Follow these steps:

1. In your document, place the cursor where you want the image to go.

2. Decide what Service to use:
   - If you want to capture the whole screen (not necessarily the current one), use the Screen Service.
   - If you want to capture a part of any screen (not necessarily the current one), use Selection.
   - If you want to capture the entire screen but need a few seconds to get yourself organized, use Timed Screen.

3. From the application menu, choose the appropriate Service from Services ➪ Grab (see Figure 45-5).

   The Screen Grab prompt appears.

4. To capture the entire screen, toggle to whichever view you want to capture and then click anywhere outside the prompt (see Figure 45-6).

   To capture a part of the screen, toggle to whichever screen you want to use and then click and drag over the area that you want captured (see Figure 45-7).

   You can also click a window once to have it automatically captured.

   If you chose Timed Screen, you have ten seconds to set up the screen as you want it.

5. Toggle back to your document.

   You see the image already inserted into it.
Using Snapz Pro X

Snapz Pro X from Ambrosia Software (www.ambrosiasw.com, $29) has long been the preferred screenshot utility for Mac writers and developers. In part, this is because there were no good alternatives (like Grab) prior to OS X. If you need to do any serious amount of image capturing, Snapz Pro X is definitely the way to go. Here’s what it can do for you:

- Take images in many formats (JPG, GIF, PNG, TIFF, BMP, PICT, PDF, and Photoshop)
- Resize images
- Perform color conversions (say from color to black and white)
- Create borders for your images
- Capture or create video (if you purchase the $69 version)

If you haven’t used Snapz Pro X before, here is all you need to do to take a quick screen capture:

1. **Open the application by double-clicking its icon (assuming you’ve installed it).**

   Snapz Pro X loads and then runs in the background, hidden from you until you press the proper keyboard shortcut. Alternatively you can have Snapz Pro X automatically load when you log in. Simply add it to your Login Items list (see Technique 2).

2. **Press Ô-Shift-3 to bring up the Snapz Pro X interface.**

   This is the default keyboard shortcut — overriding Screen Capture — and it can be changed using Snapz Pro X’s Preference.

3. **Click one of the buttons across the top to choose your capture type.**

   Your options are
   - Screen (the whole screen)
   - Objects (documents, windows, and such)

   - Selection (a selected area of the screen)
   - Movie (video)

4. **If you select Objects in Step 3, click the object that you want to capture.**

5. **If you select Selection in Step 3, click and drag to select an area to capture.**

   If you have Snapz Pro X set to let you choose a filename (under Capture Options in the main panel), you’re prompted for the file’s name.

6. **Just type in the desired name and press Return.**

   You hear Snapz Pro X making some shutterbug sounds and the newly taken picture is saved in the target directory (the Desktop or your Pictures folder).

   If you change your mind about taking a screen capture, press Escape to exit Snapz Pro X (or press Escape twice if you’re already at the filename prompt).

If you’re already using Snapz Pro X, you can use plenty of timesaving techniques:

- In the Snapz Pro X Extras folder are three AppleScripts that can automate the utility.
- You can automatically resize your images as you take them. To do so, use the scale menu found in the Object Settings prompt (see Figure 45-8).
- After invoking Snapz Pro X by pressing the keyboard shortcut, set the default filename for the image from the Preferences tab and disable Choose File Name on the main tab.

• **Figure 45-8: Resize your images with Snapz Pro X.**
If you need to make a series of numbered images like `Steps 001.tiff`, `Steps 002.tiff`, and so on, let Snapz Pro X do the work for you. Set the Prefix for the filenames under the File Naming Settings section of the Preferences tab (for example, Steps). Each screen capture is named starting with that prefix and numbered sequentially.

- Use the File Creator drop-down list to associate the taken image with a particular application.
- Have Snapz Pro X automatically change the coloring of the image (see Figure 45-9).
- Hold down the Control key to zoom in where the cursor is currently pointing (when using the Objects or Selection options).

**Figure 45-9:** Use the Color Change menu to take, for example, black and white images.

- Change the modifier keys to have Snapz Pro X launch by using a different key combination than the default.
- When capturing objects, use the Shift key to add or subtract objects to the selection.
iCal is Apple’s nice little scheduling application that, along with the Address Book, pretty much means that you never need to buy any Personal Information Management (PIM) software again. Not only does iCal have all the features that you would ever use, but it also uses a standard format that makes it compatible with alternative software. This is a great asset if you share calendars with other users who might (or might not) also be using a Mac.

In this technique, you find out the fundamental keyboard shortcuts and some best-usage techniques. Then you see how to easily subscribe to someone else’s calendar and publish your own calendars online. After that, pick up some cool tips and tricks for using iCal. But first, we make sure that you know how to create and use a basic Calendar.

**Creating Calendars and Events**

Everything in iCal relies upon one basic thing: a Calendar, which is more than just a collection of hours, days, weeks, and months. A Calendar is a collection of data — starting with hours and days, plus events (scheduled occurrences) and To-Do list items — grouped into subjects.

iCal comes with two Calendars from the start:

- Home (meant to record your personal happenings)
- Work (Meant to record work happenings)

You can add other Calendars by either

- Subscribing to special calendars (see “Subscribing and Publishing”), like U.S. holidays, the schedule of Chicago Bulls games, and listings of movie releases
- Adding your own Calendars
Here are the benefits of this multi-calendar structure:

- Search and browse Calendars by subject (such as work, home, or school).
- Share specific Calendars with others. (Share a work Calendar but not your personal one.)
- Color-code your life to make managing your schedule easier.

You can create specific events and whole Calendars.

**Creating events**

An event is just a scheduled thing, like a meeting or a birthday or a trip. It’s something you put on your calendar for a specific day and/or time. Follow these steps to create a new event:

1. **Select a Calendar by clicking its name in the Calendars window.**

   Choose which Calendar the event goes in before it can be added. If an appropriate Calendar doesn’t yet exist, use the steps later in this technique to add one.

2. **Double-click the event’s day (or the day it starts) to add the event.**

   The easiest way to add an event is to double-click the day of the event.

   Be sure to click *underneath* the day’s number if you want to add a new event. Clicking the number itself displays the day’s events without adding a new event.

3. **Click the *i* in the lower-right corner of the iCal window to bring up the Info panel (if it isn’t already visible).**

4. **Enter the event’s information by clicking the fields in the Info panel and typing the proper values (see Figure 46-1).**

   Adding and editing events from the Info panel is very easy. Just click a field (like the event name or date), type in the new values, and press Return. Select the All-Day check box to schedule the event for the entire day or for several days.

**Creating Calendars**

To create a Calendar, just do this:

1. **Choose File ➪ New Calendar.**

   A new Calendar appears in the Calendars list in the upper-left column of the iCal window (see Figure 46-2).

2. **Type the new Calendar’s name.**

   After you create a new Calendar, it’s named Untitled by default but is already highlighted. Just begin typing to rename the Calendar.

3. **Press Return to finish the renaming.**

   To hide any Calendar, clear the check box next to its name.
iCal’s Main Keyboard Shortcuts

iCal, like most applications, has oodles of keyboard shortcuts available. Rather than provide an un-learnable list of them all, here are the most useful for performing common tasks:

- Command-T: Moves to today.
- Command-Shift-T: Gives you the Go to Date prompt (as shown in Figure 46-4).

![Go to Date prompt](image)

- Figure 46-4: Use this prompt to jump to another date.

- Command-N: Creates a new event (Calendar entry).
- Command-K: Creates a new To-Do item.
- Command-1: Switches to the Day view.
- Command-2: Switches to the Week view.
- Command-3: Switches to the Month view.
- Command-R: Refreshes the selected Calendar.
- Command-Shift-R: Refreshes every Calendar.
- Command-→: Moves you to the next unit (day, week, or month).
- Command←: Moves you back a unit (day, week, or month).
- Command-I: Hides and shows the Information panel (see Figure 46-5).
- Command-Option-T: Hides and shows your To-Do list.
- Tab: Cycles you through the events.

The check box next to a Calendar’s name indicates whether that Calendar (and its events and To-Do items) is visible. By toggling these check boxes, you can more easily see only the information you want.

4. To change a Calendar’s properties, click the i in the lower-right corner of the iCal window to bring up the Info panel (see Figure 46-3).

Within the Info panel, you can
- Rename a Calendar (click its name).
- Change its color (click the arrows next to the color).
- Add a description.
Using iCal is easy, but using it well is a whole different matter. Here are our suggestions for getting the most out of this application.

- Keep many different organized calendars. Get in the habit of creating new Calendars for special projects, particular events, or when the Calendar is shared with others.

- Color-coding your calendars and turning them on and off is so easy that using several different calendars is a snap. Do yourself a favor and keep your information organized by using multiple calendars.

- Use your .Mac account to back up and synchronize your Calendars across multiple computers (see Technique 42).

- Use iSync to synchronize your Calendars with an iPod or a PDA.

- Discover what contextual menus can do for you (see Figure 46-6 and Figure 46-7). As with any application, most of the common tools are easily accessible by using a contextual menu. Just Control-click an item — like a To-Do list task in Figure 46-6 or a Calendar in the Calendars window in Figure 46-7 — to see what shortcuts are available.
Technique 46: Staying on Schedule with iCal

You have a Search box at the bottom of the iCal window! This is the fastest way to find specific events and To-Do list items. Use the drop-down list (click the magnifying glass) to help limit your search.

✔ Have iCal show people’s birthdays. A great feature added to iCal is the ability to tap into your Address Book’s birthday information (this is yet another reason to fully utilize the Address Book). If you add people’s birthdays to their Address Book records, those dates can appear in iCal. Here’s what you want to do:

1. Open the iCal Preferences.
2. Under the General tab, select the check box next to Show Birthdays calendar (Figure 46-8).
3. Close the Preferences tab.
4. Use the newly added Birthdays calendar to remind yourself of special occasions.

✔ Double-click your way to a shortcut.

Double-clicking creates a new Calendar, a new event, or a new To-Do item, depending upon what blank area you double-click. For example, double-clicking in the Calendars window creates a new Calendar; double-clicking a date creates a new event; double-clicking in the To-Do list creates a new task.

Subscribing and Publishing

The primary role of iCal is to handle your own scheduling, but you can also subscribe to other people’s calendars and publish your own so that others can see it.

Where to find subscriptions

You can subscribe to different calendars for all kinds of reasons. Maybe you want a calendar that lists all the San Antonio Spurs games or all the major Hollywood movie premieres. You can find such calendars and many others like them through these sources:

✔ Apple: www.apple.com/ical/library
✔ dotmac.info: www.dotmac.info/index.html/category/6

When you find a calendar that you want to subscribe to, just click the Subscribe link provided on the Web site. This brings up iCal, and you’re prompted to subscribe to that calendar. Then iCal gives you subscription options (see Figure 46-9).

• Figure 46-9: Subscription options for online calendars.

The calendars to which you subscribe don’t have to be corporate and impersonal. For example, you can
subscribe to a friend’s calendar to see where and when her band will play. After someone publishes a calendar to .Mac or another service, she can provide you with a URL. To subscribe to it, choose Calendar | Subscribe and enter that URL in the prompt that appears.

The subscription options prompt has three options:

- **Refresh**
  The refresh tells iCal to automatically compare your subscribed version of the calendar every so often (15 minutes, every hour, every day, or every week), updating your copy as necessary. You can also manually update a subscribed calendar by choosing Refresh from the Calendar menu.

- **Remove Alarms**

- **Remove To-Do Items**

We recommend that you select the Remove Alarms and Remove To-Do Items check boxes because that information, if present, won’t be worth much to you.

### Publishing your Calendar with .Mac

To share one of your Calendars (so that others might subscribe to it), you must first publish it online. For example, you could create a Calendar of your travel schedule or your children’s soccer games and then share this with family members via the Internet. Whenever you make changes to your Calendar, those who have subscribed to it can also retrieve these changes.

To publish a Calendar by using your .Mac account, follow these simple steps:

1. **In the left column of iCal, select the Calendar that you want to share.**
2. **Choose Calendar | Publish.**
3. **In the Publish Calendar As text box of the dialog that appears (as shown in Figure 46-10), give the calendar a title.**

Your Calendar’s title must abide by standard URL rules. This means that non-alphanumeric characters such as punctuation and spaces are replaced by representations. For example, the title *Writing Schedule* becomes *Writing%20Schedule*, which isn’t the desired result. Instead, use *Writing_Schedule*, which is acceptable.

4. **Decide whether to update the Calendar automatically.**
   This option is important for keeping subscribers abreast of your most current Calendar.

5. **Decide what extra parts of the Calendar you want to share:**
   - Titles and notes
   - Alarms
   - To-Do items

6. **Make sure that .Mac is selected in the Publish On drop-down list.**

7. **Click the Publish button.**
   When iCal is done, you see a message indicating two URLs for the Calendar (see Figure 46-11). The first is for those who use iCal; those who don’t can use the second URL to view your Calendar in any Web browser.

8. **Give the URLs to family, friends, and co-workers.**
   You can click the Send Mail button to start spreading the news.
Technique 46: Staying on Schedule with iCal

What a brilliantly simple way to schedule meetings or family gatherings!

1. Create an event in iCal.
2. Make sure that the Information panel is visible.
3. Press ⌘-Option-A to open the People window (see Figure 46-12).

4. Drag names from the People window onto the event in the Information panel.
   The event displays the list of attendees as you add them.
5. Click Attendees and then choose Send Invitations from the pop-up menu that appears (see Figure 46-13).
   iCal opens your Mail application and sends the message.
   All the participants then receive an e-mail inviting them to the event (see Figure 46-14). When a recipient clicks the embedded link, she is given the option of accepting the event and the option of e-mailing you her response.
AppleScript

iCal is, naturally, AppleScript-able. If you’re savvy with AppleScript, you can write your own. If you’d rather ride on the coattails of others (which is fine), check out some of the 250 AppleScripts that Doug Adams provides at his Web site. (Go to www.malcolmadams.com/itunes/index.shtml, and then look for iCal in the left column.) A couple of AppleScripts are particularly useful for iCal users:

- **iCal Calling iChat:** This script automatically changes your iChat status message (normally Away or Available) so that it reflects your Calendar’s schedule. For example, if you have a meeting with Marc from 1 until 3, this script changes your iChat status during that time to read *Meeting with Marc.*

- **iCal Calling iTunes:** This script uses iCal to schedule iTunes playlists. You can have iCal start and stop playing different lists that you create in iTunes. For example, you can have iCal automatically start a playlist or radio station when you log on in the morning and then stop iTunes when you go to lunch.
In this technique, we cover every possible timesaving technique in existence (well, maybe we missed one or two) related to CDs and DVDs. If you have a CD-write (CD-R), CD-rewrite (CD-RW), DVD-write (DVD-R), or DVD-rewrite (DVD-RW) drive in or attached to your Mac, use the good tips here for burning discs. If you don’t have a write drive of any sort, at least go through the first section to tell Tiger how to handle your discs.

**Setting Your System Preferences**

Setting System Preferences to automatically handle discs is an important configuration step to take. Adjusting these settings once saves you a lifetime of making decisions later.

1. In the Finder, open the Finder preferences panel.
2. Click the Sidebar icon (see Figure 47-1).

![Figure 47-1: Use the Sidebar panel to tweak the Finder window Sidebar settings.](image)
3. Select the Removable Media check box.

This setting makes your discs appear in the Sidebar of Finder windows when they’re mounted (as shown in Figure 47-2). It applies to disk images as well as CDs and DVDs.

4. Click the General icon.

5. Select the CDs, DVDs, and iPods check boxes (see Figure 47-3).

This setting guarantees that mounted discs also appear on the Desktop.

6. Open System Preferences and click the CDs & DVDs icon (under Hardware).

7. Use the drop-down lists to tell Tiger what to do when different types of discs are inserted (see the choices in Figure 47-4).

For most users, the default settings are just fine. How and what you change depends upon how you use your computer:

- If you always burn CDs from iTunes and never from another application (like the Finder, Backup, or Disk Utility), you can set blank CDs to trigger iTunes.

The same applies to blank DVDs: Open iDVD when they’re inserted.

- If you don’t use the default Apple application for a particular disc type (for example, you don’t use iPhoto or DVD Player), choose your preferred application in the CDs & DVDs System Preferences panel.

Use the CDs & DVDs System Preferences panel to indicate the default action for different media. You can then overrule this action as needed (for example, if you want to make a CD by using the Finder and not iTunes, or open a picture CD in iView Media instead of iPhoto). When those times come, let Tiger open the default application and then switch over to (or open) the application you’d rather use.
Technique 47: Working with CDs and DVDs

To burn CDs or DVDs with the old, standard way, you need as much free space on your hard drive as you’re burning. Thus, to make a CD, you must have around 700MB of free space in which to store the burned files. For burning DVDs, this means you must have a whopping 4GB or more of space available!

Always burn the latest version of a file, no matter when it was added to the burn folder.

Are faster to set up.

You don’t need to wait for files to be copied (which you do with the old method).

Burn folders aren’t much harder to make than ordinary folders or standard burnable discs:

1. In the Finder, open a new Finder window.
2. Navigate to a logical location for your burn folder.

Likely candidates would be the Desktop or your Home folder.

3. Choose File ➪ New Burn Folder.
4. Give the new burn folder an appropriate name.

The folder appears with a special icon: a folder with a burn circle on it. The default folder name — cleverly, Burn Folder.fpbf — is highlighted (see Figure 47-5) so that typing creates the new name.

5. Add items to this burn folder by dragging them onto either burn folder icon.

Using the New Burn Folders Feature

A less-promoted but great new feature in Tiger is the ability to create burn folders. The premise behind the burn folder is that aliases to the files are stored in a special folder. Then, when it’s time to actually burn the disc, the original files (whose aliases are stored in the folder) are retrieved and written to the disc. Burn folders have several benefits over the old way of making CDs (which we cover in the next section). They . . .

Require less hard drive space.

Scripting CDs

If you want to get really fancy, you can set Tiger to run specific AppleScripts when different types of discs are inserted. All you need to do is select Run Script from the appropriate drop-down list in the CDs & DVDs preferences panel and then select the script on your hard drive by using the prompt that appears.

Sample ideas might include

- Opening Backup when a blank CD is inserted and automatically running a particular type of backup
- An AppleScript that runs a command line utility and writes the event log to your CD instead of the hard drive

You can create the scripts yourself or download them from any of the common AppleScript resources online. The best AppleScript sites include

- Mac Scripter: www.macscripter.net
- Apple: www.apple.com/applescript
- Script Web: www.scriptweb.com

This feature can be extended for external drives (like a FireWire drive you occasionally use) thanks to Do Something When (www.azarhi.com/projects/DSW/index.php, free).

With its configuration tool, you can have a game automatically launch when its CD is inserted or open iTunes when the hard drive with your music on it is mounted.
Burning CDs

If you have a CD-R drive built into your Mac or attached externally, you can easily rip audio, video, or data CDs at your leisure. Considering the cheap cost of blank CD media, this is a nearly ideal medium for you to use. Making CDs in Tiger isn’t rocket science, but we go through a few tips and tricks that you can use in the different applications. Specifically, we target the Finder, iTunes, and iPhoto.

Burning CDs

Tiger never copies or moves a file to a burn folder. Instead, an alias of the object is placed within the burn folder. When you burn the folder to disc, Tiger follows the folder’s aliases back to their original items and burns the originals to disc. Therefore, the most current versions of the items are burned. So even if you change a file after it was added to a burn folder, those changes are reflected in the burned disc.

6. When you’re ready to burn this folder to disc, either
   - Click the burn icon (it looks like a little hazard symbol) next to the folder’s name in any Finder window.
   - Select the burn folder in a Finder window and select File ➪ Burn Disc.

7. Insert a blank CD or DVD at the prompt (see Figure 47-6).

   As soon as it recognizes the blank media, Tiger will burn all of the original files onto the disc.

   *Figure 47-6: Tiger prompts you to insert a blank disc.*

   When you no longer need the burn folder, delete it by dragging it to the Trash. (Your files are safe because the folder contains only aliases.)

   *Figure 47-7: The Finder prompt when blank media is inserted.*

   • Set the preferences to show discs in the Finder window Sidebar (see earlier in this chapter; refer to Figure 47-1).

   2. Insert a blank disc.

   Tiger’s built-in disc-burning applications are sufficient for most users. If you want something a little nicer and more customizable, Toast from Roxio (www.roxio.com, $100) is the reigning king.

Making CDs in the Finder

Unless you’ve told Tiger to do otherwise (by setting in the CDs & DVDs panel), the Finder asks you what to do when a blank disc is inserted (see Figure 47-7). At this point, you can choose a specific application to open and give the disc a name. After you do this, the disc is mounted on the Desktop. A faster way to create discs in the Finder is to do this:
Technique 47: Working with CDs and DVDs

3. Give the disc a name at the prompt.
4. Open a Finder window.

   The blank disc should appear in the Sidebar of the Finder window (see Figure 47-8).

5. Use the content area of the window to find the files that you want to write to the disc.
6. Drag your files onto the blank disc icon in the Sidebar.
7. Click the Burn icon (looks like a fallout shelter sign) in the Sidebar window to create the disc.

   Mount disc images in the Finder Sidebar to create discs using only a single window.

Making an audio CD in iTunes

The crucial considerations for making CDs in iTunes are tweaked in the iTunes Burning preferences panel (as shown in Figure 47-9). Use the radio buttons to dictate your CD’s format:

- Audio: For an audio CD, select the Use Sound Check box to give the CD a more consistent volume level. Set the Gap Between Songs to 2 Seconds. If you like smoother transitions, under the Audio pane, set Crossfade Playback to 2 Seconds for a more professional feel.

- MP3: The MP3 format retains information about a file. For example, it associates such metadata (information that describes a thing) as the artist name, song, and album with the file. This information is lost when you make a standard audio CD. MP3 CDs also hold about ten times as many songs as standard audio CDs.

   To make an MP3 CD, which many new compact disc players can play, the songs must be in MP3 format. If you use the AAC encoder — the Apple standard — when you import music, these might not be playable on many other devices.

- Data: A data disc is just that... and probably something you don’t want to be doing with iTunes. If you want to create data discs, just use the Finder like you would with any other CD.
Making picture CDs in iPhoto

To burn a CD in iPhoto, all you need to do is select a photo album in the left column and then choose Share ➪ Burn Disc. Just follow the prompts and you’ll be done in no time! Making CDs in iPhoto retains all your album information along with the images. If you use these CDs on your Mac or share them with other Mac users, this is perfect. If what you want instead is just a disc of images, use the Finder, Toast, or Disk Utility to burn a data disc.

When an iPhoto CD is loaded onto another Mac, it can be displayed in iPhoto, retaining all the information from the original user. The new user can do anything with the images he wants except for editing them (unless the images are imported first). You can eject a CD in iPhoto by dragging the disc icon onto the iPhoto Trash icon, just as you would in the Finder.

Also see Technique 44 on using iPhoto to manage your digital library.
If you own an iPod, we don’t have to tell you how great it is for listening to music while you’re out and about. What you might not know is that your iPod can do a lot more than play music. In this technique, we tell you about some of those other useful, timesaving capabilities.

First, we look at some of the things that you can do with the tools included in Tiger, allowing you to store other data on your iPod. Next, we show you useful tricks with third-party programs and shareware tools. Many of these use the features of the iPod in new and creative ways.

All of these uses do, of course, require free space on your iPod (anywhere from a few kilobytes to a gigabyte or more, depending on what you’re trying to do), so if you have it filled to capacity with music already, you have to make some room first. If you run into this problem, check out the final section to see how to clean out some space.

Using the iPod for Data Storage and Transfer

The iPod is a very good place to store important files. By doing so, you create backups and you gain the ability to take your stuff with you when you travel. Because the iPod connects to the Mac via a FireWire connection, you can transfer even very large files efficiently.

Here are some things you can do with the iPod:

- Transfer media files between computers (like large video files from a DV camera).
- Retain disk image (.dmg) files of big software installers for installation of the same software on several identical machines (useful if you work in a computer lab).
- Keep sensitive information on the iPod instead of the computer’s hard drive so you can always take it with you (see “Secure, Encrypted Storage on the iPod”).
Store backups of the most important data. (See “Backing Up Your Data to an iPod,” later in this technique.)

Use your iPod to help diagnose and repair broken OS X installations (see “Emergency Rescue iPod”).

The organization of your data on the iPod is really simple:

- Use iTunes to manage your music on the iPod.
- Use the Finder to store non-music files and folders that you want to carry around or just store there. (The iPod, when mounted, appears like any other volume on the Desktop or Finder window. The volumes icon differs, though, looking like a miniature iPod. If the volume doesn’t appear, select the Enable Disk Use check box in the iPod preferences in iTunes.)

The place on the iPod where the music is stored is hidden from the Finder. Similarly, your non-music files aren’t visible in iTunes. Therefore, the iPod provides a perfect and clean separation between the two kinds of data.

Because the music directories are hidden in the Finder, you usually can’t mess up anything. However, if you’re using the Terminal or disk- or file-management utilities, you can see these hidden music directories. If you erase or otherwise modify your music files outside of iTunes, you corrupt the iPod’s music database and have to re-download all of the music from iTunes.

Assuming you’ve been using your iPod on a Mac until now, you need to do these three things in order to share your iPod between Windows and Mac OS X:

1. Buy a second iPod cable to connect the iPod to the Windows PC, one that goes from the dock connector to a USB port (instead of the dock-to-FireWire cable used on a Mac).
2. Make sure you have backups of everything currently on your iPod because it’s all about to go (temporarily) bye-bye.
3. Reformatter your iPod to allow a Windows computer to access data stored on an iPod. You can reformat your iPod by using Apple’s iPod Updater program for Windows (www.apple.com/ipod/download). You want to format the iPod in the FAT file system, which is a format understood by Windows.

Reformatting the iPod is necessary for Windows compatibility because a Mac iPod is formatted with the HFS+ file system. Even with the correct USB connector cable, a Windows PC can’t recognize an iPod formatted this way. Note that all your data on the iPod is lost during the reformatting process.

After you format the iPod by using FAT, your Mac won’t have any problems using it because Mac OS X knows how to read and write FAT-formatted hard drives. The only quirk is that the iPod’s icon in the Finder might revert to a plain hard drive icon, but you can easily fix that by using a tool such as Finder Icon CM, which we present in Technique 17.

Secure, Encrypted Storage on the iPod

If you have sensitive data that you want to keep in a really safe place, this is for you! Create an encrypted virtual volume in the form of a disk image on the iPod. A disk image is a virtual hard drive whose entire contents are stored in an ordinary file, the disk image file. Double-clicking the disk image file mounts the hard drive on the Desktop so that you can use it.

Sharing your iPod between Mac OS X and Windows

If you need to move files (especially large ones) between your Mac and a computer running Windows, you can use your iPod (with a dock connector) to do just that. The iPod is perfect for moving office documents between your Windows PC at work and your Mac at home, for example.
Using an encrypted disk image is secure for two reasons:

✓ The data doesn’t stay on your computer’s hard drive. When you’re done working with your data, you simply disconnect the iPod, and nobody can get physical access to your sensitive information.

✓ The data is encrypted and password-protected by using the state-of-the-art, 128-bit Advanced Encryption Standard (AES) encryption built into Apple’s disk images.

Mac OS X already includes everything that you need to create a disk image:

1. Make sure that your iPod is connected to your Mac.

2. Open Disk Utility.
   Disk Utility is stored in the Utilities folder, naturally.

3. In the Disk Utility main window, choose New Image from the toolbar.

4. In the resulting prompt, enter a name for your encrypted disk image in the Save As box, as shown in Figure 48-1.

5. Still in the Save As dialog, choose your iPod from the Where drop-down list or from the list of volumes in the left column (if the more expanded prompt is shown).

6. Pick a reasonable size for your disk image from the Size drop-down list — the smaller the better — and enable AES encryption by choosing it from the Encryption drop-down list.

7. Make sure that the Format drop-down list box is set to Read/Write Disk Image.

8. Click Create.

9. At the prompt that appears, enter a new password.
   Pick a password that’s hard to guess.

   If you lose this password, you lose all your data on the encrypted volume. You can’t recover a lost password! Because your encrypted data is most likely very important to you, you absolutely must not lose this password. Also, remember to make regular backups of this disk image.

   As always, storing the password in the keychain is a big timesaver, so you should enable the Keychain check box. However, if you’re really paranoid about the data on this disk image, clear the Keychain check box in this case and just type in the password every time. See Technique 53 for information on passwords and the Keychain Access application.

10. Disk Utility automatically mounts the new volume, and you can immediately begin storing files there.

11. When you’re finished transferring files, eject the virtual volume by dragging it to the Trash on the Dock.

From now on, you have to double-click the disk image file on the iPod volume every time you want to work with the data. The disk mounts, and you can use it like any other removable medium to store files and folders there (see Figure 48-2).
Backing Up Your Data to an iPod

You can back up your data to an iPod in several ways, including simply dragging files and folders to the iPod in the Finder. We also show you two backup programs in this section.

Regardless of the method that you use, keep in mind that the iPod differs from the typical backup medium in a few ways:

- The iPod’s hard drive is geared toward light use during music playback. Don’t perform full backups to it every day. Writing and reading massive amounts of data very often could shorten the iPod’s life span.

- The iPod’s capacity is probably a lot smaller than your computer’s hard drive. Be selective and back up only important files, like your documents. Leave out things like applications or drivers, which you can always reinstall from installation CDs.

Using .Mac and Backup

If you’re a .Mac member (currently $99 per year; see Technique 42 for more information), you can use Apple’s Backup utility. Starting with version 2.0, it can back up to an external FireWire drive, which is exactly what an iPod is.

If you haven’t installed Backup on your computer, install it now. You can download the software after you log in to the .Mac member Web site at www.mac.com.

For more detailed instructions on using Backup (without an iPod), see Technique 49.

To set up Backup for the first time, do the following:

1. Launch Backup by double-clicking the Backup icon in the Finder (presumably in the Applications or Utilities folder), which looks like a small umbrella.

2. Choose Back Up to Drive from the drop-down list in the upper-left corner of the Backup window.

3. Decide what to back up by selecting the check box for each item that you want to back up.

Backup shows you a list of items in your Home directory (see Figure 48-3). For a full backup, choose everything. However, we suggest leaving out as much as you can. For example, you don’t need to back up the iTunes collection because it takes a lot of space (and thus backup time) and because you can always reimport the music from CDs. Furthermore, you probably already have a backup of your music collection on the iPod, anyway!

4. Use the + button to add other items to the list, especially items that aren’t stored in your Home directory.

5. Click the Set button to choose the backup location.

6. Click the Create button in the dialog that pops up.
Figure 48-4: Creating the Backup set.

Using Carbon Copy Cloner

Apple’s Backup utility is tied to a .Mac membership, even if you back up only to local drives and not to the .Mac servers. However, if you don’t have a .Mac account, you can choose from plenty of other tools to perform backups. An inexpensive and reliable one that we like is Carbon Copy Cloner by Bombich Software (www.bombich.com/software/ccc.html; free but donation requested).

Do this to back up your computer:

1. Launch Carbon Copy Cloner (see Figure 48-5).
2. In the main window, pick a source disk from the drop-down list.
3. Remove any unwanted items from the Items to Be Copied list.
   To remove an item, select it from the Items to Be Copied list and click the Delete button (the red circle with the slash through it).
4. From the Target Disk drop-down list, select your iPod.

7. In the Save dialog that appears, select your iPod in the list of available volumes on the left.

8. In the Save As text box, enter a descriptive name for this backup.
   Marc used Laptop-backup in the example (see Figure 48-4).

9. Click Create to make the new backup location and return to the main Backup window.

10. Perform the backup by clicking the Backup Now button.

You can set up automated, scheduled backups by using the Schedule button at the bottom of the window (the one that looks like a calendar). You have to make sure that your Mac is turned on, your iPod is connected to your Mac, and you’re logged in at the scheduled time. You could, for example, leave your machine running through the night and have it start the backup at a fixed time. This way, your computer does the hard work while you’re sleeping.
5. Click the Preferences button to edit your preferences.

Carbon Copy Cloner can create two kinds of backups: identical, bootable copies; and disk images. In the preferences dialog that appears (see Figure 48-6), select the Create a Disk Image on Target check box unless you really plan to boot from the iPod later on. Booting from the iPod can be handy in case of a problem with your computer’s main startup disk. Click Save to close the preferences dialog.

6. Click the little lock symbol and enter your password in the dialog that appears.

7. Click the Clone button to start the backup process.

The backup usually takes a while, so plan on getting a bite to eat or taking a nap while it does its thing.

Emergency Rescue iPod

If your computer’s startup hard drive gets corrupted, you need to boot from a secondary device in order to repair and/or rescue the main drive. The iPod is an ideal device for this purpose.

You can install a stripped-down Mac OS X package onto the iPod, which includes Apple’s Disk Utility for hard drive first aid. Optionally, you can add third-party hard drive repair products such as Norton Utilities (www.symantec.com), DiskWarrior (www.alsoft.com), or Data Rescue (www.prosofteng.net).

To create a bootable emergency Mac OS X installation on your iPod, follow these steps:

1. Insert the first Mac OS X installation CD.

2. Launch the installer and follow the on-screen instructions.

A reboot might be required (see Technique 1 for more information).

3. In the Destination screen, select your iPod volume and click the Continue button.

By default, the reformat option is disabled, which is probably what you want (so you don’t erase any existing data or songs on your iPod).
4. Click the Customize button as soon as it appears.

5. Make sure to remove as many of the optional Mac OS X components as possible.
   This includes printer drivers, language versions, and so on. You really want a bare-bones system to save space on the iPod.

6. After the installation is complete, unplug the iPod to make sure that your computer boots from the main drive and then reboot your Mac.

7. Open the Finder, connect the iPod, and install any other disk repair utilities that you have.

To boot from the iPod when an emergency actually happens, plug in your iPod and hold down the Option key during a reboot. You see a list of connected, bootable devices. Click the iPod icon and click the right arrow to continue the boot process.

**Synchronizing with iSync**

Apple adds more PDA-like features to the iPod's software all the time. Currently, this means read-only access to your iCal and Address Book data. (You can’t edit this data through your iPod.) Somehow these Contacts and Calendars need to be synchronized from your computer to your iPod, and that’s what the iSync program does.

To set up synchronization, do the following:

1. Launch iSync.
2. Choose Add Device from the Devices menu and double-click your iPod’s icon in the Add Device dialog that appears (see Figure 48-7).

3. In the iSync dialog, click the Sync Now button to perform the first synchronization.

   For maximum efficiency, allow iSync to launch and synchronize whenever you connect your iPod by marking the Automatically Synchronize When iPod Is Connected check box. This way, the data on the iPod is always up to date without you having to think about synchronizing (see Figure 48-8). Click the iPod icon in iSync’s main window to see these settings.

4. Click the Customize button as soon as it appears.

5. Make sure to remove as many of the optional Mac OS X components as possible.

   This includes printer drivers, language versions, and so on. You really want a bare-bones system to save space on the iPod.

6. After the installation is complete, unplug the iPod to make sure that your computer boots from the main drive and then reboot your Mac.

7. Open the Finder, connect the iPod, and install any other disk repair utilities that you have.

To boot from the iPod when an emergency actually happens, plug in your iPod and hold down the Option key during a reboot. You see a list of connected, bootable devices. Click the iPod icon and click the right arrow to continue the boot process.

**Synchronizing with iSync**

Apple adds more PDA-like features to the iPod’s software all the time. Currently, this means read-only access to your iCal and Address Book data. (You can’t edit this data through your iPod.) Somehow these Contacts and Calendars need to be synchronized from your computer to your iPod, and that’s what the iSync program does.

To set up synchronization, do the following:

1. Launch iSync.
2. Choose Add Device from the Devices menu and double-click your iPod’s icon in the Add Device dialog that appears (see Figure 48-7).

3. In the iSync dialog, click the Sync Now button to perform the first synchronization.

   For maximum efficiency, allow iSync to launch and synchronize whenever you connect your iPod by marking the Automatically Synchronize When iPod Is Connected check box. This way, the data on the iPod is always up to date without you having to think about synchronizing (see Figure 48-8). Click the iPod icon in iSync’s main window to see these settings.

**Figure 48-8:** Enabling automatic synchronization.

**Figure 48-7:** Add your iPod to iSync’s list of devices.
Keeping Notes on Your iPod

The new iPods (with a dock connector) can store text Notes in addition to Contacts and Calendars. To store Notes, simply drag short text files such as grocery shopping lists and To-Do items to the Notes folder on the iPod in the Finder (see Figure 48-9).

![Figure 48-9: Storing small text Notes on the iPod.](image)

Some specialized freeware and shareware tools are available to make working with iPod Notes even quicker. We picked out a few and describe them in the following sections.

Using Notes on older iPods

If you own an older iPod that doesn’t directly support Notes, utilities are available to pack up Notes as Contacts and store them in the Contacts list. This trick works fine for most short Notes.

A good utility that does this is the free Text2iPod X. Simply drop your Note text file onto the application’s icon, and the application stores the file on the iPod if the iPod is connected. The program is available at http://homepage.mac.com/applelover/text2ipodx.

Viewing outlines on the iPod

If you use the (highly recommended) OmniOutliner program to organize information, you’ll appreciate a little script addition to the program called OmniOutliner iPod Export. It exports an outline directly to the iPod. It even supports older iPods by storing the Note disguised as a Contact (see Figure 48-10).

![Figure 48-10: Export an OmniOutliner outline file directly to an iPod.](image)

You can download the script for free at www.omnigroup.com/applications/omnioutliner/extras.

Downloading driving directions to the iPod

PodQuest is an application that allows you to download driving directions from the MapQuest service to your iPod. It installs an icon on your menu bar. From there, you can look up directions (see Figure 48-11) and download them directly to your iPod.

To download PodQuest, go to www.mibasoft.dk/podquest.html ($9.95).

![Figure 48-11: Download driving directions from MapQuest to the iPod.](image)
Technique 48: Getting More Than Music out of Your iPod

Using the iPod as a limited PDA
Pod2Go combines many tasks into one application. It can collect useful information from the Internet — such as news headlines, movie showtimes, driving directions, unread e-mail messages, and weather forecasts — and store them as text on the iPod. It can also automatically back up files from your computer to the iPod every time you synchronize.

Pod2Go is available at www.kainjow.com/pod2go.

Housekeeping on the iPod
After you use your iPod for a while for music playback and data storage, it might fill up. For many reasons, including being able to do some of the other things that we mention in this chapter, you might want to clean out the data on it quickly. You have three choices to free up space on the device:

✔ Erase music via iTunes.
✔ Erase data on the iPod volume from the Finder.
✔ Reformat the drive with the Disk Utility program, which erases everything (both music and data).

The nice thing about the way the data is stored on the iPod is that your music and your other data are kept completely separate. If you erase files from the iPod in the Finder, you don’t lose any of your music; if you clean up music in iTunes, you don’t lose any of your data.

If you want a completely fresh start, reformat the iPod by using Disk Utility. Be sure to select the indented iPod volume in the list at the left. Open the Erase tab in the right half of the window and then click the Erase button (see Figure 48-12).

The next time that you launch iTunes, it responds as if a new iPod has been connected and asks you what to do.

Don’t reformat your iPod unless you’re prepared to completely wipe out everything on it!

Figure 48-12: Reformatting the iPod.
Part VIII

Security and Maintenance

The 5th Wave

By Rich Tennant

"Hey Philip! I think we're in. I'm gonna try linking directly to the screen, but gimme a disguise in case it works. I don't want all of New York to know Jerry DeMarco of 14 Queensberry, Bronx NY, hacked into the Times Square video screen."
Better Backups with rsync and .Mac

If you care about any of the data on your computer, you’d better back it up. It’s that simple. Although today’s computers are more reliable than their predecessors, you absolutely must back up your stuff. Accidents still happen, hard drives crash, laptops get dropped, and computers are stolen. Without a backup, you’re in trouble if any of these things happen to you.

We begin this technique by going over the best backup policies to abide by. Then we take you through an easy and free backup utility, rsync, which is quite handy but unfamiliar to many Mac users. After that, we demonstrate Apple’s Backup software, which is available to .Mac members only. Finally, we mention several other third-party tools that might be to your liking if rsync or Backup don’t fit your needs.

Maybe you’ve never lost data. Maybe you don’t even know anyone who has. Still, be sure to back up your computer (either the entire hard drive or just the most important files). It costs very little, doesn’t take much time, and makes you look like a savvy, pre-emptive computer user.

Smart Backups

An effective backup requires a plan. Be sure to

- **Back up your data frequently.** Ideally, you should back up your Home directory daily and your entire computer either weekly or monthly.

- **Make multiple backups.** You don’t want to discover after your computer crashes that your only backup is also corrupted.
Use multiple backup locations. Save your first backup to one set of CDs or DVDs and then save the next backup to a different set of CDs or DVDs.

Rotate your backup sets — use one backup set for a month, use a second set for the next month, and then go back to the first for a month, and so forth.

Back up to different media. Rotate your backups among your available sets, such as external hard drives, CDs, and DVDs.

Keep a backup copy in a different building from your computer. If your only backup copy is in your home office next to your computer and the house burns down, you’ve lost everything.

Leave one of your multiple backups in a fire-proof safe, at school, at the office . . . somewhere other than where your computer is.

Test your backup. This confirms that the backup worked and that you know how to use it if you need it. If you have a spare computer or drive, restore your entire backup to it. Otherwise, restore part of your backup to an arbitrary location on your computer, just for testing purposes.

### rsync: The Geek’s Backup Utility

If you don’t mind a little command-line work, you can use the rsync utility to perform your backups. The benefits of using rsync include

- It’s free!
- It’s very, very fast.
- rsync copies only the changed files, saving time and hard drive space.

Most backup utilities perform incremental backups: They copy only altered and new files. Unchanged files aren’t copied after the initial backup. rsync takes this further by copying only the altered parts of a file. For example, if you edit a text file, the new changes are copied, not the entire file.

- It doesn’t need to be run as an administrator.
- It maintains file ownership and permissions.
- Did we happen to mention that it’s free?

The only drawbacks to this application are

- You must use the Terminal.
- You can’t back up to a CD or DVD.
- It has no pretty graphical user interface to admire.
- It has problems backing up resource forks. (See the sidebar, “rsync, resource forks, and why you should care about them.”)
- You can’t deduct the purchase price from your taxes.

You can use rsync in many ways. The three most important and common are

- Backing up files *locally* (from one drive to another on your computer)
- Backing up files *remotely* (from your computer to a remote computer)
- Backing up remote files locally (from a remote computer to your computer)

rsync can back up files either to or from a remote server (if it’s also running rsync). If you’re a Web developer, this can be a very handy tool!

To use rsync, pull up the command line tool (the Terminal application, found in the Utilities folder) and enter a command with this basic syntax:

```
rsync -options sourcedirectory targetedirectory
```
For example, a simple way to use the tool would be to run this command:

```
rsync -a ~/Documents/WorkFiles/ /Users/Shared/MyWorkFiles
```

This would copy the entire contents (the \texttt{a} means that an exact copy should be made) of the WorkFiles directory (located within the Documents folder of the current user’s Home directory) to a folder called MyWorkFiles, located in the Shared users folder. By copying these files over to the Shared users folder, other Mac users can access them. Repeated uses of this command ensure that the most recent versions of the files in Larry’s WorkFiles folder are copied over to the public directory.

**rsync syntax options**

The most important options are (these can, and often are, combined)

- \texttt{a}: Creates an exact archive.
- \texttt{n}: Runs a test backup to show you what \texttt{rsync} will do without actually doing it.

If you’re a little nervous about using \texttt{rsync}, run it with the \texttt{-n} option to see what files it will copy without actually copying the files (see Figure 49-1). The \texttt{-a} indicates that an exact archive should be created, the \texttt{-z} says to use compression, but the \texttt{-n} dictates that a trial run be taken first.

- \texttt{v}: Gives you a verbose response.
- \texttt{z}: Uses compression to save space.
- \texttt{--exclude}: Skips backup of selected files.

For example, to exclude the contents of the Preferences directory, use

```
rsync -az --exclude=Preferences/ /Users/larry /Volumes/Backup
```

- \texttt{--progress}: If you want to see a progress report while \texttt{rsync} runs, use \texttt{--progress}.
- \texttt{--quiet}: If you don’t want a lot of feedback, use \texttt{--quiet}. (This is essentially the opposite of the verbose option.)
- \texttt{--stats}: To see basic statistics on the backed-up data (number of files involved, total data backed up, and so on), use \texttt{--stats} (see Figure 49-2).

If you use a trailing slash with your source directory name, you back up directory’s contents but not the directory itself. In other words, \texttt{rsync -az ~/Documents/ /target} copies everything in Documents to the target without making a Documents folder.

**Backing up Home to an external hard drive**

A good way to use \texttt{rsync} is to back up your Home directory to an external hard drive. Follow these steps to do just that:
1. Mount an external drive.
   You can use an external FireWire or USB drive, or even a Zip disk if it’s large enough.

2. Open the Terminal by double-clicking its icon in the Utilities folder.

3. At the prompt, type `ls /Volumes/` to list the drives (see Figure 49-3).
   This command lists the currently connected drives, along with their names. Before using `rsync`, make sure that your drive is available.

4. Preview the backup operation by typing this command:
   ```bash
   rsync -azn ~/ /Volumes/<drive>/path/to/destination
   ```
   The `a` and `z` flags tell `rsync` to archive and compress the files. The `n` flag states that you want to preview the operation.

   In Figure 49-4, Larry’s Home directory (`~/`) is being backed up to `/Volumes/40\ GB\ Firewire/G4\ iBook\ Backup`.

Because the Terminal has problems with spaces in filenames, spaces must be escaped (preceded with a backslash) in all path names. (In the Finder, the drive is called 40 GB Firewire, which is then shown as 40\ GB\ Firewire in the Terminal.)

See Technique 56 for more on escaping and using tab completion or the Finder to easily enter path names.

The only problem you’re likely to see from running this command is if your pathnames (the location of the volumes and directories) are incorrect. If you see such an error, change your pathnames accordingly.

5. When you’re ready for the backup, run `rsync` with this command:
   ```bash
   rsync -az --progress --stats ~/ /Volumes/<drive>/path/to/folder
   ```
   Figure 49-5 shows a successfully executed backup.

   ![Figure 49-3: Larry’s computer has a main drive (Macintosh HD) and an external drive (40GB Firewire) mounted.](image)

   ![Figure 49-4: Test the backup.](image)

   ![Figure 49-5: Running the actual backup.](image)
Usually, running this command doesn’t reveal or cause any problems. (It’s just a backup, after all.) However, if you see a Permission Denied message or it seems like an extraordinary amount of information is about to be copied, you might want to rethink your rsync command.

6. After rsync has completed its task, check the destination drive in the Finder to make sure that the files were backed up.

A cron (a UNIX task-scheduling program) can automatically call rsync at set times. This way, you can back up your computer at regular intervals (maybe every night) without any extra effort. See Technique 54 for more.

Restoring a backup
You need to restore all or part of a backup if:

- You accidentally deleted some files
- Your hard drive crashed and had to be reformatted
- You want to make the files accessible on another computer

To restore a backup, just use rsync again, with the appropriate parameters:

1. Mount the external drive containing the backup.
2. Open the Terminal by double-clicking its icon in the Utilities folder.
3. At the prompt, type ls /Volumes/ to list the drives (refer to Figure 49-3).
4. Restore the backed-up files to a new location by using this command:
   rsync –av /Volumes/<drive>/path/to/folder ~/Desktop
   This command copies the entire folder directory to your Desktop. It’s the easiest, most foolproof method of being able to re-access previously saved data. After the files are on the Desktop, you can move or edit them as you see fit.

rsync, resource forks, and why you should care about them

A resource fork is a special file that contains an application’s resources (like the icons and images it uses). rsync doesn’t recognize old-style resource forks, which might be lingering on your computer. Resource forks are still used by a number of UNIX applications that have been brought into the Mac OS X platform. This means that some of the backed-up files stored via rsync might not be usable when restored to your Mac. For this reason, you should

- Use rsync only for your personal files, not the applications or the whole operating system.
- Test rsync by restoring some files to make sure that it works for the files that are important to you.

If you need to backup applications that have resource forks, you have a couple command-line options:

- The ditto command. See the manual for ditto (type man ditto in the Terminal) for more information.
- The asr utility (Apple Software Restore). Its specific purpose is to copy disk images in order to make clones of drives. It’s not designed for routine backups but will do the trick.

Backup for .Mac Users

If you have a .Mac account, you have a pretty good backup tool — appropriately called Backup — which is free for all .Mac users. (A .Mac membership costs $99 per year, but you get some pretty nice other features as well.) In the latest version of Backup, you can copy files to

- Hard drives
- Removable drives
- CD-Rs and CD-RWs
- DVD-Rs and DVD-RWs
- iDisks
- iPods (see Technique 48)
In fact, Backup can now perform backups over multiple volumes or types of volumes. For instance, you can back up your entire hard drive to a combination of DVDs and CDs.

If you have a .Mac account, you can also use iSync to back up (or synchronize) your Address Book data, iCal Calendars, and Safari bookmarks online.

The best way to demonstrate all the timesaving techniques involved with Backup is to run through a quick example, highlighting the key points along the way.

**Getting started with Backup**

To begin using the Backup application, you must establish to what resource you will backup your data:

1. **Open Backup.**

   Backup takes a second to open while it checks the status of your iDisk. Your current iDisk usage is shown at the top of the Backup window (see Figure 49-6).

   ![Figure 49-6: Start here to use Apple’s Backup application.](image)

2. **Select one of the three backup options from the drop-down list (as shown in Figure 49-7).**

   - **iDisk:** If you select your iDisk, you don’t need to do anything more except connect to the Internet — go to the section, “Deciding what to back up,” later in this technique.

   If you’re a trial .Mac member, you can back up stuff only to your iDisk. These files are lost if you drop your membership. Use Backup only if you plan on keeping your account.

   ![Figure 49-7: Back up to your iDisk, an optical disc (CD or DVD), or a drive.](image)

   - **CD:** If you choose CD, Backup displays how many CDs are required at the bottom of the window.

   - **Drive:** If you choose Drive, follow these steps:

     a. Click the Set button, next to the drop-down list.

     b. Click the Create button at the prompt (see Figure 49-8) to make a new backup location. If you’ve already created a backup location, click Open instead.

   ![Figure 49-8: This prompt appears if you choose to back up to a drive.](image)
c. Navigate to where you want to create the backup or navigate to the existing backup location and then press Return.

Deciding what to back up

After you decide where to back up your data, the next important decision — in fact, the most important decision — is what to back up. The Backup utility uses *QuickPicks*, which automatically identifies common files and file types (refer to Figure 49-6). These include:

- Safari bookmarks
- Keychains
- Address Book contacts
- Stickies files
- iCal Calendars
- AppleWorks stuff
- iPhoto and iTunes libraries
- Microsoft Office documents
- E-mail

To back up any of these items, select the check box next to its name in the Back Up column.

To see more details about an item, bring up the Info panel (as shown in Figure 49-9). Select the item and either click the Info button (which bears a lowercase i) or press Ô-I.

To add items to be backed up, you can either:

- Click the + button and navigate to the item.
- Drag the item from the Finder and drop it into Backup.

![Figure 49-9: Use the Info panel to preview a group of files or fine-tune your selections.](image)

The easiest and most thorough way to use Backup is to drag your Home folder into the application.

If you don’t like the list of options made available to you, use the Edit menu (see Figure 49-10) to quickly make changes to the list.

![Figure 49-10: Use the Edit menu to remove items or select and clear all the items at once.](image)

Finalizing the backup

The last step for backing up your stuff is to click the Backup Now button. You’re prompted for a disc name if you’re burning to a CD/DVD (you might as well use the default name Backup provides). Then you see a progress bar while Backup continues.

When the backup is finished, click the calendar icon at the bottom of the screen. A dialog in which you
can schedule regular backups appears (see Figure 49-11). You can perform regular backups to drives or your iDisk but not to a CD or DVD.

![Schedule Drive Backups](image)

- **Figure 49-11:** After you use the application once, you can schedule incremental backups.

The downside to using Backup is that if you stop paying for .Mac, you can no longer use this application. Back up your files with a different system before you cut your service, or else!

**Other Backup Options**

If none of the preceding options are to your liking (perhaps they’re too expensive), here are some other backup utilities that you might appreciate:

- **SilverKeeper** ([www.silverkeeper.com](http://www.silverkeeper.com), free): SilverKeeper is a free product by LaCie, a maker of such hardware as hard drives and optical drives. It’s a simple application, but the price is right and it can back up to pretty much any type of drive (CDs, DVDs, external hard drives, and so forth).

- **StuffIt Deluxe** ([www.stuffit.com/mac/index.html](http://www.stuffit.com/mac/index.html), $90): StuffIt Deluxe comes with an Archive Assistant utility that can handle your backup needs.

- **iBackup** ([www.grapefruit.ch/grapefruit/ibackup](http://www.grapefruit.ch/grapefruit/ibackup), free): The interface of iBackup is a little tedious to work with, but the product is free and it focuses mostly on important things such as documents, preferences, e-mail, and so forth.

- **Retrospect Desktop** ([www.dantz.com](http://www.dantz.com), $129): Retrospect is a long-standing backup application for Mac users. It’s pricey but has a lot of useful features, including scheduled backups, the ability to search through catalogs of backed-up files, and backing up computers over a network.

- **Déjà Vu** ([http://propagandaprod.com](http://propagandaprod.com), $25): Déjà Vu is a very simple backup utility with a nice interface and the ability to run backups unattended (read: you can back up your computer while you’re sleeping). It runs as a System Preferences panel and even lets you back up to networked servers via common protocols.

- **ChronoSync** ([www.econtechnologies.com](http://www.econtechnologies.com), $30): ChronoSync is actually designed to be a synchronization utility between two computers, such as a laptop and a desktop. But because of this functionality, you can also use it for backups. If you have multiple computers and no synchronization capability, this tool’s for you.

- **Carbon Copy Cloner** ([www.bombich.com/software/ccc.html](http://www.bombich.com/software/ccc.html), donationware): We mention Carbon Copy Cloner many times in this book and for good reason. It makes a complete backup of your hard drive as a bootable drive. In other words, you can back up your hard drive to a FireWire drive or an iPod and then run a computer from that device.

Both CMS ([www.cmsproducts.com](http://www.cmsproducts.com)) and Maxtor ([www.maxtor.com](http://www.maxtor.com)) make FireWire hard drives — ranging in price from $300 to $500 — that back up your Mac at the touch of a single button. Instead of paying separately for both an external hard drive and backup software, you can meet both needs with one product.
Mac users have always been fortunate because relatively few viruses target the Mac operating system. Some people have complained that there isn’t much software written for the Mac, but the upside is that not many viruses are written for the Mac, either. Still, you have to be careful.

In this technique, we tell you what you need to know about viruses, how you can avoid getting them, and what to do if your Mac becomes infected. We focus on using McAfee’s Virex for this purpose, but we list other options at the end of this technique, too.

**What You Should Know about Viruses**

A *virus* is a special type of application that can make copies of itself. Viruses can be either mere nuisances that do nothing but spread themselves around or malicious evildoers that try to destroy your data or create security holes. Roughly speaking, the three kinds of viruses are

- **Worms** are the A-list celebrities of viruses — they get all the attention. Worms spread via e-mail applications (Outlook Express on Windows is a particular favorite), removable media (such as CDs or Zip disks), or network holes (open gateways into your machine; again, Windows provides for plenty of these). Every time a new worm comes out, you hear about it in the news as it spreads around the globe, shutting down servers and causing billions of dollars in damage.

- **Trojan horses** pretend to provide services (like remembering your Web passwords) but really do something else in the background (like e-mailing your Web passwords to somebody else). Trojan horses are spread by people downloading and installing software that they assume to be safe.

- **Macro viruses** use advanced features of scriptable applications as their medium for trouble. They are attached to documents and are activated when that document is opened. The most common macro viruses affect the Microsoft Office suite. Simple macro viruses wreak...
Technique 50: Battling Viruses

Battling Viruses

Because of the problems with macro viruses, many applications (such as Microsoft Word, see Figure 50-1) prompt you before enabling the macros.

Because of the problems with macro viruses, many applications (such as Microsoft Word, see Figure 50-1) prompt you before enabling the macros.


• Figure 50-1: Microsoft Word asks whether you want to use the macros in the document being opened.

Other operating systems have much more trouble with viruses than Mac OS X does, but you should still be careful. The rest of this technique shows what you can do to limit your risk of infection and what you can do should the worst happen.

Things You Can Do to Limit Viruses

The most important step for safe computing is knowing how not to get infected in the first place. These are our best practices for protecting your Mac:

- Use a firewall on your network. Many worms spread through network holes. Firewalls — special software programs that establish barriers between a computer or network and the Internet — prevent traffic from going through these holes. Whether you’re using a single computer on a dialup connection or you’re one of a dozen computers on a network, you can use a firewall. See Technique 41 for more information, including how to enable firewalls on your Mac (see Figure 50-2).

- Be careful whom you give your e-mail address to. If few people have your e-mail address, you have less of a chance that folks send viruses to you. It’s that simple.

- Limiting the visibility of your e-mail address minimizes the number of viruses and amount of spam that you receive. Try to keep your e-mail address off public message boards and Web pages. You can also follow the antispam suggestions from Technique 35.

- Don’t open attachments to e-mails. Receiving a virus as an attachment to an e-mail isn’t a security risk. Trouble starts when you open this attachment. If you really want to be safe, don’t open any attachments. If you find this rule to be unreasonable and excessive (and it is), scan attachments with antivirus software and abide by the next rule.
Don’t open Visual Basic Scripts or executable attachments in e-mails. Many Trojan horse viruses work by posing as one thing while being another. For example, several popular viruses were spread as a file with the extensions .txt.vbs or .jpg.exe. People recognized .txt and .jpg as benign, but the .vbs (Visual Basic Script) and .exe (executable) extensions were actually the ones that counted. These are both specifically Windows examples, but you get the point.

To be safe with e-mail attachments, always try to open them from within a specific application rather than double-clicking them. See Technique 25 for particular methods for opening files.

Keep your antivirus software up to date. About 500 new viruses are discovered each month. If your antivirus software is out of date, you might as well not even have it. We discuss one popular antivirus application, McAfee’s Virex, in the section “Using Virex,” later in this technique.

Many virus applications, like Virex, provide for automatic updates each time they run. This is a very good thing (but requires an Internet connection).

Perform daily virus scans. If you have a virus application, run it every time you log in. Most antivirus applications make this an option in their preferences.

Don’t network with Windows computers. A Windows virus can’t infect your computer, but that doesn’t keep it from trying and trying and trying, which can be an annoyance. If you can, avoid networking with Windows computers. If you must, make sure that the Windows users do everything they must do to protect their machine.

Be careful if you use Virtual PC. You can be affected by Windows viruses if you run Windows on your Mac with Virtual PC. If you use it, research all the recommended security procedures for Windows users. Then abide by these procedures as best as possible within the virtual environment.

One useful resource for virus and security-related issues is the National Security Agency. On its Web site (http://www.nsa.gov/snac), it has dozens of thorough documents recommending best security policies. The topics cover specific operating systems, Web browsers, applications, and more.

Use Rules in Mail. When the next wave of Windows worms hits, Mac users usually are pelted with hundreds of messages. You can establish a Rule in your Mail application to automatically delete these annoyances (see Figure 50-3). Technique 35 shows you how to set up a Rule in detail.

• Figure 50-3: Define Rules to handle annoying worms.

Turn off all Sharing tools. This goes along with using a firewall to shut down network holes. Your Mac comes with every Service turned off as the default; none are turned on unless you specifically turn them on. If you turned something on and don’t need it now, be certain to turn it off. Services are controlled through the Sharing System Preferences tab, which we discuss in Techniques 40 and 41.

Don’t assume that you can trust attachments from a familiar sender. The most successful worms work because they use a person’s Address Book (or Windows equivalent) to send themselves out to the world. John Smith receives an e-mail from his friend, Jane Doe, so he opens the
Technique 50: Battling Viruses

Using Virex

McAfee’s Virex (www.mcafee.com) is a popular antivirus application, partially because it comes free with your .Mac account (although that account costs $99 per year). Using it is simple, but using it efficiently and effectively requires a little more thought. Here is a recommended configuration procedure to go through with Virex:

Some people — including one of the authors of this book — has experienced significant problems with the 7.5 version of Virex. Back up your computer before installing Virex and keep older, working versions of the Virex installer around just in case.

1. Open Virex by double-clicking the Virex icon found in either the Applications or Utilities folders.

2. Open the Preferences panel (see Figure 50-4).

![Figure 50-4: The Virex Preferences panel.](image)

3. Within the Preferences panel, select the following check boxes:

   - Automatically check for virus definition updates: What’s the point of using Virex if it isn’t up to date? If you have an always-on Internet connection, take advantage of this feature.

Tips if you use Windows

Okay, this book is about the Mac, but you might also use Windows on a regular basis. We all have our crosses to bear. If you have to use Windows, here are a few quick tips on minimizing viruses on that operating system:

- Don’t use Outlook Express.
- Don’t use Internet Explorer.
- Turn off every feature that you don’t use.
- Set Windows to display file extensions.
- Use an antivirus application and keep it up to date.

One reason why Windows is less secure is that many applications — such as Outlook Express and Internet Explorer — are tied into the whole operating system. Vulnerabilities in those applications can be used to manipulate vulnerabilities in Windows. For both security and aesthetic reasons, we recommend Mozilla’s Firefox for your Web needs and Thunderbird for e-mail. They’re both freely available at www.mozilla.org.

attachment, launches the virus, and inadvertently sends it to everyone in his e-mail client’s Address Book. Even if a friend sends you a file purposefully, your friend might not know that it has a macro virus attached to it.

- **Scan every file you download, borrow, take from CD, copy from a disk, and so forth, with a virus tool.** If you have a virus application — and you should have one — use it to scan files that are new to your computer. Even if files come from a reputable source, such as a CD-ROM, it can’t hurt.

- **Let people know if they sent you a virus.** Help yourself by helping others. If someone sent you a virus, she might not even know it.

- **Eat healthy, get regular exercise, and take your vitamins.** This keeps you from getting a virus, not your computer, but it’s still sound advice.

Although it won’t prevent getting viruses, keeping recent backups of your data makes it easier to recover after a virus strikes.
Active virus detection: This feature tells Virex to be on the lookout for viruses that are currently running (as opposed to those that are just on your computer).

There have been reports of the active virus detection interfering with mounted devices such as Palm Pilots. You might find that you need to turn off Virex (or turn off this feature) when syncing with a handheld or similar device.

4. Click the More Options button.

5. On the More Options pane (see Figure 50-5), select the following check boxes:
   - Check files for virus-like characteristics: This might be overkill, but it’s better for your virus utility to be too thorough than not thorough enough.
   - Find potentially unwanted applications and joke programs: This isn’t a security feature so much as a good way to get a sense of what applications you might no longer need. Removing unnecessary applications saves you hard drive space and clears up the clutter.

6. Set the When a Virus Is Found drop-down list to Notify.
   You really don’t want Virex — or any virus utility — cleaning or deleting files on its own. Let the program notify you of potential problems, and then use your best judgment on what to do.

   One good example of why you shouldn’t have Virex automatically clean or delete infected files is that some people lost entire Mail mailboxes this way when using Virex 7.5!

7. Click the red button in the upper-left corner to exit the Preferences panel.

After you have Virex configured properly, it’s easy to use effectively. To manually scan your files, follow these steps:

1. On the main screen (see Figure 50-6), click where it says “Drop items or click here.”
   This brings up a standard Open/Save dialog for you to choose a volume or directory to scan.

2. In the resulting dialog, select your Home folder in the leftmost column (see Figure 50-7) and click Select Location to return to the main screen.

3. Click Start to begin the virus check (see Figure 50-6).

4. Read a good book, check your e-mail, or surf the Web while Virex does its thing.
   Virus scanning can be fairly processor-intensive, so don’t plan on doing much while it’s working.
With the first two options, you should probably sneak over to the Finder and make a copy of the original, just in case the clean messes up the file or you might need it later (regardless of the potential infection).

6. **Exit the application when you finish.**

Once a week or so, have Virex inspect your entire computer. Follow the preceding steps, but select your hard drive (or drives) instead of just the Home folder (in Step 2).

If you use Stuffit Expander (www.aladdinsys.com) to decompress files, you can set it to automatically scan files when decompressing them. Opt for this through the Expansion tab of the Stufflt Preferences panel (see Figure 50-8).

5. **If Virex reports on a virus, decide how to handle it.**

With the notify setting on in the Preferences panel, Virex prompts you if it finds a potentially infected file or currently running virus. The prompt gives you three options:

- Clean the file
- Move the file to the Trash
- Ignore it

**Other Antivirus Software**

We highlight using Virex as a protection tool because it’s been a popular choice for years, and it comes with a .Mac account (which seems like a good Apple endorsement). But you have other options, as always:
Norton AntiVirus (www.symantec.com/nav/nav_mac, $70): Norton AntiVirus is a solid application and has been around for a long time. In fact, Norton’s other applications have been integral to maintaining Macs for years. Norton AntiVirus (NAV for short) performs live updates of its virus definitions to stay current and certainly does the trick.

VirusBarrier X (www.intego.com/virusbarrier, $60): VirusBarrier performs automatic updates and can run at all times to keep an eye out for potential problems. VirusBarrier also works well with Intego’s other security products like NetBarrier. You can also buy packages containing multiple products.
Keeping your operating system and applications up to date is an important aspect of maintaining your computer. For performance, security, and features, the little time that you spend updating software should be considered time well spent.

We begin this technique discussing how you can update your operating system and other Apple applications (it’s pretty simple, if you didn’t know). Then we discuss some best practices when it comes to updating non-Apple applications found on your computer. Finally, we go through a few references that you can use to stay informed when updates become available.

**Using Software Update**

Keeping your operating system up to date is an absolute must for these two reasons:

- **It’s the only way for Apple to plug security holes.** Having security holes in your computer is a bad thing. Continuing to have security holes after they’ve been made public is even worse.

- **It’s the only way for Apple to fix bugs.** Nobody’s perfect, and Apple’s no exception. The more complex a piece of software is, the more likely it is to have bugs. Apple’s pretty good about fixing bugs, but you need to update your software for those fixes to take effect.

The Software Update utility (see Figure 51-1) is the tool to use to perform all operating system updates. Just select the check boxes next to the items you want to install and then press Return to begin the process. (You’re prompted for the administrator’s password.) Software Update has the added benefit of updating other Apple applications as warranted, such as iTunes and QuickTime. Although you can access this tool through System Preferences, choosing Apple-&gt;Software Update (see Figure 51-2) is much faster if you want to quickly update your computer (you can run an update at your prompting or schedule updates to occur periodically). In fact, the Software Update panel in System Preferences (see Figure 51-3) is actually the preferences page for the Software Update utility.
Using Software Update

• Figure 51-1: Apple’s Software Update application makes maintaining Tiger easy.

• Figure 51-2: Use the Apple menu to quickly access Software Update.

Updating your software with these tools is fairly straightforward. We recommend these settings for the best results:

✔ Set Software Update to run weekly. You can’t specify a day and time for it to run, so you’re best off choosing Weekly from the Check for Updates drop-down list. This drop-down list is located on the Update Software tab of the Software Update preferences panel (see Figure 51-3). At some random time — probably while you’re doing something critically important — Software Update pops up and does its thing.

✔ If you don’t have a high-speed Internet connection, select the Download Important Updates in the Background check box. With this option, also in the Software Updates preferences panel (refer to Figure 51-3), you can continue using your computer while the files are downloading. Then you’re notified that the installation is ready to take place.

✔ Set Software Update to ignore the updates that you don’t need. As an example, if you don’t have an iPod, you don’t need to update your iPod software. The same applies to applications you don’t use. You can effectively delete anything by following these steps:

1. Run Software Update and select the item to be ignored in the list of updates that appears.
2. ⌘-click to select multiple items (as shown in Figure 51-4).
Technique 51: Keeping Your Software Up to Date

3. Choose Ignore Update from the Update menu or press Ô-Delete.

You’re prompted to confirm this action (see Figure 51-5). Rest assured that you can access deleted updates again later (like after you purchase that iPod).

4. To reactivate an update that you’ve previously deleted, choose Reset Ignored Updates from the Software Update menu.

Doing so redispalyes all ignored updates, so you can install those you need and ignore those you still don’t require.

Update menu — you can download the new installations once and then run them on multiple computers. This is a good policy if you have more than one Mac and a slow Internet connection.

If you use the Install and Keep Package update method, you find the installed package in the /Library/Packages folder after the installation is complete. Tiger opens this directory in a new window for you.

Updating Other Applications

Application updaters work in two different ways: Some modify the existing software, and others replace it altogether. Using either of these is straightforward (and they should come with instructions), but make and keep a backup copy of the software before performing the update just in case problems occur.

Although we’ve never personally experienced a problem, you should back up your files before updating any software. This is especially true when it comes to installing major updates to the operating system. Although unlikely, an update gone awry can potentially wreck your system.

Updates versus upgrades

Technically, two kinds of software changes exist for applications:

- **Updates** are normally minor version changes (like from 7.0 to 7.0.1) that fix bugs and security holes. These are the most important (for obvious reasons) and should be provided for free from the application’s manufacturer.

- **Upgrades** are normally major version changes (like from 6.0 to 7.0) that add features. These normally cost you money and are a much larger download (or come with their own CDs).

(continued)
In this technique, we primarily focus on updates.

Although calling something an update instead of an upgrade is largely a syntactical difference, some people have taken issue with Apple for releasing what seems to be an update (going from Mac OS X 10.0v.3 to 10.0v.4) and charging $129 for it. Considering the number of features added to each new release, Apple could just as easily silence the critics by calling the versions Mac OS XI, XII, and so forth. Or by not charging quite so much.

Some applications come with their own updaters built into the software. You see two general types of built-in updaters:

- **Automatic updaters**: For example, QuickTime has its own updater, called QuickTime Updater. Cocktail (www.macosxcocktail.com; see Figure 51-6), a utility that performs various system maintenance routines, checks for newer versions as well.

- **Links to a supporting Web page**: Other applications let you check for updates by taking you to their Web sites. This isn’t as useful, but it’s an easy way to keep your software up to date.

Be sure to create a backup of the existing version of an application before either upgrading or updating it. For example, many users have had problems with the 7.5.x version of Virex. Those who kept the installer for the earlier 7.2.x versions were able to reinstall the old, working copy. With applications that don’t have installers — like Fire (an IM client), you can copy the older version to another location before you update it.

To find out whether an application has an updating system built-in, check the following:

- The application’s preferences panel
- On the application menu
- The application’s manual
- The application’s Help pages (if they exist), which are accessible through the Help menu

And, as a last resort, the manufacturer’s Web site might list any updates.

**Staying Informed about Updates**

Before you can update any software, you need to know that an update is available. Although Apple’s Software Update utility checks for your Apple software, you need an easy way to keep informed for everything else. Here are some recommended resources to keep informed about what updates are available:

- **VersionTracker** (www.versiontracker.com): A whole cult exists around VersionTracker, which is one of the premier application information sites around. Some fanatics check it daily to see
what updates are available for their favorite applications. It's also a great way to see what's new for Mac OS X and to find alternatives to tools you're already using. Signing up for VersionTracker's daily mailings is a great way to be informed when new software or new versions of existing software are released.

Anyone can use VersionTracker for free, but people with a membership can take advantage of more useful tools. (Membership starts at $25 per year.)

MacUpdate (www.macupdate.com): MacUpdate is similar to VersionTracker but is completely free. The site e-mails you when particular applications are updated and lets you create custom watch lists to track your favorite software.

Apple mailing lists (http://lists.apple.com): Apple maintains a number of mailing lists for various subjects. Almost all of them have a moderate amount of traffic, so signing up shouldn't overwhelm your inbox. Most important for updates is the “security-announce” list, which notifies you of security-related updates available for the operating system. Sign up for this, and you're one of the first to know when a new patch comes up.

Apple Developer Connection e-mails (http://developer.apple.com): You don't have to be a software engineer to be a member of the ADC. This free membership provides you with a ton of information. You can also sign up for the ADC update e-mail, which tells when new software or upgrades to existing applications come out.

Application e-mails: Many manufacturers have mailing lists that you can sign up for that aren't (thankfully) spam. If you want to know when a new version of StuffIt or BBEdit is available, sign up at the appropriate Web site or when you register the application. Most registration forms let you opt-in for product updates while still opting out of other “related” e-mails that they think you might be interested in. (You could call this second category “spam-like.”)
Securing Files

Security comes in many forms: for example, the security issues involved with Internet transactions, or the physical security of making sure that someone can’t steal or physically tamper with your computer. You also face the issue of protecting your passwords (see Technique 53). This particular technique is all about securing individual files and folders on your computer. If your computer never leaves the house, this might not be a concern, but if you work in an office or travel with your Mac, protecting sensitive documents is critical.

The primary tool for this is FileVault. In this technique, we show you how to use that utility most efficiently. Then we show you some other popular shareware options, just in case FileVault isn’t sufficient for your needs. Finally, we let you in on the Secure Empty Trash feature, which allows you to safely (and permanently) delete files.

Making the Most of FileVault

FileVault is a new technology that was added in Panther and is still alive and well in Tiger. FileVault makes use of a 128-bit version of the Advanced Encryption Standard (AES) to encrypt your stuff. (Encryption is the process of translating data into an unreadable form, requiring a password or similar key to make it legible again.) After you enable FileVault, it encrypts and decrypts the contents of your Home directory while you work, meaning that you automatically have this security without needing to constantly manage the process.

- If you use FileVault, make sure that you store everything within your Home directory. Anything kept elsewhere isn’t protected!

- Keeping unencrypted copies of your stuff and storing it in a secure location is prudent. For example, you could routinely back up your Home directory to CDs or an external hard drive and place those in a home safe or underneath your mattress. (Well, we’re just kidding about the mattress, but you get the idea.)
To enable and use FileVault

1. Open the System Preferences panel.
2. Click the Security icon, under the Personal heading.
3. Click Set Master Password.

You use the master password to control access to every encrypted Home directory on the computer. The files themselves are encrypted using both the master password and the user’s login password.

If you lose or forget your master password and your login password, you’re up a creek without a paddle, to put it politely. Whatever you do, make sure this never happens, or you might as well say goodbye to all your stuff. But don’t make your password obvious — and don’t write it on a note taped to your computer.

4. In the dialog that appears (see Figure 52-1), enter the password twice, and then enter a hint whose answer is hard-to-guess.

5. Click OK.
6. Click the Turn on FileVault button (see Figure 52-2).

You can’t turn on FileVault while other users are logged in to your computer. Make sure that you’re the only user logged in before proceeding.

7. Enter your master password at the prompt (see Figure 52-3).
8. After reading the warning, click the Turn on FileVault button (which appears in a prompt).

The dialog shown in Figure 52-4 appears to warn you of the consequences of forgetting your master password. (It doesn’t bode well for you if you’ve already forgotten the password.)


FileVault logs you out and then spends a few minutes encrypting your Home directory. How long this takes depends on the size of your Home directory.

While you’re in the FileVault control panel (refer to Figure 52-2), consider selecting the check boxes for these other security features, too:

- Require Password to Wake This Computer from Sleep or Screen Saver
- Disable Automatic Login
- Require Password to Unlock Each Secure System Preference
- Log Out After $x$ Minutes of Inactivity

Each of these features makes your computer more secure but also slightly more tedious to work with.

If you’re the only one who uses your computer and it’s in a safe place, leave the check boxes cleared. If you have sensitive data on your computer, keep your Mac in an environment where others can access it—or just generally want the peace of mind—enable these options.

### Other Encryption Tools

FileVault is built into Tiger, exhaustive in its coverage (your entire Home directory) and self-managing. But it has its downsides, too. If FileVault doesn’t exactly float your boat, you can use a number of other applications to encrypt and decrypt files. Here we provide you with some assistance in finding the right security tool for your situation.

#### Disk Utility

Apple’s Disk Utility helps you manage discs (like burnable CDs), hard drives, and disk images. This last category, in case you aren’t familiar with it, is a file that can be stored anywhere (on your hard drive or on a CD). When you need to work with the disk image’s contents, you mount it like any other disc, then open, add, and delete files as needed. For security purposes, Disk Utility allows you to create encrypted disk images by using the same encryption protocol as FileVault. Disk Utility has a couple neat features:

- You can make the disk image’s contents accessible only when you need them.
- You can store in the disk image only those files that must be encrypted. (For example, you can save time and space by not encrypting the 8GB of music on your hard drive, as FileVault would do.)
Technique 52: Securing Files

To use Disk Utility

1. Open Disk Utility by double-clicking its icon in the Utilities folder.


3. In the resulting dialog (see Figure 52-5), make the following selections:

![Figure 52-5: The prompt for creating a disk image.]

- Give the disk image a name in the Save As text box.

- Don’t use a give-away name like Bank Account Info. Instead, give your disk image a creative name that doesn’t indicate its purpose. Doing so helps make important information seem less appealing (or entirely unappealing) to would-be snoops. On the other hand, if you’re likely to forget that the disk image named Brautigan Thesis is actually your bank information, use a meaningful name and trust that the encryption safely protects your data.

- Decide where to save the image and set the location in the Where drop-down list.

- Select an appropriate size from the Size drop-down list.

The size of your disk image is a cap on how much information it can store. It’s also how much room the file takes on your hard drive, so choose this value wisely.

- Select AES-128 in the Encryption drop-down list.

This is the key step in making a secure disk image.

- Leave Read/Write Disk Image selected in the Format drop-down list.

4. Click the Create button.

5. At the prompt (see Figure 52-6), enter a password twice and then click OK.

![Figure 52-6: This password allows access to the disk image and its files.]

- If you store the disk image password in your keychain, you can open it without entering the password. This means that anyone else with access to your computer can open it, too. You have to decide between optimal security and more convenience here.

6. Copy files to the mounted disk image.

The disk image is automatically mounted by the operating system. You can now use it like any other disk or folder.

7. Eject the disk when you’re finished with it.

When you need to access the files, remount the disk image by double-clicking on it.
StuffIt

If you pay for the full version of Aladdin System’s StuffIt (www.stuffit.com, $80), you can create encrypted StuffIt and Zip archives. A password is required to access the archives’ contents. If you already have and use this application, then it’s an easy choice for protecting important files.

Mac GNU Privacy Guard

Mac GNU Privacy Guard (http://macgpg.sourceforge.net, free) is a free implementation of the popular Pretty Good Privacy (PGP) software. It provides a framework for using PGP within other applications, such as Mail, Entourage, or Eudora. It requires a little bit of configuration and work on your part, but the price is right.

PGP

This is the commercial version of PGP software (www.pgp.com, $50), which you can use to encrypt your e-mail and create secure disk images. It isn’t free, but it’s easier to get started with than the Mac GNU Privacy Guard.

SubRosaSoft and CodeTek Studios

Both SubRosaSoft (www.subrosasoft.com) and CodeTek Studios (www.codetek.com) develop numerous security-related products, including larger scale packages. For example, CodeTek’s SafeData Technology Suite ($50) cleans out your Internet history, encrypts and decrypts files, and securely trashes files.

Using the Finder’s Secure Empty Trash Option

Most computer users think that once they’ve deleted a file, that it no longer exists but this is not truly the case. What most operating systems do is delete the reference to the file but leave the actual file data on your hard drive until later actions happen to overwrite it. Thus, a normal Empty Trash command has little to no security benefit.

Tiger’s Secure Empty Trash option was introduced in Panther. You find it under the Finder menu (see Figure 52-7). Secure Empty Trash deletes files by writing over the file data on the hard drive before deleting the file’s reference. Think of it like pouring ink on a piece of paper, crumpling it, putting it inside a bag, and then throwing the bag away.

Unlike with the normal Empty Trash command, you can’t recover a file from Secure Empty Trash. For this reason, double-check the contents of the Trash before proceeding with a Security Empty Trash. (You can see what’s in the Trash by clicking its icon in the Dock.)
This feature is pretty easy to use. Just follow these steps:

1. **Trash a file by either**
   - Moving it to the Trash
   - Pressing \-Delete after selecting it

2. **Choose Secure Empty Trash from the Finder menu.**

3. **Click OK at the prompt.**

   If you’d rather not see the “Are you sure?” warning, clear the Show Warning Before Emptying the Trash check box under the Finder’s Advanced preferences panel (see Figure 52-8) or hold down the Option key while selecting Secure Empty Trash (or Empty Trash) from the Finder menu.

   ![Figure 52-8: Clear the Show Warning check box if you trust that you know what you’re doing.](image)

4. **Watch the Trash progress bar in action.**

   Secure Empty Trash takes much longer than the standard method. This makes sense, considering the many extra steps taking place behind the scenes.

   This feature is nice, but most snoops don’t know how to recover data that has been deleted through the standard Empty Trash anyway. The Secure Empty Trash option is great if you either have truly sensitive data to delete or fear that a particularly geeky snoop might get hold of your computer. Otherwise, save yourself some time by sticking to the standard Empty Trash.
Proper Password Policy

The security of your computer partially depends on the passwords you use to log in, access Web sites, and encrypt files. The first step is to choose good, secure passwords. The second step is to use Apple’s keychain technology to manage your passwords for you. Finally, you need to know how to change your login password.

To improve both the convenience and security of using your computer, the Mac OS X operating system uses keychains: virtual places to store and retrieve sensitive information. The first time you use any key (a password required by a file or encrypted disk image, your .Mac account information, or login values used by Web sites), you can opt — through a prompt or check box — to store that information in the keychain. The passwords and such are kept in a secure format so that they aren’t easily viewable. Your keychain (the collection of all of your keys) is unlocked when you log in to your Mac, and the different keys are then automatically used as needed. (For example, when you revisit a Web site or attempt to open a password-protected file, the proper values are entered for you.) Although Tiger handles all of this seamlessly, Tiger’s Keychain Access utility gives you more specific control over your keys and keychains.

Creating a Good Password

Good security begins with selecting good, secure passwords. There are specific recommendations when coming up with your passwords. Here is the party line on the subject:

Good passwords use

- Both letters and numbers
- Both uppercase (capital) and lowercase letters
- At least eight characters
- A combination of symbols and punctuation, if allowed
If those policies help generate good passwords, what is it that you shouldn’t do? Well, check out this list:

- Don’t use words that are in a dictionary.
- Don’t use passwords that people can easily guess, such as
  - Names of your pets, children, or spouse
  - Digits from your phone number, address, birthday, or Social Security number
- Don’t use the same password for multiple things.

The most important consideration is that your login password is unique. Make your login password distinct from the root user’s password, if one has been set.

The problem with these rules is that they can make remembering your passwords impossible. So what can you really do?

- Use the Keychain Access to remember your passwords. See “Working with Apple’s Keychain Access” later in this technique for more.
- Use the first letters of the words in a phrase to come up with a password. Just like you used the mnemonic Roy G. Biv to memorize the colors of the rainbow, you can take a phrase and create an abbreviation to create a memorable password. For example, the abbreviation for the phrase Larry Ullman and Marc Liyanage wrote a book together creates the password **LUaMLwabt**. This makes for a pretty decent password, and it isn’t impossible to recall.
- Take existing words and add numbers and punctuation. For example, you can take the word *original* and turn it into *0r!gina_L*. This password uses upper- and lowercase letters, a number, and punctuation.
- Write down important passwords and store them securely. If you forget your login password, you’re in trouble. If you must write down passwords to prevent disaster,
  - Don’t post it on your monitor.
  - Don’t leave it in a desk drawer.

Don’t keep it in your wallet.
Don’t indicate what the password is for.

If you have trouble creating your own passwords, use the Password Assistant (see Figure 53-1), which you can get to by clicking the question mark when changing your Login password (see later in this chapter). The Password Assistant offers suggestions of good, secure passwords. Because these passwords are random, they’re even more secure than something you thought up!

![Figure 53-1: Tiger’s brand new Password Assistant utility does the thinking for you.](image)

### Working with Apple’s Keychain Access

Mac OS X’s main tool for managing passwords is Keychain Access (see Figure 53-2), found in the Utilities folder. This application stores and retrieves your passwords, including those used by

- Web sites
- E-mail accounts
- FileVault
- iChat
- .Mac accounts
- Encrypted disk images
- Wireless networks
- Servers
Working with Apple’s Keychain Access

• **Figure 53–2:** The Keychain Access tool makes password management easy.

Check out Technique 62 for how you can use the Security panel to require passwords to access your computer after it’s been sleeping, idle, and so forth.

Tiger uses the keychain automatically, so there’s little you need to do to enable it. However, note these best policies here:

- **Use Keychain Access as much as possible.** This is a good, secure application, designed to make your life easier. Take advantage of this!

- **Make a very secure login password.** The keychain uses your login password as its master password. If someone can get into your computer and guess your master password, he can then get access to all your other passwords.

- **Regularly back up the keychain database.** The keychains are stored in your ~/Library/Keychains directory. They’re automatically backed up if you back up your entire Home directory, or you can manually move the files from there to a CD or a USB thumbnail drive (a small, portable hard drive).

The Backup application that comes with a .Mac account ($99 per year) automatically presents your keychain database as an option to back up. See Technique 49.

- **Use the keychain menu bar tool.** If you do a lot with keychains, choose Show Status in Menu Bar from the Keychain Access General preferences panel. This creates a menu bar shortcut to keychain-related tasks (see Figure 53–3).

- **Change the keychain settings for improved security.** Your keychain automatically unlocks when you log in and then remains unlocked. This can be a security risk, particularly if others have access to your computer when you step away. To change this behavior, go to the First Aid preferences panel and deselect all but the top box (see Figure 53–4). Now you have to manually unlock your keychain when you want to access it.

- **When prompted, grant applications permission to always allow access to the keychain.** When an application needs to access the keychain, you see a prompt that lets you choose to deny this, allow this once, or always allow this action. You might as well always allow this so that you won’t have to worry about it in the future.
You can also use your keychain to store sensitive data, such as your ATM PIN or credit card information, by creating a Note. This is a more secure option than placing such information in a plain text file or a sticky note. With the Keychain Access utility, you can encrypt and protect any little tidbit you want. You might want to use this for:

- Recording Social Security numbers
- Listing the serial numbers of your valuable equipment (such as your computers)
- Securing sensitive work-related secrets

Here’s how to create a secure Note:

1. Open Keychain Access by double-clicking its icon in the Applications ➪ Utilities folder.
2. If your keychain is currently locked, unlock it.
   
   You can do this in three ways:
   
   - Click the Lock icon in the upper-left corner.
   - Choose File ➪ Unlock Keychain KeychainName.
   - Press Ô-L.
   
   At the resulting prompt, enter your keychain password — which should be the same as your login password — and press Return.
4. In the resulting prompt (see Figure 53-5), type your note’s name in the Name text box.

   ![Figure 53-5: Use Keychain Access for important information other than passwords.]

5. Type your Note in the Note text box.
6. Click Add to add the Note.

You’re returned to the Keychain Access application itself. To later view the contents of any note, just follow these steps:

1. Open the Keychain Access application.
2. Click Secure Notes in the Category column (see Figure 53-6).

   When you select a category, you see all the keychain items for that category. When you click once on any individual item, you see its information in the top half of the window. This includes the item’s name and modification date. At this point, you can’t see any of the secure values themselves (such as a note’s contents or a password).

   ![Figure 53-6: The list of secure notes.]

3. Double-click the note’s name in the list of keychain items.
4. In the resulting window, select the Show Note check box.
5. Enter your keychain password at the prompt and click Allow Once (see Figure 53-7).

   The Keychain Access password is the same value as your login password, unless you’ve changed the Keychain Access password separately.
Changing the Login Password

Routinely changing your login password is a smart security policy. Some operating systems prompt you to do this every so many months, although Mac OS X does not. (It’s a nice security check, but it’s kind of an inconvenience, too.)

To change your login password

1. Open System Preferences.
2. Click the Accounts icon, under the System heading.
3. Select your account from the list in the left column (see Figure 53-9).

Using Open Firmware Password

To really protect your computer, use of the Open Firmware Password utility. If you enable this feature, people can’t access your computer by booting from another volume. This also means that you need to enter this password to boot from a CD-ROM or even zap your PRAM (the process of resetting your computer’s special parameter memory, which is sometimes required to fix erratic behavior). The basic steps, which are detailed at http://docs.info.apple.com/article.html?artnum=106482, are

1. Make sure that your computer supports Open Firmware Password (see the Web page).
2. Download the installer.
3. Install the Open Firmware Password application.

4. Open the application.
5. Enable the Require Password to Change Open Firmware Settings option.
6. Enter the password twice.
7. Click OK.
8. Quit the application.

Changing the Login Password

The note’s contents appear in the bottom half of the window, as shown in Figure 53-8.

Using Open Firmware Password

To really protect your computer, use of the Open Firmware Password utility. If you enable this feature, people can’t access your computer by booting from another volume. This also means that you need to enter this password to boot from a CD-ROM or even zap your PRAM (the process of resetting your computer’s special parameter memory, which is sometimes required to fix erratic behavior). The basic steps, which are detailed at http://docs.info.apple.com/article.html?artnum=106482, are

1. Make sure that your computer supports Open Firmware Password (see the Web page).
2. Download the installer.
3. Install the Open Firmware Password application.

4. Open the application.
5. Enable the Require Password to Change Open Firmware Settings option.
6. Enter the password twice.
7. Click OK.
8. Quit the application.

Changing the Login Password

The note’s contents appear in the bottom half of the window, as shown in Figure 53-8.

Using Open Firmware Password

To really protect your computer, use of the Open Firmware Password utility. If you enable this feature, people can’t access your computer by booting from another volume. This also means that you need to enter this password to boot from a CD-ROM or even zap your PRAM (the process of resetting your computer’s special parameter memory, which is sometimes required to fix erratic behavior). The basic steps, which are detailed at http://docs.info.apple.com/article.html?artnum=106482, are

1. Make sure that your computer supports Open Firmware Password (see the Web page).
2. Download the installer.
3. Install the Open Firmware Password application.

4. Open the application.
5. Enable the Require Password to Change Open Firmware Settings option.
6. Enter the password twice.
7. Click OK.
8. Quit the application.

Changing the Login Password

The note’s contents appear in the bottom half of the window, as shown in Figure 53-8.

Using Open Firmware Password

To really protect your computer, use of the Open Firmware Password utility. If you enable this feature, people can’t access your computer by booting from another volume. This also means that you need to enter this password to boot from a CD-ROM or even zap your PRAM (the process of resetting your computer’s special parameter memory, which is sometimes required to fix erratic behavior). The basic steps, which are detailed at http://docs.info.apple.com/article.html?artnum=106482, are

1. Make sure that your computer supports Open Firmware Password (see the Web page).
2. Download the installer.
3. Install the Open Firmware Password application.

4. Open the application.
5. Enable the Require Password to Change Open Firmware Settings option.
6. Enter the password twice.
7. Click OK.
8. Quit the application.

Changing the Login Password

The note’s contents appear in the bottom half of the window, as shown in Figure 53-8.

Using Open Firmware Password

To really protect your computer, use of the Open Firmware Password utility. If you enable this feature, people can’t access your computer by booting from another volume. This also means that you need to enter this password to boot from a CD-ROM or even zap your PRAM (the process of resetting your computer’s special parameter memory, which is sometimes required to fix erratic behavior). The basic steps, which are detailed at http://docs.info.apple.com/article.html?artnum=106482, are

1. Make sure that your computer supports Open Firmware Password (see the Web page).
2. Download the installer.
3. Install the Open Firmware Password application.

4. Open the application.
5. Enable the Require Password to Change Open Firmware Settings option.
6. Enter the password twice.
7. Click OK.
8. Quit the application.

Changing the Login Password

The note’s contents appear in the bottom half of the window, as shown in Figure 53-8.

Using Open Firmware Password

To really protect your computer, use of the Open Firmware Password utility. If you enable this feature, people can’t access your computer by booting from another volume. This also means that you need to enter this password to boot from a CD-ROM or even zap your PRAM (the process of resetting your computer’s special parameter memory, which is sometimes required to fix erratic behavior). The basic steps, which are detailed at http://docs.info.apple.com/article.html?artnum=106482, are

1. Make sure that your computer supports Open Firmware Password (see the Web page).
2. Download the installer.
3. Install the Open Firmware Password application.

4. Open the application.
5. Enable the Require Password to Change Open Firmware Settings option.
6. Enter the password twice.
7. Click OK.
8. Quit the application.

Changing the Login Password

The note’s contents appear in the bottom half of the window, as shown in Figure 53-8.

Using Open Firmware Password

To really protect your computer, use of the Open Firmware Password utility. If you enable this feature, people can’t access your computer by booting from another volume. This also means that you need to enter this password to boot from a CD-ROM or even zap your PRAM (the process of resetting your computer’s special parameter memory, which is sometimes required to fix erratic behavior). The basic steps, which are detailed at http://docs.info.apple.com/article.html?artnum=106482, are

1. Make sure that your computer supports Open Firmware Password (see the Web page).
2. Download the installer.
3. Install the Open Firmware Password application.

4. Open the application.
5. Enable the Require Password to Change Open Firmware Settings option.
6. Enter the password twice.
7. Click OK.
8. Quit the application.
4. Click the Change Password button.

5. At the prompt (see Figure 53-10), enter
   - Your current password
   - The new password
   - A verification of the new password

6. Click Change Password.

When you change your login password, Tiger also changes your Keychain Access password. If these aren’t the same, your keychain isn’t unlocked when you log in.

**Resetting the administrator’s password**

If you forget the administrator’s password, you still have some hope: The Mac OS X Installation discs let you reset this value. Boot your computer from the first installation CD. When the installer begins, choose Reset Administrative Password from the Installer menu and follow the prompts.

![Figure 53-10: The Change Password prompt.](image)
A big part of using your Mac effectively is choosing and using the right tool for the job. In this book, we discuss a variety of software options, most of them as a means to a timesaving end. But some applications don’t fit neatly into the predefined categories or otherwise merit their own consideration. In this technique, we go over the benefits — both timesaving and cosmetic — of using a couple more utilities.

Special attention is first given to TinkerTool, one of the best free applications around. Then we mention CronniX, a graphical user interface to the cron scheduling utility. After that, we introduce you to some good maintenance tools. Finally, we give brief notice to a smattering of other software worthy of your consideration.

**Working with TinkerTool**

TinkerTool, which we mention in other techniques of this book because it’s so helpful, is available from [www.bresink.de/osx/TinkerTool.html](http://www.bresink.de/osx/TinkerTool.html) for free. TinkerTool has been consistently developed over the years, and considering its cost — free! — you have no reason to ignore it. Some of the best features of TinkerTool are the abilities to

- Show hidden files in the Finder
- Disable animation effects
- Dim hidden applications in the Dock (see Figure 54-1)
- Align the Dock on the top, bottom, left, or right (rather than the center) of the screen

**Figure 54-1:** With TinkerTool, hidden applications have their Dock icons dimmed (like Preview on the right).
Automating Tasks with cron

One of the cool technologies built into UNIX is cron, a command-line utility for scheduling actions. Seasoned UNIX users define a crontab: a list of what actions your operating system should take and at what times. The cron daemon (a perpetually running process) calls the commands set in the crontab when the time is right. You can control all this from the Terminal (see the “Using cron in the Terminal” sidebar), but the easiest way to control cron is to use CronniX (http://h5197.serverkompetenz.net/cronnix, free).

Some example uses of cron are:
- Scheduling backups
- Accessing Web pages
- Performing maintenance
- Retrieving stock quotes
- Scheduling interactions with databases

The CronniX utility also lets you view the system crontab file (see Figure 54-3) and provides an interface for scheduling your own actions. If you need to take advantage of the cron service, you’d be crazy not to use CronniX. Even if you just want to keep your Mac running well, CronniX can come in handy.

TinkerTool doesn’t really do anything in its own right. What it really does is provide a graphical interface for changing system and application settings that are otherwise difficult to tweak. For this reason, the features of TinkerTool depend on the features of the Mac OS X operating system.

Some of these features are merely cosmetic, but others are very practical.

The popularity of TinkerTool has spurred its creator to break it into two products: TinkerTool (free) and TinkerTool System (approximately $10). The free version is for personalizing your own account settings, which is all most Mac users need. The System version can make system-wide alterations and is oriented more towards advanced Mac users, like network administrators. In this book, including this technique, we focus on the free version, which is what you most likely want. If you’re an IT professional, setting up Macs in multi-user environments, you might appreciate the different features that TinkerTool System provides at a rather inconsequential price.
As an example, your Mac relies on privileges in order to properly deny or allow access to files. These privileges can become muddled, having undesirable results. Fortunately, you can easily fix the permissions by running the Disk Utility’s Repair Disk Permissions tool (under the First Aid tab). But how are you to remember to do this? By letting CronniX do it for you, of course! Follow these steps:

1. **Open CronniX.**

   After you install CronniX, you can double-click its icon to open it.

2. **Choose the appropriate crontab with which you’d like to work.**

   You can establish crons for any user and which crontab you edit affects what commands can actually be executed. For a command to run on an administrative level (like fixing the disk permissions), choose File ➪ Open System Crontab.

   CronniX opens the current user’s (that is, your) crontab by default. Many commands, like accessing a Web page or performing a back up, can be executed through your crontab so there’s no need to open the System crontab file.

3. **Click New.**

   The Schedule prompt appears.

4. **In the Schedule prompt, set these parameters:**

   - **Hour and minute**
     
     Figure 54-4 shows 0 as the minute and 12 as the hour, so this task runs at noon.
   - **Date and month**
     
     We don’t want to limit this task to a date or month, so we select the Any check box.
   - **Day of the week**
     
     To run this task every Wednesday, select We.

5. **Enter the command to be run in the command box.**

   To run the Disk Utility’s Repair Disk Permissions command on the whole hard drive, enter the following code

   ```bash
diskutil repairPermissions /
   ```

   The slash indicates that the repair should be applied to the entire drive.

6. **Click New.**

   You now see the command added to the list of scheduled tasks.

7. **Save the added task as part of the crontab by pressing ⌘-S.**

8. **Enter the administrator’s password at the prompt.**

   Because the added task runs as the administrator, you need to authenticate yourself.

9. **Quit CronniX by pressing ⌘-Q.**
cron works only if the computer is on. If you have a task scheduled to run at three in the morning and your Mac is always off at that time, the task never runs. To work around this, you can use the free utility Anacron (http://www.alastairs-place.net/anacron.html). It remembers tasks and runs them as needed (for example, if something was supposed to happen at 3 a.m. and your computer just came on at 8 a.m., the command will be run then).

**Using cron in the Terminal**

The **cron** utility uses the information stored in the **crontab** file to know what commands to run when. You can edit the **crontab** file in your default text editor by typing **crontab -e** in the Terminal. Here’s the syntax for each **crontab** entry’s time, date, day, and command:

```
minutes hours dates months days command
```

For example, the command entered into CronniX looks like this in a crontab file:

```
0 12 * * 3 diskutil repairPermissions /
```

The time/date/day values in each **crontab** entry follow these rules:

- Each value is separated by a space.
- Values are entered as integer numbers (days are numbers from 0 to 6 so Sunday is 0; months are numbered from 1-12).
- Range values are joined by a hyphen.
  
  For example, if you want a command to run from January through April, the month value is 1-4.

- Multiple entries for the same value are joined with commas.
  
  For example, if you want a command to run at 5, 6, 7, and 9 a.m., the hour value can be either 5,6,7,9 or 5-7,9.

- An asterisk indicates that you want the command to run for each possible value.
  
  For example, If the minute value is *, the command runs every minute (60 times) for each hour that the **crontab** entry is active.

Here are some examples of **cron** entries that you can add to your **crontab** file:

- This displays a calendar every day at 4 p.m.:
```
0 16 * * * calendar
```
- This opens the Yahoo! finance page in your default Web browser every 15 minutes between 8 a.m. and 5 p.m., Monday through Friday:
```
0,15,30,45 8-17 * * 1-5 open
' http://finance.yahoo.com'
```

**Performing Maintenance**

For improved performance and free hard drive space, check out some of the many utilities available for routine maintenance. Most of these utilities do the tasks scheduled as a system **cron** (refer to Figure 54-3) as part of their feature-set. These tasks include things like cleaning out log files and caches. But because those tasks often aren’t run — due to their late schedule — or just to take a more hands-on approach to maintenance, consider the following two applications:

- **MacJanitor** (http://personalpages.tds.net/-brian_hill/macjanitor.html, free): **MacJanitor** gives you a nice interface for performing the scheduled maintenance tasks that your Mac wants to do late at night (while your computer is off). Running this application on your own (see Figure 54-5) can help clear up some hard drive space and perk up an otherwise sluggish Mac.

- Brian Hill, maker of MacJanitor, has a number of other good utilities available at his Web site (http://personalpages.tds.net/-brian_hill). These include Pseudo ($15), for running applications as another, more privileged user; Launcher ($15), a file, application, and directory opening tool; and xFiles ($20), a sophisticated tool for changing a file’s properties.

- **Cocktail** (www.macosxcocktail.com, $15): Cocktail does what MacJanitor does (running system maintenance utilities) and more. It also
lets you tweak network settings, adjust the hidden Finder and Dock options such as TinkerTool, and otherwise fix, tweak, and optimize your OS.

![Image of MacJanitor Console]

*Figure 54-5: Performing system maintenance with MacJanitor.*

### Other Useful Utilities

Without covering their usage in detail, we mention a few more popular and useful utilities. Although not every user needs every one of these, you’re bound to discover something that you didn’t know existed, which might really improve how you use your computer. For example, as great as Dashboard is, its functionality has been available to Konfabulator users for years. For another example, Marc is a huge fan of gestures, a foreign concept to even the very attentive Mac user.

**Pacifist** ([www.charlessoft.com](http://www.charlessoft.com), $20): Pacifist lets you access specific files and folders from package installers. This is very useful if you know you need a particular item but don’t want to reinstall all the software again. If you’d like to get one file from one of Apple’s huge installers, Pacifist can really simplify and hasten that process.

CharlesSoft also makes a free product called DockDisks, which adds mounted disks (CD-ROMs, DVDs, disk images, and so on) to your Dock. With this tool, you can access mounted disks without going to the Desktop.

**Cocoa Gestures** ([www.bitart.com](http://www.bitart.com), **free**): Cocoa Gestures is a clever little tool that lets you associate actions with mouse movements. For example, you could set it so that when you Option-click a file and move up your mouse, the Get Info panel appears. Marc uses Cocoa Gestures to associate mouse movements with the Back and Forward Safari buttons. The Cocoa Gestures functionality is far more useful than you might imagine, and its free price makes it worth trying. If you like Cocoa Gestures, bitart Consulting also offers the $30 CocoaSuite, with many, many added features, including the ability to

- Turn your laptop’s trackpad into a virtual scroll wheel.
- Change existing menu shortcuts in applications.
- Quickly run AppleScripts.

**Konfabulator** ([www.konfabulator.com](http://www.konfabulator.com), $25): Konfabulator is an application that runs *widgets* (little segments of code designed to perform specific tasks) written in JavaScript. Even if you don’t write JavaScript code, you can download hundreds of widgets at the Konfabulator Web site. Looking at a random sample of the widgets, you see that different widgets can

- Download stock quotes
- Get weather reports
- Act as clocks or alarm clocks
- Provide you with simple games to play
- Manage To-Do lists

If you’re thinking that this all sounds quite similar to Dashboard, it is (which indicates how useful Konfabulator is). The price might seem a little high — particularly when you have Dashboard — but the widgets are free, so $25 buys many, many tools at once.

Until people develop more Dashboard widgets, Konfabulator might still be the best option around.
AutoPairs (www.jwwalker.com, free): AutoPairs is a System Preferences addition that constantly runs in the background. It’s useful for programmers in particular because it makes a matching quotation mark, parenthesis, bracket, or curly brace whenever you type the initial one. For example, if you type a left bracket ( [, AutoPairs adds the right bracket (]) and places the cursor between the two so that you can begin typing. Besides saving you an extra keystroke here and there, it helps you avoid errors caused by forgetting a closing mark.
Okay—you were right, I was wrong. F5 opens the garage door, and F6 backs the car out.
Controlling Cellphones with Bluetooth

Mac OS X includes extensive support for Bluetooth, which is a wireless networking standard. Many new Macintosh computers now have Bluetooth hardware built in. It’s an exciting and versatile technology. In this technique, we show several examples of how Bluetooth can help you save time.

Many new cellphones are Bluetooth-enabled. With a bit of configuration, your computer and your cellphone can talk to each other and exchange data. This one-time setup procedure is what we look at first. We also take you on a tour of the things that you can do with Apple’s Bluetooth-compatible applications, and then we highlight some useful third-party applications.

What Is Bluetooth?

Bluetooth (www.bluetooth.com) is a wireless communications protocol used to connect up to seven compatible devices to each other within a limited range, usually less than 30 feet. Designed to be small and inexpensive, integration into today’s digital entertainment and communications gadgets is technically and economically feasible. The list of Bluetooth-enabled devices now includes mobile phones, portable music players, digital cameras, printers, laptops, PDAs, and even computer mice and keyboards.

Because it doesn’t require a clear line of sight between the communicating devices, Bluetooth is more convenient than infrared connections. You can leave your mobile phone in your pocket and still use it to connect to the Internet with a PDA or receive a phone call on your headset.

Bluetooth is designed for lower cost and more versatility than the AirPort/802.11x family of wireless networking protocols (WiFi and its cousins). You use Bluetooth to connect your computer to small communications and entertainment devices; AirPort connects your computer to other computers on a network.
If you want to find out more about it, start by visiting Apple’s Bluetooth Web site at www.apple.com/bluetooth.

Getting Started with Bluetooth

To follow the steps in this technique, both your computer and cellphone need to be Bluetooth-enabled. You have a couple Bluetooth options with Macs.

If you use a recent Mac (such as an aluminum-series PowerBook), it probably includes everything you need for Bluetooth communications.

If your Mac doesn’t have built-in Bluetooth hardware, you have to use a USB Bluetooth adapter. This is a tiny device that plugs into the USB port. (Apple sells these devices for about $50 in the Apple Store. See Figure 55-1.)

Bluetooth has a slower speed and shorter range than AirPort/802.11x.

Getting Started with Bluetooth

You can determine whether your computer’s Bluetooth system is working by checking the Bluetooth system control panel in the Hardware section of System Preferences. If a problem exists, the Bluetooth Device Name is displayed as Not Available.

If you know that you have Bluetooth but it isn’t active on your Mac or your cellphone, follow these recommendations:

- If your Mac uses a USB Bluetooth adaptor, make sure it has a good connection:
  - Unplug and replug it.
  - Make sure that it’s seated firmly in the USB port.
  - Try another USB port (preferably one directly on the computer).

- If your cellphone isn’t available, it might need different settings. Make sure that
  - Bluetooth is enabled on the phone.
  - The phone is in Discoverable mode (either permanently or just for the next few minutes).

These settings vary for each manufacturer, so check the phone’s menu options or documentation for information or specific details.

Setting Up Your Connection

The Bluetooth control panel is where you set up the connection between the computer and phone. This process — pairing two devices — is a security feature to assure that nobody can interact with your Bluetooth equipment without you knowing it.

To set up the connection between your Mac and your phone:

1. On your Mac, open the Bluetooth control panel and click the Devices tab (see Figure 55-2).
2. Click the Set Up New Device button.
   The Bluetooth Setup Assistant launches.
3. Click the Continue button to start.
4. Select the Mobile Phone radio button on the Select Device Type screen (see Figure 55-3), and then click Continue.

5. On the Bluetooth Mobile Phone Set Up screen, select your phone from the list, and then click Continue (see Figure 55-4).

   A numeric passkey appears (see Figure 55-5).

   If your device doesn’t appear in the list, make sure that it’s still in Discoverable mode and that it’s within a short distance of your computer.

6. Tell your cellphone how to connect to your Mac.

   If your cellphone is on and Bluetooth is enabled, your cellphone should recognize that a Bluetooth signal is coming from your Mac. After it does . . .

   a. When the phone asks how to pair the two devices, select the Add to Paired option (see Figure 55-6).

   The specifics for your device might be slightly different, but basically you need to tell the device to accept the request coming from your Mac.
8. If you want to use your cellphone to provide an Internet connection, enter the Internet connection settings that you want to use (see Figure 55-9).

Ask your mobile carrier or ISP for this information if you don’t know it.

Leave the fields empty if you don’t plan to use the Internet connectivity.

9. Click Continue.

You’re finished setting up the connection (see Figure 55-10).

On your Mac, select all the offered services in the Bluetooth Set Up (see Figure 55-8) and then click Continue.

7. On your Mac, select all the offered services in the Bluetooth Set Up (see Figure 55-8) and then click Continue.

b. When the phone asks for your passkey, enter the numeric passkey from your Mac’s screen (see Figure 55-7).

If you don’t plan to use Internet connectivity on your cellphone, leave the Access the Internet option (see Figure 55-8) selected — just leave the fields blank (as in Figure 55-9). Some of the tricks that we show you won’t work unless the phone is configured for Internet access even if you won’t actually use the phone for this purpose.

10. Click the Quit button to leave the Bluetooth Setup Assistant.

The phone is added to the list of paired devices.

You’re now ready to explore the various Bluetooth features.
Working with Your Address Book

The most elegant and useful features of Bluetooth are in Apple’s Address Book application.

To use these features most effectively, always keep all Address Book entries up to date, especially the mobile phone numbers.

Tell the Address Book to look for your mobile phone. Click the little Bluetooth button near the upper-left corner of the window (see Figure 55-11; look for the angular capital B). The button should turn blue — now you’re ready to use your cellphone from within Address Book.

Dialing from within Address Book

To call somebody directly from within the person’s Address Book entry, just follow these steps:

1. Click the category word (such as mobile or work) to the left of the phone number that you want to dial (see Figure 55-11).

A pop-up menu appears.

2. Select the Dial With option.

Your cellphone should now dial the number.

Using the Address Book to call people is much faster than dialing the cellphone itself.

Display incoming call alerts

If you keep the Address Book open and connected to your phone in the background, it pops up a small dialog if somebody calls you (see Figure 55-12). Usually you just pick up the phone and accept the call as usual (or click the Answer button). If you can’t take the call, you can use one of the other options offered by the dialog:

- Voice Mail forwards the call to your voice mailbox so the caller can leave a message there.
- SMS Reply rejects the call and allows you to send a short text message to the caller’s cellphone (like “I’m in a meeting right now, will call back”).
- Log Call adds a short entry to the Notes section of the person’s card in the Address Book.
- If the incoming cellphone number isn’t yet known in the Address Book, an Add Card button lets you add a new card in the Address Book for the calling person.
Technique 55: Controlling Cellphones with Bluetooth

Sending and receiving SMS messages

SMS stands for Short Message Service. It’s available on some advanced cellular networks. Using SMS, a short alphanumeric message of up to 160 characters can be sent to a cellphone. The receiving device displays the message and allows you to respond. Replacing the functionality that people used to get from pagers, SMS messaging is much like Instant Messaging over a phone.

If you use your cellphone to send text messages, you know how awkward and annoying typing them on a tiny phone keypad can be. Address Book lets you send and reply to text messages with the comfort of your computer keyboard.

 jika someone sends you a new message and Address Book is hooked up to the phone, your computer displays the text in a pop-up window (see Figure 55-13). To reply:

1. Click the Reply button.
   An empty text field appears.
2. Type your message.
3. Click Send (see Figure 55-14).

To send a new message, follow these steps:

1. Open the Address Book.
2. Find the person’s card to whom you want to send the message.
3. Click the Mobile category label to the left of the mobile phone number.
4. Choose SMS Message from the pop-up menu that appears (see Figure 55-15).
5. Type your text into the field that appears and then click Send.
Your Mac has a much better keyboard than the phone’s 10-digit keypad! Use your Mac when you can.

**Dialing Your Phone from a Text Selection**

You can download a great little (and free!) application called T68iDialer that dials phone numbers that you select in any piece of text. For example, if you find a phone number on the contact page of a company’s Web site, T68iDialer lets you select that phone number with the mouse and then dial it immediately on your cellphone. How cool is that?

This program currently works with the T39m, T68m, or T68i Ericsson cellphones. It might work with others, and because it’s free, you can try it with no commitment. As of this writing, we don’t know of a similar utility for other cellphones, but they’re bound to come along sooner or later.

T68iDialer publishes a service to accomplish its function. (See Technique 29 on Services for more information about how Services work.)

Here’s how to try out the T68iDialer:

2. Move the application into the Applications folder.
3. Log out of your Mac and log back in.
4. Launch any program that supports Services.

   Mail is a good choice because many e-mail messages end with a signature that includes phone numbers.

5. Select a phone number and choose Mail::Services::Dial Number (see Figure 55-16).

   T68iDialer launches (if it isn’t already running) and inserts the phone number into the corresponding field in its main window.

6. Click Dial to dial the number (see Figure 55-17).

   Enable the Service Dial Immediately option in the program’s preferences. That way, you don’t have to click the Dial button anymore. Instead, T68iDialer dials the selected number as soon as you choose the Service menu command.

**Synchronizing with iSync**

Bluetooth-equipped cellphones usually have an Address Book and a Calendar. Some of these phones can be synchronized with the Address Book and iCal data on your computer with Apple’s iSync application.
Technique 55: Controlling Cellphones with Bluetooth

Synchronization means that

- All data is available in both places.
- Any additions or changes made on either the computer or the mobile phone are effective on the other device.

For example, if you add to new contact information to your cellphone’s address book, this information is automatically transferred into a new card in your Address Book application on the Mac the next time you synchronize the computer with the cellphone. On the other hand, if you add a new card for a person while working at your computer, you don’t have to remember to also store the person’s mobile phone number into your phone manually; synchronization does this for you automatically.

To discover whether your particular phone (or a phone that you’re thinking about buying) can be used with iSync, go to Apple’s device compatibility list at www.apple.com/isync/devices.html. The best way to be sure is to check that list . . . or to try it out before buying, if possible.

**Setting up iSync**

To start synchronizing with your phone, you need to add it to iSync’s list of devices, unless the Bluetooth Setup Assistant has already done so.

- iSync is really good at recognizing available devices, so you might or might not need to go through these steps to add a device.

1. **Launch iSync.**
2. **Choose Add Device from the Devices menu.**
   Your phone should appear in the list of recognized devices (see Figure 55-18). If it doesn’t, put your device into Discoverable mode and try again.

3. **Double-click the phone to add it to iSync’s list.**
   New in Tiger is the iSync Agent, which makes syncing your device much easier. If, during these steps your Mac suggests that you perform some extra tasks (such as installing other software), trust its recommendation and just follow the instructions.

4. **In the For First Sync drop-down list, select the first-time data synchronization behavior option that you prefer.**
   Use the Merge Data on Computer and Device option unless you really want to erase all existing Contact and Calendar information on the phone (see Figure 55-19).

5. **Use the check boxes and drop-down lists to indicate what to synchronize (contacts and calendars).**

6. **Click Sync Now.**
   After you set up iSync to work with your cellphone, you only have to click Sync Now to start the synchronization. It usually takes a while, especially for the first synchronization. You should sync regularly because this feature is most useful when all data is up to date all the time.
You should enable the iSync menu bar icon in the application’s preferences, which you can find in the iSync menu. This allows you to start a synchronization very quickly without having to launch iSync.

**Your Cellphone as a Remote Control**

If you use a Sony Ericsson cellphone (or a Palm PDA), you can use one of the hottest Bluetooth-related utilities, Salling Clicker ([www.salling.com](http://www.salling.com), $10). It installs a menu on your phone that allows you to control your computer from the phone or to view information about the computer on the phone’s display. Examples of some things you can do include:

- Starting, stopping, or skipping music in iTunes
- Displaying information about the current iTunes song
- Controlling DVD playback
- Adjusting or muting the sound volume
- Controlling slides in a presentation program, including the ability to display slide notes on the phone’s display

Salling Clicker also has a **proximity sensor**. You can use this to trigger certain actions when you (or more accurately, your cellphone) enter or leave the proximity of your computer. Examples include:

- Stopping iTunes or muting the volume when you leave the room
- Restarting iTunes when you return to the machine
- Changing your iChat availability when you leave or return.

Here’s how to quickly get started with Salling Clicker:

1. **Download and install the software.**
2. **Open the Salling Clicker panel in System Preferences.**
3. **Click Select Phone and choose the cellphone on which you’d like the menu installed.**
   
   If the phone you would like to use as a remote control doesn’t appear in the list, make sure that the phone is in Discoverable mode.

4. **In the main Salling Clicker window, click the Connect to Phone button to install the menu on your phone (see Figure 55-20).**
   
   If the connection setup was successful, you can now control your Mac from the special menu that was installed on your phone.

   The location of the menu in the phone’s screens varies depending on the model that you have. On Marc’s T68i, it’s under Connect→Accessories. Have fun!
Technique 55: Controlling Cellphones with Bluetooth

• Figure 55-21: Enabling the Bluetooth menu.

Storing Notes and Pictures on a Cellphone

Modern Bluetooth phones can accept text and picture files. The text feature is especially handy for storing items like shopping lists, travel itineraries, and travel directions.

Tiger includes the Bluetooth File Exchange application to send files to and from a mobile phone. Make sure to select the Show Bluetooth Status in the Menu Bar check box on the Settings tab of the Bluetooth control panel (see Figure 55-21). That way, you always have instant access to the File Exchange application by choosing the Send File command from the menu (see Figure 55-22).

An even quicker way to send short snippets of text to your cellphone is to use a Services menu command. Follow these steps to add the command:

1. Download the free Services menu extension called BlueService.
   

2. Copy the BlueService file into the Library/Services folder in your Home directory.

3. Log out of your Mac and log back in (which enables the newly added Service).
Follow these steps to send the text from your Mac to your cellphone:

1. **On your Mac**, select a piece of text in an application that supports Services, and then choose Send to Bluetooth Device from the ApplicationServices menu.

   Your note should be transmitted to the cellphone.

2. **On your phone**, choose Accept to receive the file and store it.

   Each cellphone manufacturer uses a different message. Check the documentation for your model if you’d like more info on how to accept a file.

Some applications don’t support Services. First try this command in an application that you know works with Services, such as Safari or Mail first.
The Terminal, the Finder, and You

The Terminal is Tiger’s bridge between the beautiful Mac interface and the awesome UNIX infrastructure. Still, you don’t have to be a UNIX geek to use and appreciate this application. After you discover the basics of getting around and have picked up a few key commands, you’ll see how useful the Terminal can be.

In this technique, we begin with the quickest and easiest ways to move around within the Terminal. Then we demonstrate some cool and handy tricks to use, including how you can use the Terminal and the Finder together. Finally, we cover some efficient ways to make edits in the Terminal.

If you have some UNIX and command line experience, you’ll be thrilled to see how most of those skills (plus a few more) apply to your Mac. If you’ve never tinkered in this area before, this and the subsequent techniques open a whole new — and quite useful — universe to you.

Navigating within the Terminal

When you start using the Terminal, you figure out pretty quickly that the standard Finder navigation techniques don’t work. In fact, without mastering some commands, you can’t get anywhere in the Terminal. Luckily, figuring out these things isn’t hard.

The Terminal window greets you with a lot of information (see Figure 56-1). The most important of this is the command prompt line itself, which is where you find the cursor. This line is formatted as

\[\text{ComputerName: CurrentDirectory CurrentUser}\]

In Figure 56-1, you can tell that Larry is connected to his G4 iBook, that he is in his Home directory (indicated by the tilde; ~), and that he is logged in as the user named larry. The $ reflects that Larry is logged in as a normal user. (A number sign indicates a root user — techie speak for a user with unlimited power.)
Navigating within the Terminal

If you ever forget where you are, you can use the `pwd` (print working directory) command to have the Terminal tell you (see Figure 56-2).

Getting around in the Terminal

When you know where you are, it’s time to get a move on. To move around within the Terminal, you use the `cd` (change directory) command, like this:

```
    cd /path/to/directory
```

To go to the Applications directory, enter `cd /Applications` (as shown in Figure 56-3). This is the equivalent of opening a folder in the Finder (by double-clicking or otherwise).

Tab completion

The best tool to use in the Terminal — which is unbelievably helpful — is **tab completion**. Tab completion automatically completes words for you, requiring less typing and cutting down on the number of errors that you might make. For example, to use tab completion...
to move into the Mac OS X TST FD folder within the Books folder within the Documents folder of your Home directory (as a completely hypothetical example), do this:

1. Open the Terminal application, which you can find in the Utilities folder.

2. In the Terminal window, type cd.

   The command that you want to eventually type is
   
   cd ~/Documents/Books/Mac\ OS\ X\ TST\ FD
   
   For this example, you need to type the command (cd) itself and then use tab completion as much as possible.

   Spaces in filenames are common in the Finder but somewhat problematic in the Terminal because a space delineates a command. To work around this potential problem, escape the space by using the backslash, as in Mac\ OS\ X\ TST\ FD, which looks like Mac OS X TST FD in the Finder. Escaping is the process of preceding problematic characters with a backslash, so that they don’t cause problems. In this example, the backslash-space combination is interpreted as a space character.

3. Type ~/Doc (see Figure 56-4).

   To get to this destination, you must first go into the Documents directory. Because the Terminal automatically starts you in your Home directory, you can make a relative path to it (just start typing Doc) or you can be extra precise by starting with ~/ before the Doc.

   Capitalization matters!

   You can move around by using either absolute or relative paths. An absolute path is accurate no matter where you’re currently located. A relative path is accurate only with respect to your current location. For example, /Users/larry/Documents/Books/ is an absolute path (as is ~/Documents/Books/), but Documents/Books/ is relative (and accurate as long as Larry is currently in his Home directory).

4. Press Tab.

   The remaining folder name (Documents/) should be filled in automatically.

   If the Terminal can’t find a match for tab completion, it does nothing. If it finds several matches, it either does nothing or completes the text that all the matches have in common. For example, if a directory contains filename.txt and filename.pdf, and you type fi and try to do a tab completion, the Terminal returns filename. (with the period). Pressing tab again normally returns a list of potential options.

5. Type Bo and press Tab.

   The folder name Books/ is filled in automatically.

6. Type Mac and press Tab.

   The folder name Mac OS X TST FD is filled in automatically (with the spaces escaped).

7. Press Return to complete the command (see Figure 56-5).

   You can use tab completion on files and directories. You can also use it with practically any command, not just cd.
Navigating within the Terminal

• Figure 56-5: Execute a long command with a minimum of typing.

Viewing directory contents

If you’re in a directory and need to see what’s there, use the `ls` (list) command. The `ls` command presents you with a list of a directory’s contents, much like you would see in a Finder window . . . but without the icons. Common ways to use `ls` include:

- Type `ls` to list the basic contents of the current directory.
- Type `ls -G` to show the list in color (assuming that the Disable ANSI Color check box isn’t selected in the Terminal ➪ Window Settings ➪ Color panel).
- Type `ls -a` to show every file, including hidden ones.

The `-a` flag makes the `ls` command show many other items. These include hidden files (filenames that begin with a period), a line for the current directory (marked by a single period), and a line for the parent directory, if one exists (marked with two periods).

- Type `ls -l` to show more file information.
- If you like, you can combine parameters, (for example, `ls -al` or `ls -aG`).
- Add a directory name to view a directory other than the one you’re in. Here are three ways to do it:
  - `ls -G ~/Documents`
  - `ls -al /usr/local/php`
  - `ls /Applications/Utilities`

To see the last of the three examples in action, take a glance at Figure 56-6.

• Figure 56-6: You can view a directory’s contents without being in it.

Navigating among open Terminal windows

The Terminal opens a new window for you when you open the Terminal application, but you don’t need to restrict yourself to just a single session. You can open more windows by either choosing File ➪ New Shell or using the ⌘-N keyboard shortcut.

Each Terminal window opens with the default user logged in and located in their Home directory. There is no relationship between different Terminal windows, and no history is maintained from one to the other.

Working with multiple Terminal windows is great if you’re trying to accomplish many things at once. If you’re working in two directories at the same time, you can use two windows (one for each directory) so that you don’t have to keep moving yourself around.

When you have multiple Terminal windows open, you can easily move from one to the other:
Technique 56: The Terminal, the Finder, and You

Use ⌘← and ⌘→ to move back and forth.

Use ⌘-- to rotate among them.

Use ⌘-1 to access the first window, ⌘-2 to access the second, and so forth.

Other commands
Here are a few other must-know commands that we should mention:

- clear: Clears the Terminal screen.
- Control-C: Stops the currently running command.
- exit: Logs out (see Figure 56-7).

• Figure 56-7: When you’re done using the Terminal, log out with exit.

You can set the Terminal to automatically close the window after you exit. Check out Technique 60 or the Shell panel of the Window Settings panel.

Terminal Tips and Tricks

In the next four techniques, we cover various tips and tricks involving broader subjects — finding files, handling output, viewing files, and customization. Here we include a few miscellaneous little tricks that you’ll appreciate.

Getting help

The world of UNIX is a world of commands, but you’d have to be a genius to remember how to use them all. Fortunately, you don’t have to. Most commands come with a help manual (called man files) you can read. For example, to find help for the ls (list) command, do the following:

1. Open the Terminal.
2. Type man ls.

This displays the manual for the ls command (see Figure 56-8).

• Figure 56-8: The manual for the ls command.

3. Scroll through the manual with these keys:
  - Press the spacebar or F to go forward.
  - Press B to go backward.
4. Press Q to quit (at any time).

Many commands have a help option, which is like a short version of the manual. If it’s supported by a command, you type command-name --help to see that command’s help information.

A command of history, or a history of commands

One of the best ways to save time is to make use of the Terminal’s memory. We don’t mean memory in a RAM sense; the Terminal remembers your history of commands. For example, you can use history to re-enter a previously used command:
1. Press the up arrow to display the previously entered command.
   Continue to press the up arrow to find earlier commands.
2. Press the down arrow if you went too far.
3. Edit an existing command as needed.
4. Press Return to re-execute it.

A more elaborate but related tool is the `history` command. After you’ve used the Terminal for a while, type `history` and press Return (see Figure 56-9). The `history` command shows you what you’ve done (in order), numbering each command. With this knowledge, you can

- Type `!n` to repeat a command listed by `history` (n is the line number associated with the command).
  As you can see in Figure 56-9, each command is numbered. To rerun the `pwd` command, for example, type `!4` and then press Return (see Figure 56-10).
- Type `!command` to repeat the last version of a specific command (see Figure 56-11).

![Figure 56-10: Repeat commands with the !n syntax.](image)

This version of the history trick tells the Terminal to repeat the last version of whatever the command was. For example, `!ls` might actually call `ls /Applications/Utilities`, which you had previously entered.

Don’t use the `!command` trick with the `rm` (remove) command. This probably permanently removes something that you don’t want to remove. Or, it might attempt to remove something that you’ve already deleted (because that command has already been run).
Use the !command:p or !n:p syntax to see what a command would be (see Figure 56-12).

The :p addition reminds you of what a particular command was without executing it. You can use it with the numbering system (!4:p) or with the command syntax (!ls:p).

![Figure 56-12: The :p flag gives you a preview of what command a shortcut would be.](image)

Role playing: Executing commands as another user

One trick that you inevitably need to know is how to execute commands as other users. These are common situations:

- You need to execute a command as a more powerful user.
  
  For example, you may need to pretend to be the super-powerful root user. I explain this concept in the sidebar.

- You need to access another user’s files (on your Mac or another).

The `sudo` command lets you run a command as another user. In the following example, we show you one use of `sudo`: controlling the built-in Web serving application:

1. Open a Terminal window.
2. Try starting Apache by using `apachectl start` (see Figure 56-13).

You can control the Apache Web server through the Sharing System Preferences panel or via the command line by using `apachectl`. However, you must be an administrator to use the command line. Therefore, trying to control Apache as yourself creates errors.

![Figure 56-13: Even administrators can’t start Apache when logged in as themselves.](image)

3. Type `sudo apachectl start`.
   
   To run any command as a more powerful user, preface it with `sudo`.

4. Enter your administrative password at the prompt (see Figure 56-14).

![Figure 56-14: The first time you use sudo, a strong warning is displayed.](image)

You need to use `sudo` when you get a permission-denied error message in the Terminal.

The `sudo` command recalls your administrative password for five minutes after you last used it. If you don’t use `sudo` for a few minutes, you’re required to enter the password again.
Creating a root user

Your Mac has many users on it, users that are entirely different than those you use to login and access the computer. Of these system users, the most critical is the root user. The root user has unlimited powers but isn’t enabled by default. This is a good thing because it protects your computer from highly detrimental mistakes (only the root user can do very serious damage).

On the other hand, working as the root user is sometimes useful. Switching over to the root account lets you do those things you need to do without preceding each command with `sudo`. To use the root user feature, you must enable it and create a password, by following these steps:

1. Open the NetInfo Manager application, which you can find in the Utilities folder.
2. Choose Security ➪ Authenticate.
3. At the prompt, enter your administrative password.
5. Read the prompt (shown here) and click OK.
6. Use the second prompt (see the accompanying figure) to enter the new password and then click OK.
7. Quit the NetInfo Manager.
8. In the Terminal, type `su root` and press Return.
9. Enter the new root user’s password.
10. Be very, very, very careful!

Even though you can create a root user password, you really, really should avoid creating it unless you really know what you’re doing and absolutely need a root user.

Making the Terminal and the Finder Play Together Nicely

One of the nice things about the Terminal is how easily it interacts with the Finder. Here you find a couple tricks to make interactions between the two more seamless.

Using the open command

The `open` command is a pretty useful little tool. It uses the Finder to open a file, directory, or even a URL. Essentially, `open` works in the Terminal exactly the way opening a file, folder, URL, or application works in the Finder.

- `open .`: Opens the current directory in a Finder window (see Figure 56-15).
- `open directoryname`: Opens the directory in a Finder window.
- `open /Applications/application_name`: Opens the application.

Marc has created an AppleScript that can be added to your Finder window toolbars (www.entropy.ch/software/applescript/welcome.html, free). When you click it, it opens the Finder directory in the Terminal.

- Applications in the Applications folder can also be opened by using the `-a` (open with application) flag (for example: `open -a Calculator.app`).
4. Navigate to the directory that you want to use in a Finder window.

5. Click the directory’s proxy icon in the window’s title bar and drag the icon into the Terminal window.

6. Switch back to the Terminal (see Figure 56-16).

7. Press Return to execute the command.

You can drag and drop anything from the Finder into the Terminal, including folders, files, and applications.

**Editing between the Terminal and the Finder**

You can also make edits between the Terminal and the Finder. You use the Clipboard (of course) to temporarily store and retrieve text, but you have two ways of using it:

- You can select text in the Terminal by using the mouse and then pressing Ô-C to copy it.
- You can use the `pbpaste` and `pbcopy` commands.

These two commands are very handy but require **piping**. Head over to Technique 58 for information on piping and how to use it with `pbpaste` and `pbcopy`.

---

**Drag and drop with the Finder**

If the tab completion trick that we discuss in an earlier section isn’t good enough for you, here’s another timesaver: You can drag and drop items from the Finder into the Terminal.

1. Open a Terminal window.
2. Type `cd`, followed by a space.
3. Switch to the Finder.

**Figure 56-15:** The `open` command makes quick transitions between the Terminal and the Finder.

- `open http://www.espn.com`: Opens the URL in your default Web browser.
- `open -a ApplicationName filename`: Opens the file in the particular application.
- `open -e filename`: Opens the file in TextEdit.
Managing and Finding Files Fast

You can do countless tasks with the Terminal and a command line interface. Many of them, including managing and finding your files, you actually can do faster in the Terminal than in the Finder. Plus, the command line options provide for flexibility and automation of tasks that can’t be replicated elsewhere.

In this technique, you find out the easiest ways to copy, move, rename, and delete your files and directories by using the Terminal. Then you see two ways to search your hard drive for files and directories.

**Copying, Moving, Renaming, and Deleting Files**

Managing your files in the Finder is easy and relatively quick. But you can also perform the same tasks in the Terminal with many benefits. For example, you can

- **Move or copy files** from one folder to another without having multiple windows open.
- **Delete files** without having to empty the Trash. (It’s a one-step process.)
- **Manage files** by using just a few commands, not a bunch of keyboard shortcuts.
- **Apply changes to files** that meet a certain naming scheme.

To copy a file, use the `cp` (copy) command:

```
cp source target
```

For example, to make a copy of `myfile.jpg` called `myfile2.jpg` (both of which are in the current directory):

```
cp myfile.jpg myfile2.jpg
```
```
cp ~/Documents/Books/chapter.doc ~/Desktop/chapter.doc
```
To copy an entire directory, add the -R flag (you must use a capital R):

```
cp -R myfolder ~/Desktop/myfolder
```

The `cp` command doesn't warn you if you're about to overwrite an existing file (as the Finder does). To prevent doing something you'll regret, use the -i flag: `cp -i source target`. Then `cp` prompts you before overwriting an existing file (see Figure 57-1).

To delete a file, use the `rm` (remove) command:

```
rm filename
```

Be very, very careful with the `rm` command. Unlike deleting something in the Finder — which places the item in the Trash to be deleted (emptied) or recovered later — the `rm` command is an immediate deletion. The command has a `-W` (capital W) flag that attempts to undelete a deleted file. It might let you undelete a file for a few minutes after deletion, but you can't count on that.

The `rm` command can also delete directories, using the `-R` flag:

```
rm -R mydirectory
```

If you want to move a file, use the `mv` command:

```
mv source target
```

For example

```
mv myfile.txt ~/Desktop/myfile.txt
mv ~/Desktop/afolder /Volumes/Main/afolder
```

Like the `cp` command, the `mv` command doesn't warn you if you're about to overwrite an existing file. Use the -i flag to be prompted when this might happen.

No actual rename command exists in the Terminal. Instead, use `mv` and provide a new name:

```
mv myfile.txt newname.txt
mv ~/Desktop/afolder ~/Desktop/bfolder
```

The `mv` command can't create a path, but `cp` can. In other words, if you try to copy `filename.txt` to `/Users/larry/Document/newfiles/filename.txt` and the `newfiles` directory doesn't exist, the `cp` command creates it for you.

To copy an entire directory, add the -R flag (you must use a capital R):

```
cp -R myfolder ~/Desktop/myfolder
```

The `cp` command doesn't warn you if you're about to overwrite an existing file (as the Finder does). To prevent doing something you'll regret, use the -i flag: `cp -i source target`. Then `cp` prompts you before overwriting an existing file (see Figure 57-1).

To delete a file, use the `rm` (remove) command:

```
rm filename
```

Be very, very careful with the `rm` command. Unlike deleting something in the Finder — which places the item in the Trash to be deleted (emptied) or recovered later — the `rm` command is an immediate deletion. The command has a `-W` (capital W) flag that attempts to undelete a deleted file. It might let you undelete a file for a few minutes after deletion, but you can't count on that.

The `rm` command can also delete directories, using the `-R` flag:

```
rm -R mydirectory
```

Command names (`rm`, `cp`, `mv`) are case-insensitive, so `RM`, `Cp`, and `Mv` work equally well. Flags (like the `-R` flag added to `rm`), filenames, and directory names are case-sensitive.

As with `cp` and `mv`, the -i flag asks for confirmation before completing the deletion.

The absolute worst command that you can ever use is `rm -R /`, which attempts to delete everything on your computer. To avoid running this risk, don't use `rm` with `sudo` (see Technique 56), don't use `rm` when you're logged in as root, and always use the -i option to be prompted before disaster strikes.
Another common Finder trick that is replicated in the Terminal is the ability to make an alias. In UNIX terms, these are symbolic links. They’re created with the `ln` (make link) command.

```
ln -s file alias
ln -s directory alias
```

### Creating and Listing Directories

If you’re in the Finder, you always see a directory’s contents whether you’re in icon, list, or column view mode. In the Terminal, you don’t see any directory contents unless you specifically ask for them by using the `ls` (list) command. (See Figure 57-2.)

```
ls
ls ~
```

![Figure 57-2: The listed contents of Larry’s Home directory.](image)

The nice thing is that the `ls` command lets you view the contents of a directory you’re not even in! For example, to see the contents of the Games folder, use

```
ls /Applications/Games
```

Like most commands, `ls` takes several arguments.

- `-a`: View every file, including hidden ones (see Figure 57-3).
- `-A`: View every file, including hidden ones, without listing the current and parent directories (see Figure 57-4).
  
  - The current directory is represented by one period.
  
  - The parent directory is represented by two periods.

- `-l`: Use `-l` (lowercase L) to view more information about the directory contents (see Figure 57-5).

- `-r`: Sort the directory contents in reverse order by name.
-S: Sort the directory contents by size in descending order.

-t: Sort the directory contents by date and time in descending order.

You can delete all the files that begin with the word *chapter*:

```bash
rm -i *chapter
```

The best way to figure out how to use wildcards is to test your command first by preceding it with `echo`. The result of this is to display (in the Terminal screen) the affected files without actually affecting the files (see Figure 57-6).

![Figure 57-6: Use echo to preview the results of a command.](image)

Run your `rm` commands with `echo` first to see the effect before you remove a bunch of files.

### Using the `find` Command

The `find` command alone is a really good reason to use the Terminal. It provides a quick and flexible search capability. Although you can use `find` in many different ways, the easiest way to use it is like so:

```bash
find -f directory --name 'filename'
```

For example:

```bash
find -f ~/Documents --name 'chapter.doc'
```

To search for a file in the current directory, use

```bash
find . --name 'filename'
```

Other options include the ability to search for files by type. A type of `f` restricts the find to files, and `d` limits it to directories.

```bash
find -f ~ --name 'book*' -type f
find -f ~ --name 'book*' -type d
```
Using the locate Command

You can add a number to the end to indicate a modification date within a certain number of days from now. The following applies only to files modified in the last 24 hours:

```
find -f -name 'book*' -type f -1
```

The `find` tool can also be used without a filename, in which case it returns all the contents for the named directory and all its subdirectories, as shown in Figure 57-7:

```
find ~/Sites
```

• Figure 57-7: All the directory contents and subdirectory contents are listed by using `find`.

In this way, the `find` tool can be a much more potent version of the `ls` command. In fact, another easy-to-remember trick is to use the `-ls` flag with `find`, as shown in Figure 57-8:

```
find ~/Sites -ls
```

• Figure 57-8: The same directory as in Figure 57-7, displaying more information.

All in all, the `find` tool is one of the most useful command line utilities. As an example, if you’re looking for a file called something like `quotes.doc` or `quotations.doc`, and it’s somewhere in your Documents directory, do this:

1. Open a Terminal window.
2. Type `find -f ~/Documents -name quot*.doc -type f` and press Return (see Figure 57-9).

   This command searches through the Documents directory (and its subfolders) looking for a file whose name begins with `quot` and ends with `.doc`.

   • Figure 57-9: The directories searched and the files found are returned.

3. If you see your desired file, open it with `open /path/to/filename`.
4. If you don’t see your desired file, rerun the `find` command with new parameters.

   You can also use `grep` to find files. `grep` is a regular expressions tool (regular expressions being a very useful, and not easy to learn, method of creating patterns to match). For more information, either see a good UNIX (or regular expressions) book or search the Internet for tutorials.

Using the locate Command

Another option for finding files is to use the `locate` command. But before you can use this, you need to create the `locate` database and then update this database often. You use the `updatedb` command to create and update the `locate` database:

1. Open a Terminal window.
2. Type `sudo /usr/libexec/locate.updatedb` to create the database.
3. Type `locate filename` to look for a particular file.
locate is faster than find but requires the initial creation of a database (which is really just an index) to function. Here are some tips for getting the most out of this simple command:

- Run the updatedb tool often (to update the database) for your searches to be up to date and accurate.
- Create a cron (see Technique 54) to automatically run the updatedb command.
- Use wildcards in your filename to create a more flexible search.
- For a good tutorial on locate, see www.kingcomputerservices.com/unix_101/using_find_to_locate_files.htm
Most beginning command line users are able to execute simple commands in the Terminal to accomplish basic tasks. But the advanced user also understands the concepts of standard input and output: controlling where a command’s results are directed. You can do this with piping and redirection output. This technique focuses primarily on those two subjects, but we first discuss a few other useful commands that you can use with piping.

**Handy Commands to Use with Piping**

This book’s techniques relating to the Terminal cover the most efficient ways to use the most common and useful commands, but we also want to mention a few other tools that you’ll likely appreciate. These commands can be used independently, but they’re particularly useful with piping and output redirection.

You can use the `wc` (word count) command to count the number of lines, words, and characters in a file:

```
wc filename
```

```
wc chapter58.txt
```

The output of this command is very simple. It returns the number of lines, words, and characters (see Figure 58-1). In the figure, you can see that the Installer Log File contains 0 lines, 3,803 words, and 47,647 characters. If you want to see only some of these values, use the different flags to control output:

- `-l`: For lines
- `-w`: For words
- `-c`: For characters
You can actually use `sort` to see whether a file is already sorted: Use `sort -c filename`.

The `ps` command lists currently running processes (think `process status`). A `process` is UNIX-speak for a running application, service, or technology. This command is very easy to use:

```
ps flags
```

The relevant parameters (flags) for this command are:

- `a`: Shows all processes, not just the ones you’re running.
- `c`: Shows a minimal version of the process name.
- `m`: Sorts the list of running processes by memory usage.
- `r`: Sorts the list of running processes by CPU usage.
- `U`: Shows the process for a particular user.

The functionality of the `ps` command is duplicated in the Finder by the Process Viewer utility.

Finally, the `du` command displays disk usage statistics. It takes several flags:

```
  k: Returns the statistics in megabytes.
  h: Makes the result more readable for humans.
  s: Shows the results for every file.
  c: Totals the statistics.
```

Here are several practical examples of this command:

- To view the total disk usage of the current directory, type `du -sh` (see Figure 58-2).
- To see the disk usage of individual files in the current directory (and its subdirectories), type `du -h` (see Figure 58-3).
Combining Commands with Pipes

Pipes are one of the most important timesaving command line tools. As you can see, commands normally send their output (the result of the command) to the display (the Terminal). By using pipes, you can send the output of one command to be used as the input for another. This is accomplished by the pipe operator, a vertical bar (created by pressing Shift-backslash), to join multiple commands together:

```
output_command | input_command
```

For example, here’s how you find the number of processes that you have running:

- Type `ps -auxU username` to see all your processes.
- Type `ps -auxU username | wc -l` to view the number of your processes (see Figure 58-6).

To display the disk usage of a specific directory, type `du -h ~/Desktop` (see Figure 58-4).

To view the size of a specific file in kilobytes, type `du filename` (see Figure 58-5).

• Figure 58-2: Larry’s Home directory uses a whopping 3.9MB of space.

• Figure 58-3: The du command can show the size of every file.

• Figure 58-4: You can limit du to a specific directory.

• Figure 58-5: Show a file’s size.
The `find` command returns all the files in the current directory and subdirectory. This list is then sent to the `grep` utility, which allows you to perform very flexible searches. In this case, `grep` finds every file that includes some version of `tif` (The `i` flag means that it should ignore case.) The result is then sent to the Terminal (see Figure 58-8).

Another good use of piping is to find the largest directories on your computer. You can do this by combining the `du` and `sort` commands (see Figure 58-9).

If you want to see how many items you have in a particular directory, do this:

- Type `ls directoryname` to list the files in the directory.
- Type `ls directoryname | wc -l` to view the number of files in the directory.
- Type `ls -A directoryname | wc -l` to view the number of files in the directory, including hidden files (see Figure 58-7).

If you want to find every file with an extension of `TIFF` or `TIF` or `tiff` or `tif`, you can use the `find` command with `grep`:

```
find . | grep -i tif
```
du -sk * | sort -nr

The du -sk * syntax calculates the size of all the items (indicated by the asterisk) in the current directory. (Larry was in his Home directory when he ran it, so it checked his files.) This is then piped through the sort command, which places this list in numerically reverse order. You can repeat this process for other folders by using cd to go into a directory and then using the history command’s !du (see Technique 56) to repeat this piping procedure:

    cd Library

    !du

The pbpaste and pbcopy commands allow you to move data on and off the Clipboard while you’re working with the command line. This means that these two commands are the ultimate glue for transferring text between regular Mac applications and UNIX tools:

- **pbpaste outputs the current contents of the Clipboard to the Terminal.** You then use output redirection or a pipe to feed this output to a file or to a second UNIX program that does something useful with the data.

- **pbcopy puts data onto the Clipboard.** The data is placed on the right side of a pipe, which means that the output of some other UNIX program is piped into pbcopy. The output of the first program is stored on the Clipboard, where it can be accessed from Mac applications by pressing Ô-V.

As an example, here’s how to use these commands to create a TextEdit file that lists the contents of the /etc directory:

1. **Open a Terminal window.**
2. **Type** ls -A /etc | pbcopy and press Return (see Figure 58-10).

   - **Figure 58-10: Send the results of a command to the Clipboard.**

The ls command is executed (the -A means it should list everything), but you won’t see any results displayed in the Terminal. Instead, the results are pasted onto the Clipboard.

3. **Open TextEdit.**
4. **Create a new document.**
5. **Press Ô-V to paste the Clipboard contents into the document (see Figure 58-11).**

   - **Figure 58-11: The results of the ls command have been passed into the TextEdit document.**
Technique 58: Piping and Redirecting Output with the Terminal

Alternatively, you can use pbpaste to do something with the Clipboard contents. For example, if you’re writing an e-mail and want to know how long it is, do this:

1. Open your e-mail message in Mail.
2. Select the entire message body by pressing ⌘-A.
3. Open a Terminal window.
4. Type `pbpaste | wc -w` and press Return (see Figure 58-12).

- Figure 58-12: Piping the Clipboard contents through the word count command.

5. If you want, you can store the number of words back in the Clipboard by using `pbpaste | wc -w | pbcopy`.

A more advanced level of piping uses the `tee` command. `tee` lets the output go to a command but also saves it to a file (think of it like a plumbing T, where the water splits in two opposite directions):

```
output_command | tee filename | input_othercommand
```

```
ls -A /path/to/directory | tee ~/contents.txt | wc -l
```

The preceding command lists (`ls`) all (`-A`) the contents of a directory. Instead of displaying these contents, they are instead stored in a text file called `contents.txt` (located in the Home directory). The result of the `ls` command is also sent to the `wc` command, which returns the number of items (by counting the number of lines).

Redirecting Output

Your Terminal uses the notion of STDIN (standard input), STDOUT (standard output), and STDERR (standard error) to control the flow of information. These are each channels for information to travel through. For example, the `ls` command receives arguments through the Terminal (STDIN) and sends its results to the Terminal screen (STDOUT). But it doesn’t have to work this way. As you can see with piping, you can send the standard output to another command, not the Terminal. Likewise, a command can take its input from the output of another command. You can also add files to the mix by using output redirection.

To indicate that a command should take its input from a file, use `<`:

```
command < sourcefile
```

Use `<` in cases where the command normally takes its input from the keyboard. Many commands — including `more`, `head`, `tail`, `pine`, and `vi` — take filenames as arguments by default, so using `<` is unnecessary.

Comparatively, to redirect standard output to a file instead of displaying it in the Terminal screen, use `>`:

```
command > filename
```

For example, you can create a text file listing the contents of a directory by using

```
ls -la ~/Documents > ~/Desktop/documents_listing.txt
```

You should be aware that this technique overwrites any existing file contents and creates the file if it doesn’t already exist. If you want to build on an existing file or not risk overwriting a file, use `>>`: 
command >> filename

This syntax appends the output to the existing file, adding it at the end. For example:

```
ls -l ~/Documents >> ~/Desktop/listing.txt
ls -l ~/Music >> ~/Desktop/listing.txt
ls -l ~/Pictures >> ~/Desktop/listing.txt
```

Essentially, this is how your system logs function: All messages created by the process being monitored are appended to the existing system log.

The > operator erases any existing contents in the named file. To be extra careful, use >> instead!
Viewing and Editing Text Files

This is the last of the major Terminal techniques, and here we discuss viewing and editing text files. Although you can easily work with text files through the Finder using applications such as TextEdit or BBEdit, the following are some good reasons for working with text files in the Terminal:

- Accessing hidden files is easier in the Terminal.
- If you’re already in the Terminal, you might not want to switch applications.
- You might already be working on a remote server.

In this technique, you master two basic commands for viewing a text file. Then you see two other handy commands that display only a portion of a text file — a real timesaver. Finally, you see how to perform basic edits of a text file in the Terminal by using the `pico` editor.

**Viewing Files**

Because UNIX uses a gazillion little utilities with a specific function, there are separate commands for viewing files and editing files. Obviously, you can use an editing tool to just view a file, but why would you want to? By using one of the two commands for viewing a file, you can simplify the experience.

**cat**

The `cat` command is actually short for *concatenation*, which is the process of appending one thing to another. The command’s intention is to take several files as arguments and then display them all in order, as if their contents constituted one large file. You can use `cat` to do this, showing multiple files at once, or you can use it to display a single file (see Figure 59-1).
The syntax for this command is simply

```
cat filename
```

For example, to view the Apache Web Server’s configuration file, type

```
cat /etc/httpd/httpd.conf
```

These two examples demonstrate how you can use `cat` to view multiple files at once (each appended to the next):

```
cat myfile1.txt myfile2.txt
```

You can make `cat` a little more useful by using either the `-n` flag to number the lines as they’re displayed or by using `-b`, which numbers all but the blank lines. You can also use `cat` with the pipe or output redirection. (For more on output redirection and piping, see Technique 58.) For example, the following command creates a new file (named `newfile.txt` in this example) by putting the other two files (`myfile1.txt` and `myfile2.txt`) together:

```
cat myfile1.txt myfile2.txt > newfile.txt
```

This command tells you how many lines the two files together contain (1,687 in the example shown in Figure 59-2):

```
cat myfile1.txt myfile2.txt | wc -l
```

Don’t try to concatenate two files with the command `cat myfile1.txt myfile2.txt > myfile1.txt`. This doesn’t append the `myfile2.txt` contents to `myfile1.txt`; it destroys the original `myfile1.txt` contents and then adds the `myfile2.txt` contents to it. If you want to concatenate `myfile1.txt` to `myfile2.txt`, do so in a new file.

more or less

The `cat` utility lacks certain features. Namely, you can’t move around too much within the `cat` command. As a step up from this, UNIX normally comes with a `more` command, which displays a file one page at a time. After the `more` command is displaying a file, you can then press the spacebar (or F) to page forward or Q to quit.

Sadly, your Mac doesn’t have `more` on it. What it has instead is its successor, `less` (and no, we’re not making this up). The `less` command is faster than `more` and lets you page backward, too. To use `less`, simply type

```
less filename
```

For example (the result of the second command is displayed in Figure 59-3):

```
less ~/Documents/myfile.txt
```

Familiarize yourself with `less` because all man pages are displayed by using it. For more on the `man` (manual) command, see Technique 56.
Technique 59: Viewing and Editing Text Files

Figure 59-3: Use less to view a file one page at a time.

Here are the basic commands for moving around when you’re in less:

- Press F to scroll forward one page.
- Press B to scroll backward one page.
- Press Return to scroll forward one line.
- Press D to scroll forward one-half page.
- Press Y to scroll backward one-half page.
- Press G to go to a specific line number.

You can precede the d, b, f, Return, and y commands with a number to move that many lines. For example, 10f moves forward 10 lines, and 20b moves backwards 20 lines.

Note that g behaves differently: a g preceded by a number goes to a specific line. (1g goes to the first line, and 169g moves to line 169.)

Two very important other shortcuts are

- Press H at any time to see all the commands (see Figure 59-4).
- Press Q to quit.

Type man less or less --help to see all the options, including how to perform searches.

Your Mac has a utility called more on it, but it’s the same thing as less. (It isn’t really more, it’s just called more.) In fact, if you check out the manual for more (man more), you can see the manual for less. Marc’s explanation for this phenomenon is that sometimes less is more. You can’t argue with that.

Viewing Parts of Files

If you don’t need to view an entire file, you have no reason to use less. Viewing just the part that you need saves time:

- Use the head command to view just the first few lines of a file.
  
  head myfile.txt

- Use the tail command to view just the last few lines of a file.
  
  tail ~/Documents/file.txt
Both of these commands take an \texttt{n} flag to dictate how many lines to display (see Figure 59-5 and Figure 59-6):

\begin{verbatim}
head -n 5 /etc/httpd/httpd.conf
tail -n 15 /etc/httpd/httpd.conf
\end{verbatim}

• Figure 59-5: When using \texttt{head}, you can view just the first few lines of a file.

• Figure 59-6: When using \texttt{tail}, you can view just the last several lines of a file.

The \texttt{tail} command has a couple other useful flags. These are

\begin{itemize}
  \item \texttt{-r}: Shows the lines in reverse order.
  \item \texttt{-f}: Keeps the \texttt{tail} utility running. (\texttt{tail} continues to show the last lines of a file — even as lines are added to the file — until you press Control-C to stop it.)
\end{itemize}

You can view system logs with \texttt{tail} by using \texttt{tail -f logname}. This keeps the \texttt{tail} utility running, persistently updating you as the system log changes. In other words, the last ten lines (the default number of lines to display) are always displayed on-screen, even as lines are added to the log. This is essentially the functionality duplicated with the \texttt{Console} utility. This is extremely useful to Web developers and system administrators.

\section*{Editing Files}

If you want to edit files in the Terminal, you have several options:

\begin{itemize}
  \item \texttt{pico}: A bare-bones application.
  \item \texttt{vi}: A more advanced text editor.
  \item \texttt{vim}: A modified version of \texttt{vi}.
  \item \texttt{emacs}: Perhaps the most powerful text editor.
\end{itemize}

To keep this simple, we briefly discuss \texttt{pico} in this chapter. If you find yourself doing command line editing frequently, you should learn \texttt{vim} or \texttt{emacs}. (Tiger has \texttt{vim} instead of the tradition \texttt{vim}.) Here is the good, the bad, and the ugly about \texttt{vi}, \texttt{vim}, and \texttt{emacs}:

\begin{itemize}
  \item They’re all very powerful after you master them.
  \item They’re difficult to master and not even remotely intuitive to learn.
  \item Never, under any circumstances, suggest to someone that \texttt{vi} or \texttt{vim} or \texttt{emacs} is any better or worse than any other text editor. If you do, you’ll never hear the end of that person’s diatribe. (This is a point of serious contention among computer geeks.)
\end{itemize}

\begin{itemize}
  \item In Technique 60, we demonstrate how to set your default text editor.
\end{itemize}

\section*{Editing with pico}

The \texttt{pico} editor is really easy to use. Here’s all you need to know:
1. Type `pico filename` to open a file.

2. Write and edit the file as you need.
   - Type the text you want (see Figure 59-7).

   Unlike other command line text editors, you can begin typing in `pico` without entering a keyboard shortcut or command first. For example, `vim` requires you to press `I` to begin inserting characters.

Figure 59-7: Working in the pico text editor.

3. Press `Delete` to remove characters.

4. To copy, move, or cut a section of code, follow the steps in the sidebar, “Rearranging text.”

   The selected text is highlighted.

To copy or move text in `pico`, follow these steps:

1. Use the preceding numbered steps to cut the original text.

2. If you want to copy the text without deleting it from its original location, press Control-U to paste the selected text back into its original location.

   If you want to move the text to another location, skip this step.

3. Move the cursor to the new location where you want to paste the original text.

4. Press Control-U to paste the selected text into the new location.

3. Press Control-O to save your work.

   After you press this command, you’re prompted with what filename to use (see Figure 59-8). Press Return to use the default filename listed. To change the filename, press the Delete key to delete the default name and then type in the new name.

   • Figure 59-8: Saving a file in pico.

4. Press Control-X to exit `pico`.

   If you haven’t saved your work, you’re given the option to do so (`pico` calls the changes a modified buffer) before exiting.
Editing with Finder tools

Don’t forget that you can also edit text files by using Finder tools — but launch those from the Terminal. For example, you can use these commands:

- `open -e filename`: Opens a file in TextEdit.
- `open -a applicationname filename`: Opens a file in the named application.
- `bbedit filename`: Opens a file in BBEdit.

BBEdit has an option to open hidden files directly in the application.
Because several of the previous techniques — and much of what you might do — depends upon the Terminal application, knowing how to adjust its behavior is well worth the time spent. In this technique, we begin with the preference settings the application itself has to offer and how they relate to using this tool most effectively. Then we show you the benefits of the different shells that you can use. (A shell is a tool that allows you to interact with the operating system.) Afterward, you figure out how to use special preferences files that affect your shell. Finally, we discuss a few cool related freeware and shareware applications.

**Adjusting Terminal’s Preferences**

The Terminal actually has two areas for setting its preferences. Both of these areas are accessible under the Terminal menu.

**Terminal Preferences panel**

The Terminal Preferences panel (see Figure 60-1) is great for customizing the application if you know what you’re doing.

![Figure 60-1: The Terminal Preferences panel has limited uses.](image-url)
Usually, the only Terminal Preferences setting you should consider changing is what, if any, `.term` file to open when a new Terminal window is created. This can be handy. We cover it in the section “Creating Terminal Preferences Files” later in this technique.

You probably shouldn’t change two specific Terminal settings. The first is what to execute when a new Terminal window is created and the second is how to identify the type of Terminal.

Window Settings

Window Settings, also called Terminal Inspector (see Figure 60-2), is for general-purpose and cosmetic adjustments.

The Window Settings dialog lets you adjust many features. Each setting can be altered by selecting an option (listed next) from the drop-down list at the top of the window. After selecting an option, each subsequent panel uses some combination of radio buttons, check boxes, and/or drop-down lists.

- **Shell**: The only thing you can do here is dictate what the Terminal does when you exit a shell. Most likely, you’ll want to close the window.

    To change what shell you use by default, use the Terminal Preferences panel. Read about the different shells in the upcoming section, “Choosing Your Shell.”

- **Processes**: Don’t touch the processes unless you really, really know what you’re doing. For the most part, the best use of the Processes panel is to see what processes are running, particularly if you have some going in the background.

- **Emulation**: The Emulation panel lets you control how the Terminal behaves (in other words, what other tools it behaves like). You probably don’t want to mess around here unless you decide to turn on the audible and visual bells.

- **Buffer**: The Buffer panel controls how much of the data the Terminal has received is retained in memory. You definitely want to enable this, and the 10,000-line default usually is enough. You can also tweak the Scrollback settings here.

- **Display**: Use the Display panel to set how your Terminal looks (see Figure 60-3). You can choose a cursor, a font, and how characters look on the screen.

    Select the Enable Drag Copy/Paste of Text check box so you can easily copy (using the mouse) and paste between the Terminal and the Finder.

    If you spend a lot of your time using the Terminal to access UNIX servers, you might have better luck changing the encoding (by using the Character Set Encoding drop-down
list) to ISO Latin 1. Local filenames might look strange with this setting, but your remote filenames (which are normally in ISO format) will look correct.

- Figure 60-3: Use the Display panel to make your Terminal more cosmetically pleasing.

- Figure 60-4: For the truly stylish Terminal geek, use an image for the background.

- Figure 60-5: Customize your Terminal title with the Window panel.

- Figure 60-6: The active process name

If you use the Terminal a lot, you can save a lot of time by giving your Terminal windows a useful title. A title lets you easily select the right Terminal window by seeing its name in Exposé or when it’s minimized in the Dock. We recommend that your Terminal title contain

- The active process name
- The .term filename (if a .term file — see “Creating Terminal Preferences Files” — is being used)
- The command key (⌘) shortcut
You can also resize the Terminal window at any time by clicking and dragging the lower-right corner. This is likely to mess up the existing Terminal display, though.

**Keyboard:** The Keyboard tool is just downright fantastic for people who use the Terminal regularly. It allows you to map commands or text to certain key combinations.

For example, with the Keyboard tool, you could make a shortcut to list the current directory’s contents as you want them:

1. Open the Keyboard panel of the Window Settings (see Figure 60-6).

   ![Figure 60-6: The Keyboard Terminal Inspector panel.](image)

   **Figure 60-6: The Keyboard Terminal Inspector panel.**

2. Select the F5 line in the list of keys.

   You don’t have to use F5, we’ve just selected that arbitrarily.

3. Click the Edit button.

4. In the resulting dialog, select Shift from the Modifier drop-down list.

5. Leave the Action drop-down list as is (“send string to shell”).

6. In the text box, type `du -sk * | sort -nr` (see Figure 60-7).

   This is the basic command that you want to execute. It returns a list of files or folders and their disk usage, sorted from most to least.

   ![Figure 60-7: Use the prompt to add a keyboard shortcut.](image)

   **Figure 60-7: Use the prompt to add a keyboard shortcut.**

7. Hold down the Option key and then press Return.

   The Option-Return combination adds a Return to the end of the command so that you don’t have to press Return after using the keyboard shortcut.

8. Click OK or press Return.

9. To use the shortcut, press Shift-F5 (or Shift-fn-F5 on a laptop).

   See the results in Figure 60-8.

   ![You can add new keyboard shortcuts (instead of editing existing ones) by clicking the Add button in the Keyboard panel.](image)
Technique 60: Customizing Your Terminal

After you customize the Terminal, click the Use Settings as Defaults button. If you want to create a temporary set of preferences, use a .term file, which we discuss in the next section.

Creating Terminal Preferences Files

If you use the Terminal, you probably use it a lot. Changing your settings for each circumstance is inconvenient. To work around this, you can create .term files, which are like saved Terminal settings. Follow these steps:

1. **Create a Terminal folder within the ~/Library/Application Support folder.**
2. **Open the Terminal.**
3. **Adjust the settings as necessary.**
   
   See the preceding section for which settings you want to work with.

4. **Choose File ➤ Save (or press ⌘-S).**
5. **In the resulting dialog (see Figure 60-9), type a name for your settings in the Save As text box and save the file in the ~/Library/Application Support/Terminal folder.**

To use the .term file, you can

- Choose it from the File ➤ Library menu (see Figure 60-10).
- Drag the .term file from the Finder onto the Terminal icon.
- Double-click the .term file (if it's set to open in the Terminal by default).

After you create a .term file, you can edit it in any text editor.

You can edit a .term file manually by using any text editor, although you'll find that trying to change colors in the file is ridiculously hard.

Even more handy than saving your preferences, your .term files can automatically run commands when they're opened. Follow these steps to have the Terminal immediately execute a command when you open a new Terminal window:
Choosing Your Shell

When you’re running the Terminal, you’re really using a shell. A shell is a tool that allows you to interact with the operating system. In other words, from the command line, you don’t tell the OS anything directly. You tell the shell what you want to do, and the shell makes it happen. The only reason you need to know this obscure fact is that you must know what shell you’re running to be able to configure it. Your Mac has all the popular shells:

- **sh**: The Bourne shell.
- **csh**: The C shell.
- **tcsh**: A enhanced version of the C shell (called the *T shell*).
- **bash**: The Bourne Again shell. (Yes, that is its name.)
- **zsh**: A geeky, lesser-used shell that’s very powerful.

Tiger’s Terminal uses the **bash** shell by default. If you’d rather use **tcsh** or any other shell, follow these steps:

1. **Open the Terminal Preferences panel.**
2. **Select the Execute This Command (Specify Complete Path) radio button.**
3. **Enter */bin/shellname* as the command.**

   All the shells are located in the */bin* directory. To use **tcsh** instead of **bash**, type */bin/tcsh* in the text box (see Figure 60-11).

4. **Close the Terminal Preferences panel to save your settings.**

Features such as tab completion, using the asterisk as a wildcard, and many other tricks are parts of your shell, not the operating system or the Terminal. You can find out more about any shell by typing **man bash** or **man tcsh** (for the *man* files on each) in the Terminal.
Technique 59 shows how to use the `pico` text editor.

2. Enter different commands to customize your shell.
   - To have the Terminal print a message, type `echo “This is a message.”`  
     The `echo` command prints out a string. You can use anything as your message.
   - To have the Terminal execute a command, type it on its own line.
     For example, you could have the Terminal show you a calendar by entering `cal` on its own line.
   - Set your default text editor by typing `setenv EDITOR /path/to/editor`.
     If you’d like your shell to use a particular editor by default (for example, `vi` or `emacs`), change this environmental setting. All the command line editors are in `/usr/bin`, so `setenv EDITOR /usr/bin/vim` makes `vim` your default editor.
   - Create aliases.
     If you’re using `tcsh`, type `alias aliasname ‘command’` — for example, `alias mysite ‘ssh -l user www.mysite.com’`. If you’re using `bash`, type `alias aliasname=’command’`.

Aliases let you use shortcuts for longer commands.

3. Save the file and close `pico`.

4. Create a new shell/Terminal window (by pressing `Ô-N`) to use the customization file (see Figure 60-12).

A great site for information about configuring shells is www.dotfiles.com. (But be sure to take a rest first if you’re feeling a bit shell-shocked.)

---

**Customizing Your Shell**

Knowing what shell you’re using is important because then you can create special files to customize its behavior. Each shell automatically loads a configuration file when a new shell is created (like when you open a new Terminal window). You can use these configuration files to

- Print a message.
- Create shortcuts for common commands.
- Adjust your environment settings.
- Automatically execute commands.

In these steps we demonstrate how to configure your shell, using some sample configuration ideas:

1. In the Terminal, type `pico filename` (filename is the file for your shell).
   - If you’re using `bash`, type `pico .bash_profile`.
   - If you’re using `tcsh`, type `pico .tcshrc`.

You don’t have to use `pico` to edit these, but because they are hidden files (note the initial period in the filename), you won’t see them in the Finder.

---

*Figure 60-11: You can tell the Terminal which shell to use.*
Shareware Tools for Working with the Terminal

You can use dozens of shareware and freeware applications with the Terminal. Some of the best free tools are

- **Terminal Pal** ([http://freshlysqueezedsoftware.com/products/freeware](http://freshlysqueezedsoftware.com/products/freeware)) lets you launch .term files from the Dock, which saves you the step of loading the Terminal and then selecting the .term file from the File ➪ Library folder.

- **Terminal Here plug-in** ([www.pyehouse.com/lynn/termopen.php](http://www.pyehouse.com/lynn/termopen.php)) creates a contextual menu item that allows you to instantly open the Terminal but in the current directory.

- Marc’s very own **Open Terminal Here script** ([www.entropy.ch/software/applescript](http://www.entropy.ch/software/applescript)) resides in your Finder window toolbars and opens the current directory in the Terminal.

- **Terminal Services** ([http://homepage.mac.com/stas/terminalservices.html](http://homepage.mac.com/stas/terminalservices.html)) creates a service for running the selected text in the Terminal. Another service option that it provides is to fetch a URL in the Terminal by using the `curl` tool.

- **Connect 4** ([http://members.tripod.com/boneheadproductions/connect4](http://members.tripod.com/boneheadproductions/connect4)) lets you play the popular game in the Terminal. (Well, Connect 4 was popular when you were eight, anyway.)

- **Fortune** ([www.vushta.com/fortune](http://www.vushta.com/fortune)) brings the classic UNIX `fortune` utility to the Mac. It provides you with a random fortune when you open a new Terminal window.
One big new feature in Tiger is a handy utility called Automator. This application makes it easy for everyday Mac users to, um, automate their routines. You can think of it like the non-programmer's version of AppleScript. Automator provides essentially the same functionality as AppleScript without all that pesky code (although you can tie AppleScripts and even shell scripts into Automator).

In this technique, we present a soup-to-nuts discussion of Automator. For starters, you get a basic introduction to the application and why you might want to use it. Then we run you through a simple example to get your Automator blood pumping. Next you see how and where you can save your example so that you can run it whenever you have the need. And finally, we demonstrate a more elaborate and helpful use of this fine new application by creating a multi-step routine that uses both the Finder and Mail.

Introducing Automator

After you've used your Mac for any length of time, you develop certain routines. For example, you might frequently need to

- Resize a bunch of images imported from your digital camera.
- Add more songs to your iPod.
- Send an e-mail to someone whose birthday is coming up.
- Load a certain collection of Web sites at once.

Some of the things you do are multi-step processes that require little thought but lots of repetition. Others might not be that involving but can still be done faster if automated. This is where our new favorite toy, Automator, comes in.
Creating a Simple Workflow

You use Automator to create Workflows, which are memorized sequences of steps. Workflows are created by defining which steps (Actions) are taken with an application. The beauty of Automator is that it already knows all the available Actions for Apple applications. (Apple's getting better and better at convincing you to use its software.) When you know what you're trying to accomplish, automating that process is just a matter of clicking and dragging your way through Automator. We go through one simple example in this section, and then show you how to create another, more elaborate sequence in the section “Creating a More Complex Workflow.”

Automator, as it ships in Tiger, has defined Actions for Apple applications. But you probably use applications that aren't made by Apple as well, right? If so, check out the resources for those applications to see whether or when that manufacturer starts supplying Actions for its software.

In this first example, you create a basic Workflow that sets the Desktop picture. It's a somewhat trivial use of the technology but does a great job of demonstrating the process and giving you a starting point.

1. Open Automator (found in the Applications directory).

2. Click the Finder title in the Library column, under Applications.

   The Library column contains three folders by default:
   - Applications
   - Example Workflows
   - My Workflows

   The Applications folder is where you find a list of all Automator-supported applications. Obviously it's the most important folder when it comes to creating Workflows. The Example Workflows folder lists completed, sample routines and the My Workflows folder is where you store and find your completed work.

3. Click on the Ask for Finder Items option in the Action column (see Figure 61-1).

   All of the available Actions for the application selected in the Library column appear in the Action column. Clicking once on any of these Actions selects it and shows a description of that Action in the bottom panel.

4. Drag the Ask for Finder Items Action into the rightmost column (see Figure 61-2).

   This is all you need to do to add a step to your sequence. The Ask for Finder Items Action presents a standard Open dialog so that the user may select a file.

   You can delete an Action by clicking the X in the upper-right corner of that Action's box. Clicking once on an action in the third column shows its description again. If you add an Action for an application that isn’t currently open, Tiger opens it for you.
Technique 61: Automating Your Routines

What type of thing the user can select
Use the Type drop-down list to change this value. You can allow the user to select just Files, both Files and Folders, or just Folders. For this example, Files is the proper option.

What directory the dialog should start out in
Use the Start At drop-down list to change this value. Because this example chooses a new Desktop picture, it makes sense to have the dialog open within the user’s Pictures folder.

The prompt given to the user
This is what the user sees when running the Workflow. It should be informative, like Choose a file to use as the Desktop picture.

Whether to allow multiple selections
If the user should be able to select multiple files, select the Allow Multiple Selection check box. This makes sense if you’re e-mailing multiple documents or resizing a bunch of images at once. For choosing a Desktop picture, if the user selects multiple files, the Desktop rotates through them in timed increments.

5. Customize the Ask for Finder Items Action (see Figure 61-3).

Different Actions can be customized in different ways. For the Ask for Finder Items Action, you have four options:

6. Drag the Set the Desktop Picture Action into the third column (see Figure 61-4).
Add the new Action after the first one because that’s the order in which you want the steps to run. (When you drag a new Action into the steps column, it’s automatically numbered for you.) This particular Action can’t be further customized.

Frequently, the results of one step are fed into the next step. For example, an image is selected and then used as the Desktop picture. If you attempt to create a sequence that doesn’t make sense (such as selecting an Address Book record and trying to copy those files), Automator shows its confusion by highlighting the input and output of the steps in red. If you see this, you’ve done something wrong. Pay attention to the Input and Result fields of the Action descriptions, insuring that they match (see Figure 61-5)!

7. Test your Workflow by clicking the Run button.

Before saving a sequence, make sure that it works. Clicking the Run button starts the steps. In this case, the Finder should present you with a dialog in which you can choose a picture and then this picture should be set as your Desktop.

Now that you’ve developed a working Workflow, you need to discover how to save and run it. The options are numerous, so see the following section.

Saving and Running Your Workflow

Discovering how to create a Workflow is an important and obvious step, but understanding how you can save your Workflow is just as critical. How you save a Workflow dictates how easily you can run the sequence when you need to. After you’ve written and tested your Workflow, these are the next logical steps to take:

✔ Save the Workflow by choosing File ➪ Save. After you do this, you’re presented with a Save dialog. Give the Workflow a proper, descriptive name (such as Set Desktop Picture), and save it somewhere in your Home directory (you might want to create an Automator folder within Documents). You can run Workflows saved this way by opening them in Automator and clicking the Run button (or by pressing ⌘-R).
If you save a Workflow in your Home directory (not in a subfolder therein), it’s automatically added to your My Workflows folder, which makes it more accessible. If you’d rather store your Workflows in another directory, that’s fine, but you’ll need to open or import it into Automator (using the corresponding File menu option) before you can run or edit it.

Get in the habit of always first saving Workflows by using the File→Save method. This way you can open the Workflow and edit it at a later time. You might also want to then save your Workflows by using these other methods because they have their own benefits. You should do a standard save first, because if you save your Workflows as only a standalone application or as a plug-in, you won’t be able to edit them later.

Save the Workflow as a standalone application.
The Save dialog also provides a drop-down list (see Figure 61-6), letting you save the Workflow as just a plain Workflow or as a standalone application. If you choose the latter, you can run the sequence without opening Automator. To do so, just double-click the file in the Finder (the Workflow runs through the Automator Launcher instead).

Save the Workflow as a plug-in by choosing File→Save As Plug-In (see Figure 61-7). If you choose File→Save As Plug-In, you really increase the ease of rerunning your sequence. You can put this plug-in in several places, making it available through different channels. Five of the most useful options are:

- Finder
  If you create a Finder plug-in, it’s available as a contextual menu item (see Figure 61-8).

- Folder Actions
  Folder Actions are sequences assigned to specific folders. For example, you could have a folder that automatically resizes any image dropped in it. To assign a Workflow as a
Creating a More Complex Workflow

Folder Action, just select Folder Action from the Plug-In For drop-down list, and then select the desired folder from the Attached to Folder drop-down list that appears.

Font Book

The Font Book application has its own Actions (see Technique 28). Any plug-in added there is an option the next time you open Font Book.

Print Workflow

The Print Workflow is a special button of options that appear in a Print dialog (see Technique 26). If you have a printing-related sequence, save it as a Print Workflow plug-in to quickly run it the next time you print a document.

Script Menu

The Script Menu appears in the menu bar at the top of the display (assuming that you've enabled it by using the AppleScript Utility in the Actions ➪ AppleScript folder). Added Workflow plug-ins can be stored here, making them easily and universally available.

How you save a Workflow affects how and from where you can run it. Make good use of the plug-in option in order to access your Workflow through contextual menus, the Script Menu, and so forth. You can even save the same Workflow as multiple types of plug-ins so it’s always readily available!

Creating a More Complex Workflow

The basic example, although practical and functional, doesn’t really demonstrate how easily you can use Automator to create a sequence of steps. So in this last section you create a more involved Workflow. The demonstration will be a “start the day” Workflow, using three different applications. First, iTunes will start playing a specific playlist. Then, Safari will open two favorite Web sites. Finally, the Mail application will check for new e-mail.

For more complex Workflows, think or write out what you want to accomplish and what you think those steps will be before going into Automator.

This is what you need to do to make this happen:

1. Open Automator, if it isn’t already open.
2. Click the iTunes item in the Library column.
   The majority of your Workflows probably involve the Finder to some extent.
3. Drag the Get Specified iTunes Items Action into the rightmost column.
   This Action lets you choose, in advance, a song or playlist.
4. Customize the Get Specified iTunes Items Action.
   What you need to do is add a specific item (or items). To do so,
   a. Click the plus button to bring up the prompt (see Figure 61-9).

- Figure 61-9: The prompt shows my iTunes library so that I may select items from it.
b. Select a playlist from the top part of the window or select a song from the bottom part of the window.

c. Click Add.

You can add multiple items by repeating these steps (click the plus sign and so forth) or by ⌘-clicking multiple items within the iTunes prompt. The prompt also has a Search box so that you can more easily find a specific item.

5. Drag the Start iTunes Playing Action into the third column.

iTunes begins playing the items selected in the previous step.

6. Click the Safari item in the Library column.

Now you can customize what you want Safari to do in this Workflow.

7. Drag the Get Specified URLs Action into the third column.

This Action is much like the Get Specified iTunes Items Action, letting you dictate what URLs should be used in the following step.

8. Customize the Get Specified URLs Action (see Figure 6-10).

For this Action, it’s a matter of adding URLs (Apple’s URL is automatically added). Simply:

a. Click the plus button.
b. Double-click URL name, the newly added item’s bookmark title. (Each new item will appear at the top of the list with URL name as the title and http:// as the address.)
c. Type in the name you want to give this item.
d. Press Tab.
e. Type in the URL for this item.
f. Press Return.

9. Drag the Display Webpages Action into the third column.

This Action will do the actual loading of the URLs set in the previous Action.
One option is to choose for which accounts new e-mail should be downloaded. Another step you can take is to tell this Action to ignore the results from the previous Action (refer to Figure 61-11). In this example, the previous Action results in Safari documents, which aren’t needed by the Get New Email Action. Telling this later Action to ignore the previous results isn’t required, but is a good idea.

13. Test your Workflow by clicking the Run button.

14. Save your Workflow by using the options that we outline in “Saving and Running Your Workflow.”

Just because you’ve created a Workflow that runs on your computer doesn’t mean that it’s good only for you. You can share your Workflows with family and friends because most Workflows run on other computers (at least ones that run Tiger, that is) with little or no modification.
The Mac has always been an attractive operating system, complete with some pretty nice screen savers. Unlike all those boring ones that Windows users see — most of which just promote Microsoft and its products — your Mac can display flying toasters, an aquarium, or complex fractals. Even though screen savers no longer serve any practical purpose whatsoever (it’s virtually impossible to burn an image onto your display), there’s nothing wrong with some good old-fashioned eye candy.

This technique is long on cool and short on boring. We begin with some information about Tiger and screen savers. This section is practical for most users, and you’ll see some nice tips. Next, we tell you where you can get more screen savers (for those of you addicted to them) and how to install the suckers. Finally, we show you one way-cool trick, which is of absolutely no practical benefit to you at all! All in all, you’re not going to find much in the way of increasing your productivity here (just the opposite, in fact), but all work and no play makes Jack a dull boy, right?

**Configuring Screen Savers in Tiger**

If you don’t like screen savers, you should at least read this section of the book to know how to turn the things off. If you like screen savers, you should read this section to discover how to configure them. If you’re indifferent toward screen savers, read this anyway. What do you care?

You can control your screen savers from the Screen Saver tab of the Desktop & Screen Saver panel of System Preferences (see Figure 62-1). The left column lets you choose what screen saver to run. The right column displays a preview of the selected screen saver. Under the preview is the Options button, which lets you configure the selected screen saver (for those that are configurable; see Figure 62-2) and the Test button to preview it.
Configuring Screen Savers in Tiger

- **Figure 62-1:** Control your screen saver settings here.

- **Figure 62-2:** If a screen saver can be configured, clicking the Options button brings up a configuration panel.

Toward the bottom of the Screen Saver tab are two important controls:

- **A Start Screen Saver slider that lets you control when to start the screen saver:** You can set the screen saver to start after a certain amount of idle time or never at all. Keep in mind that if this value is longer than the sleep or display sleep settings in the Energy Saver panel (see Figure 62-3), you’ll never, ever see the screen saver. Your machine goes to sleep before the screen saver ever kicks in.

- **A Hot Corners button that lets you set hot corners:** Here’s our advice: Don’t use hot corners to activate your screen saver. Save them for Exposé and Dashboard, which are far more useful and important than a screen saver. Also, there’s a decent chance that you’ll set a hot corner to activate the screen saver and then inadvertently hit...
The best, perhaps only, reason to set a hot corner to activate your screen saver is if you set up your computer to require a password to return from displaying a screen saver. If you’re in a multi-user environment, select the Require Password to Wake This Computer from Sleep or Screen Saver check box in the Security panel (see Figure 62-4), and then move your cursor to the hot corner before you leave your desk. By using this method, you can quickly secure your computer before you walk away from it. (Any mischief-makers must enter your password to wreak havoc with your system.)

Adding to Your Screen Saver Library

Your Mac comes with a half-dozen screen savers out of the box, but you don’t have to be satisfied with those. You can download and use dozens of screen savers. Here are some Web sites where you can find collections to download:

- **LOOPS**: [http://loops.pardeike.net](http://loops.pardeike.net)
- **epicware**: [www.epicware.com/macosxsavers.html](http://www.epicware.com/macosxsavers.html)
- **VersionTracker**: [www.versiontracker.com/macosx/screensavers](http://www.versiontracker.com/macosx/screensavers)
- **WhiteBox**: [http://s.sudre.free.fr/Software/WBSOFTWARE.html](http://s.sudre.free.fr/Software/WBSOFTWARE.html)

Many, but not necessarily all of the collections in the preceding list, are free (*free!)*.

These are some of our particular favorite individual screen savers:


After Dark was *the* screen saver for many years. Then people stopped using screen savers...
entirely (or so the story goes). Then came Marine Aquarium (see the next bullet), which opened up the world’s eyes to how fun a screen saver can be. The latest version of After Dark, put out by Infinisys, has many modules, from the toasters to the aquarium to a Mandelbrot set. Definitely worth the sawbuck!

Marine Aquarium 2:

Marine Aquarium 2 (from SereneScreen) creates a beautiful virtual fish tank, using dozens of types of fish plus a healthy dose of coral. You can run this as a screen saver or all by itself. Another version of the Marine Aquarium is available, and it displays the current date and time on a crystal located in the tank.

To install a screen saver, follow these steps:

1. Download the file from the Web site.
2. Decompress and/or mount the downloaded file.
   
   The downloaded file is most likely in some sort of compressed format, like .sit or .gz. You’ll need to use Stuffit Expander to decompress it. If the file then has a .dmg extension, double-click it to mount it as a disk image. After you have either a folder or a disk image left (see Figure 62-5), you can install the file.

3. Move the screen saver file to ~/Library/Screen Savers, where ~ refers to your Home directory (see Figure 62-6).

   The screen saver itself has a .saver file extension. Move this into your Library/Screen Savers folder to add it to your available entertainment.

   • Figure 62-6: Add the new screen saver to your Screen Savers folder.

   If your Library folder doesn’t already have a Screen Savers directory, create one. You can also add screen savers to /Library/Screen Savers, which makes them available to all users. If you do this, though, they won’t be backed up with the rest of your stuff and can easily be lost during operating system upgrades or transitions from one computer to another.

4. Open System Preferences.

   You can’t select and use your screen saver unless you open the Screen Saver panel after the screen saver has been added to your system. If the panel was open when you added the new file, quit and reopen System Preferences.

5. Click the Desktop & Screen Saver icon.
6. Click the Screen Saver tab.
7. Select and configure the new screen saver (see Figure 62-7).

   The screen savers that you’ve installed appear in the middle group of listings in the left column.

   Here’s another really cool way to add screen savers: Use iPhoto. Your photo albums in iPhoto are automatically added as potential
Using the Desktop as a Screen Saver

In a technique that discusses nothing but eye candy, this trick takes the cake. You can have a screen saver — any screen saver — run in place of the Desktop image. It slows down your computer like few other things can, but it looks so cool.

Unless you have a Quartz Extreme–compatible computer with a really good processor (or a dual-processor, ideally), don’t plan on doing anything else when running a screen saver on your Desktop. We found this to be really sluggish on a 550 MHz G4 PowerBook but not too bad on a 933 MHz G4 iBook.

1. Go to http://software.couthouis.com and download a copy of CoolBackground.

2. Unstuff the downloaded file if it doesn’t automatically unstuff, and then open the resulting folder.

3. Copy the CoolBackground application to your Applications or Utilities folder.

4. Run the CoolBackground application (see Figure 62-9).

• Figure 62-7: Select and configure the new screen saver.

• Figure 62-8: Select and configure a new screen saver from iPhoto images.

• Figure 62-9: CoolBackground has a very simple interface.
5. Configure CoolBackground as you want, and press Start.

The result is the selected screen saver running as your Desktop (see Figure 62-10)! If you have multiple monitors, one monitor runs the screen saver while the other has a solid black background.

Here’s a good tip for any Mac user: if you like the shareware provided by others, encourage the developers by paying for it. Click the CoolBackground Contribute button to donate a couple bucks for a job well done.

• Figure 62-10: Running the Flurry screen saver as the Desktop.
Symbols
/ (forward slash), Terminal commands tab completion, 444
- (minus sign) in Google searches, 252
64-bit addressing, 10
^ (Control key), keyboard navigation and, 70
+ (plus sign) in Google searches, 252

A-Dock X shareware, 107
AAC files, 337
accessibility
AppleScripts and, 60
assistive technology, 53
AutoCorrect and, 60
automation and, 60
keyboard settings, 58–60
macros and, 60
mouse settings, 58–60
trackpad behavior, 59
voice commands, 56–57
VoiceOver, 53–56
Workflows and, 60
zoom feature, 57–58
Accounts panel, auto-launch and, 179–181
Address Book
access, 142
backups, 141
Bluetooth and, 427–429
BuddyPop, 142
dashboard, 142
groups, 146–149
iAddressX, 142
iCal and, 364–365
introduction, 141
QuickAddress, 142
Send Updates option, 149
template customization, 142–144
vCard creation, 144–146
Advanced pane, Finder, 87–88
AIFF files, 337
AirPort
card installation, 299–300
network creation, 299–300
optimization and, 30
setup, 300
software, 297
alerts, speaking, 55
aliases
benefits, 133
deleting, 133
Favorites, 135–136
introduction, 132
operating system and, 133
originals, locating, 162
overview, 133
Terminal, creating in, 445
UNIX, 135
Alt key, 45–46
antenna, base station, 299
anti-aliasing, fonts and, 65
anti-virus software, Virex, 394–396
antivirus software, 393, 396–397
AntiWordService, 221
AOL, spam and, 275
AP (access point), wireless networks, signals, 298
Apache Web server, sharing and, 313
Appearance dialog, font smoothing, 65
Apple Lossless files, 337
Apple menu
overview, 90
representation in book, 4
AppleScript
CDs, 368
contextual menus (CMs), 111–113
iCal, 365
overview, 112
Script menu, 91
AppleScripts, accessibility and, 60
AppleTalk, 294
application menus, representation in book, 5
Application Support folder (Library), 126
application switching
Exposé, 187–188
keyboard shortcuts, 187
overview, 81, 186–188
shareware for, 188
applications
  aliases, 133
  drive space and, 174–175
  hiding, 188–189
  installing additional, 16
  keyboard shortcuts, 80–81
  launching automatically, 179–181
  launching automatically, Dock, 182–183
  launching automatically, Finder, 181–182
  logout and, 190
  opening files from, 194
  quitting, 190
  shut down and, 190
  stalled, 34–35
  start automatically, 23–24
Applications directory, shortcut, 74
archive and install method of installation, 11
archives, drive space and, 174
arguments, \ls command, 445–446
arrow keys
  Desktop, 74
  Finder, 71
assistive technology. See accessibility
attachments (Mail), 269
audio CDs, iTunes, 370
Audio directory (Library), 127
AutoCorrect, accessibility and, 60
AutoFill, Safari, 232–233
automatic login, downfalls, 23
Automatic network location, 290
automatic start
  applications, 23–24
  System Preferences, 25
automation, accessibility and, 60
Automator
  introduction, 9
  overview, 470–471
Workflows, creating, 471–473
Workflows, creating complex, 475–477
Workflows, saving, 473–474
AutoPairs utility, 420
B
background, Icon view (Finder), 94–95
Backup (.Mac Account)
  file types, 389
  finalizing, 389–390
  introduction, 387–388
  startup, 388–389
backups
  Address Book, 141
  Carbon Copy Cloner, 376–377, 390
  ChronoSync, 390
  Deja Vu, 390
  frequency, 383
  Home directory to external hard drive, 385–387
  iBackup, 390
  iPod and, 373, 375–377
  location, 384
  media, 384
  number of, 383
  recommendations, 383–384
  restoring with rsync, 387
  Retrospect Desktop, 390
  rsync utility, 384–387
  set rotation, 384
  SilverKeeper, 390
  StuffIt Deluxe, 390
  testing, 384
base station, wireless networks
  antenna extension, 299
  Apple manufactured, 299
  encryption, 298
  Ethernet ports, 298
  firewall, 298
  802.11g wireless protocol, 299
  introduction, 298
  iTunes broadcasting, 298
  modems and, 298
  printer support, 298
  range, 298
batteries for laptop, extending, 30–32
BBEdit
  Bonjour and, 306
  opening from Terminal, 461
  Services, 219
  birthdays in iCal, 362
  BlueService, 221
Bluetooth
  adapters, 424
  Address Book and, 427–429
  Bluetooth File Exchange, 432–433
  connection setup, 424–427
  dial phone from text selection, 429
  enabled devices, 424
  introduction, 423–424
  iSync and, 429–431
Bonjour
  BBEdit and, 306
  Games and, 306
  hardware and, 310
  iChat and, 279, 305, 306–307
  iPhoto and, 306, 309–310
  iTunes and, 306, 308–309
  naming computer, 305
  reasons to use, 304–305
  Safari and, 306
  setup, 305
  SubEthaEdit and, 306
  Transmit and, 306
  World Book Encyclopedia and, 306
  Zero conf, 304
bookmarklets (JavaScript), 241–242
bookmarks
RSS, 235–236
utilities, Safari, 240–241
Bookmarks Bar (Safari)
folders, 247
grouping bookmarks, 246
introduction, 244
Bookmarks menu (Safari)
deleting bookmarks, 246
introduction, 244
bookmarks (Safari)
accessing, 248–249
deleting, 246
mark a page, 245
preferences, 247–248
sharing with other browsers, 249
tips, 250
transfer to new computer, 249
Bookmarks window (Safari)
folder creation, 245
imported folders, 245
introduction, 243–244
nesting folders, 245
browsers
Cache, 231
cookies, 231
default, 228
History, 231
BSD Subsystem, installation
and, 16
BuddyPop, Address Book, 142
Buffer setting (Terminal preferences), 463
burnable folders, CDs, 368–369
burning CDs, Finder, 369–371
CDs
audio, iTunes and, 370
battery life of laptop and, 31
burnable folders, 368–369
burning, 369–371
iPhoto picture CDs, 371
scripting and, 368
System Preferences, 366–368
cellphone
as remote control, 431–430
Bluetooth setup, 424–427
note storage, 432–433
picture storage, 432–433
Character Palette, 211–212
ChronoSync backup utility, 390
Classic, dual-booting, drive space
and, 176
ClearDock shareware, 107
CleverKeys, 111, 221
Clipboard
Find Clipboard, 208
overview, 207
shareware, 207
ClipboardSharing clipboard alternative, 207
CMs. See contextual menus
& (Command key)
Desktop, 74
Finder, 71
introduction, 46
keyboard navigation and, 70
Tab key and, 81, 187
Cocktail
maintenance and, 418
optimization and, 27
Cocoa
Services, 219
Stickies, 151
Cocoa Gestures utility, 419
CodeTek Studios software, 407
color
 calibration, 64
displays, 63–65
Color panel, Displays dialog, 64
Color setting (Terminal preferences), 464
ColorSync, profiles, 63–64
ColorSync folder (Library), 127
Column view (Finder)
 introduction, 97
navigation, 72–73
command history, Terminal, 438–440
commands, voice commands,
56–57
commands (Terminal)
cat, 456–457
combining using pipes,
451–454
cp, 443–444
du, 450–451
find, 446–447
head, 458–459
less, 457–458
ln, 445
locate, 447–448
ls, 445–446
mkdir, 446
mv, 444
pbcopy, 453–454
pbpaste, 453–454
ps command, 450
rm, 444
Caches folder
clearing, 28
Library folder, 27
caching, browsers, 231
commands (Terminal) (continued)
   rmdir, 446
   sort, 450
   tail, 458–459
   tee, 454
   wc, 449–450
   wildcards, 446
Comments, List view (Finder), 96
Comments panel, Get Info, 161
Composing preferences, Mail, 260–261
computer type in book, 5
combination of files, viewing multiple in Terminal, 456–457
configuration
   screen savers, 478–480
   Terminal Preferences panel, 462–466
Contextual Menu Items folder (Library), 127
contextual menus (CMs)
   AppleScript and, 111–113
   CleverKeys, 111
   DesktopPictureCM tool, 110
   Dock, 110
   file opening, 192–193
   files, 109
   FinderIcon, 111
   folders, 109
   Get Info option, 109
   Help option, 109
   iCal and, 361
   introduction, 108
   OnMyCommandCM, 111
   packages, 110
   QuickAccessCM, 110
   Sticky Brain, 111, 153
   StuffIt Deluxe, 111
   third-party applications, 110–111
   windows, 109
   Zinggg!, 110
Control key, 46
conventions in book, 4–6
cookies, browsers, 231
copying
   files with Terminal, 443
   keyboard and, 204–206
   keyboard shortcuts, 79
   mouse and, 204–206
tips, 207–208
CopyPaste-X clipboard alternative, 207
cp command (Terminal), 443–444
crash recovery/prevention, 37–38
cron utility, 416–418
cross-platform fonts, 209
CSSs (cascading style sheets), Safari customization and, 238
customization
   print settings, 201
   Terminal Preferences panel, 462–466
   TinkerTool freeware and, 66
Daemon, 37
Dashboard
   Address Book, 142
   Exposé, 119–120
   introduction, 2, 9
   Stickies, 152–153
   widgets, 119
data fork suitcase fonts, 209
data transfer, iPod and, 372–373
databases (locate command), 447–448
Date Created, List view (Finder), 96
Date Modified, List view (Finder), 96
date/time, Text to Speech, 56
Debug menu (Safari), 238–239
Déjà Vu backup utility, 390
Del key, keyboard navigation, 70
deleting
   Actions (Automator Workflow), 471
   aliases, 133
   bookmarks (Safari), 246
directories with Terminal, 444, 446
files, manually, 173–176
files with Terminal, 443
undeleting files with Terminal, 444
Desktop
   Desktop & Screen Saver panel (System Preferences), 129
   Home directory and, 124
   navigation, 74
   screen saver as, 482–483
   virtual desktops, 63
Desktop & Screen Saver panel, preferences, 129
desktop printing, 202
DesktopManager, 63
DesktopPictureCM tool, 110
destination of installation, 14
DEVONtechnologies’ services, 221
dial phone from text selection with Bluetooth, 429
dialing from Address Book with Bluetooth, 427
dialup connections, configuration, 292–293
directories
   deleting with Terminal, 444, 446
   listing with Terminal, 445–446
   searching for files in, 446–448
   size of, viewing, 451
   Terminal, creating in, 445–446
disabling features
- optimization and, 29–30
- ports, 291
- screen savers, 479
disk images, ejecting, 162
disk usage statistics, 450–451
Disk Utility
- encryption and, 405–407
- optimization and, 27
- running, 27
- volume formatting, 12–13
- warnings, 11
display, hot corners and, 116
Display menu bar icon, multiple displays and, 68
Display setting (Terminal preferences), 463
displays
- anti-aliasing and, 65
- color, 63–65
- fonts, 65–66
- multiple, 66–68
- refresh rate, 64
- resolution, 61–63
Displays dialog, resolution, 62–63
Dock
- Activity Monitor, 36–37
- applications, stalled, 34–35
- contextual menus, 110
- customizing, 102–103
- file opening, 192
- hide/show, 103
- hierarchical menus, 105
- keyboard shortcuts, 104–107
- laptop, 106
- launching applications, 182–183
- mouse shortcuts, 104–107
- organization, 104, 130–131
- properties, 103
- separator bar, 104
shareware, 107
- Start menu and, 47
- System Preferences, 102–103
- Trash, empty, 106
Dock icon (Mail), 268–269
DockExtender shareware, 107
document switching, Exposé, 117–118
Documents folder, Home directory, 124
downloads
- driving directions to iPod, 379
- Safari, 229
Drafts mailbox (Mail), 265
drag and drop
- Exposé, 118–119
- Finder and Terminal, 442
DragThing launch utility, 185
DragThing shareware, 107
drive space
- application cleanup, 174–175
- archives and, 174
- deleting files manually, 173–176
- dual-booting Classic and, 176
- fonts, 173
- important folders, 176
- Language Translations, 173
- Library, 175
- printer drivers and, 172–173
- System folder, 175
- third-party applications and, 176
- volume cleanup, 175
drivers
- IOXperts drivers, 299
- printer, installation and, 15
- WirelessDriver, 299
driving directions on iPod, 379
du command (Terminal), 450–451
dual-booting, drive space and, 176
dual processors, 10
Duality 4.0 GT, Finder themes, 88
DVDs
- battery life of laptop and, 31
- System Preferences, 366–368
E
- e-mail, viruses and, 392
- ease and security comparison, 23
- EasyFind service, 221
- Edit menu, 90
- editing, files with Terminal, 459–461
- Ego Surfing, 253
- ejecting, disk images, 162
- emacs editor, 459
- Emulation setting (Terminal preferences), 463
- encoding settings (Terminal), 463–464
- encryption
- base station and, 298
- CodeTec Studios software, 407
- Disk Utility, 405–407
- FileVault and, 403
- iPod as storage, 373–375
- keys, 301
- Mac GNU Privacy Guard, 407
- passwords, 301
- PGP software, 407
- Stuffit and, 407
- SubRosaSoft software, 407
- WEP (Wired Equivalent Protocol), 301
- WPA Personal encryption, 300–301
- Energy Saver panel, selecting, 21
- erase and install method of installation, 11
Esc key, 79
Ethernet, ports to support wired computers, 298
events (iCal), creating, 359
Exposé
application switching, 187–188
customizing, 115
Dashboard, 119–120
document switching, 117–118
drag and drop, 118–119
function keys, 116
hot corner setup, 114
introduction, 114–115
keyboard use, 119
modifier keys, 116
pop-up menus, 115
usage potential, 116–119

F
F10 Launch Studio launch utility, 185
Favorites
aliases, 135–136
launching applications, 184
opening files, 192
Favorites folder (Library), 127
File Buddy (Get Info), 161
file formats, music, 337–338
file management (Terminal), 443–445
File menu, 90
file paths, creating in Terminal, 444
file sharing
other OSs, 163
Personal File Sharing, 314–316
Windows Sharing, 314
file transfer
iChat, 282–283
installation and, 18–19
files
aliases, 133
contextual menus, 109
counting lines, words, and characters in, 449–450
deleting manually, 173–176
drive space, deleting manually, 173–176
editing with Terminal, 459–461
extensions, 158–159
locked, deleting, 162
opening, default application, 196
opening with contextual menus, 192–193
opening with Dock, 192
opening with Favorites, 192
opening with Finder, 191
opening with Finder Window toolbar, 192
opening with LaunchBar, 193–194
opening with Recent Items menu, 194–195
opening within applications, 194
overwriting, 200–201
properties, 155–161
renaming in Terminal, 444
saving, 197–201
searching for with Terminal, 446–448
size of, viewing, 451
sorting alphabetically, 450
viewing in Terminal, 456–459
FileVault
enabling, 404
encryption and, 403
Master Password, 404
Find Clipboard, 208
Find command, Finder, 166–168
find command (Terminal), 446–447
Find window (Find command)
criteria, 167–168
searches, 166–168
Finder
Advanced pane, 87–88
application launch, 181–182
arrow keys, 71
burning CDs, 369–370
⌘ (Command key), 71
Column view, 97
copying within, 208
desktop printing, 202
Duality 4.0 GT, 88
editor tools, launching from Terminal, 461
file opening, 191
folders, moving, 100
General section, 85
Icon view, 94–95
Icon view, background, 94–95
input devices, 91–92
keyboard navigation, 70–73
Labels, 85–87
List view, 95–97
menus, 89–91
modifier keys, 92
mouse, 92
new windows, 72
new windows, keyboard shortcut, 79
overview, 47–48
preferences, 84–88
Removable Media, 367
scrollbars, 100–101
Secure Empty Trash option, 407–408
services, 218
ShapeShifter, 88
Shift key, 71
shortcuts, 70–73
Sidebar, 87, 99–100
Stickies, 151
Tab, 71
Terminal and, 441–442
Terminal and, editing between, 442
ThemeChanger, 88
themes, 88
view modes, 93–97
View Options, 88–89
Finder menu, 90
Finder window
customizing, 97–101
searches, 164–166
toolbar, 98–99
Finder Window toolbar, file open, 192
FinderIcon CM, 111
firewalls
base station (wireless), 298
enabling, 320
hardware, 321–322
routers, 321
Sharing services, 321
software, 320–321
viruses and, 392
FireWire
drive upgrade, 32
networks and, 295
firmware, updates at
installation, 13
folders
aliases, 133
Bookmarks Bar (Safari), 247
contextual menus, 109
moving, 100
Smart folders, 168–169
Font Book utility, 214–215
Font panel
Characters, 214
Color, 214
Edit Sizes, 214
Favorites, 213–214
Manage Fonts, 214
Show/Hide Effects, 214
Show/Hide Preview, 214
Typography, 214
font smoothing, 65
FontBook, collections, 215–216
fonts
cross-platform, 209
data fork suitcase, 209
display and, 65–66
drive space, 173
FontBook and, 215–216
installation, 210
installation and, 15
PostScript, 209
resolution and, 63
TrueType, 210
viewing, 210–215
Fonts folder (Library), 127
Force Quit Applications menu
quitting applications, 190
stalled applications and, 35
formatting
hard drive, 11
hard drive, installation and, 12
partitioning, 11
Stickies, 151
volumes, Disk Utility and, 12–13
forward slash (/), Terminal commands tab completion, 444
Froogle (Google), 257
FTP (File Transfer Protocol), 294
Full Keyboard Access, 75
function keys
Exposé, 116
introduction, 82
uControl shareware, 82
G
G5 processor, 10
Games, Bonjour and, 306
General panel
Finder, preferences, 85
Label (Get Info), 157
Locked check box (Get Info), 157
Mail, 260
Stationery Pad (Get Info), 156
Get Info option, contextual menus, 109
Get Info panel
Comments panel, 161
file properties, 156–157
General panel, 156–157
More Info panel, 157–158
Name & Extension panel, 158–159
Open With panel, 159
Ownership & Permissions panel, 160–161
Preview panel, 159–160
Super Get Info, 161
Go To Folder dialog, 76–77
Google
- (minus sign), 252
+ (plus sign), 252
advanced searches, 252–253
case sensitivity, 252
as dictionary, 255
Ego Surfing, 253
file type searches, 253–254
Froogle, 257
Google Answers, 257
Googlewhacking, 253
keywords, 251–252
language translation, 256–257
maps, 257
math problems, 255–256
Google (continued)
   OR keyword, 252
   phrases, 252
   preferences, 254
   quotation marks, 252
Safari and, 254–255
services, 220
SnapBack and, 234
specialized searches, 253–254
stock quotes, 257
unit converter, 256
Grab utility
   screen shots and, 219
   screenshots and, 354–355
groups (Address Book)
duplicating, 148
manual creation, 147–148
New Group From Selection, 146–147
Smart Groups, 148–149

H

hard drive
disk usage statistics, viewing, 450–451
formatting, 11
formatting, installation and, 12
icons, 48
partitioning, 13
hardware
   Bonjour and, 310
   firewalls, 321–322
   performance and, 32–33
   upgrading, 32
head command (Terminal), 458–459
Help menu, 90
Help option, contextual menus, 109
Help Viewer
glossary, 50
uses, 49–50
hiding/showing, application hiding, 188–189
hierarchical menus, Dock, 105
HimmelBar launch utility, 185
History, browsers, 231
Home calendar (iCal), 358
Home directory
   backup to external hard drive, 385–387
   cleanup, 174
   Desktop, 124
   Documents folder, 124
   introduction, 123
   Library, 124–125
   Users directory and, 124
Home folder, shortcut, 74
hot corners (Exposé), setting, 114
HotService, 221
hotspots, wireless networks
   Bonjour and, 306
   finding computers, 301
HTTP (HyperText Transfer Protocol), 294
iAddressX, Address Book, 142
iBackup backup utility, 390
iCal
   AppleScript and, 365
   benefits of multi-calendar structure, 359
   best practices, 361–362
   birthdays, 362
   calendar creation, 359–360
   calendar properties, 360
   event creation, 359
Home calendar, 358
iSync and, 361
iTunes and, 365
keyboard shortcuts, 360–361
.Mac account and, 361
Mail and, 364–365
publishing calendars, 363–364
subscriptions, 362–363
Word calendar, 358
ICeCoffEE, 221
iChat
   Bonjour and, 305, 306–307
   customization, 280–282
   file transfer, 282–283
   iChat AV, 283–285
   introduction, 9
   keyboard shortcuts, 278–280
   logging, 282
   mouse, 278–280
   URLs, creating, 285–286
   videoconferencing, 283–285
Icon view (Finder)
   background, 94–95
   navigation, 71–72
   Snap to Grid, 94
icons
   alignment, 47
   creating, 137–138
   defaults, 140
   Dock, 104
   My Computer, 48
   overview, 137
   size, 137
   View Options panel, 137
icons in book, 5
iDisk
   another member’s, 328
   local copy, 328
   security, 327–328
   storage, 325–328
   synchronization, optimization and, 29–30
images
   Google searches, 253
   importing to iPhoto, 347–348
   megapixels, 349
Stickies, 152
iMovie folder (Library), 127
In mailbox (Mail), 265
incoming calls, Bluetooth and, 427–428
InfoDog (Get Info), 161
input devices, Finder, 91–92
installation
   applications, additional, 16
   archive and install, 11
   benefits, 9–10
   BSD Subsystem, 16
   destination, 14
   erase and install, 11
   file transfer and, 18–19
   firmware updates, 13
   fonts, 15, 210
   language translations and, 16
   license agreement and, 14
   methods, 10–11
   printer drivers and, 15
   quitting installer, 16
   restart and, 16
   screen savers, 481
   Setup Assistant, 9, 17–18
   speech voices, additional, 16
   upgrade, 10
X11, 16
Internet. See also networks
   modem, 292–294
   optimization and, 30
   Internet Sharing, 316–318
   IOXperts drivers, 299
iPaste clipboard alternative, 207
iPasteboard clipboard alternative, 207
iPhoto
   Bonjour and, 306, 309–310
   editing images, 347
   importing images, 347–348
   Mail and, 345
   Photo Albums, 346
   Photo Albums, online, 350–351
   picture CDs, 371
   preferences, 344–345
   rotate images, 345
   Smart Album creation, 346–347
iPod
   backups, 375–377
   Carbon Copy Cloner, 376–377
   data transfer and, 372–373
   driving directions download, 379
   emergency Mac OS X installation, 377–378
   file management, 380
   housekeeping, 380
   iSync and, 378
   moving between Mac OS X and Windows, 373
   Notes, 379–380
   as PDA, 380
   storage and, 372–373, 373–375
iPulse, performance and, 37
iStumbler, 303
iSync
   Bluetooth and, 429–431
   iCal and, 361
   iPod and, 378
iTunes
   audio CDs, 370
   Bonjour and, 306, 308–309
   broadcasting, base station and, 298
   editing songs, 340
   iCal and, 365
   iTunes Music Store, 342–343
login with a song, 24
managing music, 339–342
from other applications, 341
playlist creation, 341
preferences, 333–338
sharing, 336
tracks, searching for, 340–341
window, 338–339
iTunes folder (Library), 127

J
JavaScript
   Java and, 241
   Safari and, 241–242
JiWire, 303
Junk mailbox (Mail)
   overview, 265
   spam deletion, 271–273

K
kernel, 10
Key Caps. See Character Palette
keyboard
   accessibility settings, 58–60
   Alt key, 45–46
   ⌘ (Command key), 46
   commands, cheat sheet, 46
   copying and, 204–206
   delay rate, 59
   Exposé and, 119
   Full Keyboard Access, 75
   repeat rate, 59
   services and, 220
   Slow Keys, 59
   Sticky Keys, 59
   Windows transition and, 46
Keyboard & Mouse System
   Preferences panel, mouse behavior, 47
keyboard navigation
  ^ (Control key), 70
  Applications directory, 74
  characters, 69–70
  Ô (Command key), 70
  Del key, 70
  Finder, 70–73
  Full Keyboard Access, 75
  Home folder, 74
  modifier keys, 70
  Option key, 70
  Shift key, 70
  Utilities directory, 74
Keyboard setting (Terminal preferences), 465–466
keyboard shortcuts
  ^ (Control key), 70
  applications, 80–81
  Applications directory, 74
  Ô (Command key), 70
  copying, 79
  Del key, 70
  Dock, 104–107
  Esc key, 79
  function keys, 82
  Home folder, 74
  iCal, 360–361
  iChat, 278–280
  image capture, 353
  Mail, 258–260
  Option key, 70
  pasting, 79
  programming, 82–83
  representation in book, 4
  Return, 78
  Safari navigation, 225–226
  Safari operations, 226–228
  save, 198
  Shift key, 70
  switching applications, 187
  Trash, 79
  undo, 79
  Utilities directory, 74
Keychain Access
  introduction, 410
  Notes, 412
  keychains, 409
  Keychains folder (Library), 127
  keywords, Google searches, 251–252
  Kind, List view (Finder), 96
  Konfabulator utility, 419
Language Translations, drive space and, 173
language translations, installation and, 16
laptop
  batteries, extending, 30–32
  Dock, 106
  LaunchBar, 184–185, 193–194
launching applications
  automatically, 179–181
  Dock, 182–183
  Favorites, 184
  Finder, 181–182
  Recent Items submenu, 184
  shareware tools, 184–185
less command (Terminal), 457–458
Library
  Application Support folder, 126
  Audio directory, 127
  Calendars directory, 127
  cleanup, 175
  ColorSync folder, 127
  Contextual Menu Items folder, 127
  Favorites folder, 127
  folders, 126–128
  Fonts folder, 127
  Home directory, 124–125
  iMovie folder, 127
  iTunes folder, 127
  Keychains folder, 127
  Mail folder, 127
  Movies directory, 125
  Music directory, 125
  Pictures directory, 125
  Preferences folder, 127
  Public directory, 125
  Safari directory, 127
  Sites directory, 125
License agreement, installation
  and, 14
limiting viruses, 392–394
List view (Finder)
  Comments, 96
  Date Created, 96
  Date Modified, 96
  Kind, 96
  Label, 96
  navigation, 72
  Size, 96
  sorting and, 95
  Version, 96
listing directories (Terminal), 445–446
LiteSwitch X application switcher, 188
Little Snitch, 323
ln command (Terminal), 445
locate command (Terminal), 447–448
location, networks
  Automatic, 290
  setup, 289
  switching on the fly, 294
locked files, deleting, 162
logging, iChat sessions, 282
login
  automatic, 23
  increase speed, 22–23
  multiple users and, 22
  song at startup, 24
  System Preferences and, 23–24
Login Items
  add items, 180
  remove applications, 181
login password, 413–414
logout, close applications and, 190
ls command (Terminal), 445–446

M

.mac Account
  Backup, 387–390
  iCall and, 361
  publishing calendars, 363–364
.mac Account mailbox (Mail), 265
.mac Accounts
  iDisk storage, 325–328
  reasons to use, 324–325
  synchronizing data, 329–330
Mac GNU Privacy Guard, encryption and, 407
MacJanitor, maintenance and, 418
macro viruses, 391
macros. See also Workflows
  accessibility and, 60
MacScan, 323
MacStumbler, 303
Mail
  address completion, 261
  attachments, 269
  Composing preferences, 260–261
  Dock icon, 268–269
General preferences, 260
  headers, 264
  iCal and, 364–365
  iPhoto and, 345
  keyboard shortcuts, 258–260
  Mail drawer, 265
  mailbox organization, 265–266
  message window customization, 262–263
  new features, 9
  New Message window customization, 263–264
  rules, 273–275
  searches, 266–267
  services, 219–220
  signatures, 267–268
  Smart Mailboxes, 269–270
  spam, Junk Mail button, 271–273
  spam bouncing, 276
  spam description, 273
  spam software, 276
  spelling check, 261
  toolbar customization, 261–262
  Mail folder (Library), 127
  mail-order catalogs, Google searches, 253
  mailboxes (Mail), organizing, 265–266
maintenance
  optimization and, 26–27
  utilities, 418–419
maps, Google, 257
Master Password, FileVault, 404
math on Google, 255–256
megapixels, 349
menu bar, representation in book, 4
menu sequences, representation in book, 4
menus
  Apple, 90
  contextual, 108–113
  Edit, 90
  File, 90
  Finder, 89–91
  Finder menu, 90
  Help, 90
  keyboard shortcuts and, 46
  View, 90
  Window, 90
message window (Mail), customizing, 262–263
migration resources, 50
minus sign (-) in Google searches, 252
mkdir command (Terminal), 446
modem, configuration, 292
modifier keys
  Exposé, 116
  Finder and, 92
monitor
  calibration, 64
  Detect Displays button, 63
  multiple, 66–68
  nonmirroring format, 67
  pixels, 61–62
  resolution, 61–63
  shutdown and, 21
monospace font (computer type), 5
More Info panel, Get Info, 157–158
motherboard, upgrades, 33
mouse
  accessibility settings, 58–60
  copying and, 204–206
  Dock shortcuts, 104–107
  Finder and, 92
  iChat, 278–280
  one-button, 47
  Safari, 228

TEAM LINING
Move2Mac Web site, 50
Movies directory (Library), 125
moving, files with Terminal, 443
MP3 files, 338
mrclean, 176
MSN, spam and, 275
multiple displays, 66–68
music, file formats, 337–338
Music directory (Library), 125
mv command (Terminal), 444
My Computer. See hard drive

Name & Extension panel, Get Info, 158–159
Namely launch utility, 185
naming files, renaming in
Terminal, 444
NAT (Network Address
Translation), routers and, 321
navigation
Desktop, 74
Finder, 70–73
keyboard (See keyboard
navigation)
Safari, keyboard shortcuts,
225–226
shortcuts, Mail, 259
Terminal, 434–438
Network panel, unlock, 290
network security, Sharing System
Preferences panel, 319–320
networks. See also Internet
AirPort, creating, 299–300
AirPort software, 297
Automatic (location), 290
calling card dialing, 295
cards, 297
FireWire, 295
location, 289
location switching, 294
ports, 291
ports, ordering, 295
protocols, 294
status, 291
tips, 294–296
wireless (See wireless
networks)
New Group From Selection tool,
146–147
news, Google searches, 253
newsgroup postings, Google
searches, 253
Nmap, 323
Norton AntiVirus, 397
Notes
iPod, 379–380
Keychain Access, 412
optimization
Activity Monitor, 35–37
AirPort Card and, 30
Cocktail, 27
disabling features and, 29–30
Disk Utility and, 27
Internet connection and, 30
maintenance, 26–27
Sharing panel and, 30
Option key
description, 46
keyboard navigation and, 70
OR keyword, Google, 252
organization of book, 3–4
overwriting files, 200–201, 444
Ownership & Permissions panel,
Get Info, 160–161
Pacifist utility, 419
packages, contextual menus, 110
palettes, Character Palette,
211–212
partitioning hard drive
installation and, 13
overview, 11
passwords
admin, resetting, 414
AutoFill, 232–233
keychains, 409
login password, 413–414
Master Password, FileVault,
404
Open Firmware Password utility,
413
rules for creating, 409–410
Safari, 233
screen savers, 480
paste operations
keyboard shortcuts, 79
tips, 207–208
paths (file and folder), Terminal, creating in, 444
pbcopy command (Terminal), 453–454
pbpaste command (Terminal), 453
PDF, creating, 202–203
performance
  Activity Monitor, 35–37
  hardware tuning, 32–33
permissions
  Ownership & Permissions panel, 160–161
  UNIX, 160–161
Personal File Sharing, 314–316
Personal Web Sharing
  introduction, 312–313
  URLs, 313
PGP (Pretty Good Privacy) software, 407
Photo Albums, iPhoto
  create, 346
  online, creating, 350–351
phrases in Google searches, 252
pico editor (Terminal), 459–460
Pictures directory (Library), 125
PIM (Personal Information Management) software, 358
piping commands (Terminal), 449–455
pixels, monitor resolution, common measurements, 61–62
Plain Clip clipboard alternative, 207
plus sign (+) in Google searches, 252
pop-up menus
  Exposé, 115
  hierarchical, Dock and, 105
  pop-ups in Web pages, blocking in Safari, 231–232
ports, network access
  disabling, 291
  Ethernet, wire computer support, 298
  firewalls, 320
  ordering, 295
  troubleshooting, 292
PostScript fonts, 209
PPP options, Internet dialup, 293
PPP (Point-to-Point Protocol), 294
PPPoE (Point-to-Point Protocol over Ethernet), 294
preferences
  Address Book, 142–144
  bookmarks (Safari), 247–248
  Finder, 84–88
  Google, 254
  iPhoto, 344–345
  iTunes, 333–338
  keyboard shortcut programming, 82–83
  Mail, 260–264
  RSS, 236
  Safari, 228–231
  Terminal, creating preferences files, 466–467
Preferences folder (Library), 127
Preferences panel (Terminal), 462–466
Preview panel, Get Info, 159–160
previewing documents, 202
print sharing, 316
printer drivers
  drive space and, 172
  installation and, 15
printers
  base stations (wireless network), 298
  Bonjour and, 310
  printing
    custom settings, 201
    desktop printing, 202
    PDF creation, 202–203
    previewing, 202
Private Browsing, Safari, 232
processes
  listing currently running, 450
  overview, 37
Processes setting (Terminal preferences), 463
profiles, ColorSync, 63–64
programmable mouse, Safari, 228
pronunciation, VoiceOver, 55
properties
  calendars (iCal), 360
  Dock, 103
  files, 155–161
protocols
  AppleTalk, 294
  FTP (File Transfer Protocol), 294
  HTTP (HyperText Transfer Protocol), 294
  PPP (Point-to-Point Protocol), 294
  PPPoE (Point-to-Point Protocol over Ethernet), 294
SMB (Server Message Block), 294
TCP/IP (Transmission Control Protocol/Internet Protocol), 294
ps command (Terminal), 450
Public directory (Library), 125
publishing calendars (iCal), 363–364
Q
QuickAccessCM, 110
QuickAddress, Address Book, 142
Quicksilver launch utility, 185
quitting
  applications, 190
  installer, 16
quotation marks in Google searches, 252

Recent Items submenu
  file opening, 194–195
  launching applications, 184
redirection commands
  (Terminal), 449–455
refresh rate, display, 64
remote control, cellphone as, 431–430
renaming files, Terminal, 444
resolution
  display, 61–63
  Displays dialog, 62–63
  fonts, 63
  virtual desktops, 63
resource forks, rsync and, 387
resources, Web sites, 5
restart, installation and, 16
restore backups, rsync and, 387
Retrospect Desktop backup utility, 390
Return key
  description, 46
  keyboard shortcuts, 78
rm command (Terminal), 444
rmdir command (Terminal), 446
root user, Terminal, 441
routers
  firewalls, 321
  networks, 298
routines. See Workflows
RSS feeds
  introduction, 2
  preferences, 236
RSS (Really Simple Syndication), Safari, 235–236
rsync backup utility
  benefits, 384
  drawbacks, 384
  Home directory backup to external hard drive, 385–387
  restores, 387
  syntax options, 385
Rules (Mail)
  creating, 273–274
  viruses and, 393
Safari
  AcidSearch, 240
  Aquafier, 238
  AutoFill forms, 232–233
  Bonjour and, 306
  bookmark a page, 245
  bookmark access, 248–249
  bookmark preferences, 247–248
  bookmark sharing, 249
  bookmark utilities, 240–241
  bookmarks, transfer to new computer, 249
  Bookmarks Bar, 244, 246–247
  Bookmarks Menu, 244, 246
  Bookmarks window, 243–244, 245
  CSSes (cascading style sheets), 238
  Debug menu, 238–239
  download location, 229
  Find dialog, 227
  fiwt, 239
  General preferences, 227, 228–229
  Google searches, 254–255
home page, 228–229
iLynX, 241
JavaScript, 241–242
keyboard shortcuts, 226–228
links, 229
mouse features, 228
new features, 9
passwords, 233
Pith, 239
PithHelmet, 239
pop-up blocking, 231–232
preferences, 228–231
Private Browsing, 232
RSS (Really Simple Syndication), 235–236
Safari Enhancer, 238
Safari Extender, 239
Safari Menu, 241
SafariBookmarkChecker, 241
SafariSorter, 240–241
SafariSource, 239
SafariSpeed, 238
Saft, 239
searches, 240
services, 218
SIMBL, 239
SnapBack, 234
Sogudi, 240
tabbed browsing, 226, 229–231
usernames, 233
Safari directory (Library), 127
Save As dialog, 197–201
Save dialog, navigation, 200
saving, files, 197–201
scheduling startups, 21–22
Screen Capture, screenshots,
  352–354
screen savers
  configuring, 478–480
desktop as, 482–483
library, adding to, 480–482
passwords, 480
screenshots
  Grab utility, 219, 354–355
  Screen Capture, 352–354
  Snapz Pro X, 356
Script menu (AppleScript), 91
scripting, CDs, 368
scroll bars, Finder, 100–101
Search box, Finder window
  case-sensitive searches, 165
  results, 166
searches
  AcidSearch, 240
  advanced, Google, 252–253
  Finder window, 164–166
  Google (See Google)
  Mail, 266–267
  Safari, 240
  Smart folders, 168–169
  Sogudi, 240
  Spotlight, 170–171
  Sticky Brain, 153
  System Preferences panel, 49
SearchGoogle service panel, 421
searching
  find command (Terminal),
    446–447
  locate command (Terminal),
    447–448
Secure Empty Trash option,
    407–408
security
  checking for problems,
    322–323
  ease and, 23
  FileVault, 403–405
  firewalls, 320–322
  iPod as storage, 373–375
  screen savers, setting passwords, 480
  sharing and, 311
software for, 323
  Web access block, 322
select, keyboard shortcuts, 79
Services
  adding, 221
  AntiWordService, 221
  application supporting, 218
  BBEdit, 219
  BlueService, 221
  CalcService, 221
  Carbon, 219
  CleverKeys, 221
  Cocoa, 219
  EasyFind, 221
  Finder, 218
  Google, 220
  HotService, 221
  ICeCoffEE, 221
  introduction, 217
  keyboard and, 220
  Mail, 219–220
  Safari, 218
  SearchGoogle, 221
  Stickies, 220
  WordService, 221
Setup Assistant
  introduction, 9
  questions, 17
ShapeShifter, Finder themes, 88
ShareClip clipboard alternative, 207
shared volumes, Bonjour and, 310
shareware
  application launch, 184–185
  application switching, 188
  Clipboard alternatives, 207
  Dock, 107
  file properties, 161
sharing
  files, other OSs, 163
  Internet Sharing, 316–318
iTunes music, 336
  Personal Web Sharing, 312–313
  print sharing, 316
  security, 311
  viruses and, 393
  Web pages, 312–313
Sharing panel
  Bonjour setup, 305
  optimization and, 30
  Sharing services, firewalls, 321
Sharing System Preferences
  panel, 319–320
shell
  customizing in Terminal,
    468–469
  selecting in Terminal, 467–468
  shell setting (Terminal preferences), 463
Shift key
  description, 46
  Desktop, 74
  Finder, 71
  keyboard navigation and, 70
shutdown
  close applications and, 190
  startup and, 20–21
Sidebar, Finder
  customizing, 99–100
  preferences, 87
signatures (Mail), 267–268
SilverKeeper backup utility, 390
SIMBL (Smart InputManager
  Bundle Loader), Safari and, 239
Sites directory (Library), 125
Size, List view (Finder), 96
sleep mode, startup and, 20–21
Slow Keys, properties, 59
Smart Album, iPhoto and,
  346–347
Smart folders, 168–169
Smart Groups (Address Book), creating, 148–149
Smart Mailboxes (Mail), 269–270
SMB (Server Message Block), 294
SMS (Short Message Service), Bluetooth and, 428
Snap to Grid, Icon view and, 94
SnapBack (Safari)
  bookmark comparison, 234
Google pages and, 234
Snapz Pro X, screenshots, 356
Snard shareware, 107
software
  antivirus, 396–397
  firewalls, 320–321
  security software, 323
  Software Update utility, 398–400
  Terminal, third-party, 469
  virus protection, 396–397
Software Update utility, 398
Sogudi, 240
sort command (Terminal), 450
sorting, List view (Finder), 95
sound, Stickies, 152
space on disk drive. See drive space
spam (Mail)
  AOL accounts, 275
  bouncing, 276
  description, 273
  Hotmail accounts, 275
  Junk Mail button, 271–273
  JunkMatcher, 277
  Mailblocks, 277
  MSN accounts, 275
  responding, 275
  SpamCop, 277
  Spamfire Pro, 277
  SpamSieve, 277
  SpamSlam, 277
Web bugs, 275
Yahoo! accounts, 275
Speakable Items, 56–57
specialized Google searches, 253–254
Speech pane
  Text to Speech, 55
  voice commands, 56–57
speech recognition, voice commands, 56–57
speech voices, installing additional, 16
speed. See also optimization
  application specific improvement, 29
spelling, Stickies, 152
Spotlight, 2, 9, 170–171
stalled applications, 34–35
Start menu. See Dock
startup
  scheduling, 21–22
  shutdown and, 20–21
Stationery Pad, 156
STDERR, redirecting output (Terminal), 454–455
STDOUT, redirecting output (Terminal), 454–455
STDIN, redirecting output (Terminal), 454–455
Stickies
  Cocoa, 151
  Dashboard Stickies, 152–153
  defaults, 152
  Finder, 151
  floating, 152
  formatting, 151
  introduction, 151
  services, 220
  spelling, 152
  Sticky Brain, 111, 153–154
  Sticky Keys, properties, 59
stock quotes, Google, 257
storage
  disk usage statistics, viewing, 450–451
  iPod and, 372–373, 373–375
stuffIt, encryption and, 407
stuffIt Deluxe
  backups and, 390
  contextual menus, 111
SubEthaEdit, Bonjour and, 306
SubRosaSoft software, 407
subscriptions to calendars, iCal, 362–363
sudo command (Terminal), 440–441
Super Get Info, 161
surfing. See Web surfing
Switch site (switching to Mac from Windows), 50
switching applications. See application switching
symbolic links (UNIX), 135
synchronization
  iDisk, 29–30
  .Mac Accounts, 329–330
System folder, cleanup, 175
System Preferences
  automatic startup and, 23–24
categories, 48
CDs, 366–368
Desktop & Screen Saver panel, 129
Dock, 102–103
DVDs, 366–368
login and, 23–24
login for multiple users, 22
open automatically, 25
screen savers, configuring, 478–480
searches, 49
setting, 48–49
startup schedule, 21–22
utilities, 49
system requirements
assumptions about reader, 3
Tiger installation, 10

tab completion, Terminal, 435–437, 444
Tab key
Ô (Command key) and, 81
Desktop, 74
Finder, 71
tabbed browsing, Safari, 226, 229–231
tail command (Terminal), 458–459
TCP/IP (Transmission Control Protocol/Internet Protocol), 294
technical topics, Google searches, 253
tee command (Terminal), 454
templates
Address Book, 142–144
Sticky Brain, 153
Terminal
aliases, creating, 445
Applications directory, 435
cat command, 456–457
command history, 438–440
commands, executing as another user, 440–441
commands, wildcards and, 446
cp command, 443–444
cron utility and, 418
directories, creating, 445–446
directories, deleting, 444, 446
directories, listing, 445–446
directories, viewing contents, 437
du command, 450–451
editing files, 459–461
file management overview, 443–445
file paths, creating, 444
files, viewing, 456–459
find command, 446–447
Finder and, 441–442
Finder and, editing between, 442
head command, 458–459
help, 438
less command, 457–458
ln command, 445
locate command, 447–448
ls command, 445–446
mkdir command, 446
mv command, 444
navigation, 434–438
navigation among windows, 437–438
pbcopy command, 453–454
pbpaste command, 453–454
pico editor, 459–460
piping and redirection, 449–455
preferences files, creating, 466–467
Preferences panel, 462–466
ps command, 450
rm command, 444
rmdir command, 446
root user, 441
shell, customizing, 468–469
shell, selecting, 467–468
sort command, 450
sudo command, 440–441
tab completion, 435–437
tab completion, forward slash, 444
tail command, 458–459
tee command, 454
wc command, 449–450
Terminal Inspector, settings, 463–466
text, speaking, 55
Text to Speech, vocalizing and, 55
TextEdit, opening from Terminal, 461
ThemeChanger, Finder themes, 88
themes, Finder, 88
third-party software
contextual menus, 110–111
drive space and, 176
T68iDialer (Bluetooth), 429
Tiger
installation benefits, 9–10
installation system requirements, 10
new features, 2, 9–10
purchase price, 10
time, speaking, 55
TinkerTool freeware, 66, 415–416
to-do lists, Sticky Brain, 153
trackpad, accessibility settings, 59
Transmit, Bonjour and, 306
Trash
empty, Dock, 106
keyboard shortcuts, 79
Trash mailbox (Mail), 265
Trojan horses, 391
TrueType fonts, 210
uControl shareware, function keys and, 82
undeleting files, Terminal rm command and, 444
Undo, keyboard shortcut, 79
unit converter, Google, 256
Universal Access panel
VoiceOver, 53
zoom feature, 57–58
university Web sites, Google searches, 253
UNIX
aliases, 135
permissions, 160–161
UNIX servers, accessing and changing Terminal encoding setting, 463–464
updates. See also Software Update utility
Apple Developer Connection e-mails, 402
Apple mailing lists, 402
application e-mails, 402
built-in updaters, 401
to Web pages, 401
MacUpdate, 402
upgrades comparison, 400–401
VersionTracker and, 401–402
upgrades
Tiger, 10
updates comparison, 400–401
URLs (uniform resource locators)
creating in iChat, 285–286
sharing and, 313
usernames, Safari, 233
Users directory, Home directory and, 124
utilities
AutoPairs, 420
Cocoa Gestures, 419
cron, 416–418
Font Book, 214–215
Konfabulator, 419
launching jobs, 185
maintenance, 418–419
Pacifist, 419
rsync (backups), 384–387
Software Update, 398–400
System Preferences panel, 49
TinkerTool, 415–416
VoiceOver, 53–56
Utilities directory, shortcut, 74

V

vCard, creating, 144–146
Version, List view (Finder), 96
VersionTracker, 401–402
vi editor, 459
video, Stickies, 152
video card, upgrades, 32
video conferencing with iChat, 283–285
View menu
overview, 90
panels, 48–49
view modes, Finder, switch, 93
View Options, Finder, 88–89, 137
viewing fonts, 210–215
vim editor, 459
Virex software, 394–396
virtual desktops, resolution and, 63
Virtual PC, viruses and, 393
VirusBarrier X software, 397
viruses
antivirus software and, 393
e-mail and, 392
firewalls and, 392
limiting, 392–394
macro viruses, 391
Rules (Mail), 393
scans, 393
sharing and, 393
Trojan horses, 391
Virex software, 394–396
Virtual PC and, 393
Visual Basic Scripts, 393

W

WAV files, 338
wc command (Terminal), 449–450
Web browsers. See browsers
Web bugs, spam and, 275
Web pages
pop-ups, blocking, 231–232
sharing, 312–313
Web sites
migration, 50
resources, 5
screen saver download sites, 480–481
switching to Mac from Windows, 50
Web surfing (Safari)
keyboard shortcuts, 226–228
shortcuts for navigation, 225–226
tabbed browsing, 226
WiFi Finder, 303
WiFinder, 303
wildcards, Terminal commands, 446
Window menu, 90
Window setting (Terminal preferences), 464–465
Windows
  iPod, moving between, 373
  switching from, 45–50
  viruses and, 394
windows
  contextual menus, 109
  Exposé, 114–120
  Finder, custom, 97–101
  iTunes, 338–339
  moving, 101
Windows Sharing, 314
wireless networks. See also networks
  alternatives, 299
  base station, 298
  devices, 297
  finding, 301–303
  hotspots, 301
  IOXperts drivers, 299
  iStumbler, 303
  JiWire, 303
  MacStumbler, 303
  routers, 298
  WiFi Finder, 303
  WiFinder, 303
  WirelessDriver, 299
  World Book Encyclopedia, Bonjour and, 306
worms, 391
WPA Personal encryption, 301

X–Y–Z
X11, installation and, 16
XBar launch utility, 185
Xcode 2, 9
XShelf clipboard alternative, 207
Yahoo!, spam and, 275
Zero conf, 304
Zingg! contextual menus, 110
zoom feature, Universal Access, 57–58
<table>
<thead>
<tr>
<th>Category</th>
<th>Books</th>
<th>ISBNs</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUSINESS, CAREERS &amp; PERSONAL FINANCE</td>
<td><strong>Also available:</strong>&lt;br&gt;- Accounting For Dummies †&lt;br&gt;- Business Plans Kit For Dummies †&lt;br&gt;- Cover Letters For Dummies&lt;br&gt;- Frugal Living For Dummies&lt;br&gt;- Leadership For Dummies&lt;br&gt;- Managing For Dummies&lt;br&gt;- Marketing For Dummies&lt;br&gt;- Personal Finance For Dummies *&lt;br&gt;- Project Management For Dummies&lt;br&gt;- Resumes For Dummies †&lt;br&gt;- Selling For Dummies&lt;br&gt;- Small Business Kit For Dummies †&lt;br&gt;- Accounting For Dummies †&lt;br&gt;- Business Plans Kit For Dummies †&lt;br&gt;- Cover Letters For Dummies&lt;br&gt;- Frugal Living For Dummies&lt;br&gt;- Leadership For Dummies&lt;br&gt;- Managing For Dummies&lt;br&gt;- Marketing For Dummies&lt;br&gt;- Personal Finance For Dummies *&lt;br&gt;- Project Management For Dummies&lt;br&gt;- Resumes For Dummies †&lt;br&gt;- Selling For Dummies&lt;br&gt;- Small Business Kit For Dummies †&lt;br&gt;- Accounting For Dummies †&lt;br&gt;- Business Plans Kit For Dummies †&lt;br&gt;- Cover Letters For Dummies&lt;br&gt;- Frugal Living For Dummies&lt;br&gt;- Leadership For Dummies&lt;br&gt;- Managing For Dummies&lt;br&gt;- Marketing For Dummies&lt;br&gt;- Personal Finance For Dummies *&lt;br&gt;- Project Management For Dummies&lt;br&gt;- Resumes For Dummies †&lt;br&gt;- Selling For Dummies&lt;br&gt;- Small Business Kit For Dummies †</td>
<td>0-7645-5307-0 0-7645-5331-3 † 0-7645-5314-3 0-7645-5365-8 0-7645-5224-4 0-7645-5403-4 0-7645-5176-0 0-7645-1771-6 0-7645-5600-2 0-7645-2590-5 0-7645-5283-X 0-7645-5471-9 0-7645-5363-1 0-7645-5093-4</td>
</tr>
<tr>
<td>HOME &amp; BUSINESS COMPUTER BASICS</td>
<td><strong>Also available:</strong>&lt;br&gt;- ACT! 6 For Dummies&lt;br&gt;- iLife '04 All-in-One Desk Reference For Dummies&lt;br&gt;- iPAQ For Dummies&lt;br&gt;- Mac OS X Panther Timesaving Techniques For Dummies&lt;br&gt;- Macs For Dummies&lt;br&gt;- Microsoft Money 2004 For Dummies&lt;br&gt;- Office 2003 All-in-One Desk Reference For Dummies&lt;br&gt;- Outlook 2003 For Dummies&lt;br&gt;- PCs For Dummies&lt;br&gt;- TiVo For Dummies&lt;br&gt;- Upgrading and Fixing PCs For Dummies&lt;br&gt;- Windows XP Timesaving Techniques For Dummies</td>
<td>0-7645-4074-2 0-7645-3758-X 0-7645-2645-6 0-7645-7347-0 0-7645-6769-1 0-7645-5812-9 0-7645-5656-8 0-7645-5105-1 0-7645-3883-7 0-7645-3759-8 0-7645-4074-2 0-7645-6923-6 0-7645-1665-5 0-7645-3748-2</td>
</tr>
</tbody>
</table>
| FOOD, HOME, GARDEN, HOBBIES, MUSIC & PETS | **Also available:**<br>- Bass Guitar For Dummies<br>- Diabetes Cookbook For Dummies<br>- Gardening For Dummies *
- Guitar For Dummies<br>- Holiday Decorating For Dummies<br>- Home Improvement All-in-One For Dummies<br>- Knitting For Dummies<br>- Piano For Dummies<br>- Puppies For Dummies<br>- Scrapbooking For Dummies<br>- Senior Dogs For Dummies<br>- Singing For Dummies<br>- 30-Minute Meals For Dummies | 0-7645-2487-9 0-7645-5230-9 0-7645-5130-2 0-7645-5106-X 0-7645-2570-0 0-7645-5680-0 0-7645-5395-X 0-7645-5105-1 0-7645-5255-4 0-7645-7208-3 0-7645-5818-8 0-7645-2475-5 0-7645-2589-1 |
| INTERNET & DIGITAL MEDIA | **Also available:**<br>- 2005 Online Shopping Directory For Dummies<br>- CD & DVD Recording For Dummies<br>- eBay For Dummies<br>- Fighting Spam For Dummies<br>- Genealogy Online For Dummies<br>- Google For Dummies<br>- Home Recording For Musicians For Dummies<br>- iPod & iTunes For Dummies<br>- Preventing Identity Theft For Dummies<br>- Pro Tools All-in-One Desk Reference For Dummies<br>- Roxio Easy Media Creator For Dummies | 0-7645-1664-7 0-7645-6924-4 0-7645-7495-7 0-7645-5956-7 0-7645-5654-1 0-7645-5965-6 0-7645-5964-8 0-7645-4420-9 0-7645-1634-5 0-7645-4173-0 0-7645-7772-7 0-7645-7336-5 0-7645-5714-9 0-7645-7131-1 |

* Separate Canadian edition also available
† Separate U.K. edition also available

Available wherever books are sold. For more information or to order direct: U.S. customers visit www.dummies.com or call 1-877-762-2974.
U.K. customers visit www.wileyeurope.com or call 0800 243407. Canadian customers visit www.wiley.ca or call 1-800-567-4797.
### SPORTS, FITNESS, PARENTING, RELIGION & SPIRITUALITY

Also available:
- Adoption For Dummies 0-7645-5488-3
- Basketball For Dummies 0-7645-5248-1
- The Bible For Dummies 0-7645-5296-1
- Buddhism For Dummies 0-7645-5359-3
- Catholicism For Dummies 0-7645-5391-7
- Hockey For Dummies 0-7645-5228-7
- Judaism For Dummies 0-7645-5299-6
- Martial Arts For Dummies 0-7645-5358-5
- Pilates For Dummies 0-7645-5397-6
- Religion For Dummies 0-7645-5264-3
- Teaching Kids to Read For Dummies 0-7645-4043-2
- Weight Training For Dummies 0-7645-5168-X
- Yoga For Dummies 0-7645-5117-5

### TRAVEL

Also available:
- Alaska For Dummies 0-7645-1761-9
- Arizona For Dummies 0-7645-6938-4
- Cancún and the Yucatán For Dummies 0-7645-2437-2
- Cruise Vacations For Dummies 0-7645-6941-4
- Europe For Dummies 0-7645-5456-5
- Ireland For Dummies 0-7645-5455-7
- Las Vegas For Dummies 0-7645-5448-4
- London For Dummies 0-7645-4277-X
- New York City For Dummies 0-7645-6945-7
- Paris For Dummies 0-7645-5494-8
- RV Vacations For Dummies 0-7645-5443-3
- Walt Disney World & Orlando For Dummies 0-7645-6943-0

### GRAPHICS, DESIGN & WEB DEVELOPMENT

Also available:
- Adobe Acrobat 6 PDF For Dummies 0-7645-3760-1
- Building a Web Site For Dummies 0-7645-7144-3
- Dreamweaver MX 2004 For Dummies 0-7645-4342-3
- FrontPage 2003 For Dummies 0-7645-3882-9
- HTML 4 For Dummies 0-7645-1995-6
- Illustrator CS For Dummies 0-7645-4084-X
- Macromedia Flash MX 2004 For Dummies 0-7645-4358-X
- Photoshop 7 All-in-One Desk Reference For Dummies 0-7645-1667-1
- Photoshop cs Timesaving Techniques For Dummies 0-7645-6782-9
- PHP 5 For Dummies 0-7645-4166-8
- PowerPoint 2003 For Dummies 0-7645-3908-6
- QuarkXPress 6 For Dummies 0-7645-2593-X

### NETWORKING, SECURITY, PROGRAMMING & DATABASES

Also available:
- A+ Certification For Dummies 0-7645-4187-0
- Access 2003 All-in-One Desk Reference For Dummies 0-7645-3988-4
- Beginning Programming For Dummies 0-7645-4997-9
- C For Dummies 0-7645-7068-4
- Firewalls For Dummies 0-7645-4048-3
- Home Networking For Dummies 0-7645-42796
- Network Security For Dummies 0-7645-1679-5
- Networking For Dummies 0-7645-1677-9
- TCP/IP For Dummies 0-7645-1760-0
- VBA For Dummies 0-7645-3989-2
- Wireless All In-One Desk Reference For Dummies 0-7645-7496-5
- Wireless Home Networking For Dummies 0-7645-3910-8
Do More with Dummies
Products for the Rest of Us!

From hobbies to health, discover a wide variety of fun products

DVDs/Videos • Music CDs • Games
Consumer Electronics • Software
Craft Kits • Culinary Kits • and More!

Check out the Dummies Specialty Shop at www.dummies.com for more information!